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Abstract

				This document describes the installation, configuration, and administration of virtual machines in Red Hat Virtualization.
			






Chapter 1. Introduction




			A virtual machine is a software implementation of a computer. The Red Hat Virtualization environment enables you to create virtual desktops and virtual servers.
		

			Virtual machines consolidate computing tasks and workloads. In traditional computing environments, workloads usually run on individually administered and upgraded servers. Virtual machines reduce the amount of hardware and administration required to run the same computing tasks and workloads.
		
Audience




				Most virtual machine tasks in Red Hat Virtualization can be performed in both the VM Portal and Administration Portal. However, the user interface differs between each portal, and some administrative tasks require access to the Administration Portal. Tasks that can only be performed in the Administration Portal will be described as such in this book. Which portal you use, and which tasks you can perform in each portal, is determined by your level of permissions. Virtual machine permissions are explained in Virtual Machines and Permissions.
			

				The VM Portal’s user interface is described in the Introduction to the VM Portal.
			

				The Administration Portal’s user interface is described in the Administration Guide.
			

				The creation and management of virtual machines through the Red Hat Virtualization REST API is documented in the REST API Guide.
			

Supported Virtual Machine Operating Systems




				See Certified Guest Operating Systems in Red Hat OpenStack Platform, Red Hat Virtualization and OpenShift Virtualization for a current list of supported operating systems.
			

				For information on customizing the operating systems, see Configuring operating systems with osinfo.
			

Virtual Machine Performance Parameters




				For information on the parameters that Red Hat Virtualization virtual machines can support, see Red Hat Enterprise Linux technology capabilities and limits and Virtualization limits for Red Hat Virtualization.
			

Installing Supporting Components on Client Machines



Installing Console Components




					A console is a graphical window that allows you to view the start up screen, shut down screen, and desktop of a virtual machine, and to interact with that virtual machine in a similar way to a physical machine. In Red Hat Virtualization, the default application for opening a console to a virtual machine is Remote Viewer, which must be installed on the client machine prior to use.
				
Installing Remote Viewer on Red Hat Enterprise Linux




						The Remote Viewer application provides users with a graphical console for connecting to virtual machines. Once installed, it is called automatically when attempting to open a SPICE session with a virtual machine. Alternatively, it can also be used as a standalone application. Remote Viewer is included in the virt-viewer package provided by the base Red Hat Enterprise Linux Workstation and Red Hat Enterprise Linux Server repositories.
					
Procedure
	
								Install the virt-viewer package:
							
# dnf install virt-viewer

	
								Restart your browser for the changes to take effect.
							



						You can now connect to your virtual machines using either the SPICE protocol or the VNC protocol.
					

Installing Remote Viewer on Windows




						The Remote Viewer application provides users with a graphical console for connecting to virtual machines. Once installed, it is called automatically when attempting to open a SPICE session with a virtual machine. Alternatively, it can also be used as a standalone application.
					

						Installing Remote Viewer on Windows
					
	
								Open a web browser and download one of the following installers according to the architecture of your system.
							
	
										Virt Viewer for 32-bit Windows:
									
https://your-manager-fqdn/ovirt-engine/services/files/spice/virt-viewer-x86.msi

	
										Virt Viewer for 64-bit Windows:
									
https://your-manager-fqdn/ovirt-engine/services/files/spice/virt-viewer-x64.msi




	
								Open the folder where the file was saved.
							
	
								Double-click the file.
							
	
								Click Run if prompted by a security warning.
							
	
								Click Yes if prompted by User Account Control.
							



						Remote Viewer is installed and can be accessed via Remote Viewer in the VirtViewer folder of All Programs in the start menu.
					

Installing usbdk on Windows




						usbdk is a driver that enables remote-viewer exclusive access to USB devices on Windows operating systems. Installing usbdk requires Administrator privileges. Note that the previously supported USB Clerk option has been deprecated and is no longer supported.
					

						Installing usbdk on Windows
					
	
								Open a web browser and download one of the following installers according to the architecture of your system.
							
	
										usbdk for 32-bit Windows:
									
https://[your manager’s address]/ovirt-engine/services/files/spice/usbdk-x86.msi

	
										usbdk for 64-bit Windows:
									
https://[your manager’s address]/ovirt-engine/services/files/spice/usbdk-x64.msi




	
								Open the folder where the file was saved.
							
	
								Double-click the file.
							
	
								Click Run if prompted by a security warning.
							
	
								Click Yes if prompted by User Account Control.
							






Chapter 2. Installing Red Hat Enterprise Linux Virtual Machines




			Installing a Red Hat Enterprise Linux virtual machine involves the following key steps:
		
	
					Create a virtual machine. You must add a virtual disk for storage, and a network interface to connect the virtual machine to the network.
				
	
					Start the virtual machine and install an operating system. See your operating system’s documentation for instructions.
				
	
							Red Hat Enterprise Linux 6: Installing Red Hat Enterprise Linux 6.9 for all architectures
						
	
							Red Hat Enterprise Linux 7: Installing Red Hat Enterprise Linux 7 on all architectures
						
	
							Red Hat Enterprise Linux Atomic Host 7: Red Hat Enterprise Linux Atomic Host 7 Installation and Configuration Guide
						
	
							Red Hat Enterprise Linux 8: Installing Red Hat Enterprise Linux 8 using the graphical user interface
						



	
					Enable the required repositories for your operating system.
				
	
					Install guest agents and drivers for additional virtual machine functionality.
				


Creating a virtual machine




				When creating a new virtual machine, you specify its settings. You can edit some of these settings later, including the chipset and BIOS type. For more information, see UEFI and the Q35 chipset in the Administration Guide. .Prerequisites
			
Note

					Before you can use this virtual machine, you must:
				
	
							Install an operating system
						
	
									Use a pre-installed image by Creating a Cloned Virtual Machine Based on a Template
								
	
									Use a pre-installed image from an attached pre-installed Disk
								
	
									Install an operating system through the PXE boot menu or from an ISO file
								



	
							Register with the Content Delivery Network
						



Procedure
	
						Click Compute → Virtual Machines.
					
	
						Click New. This opens the New Virtual Machine window.
					
	
						Select an Operating System from the drop-down list.
					
Note

							If you selected Red Hat Enterprise Linux CoreOS as the operating system, you may need to set the initialization method by configuring Ignition settings in the Advanced Options Initial Run tab. See Configuring Ignition.
						


	
						Enter a Name for the virtual machine.
					
	
						Add storage to the virtual machine: under Instance Images, click Attach or Create to select or create a virtual disk .
					
	
								Click Attach and select an existing virtual disk.
							

								or
							

	
								Click Create and enter a Size(GB) and Alias for a new virtual disk. You can accept the default settings for all other fields, or change them if required. See Explanation of settings in the New Virtual Disk and Edit Virtual Disk windows for more details on the fields for all disk types.
							



	
						Connect the virtual machine to the network. Add a network interface by selecting a vNIC profile from the nic1 drop-down list at the bottom of the General tab.
					
	
						Specify the virtual machine’s Memory Size on the System tab.
					
	
						In the Boot Options tab, choose the First Device that the virtual machine will use to boot.
					
	
						You can accept the default settings for all other fields, or change them if required. For more details on all fields in the New Virtual Machine window, see Explanation of settings in the New Virtual Machine and Edit Virtual Machine Windows.
					
	
						Click OK.
					



				The new virtual machine is created and displays in the list of virtual machines with a status of Down.
			

Configuring Ignition

					Ignition is the utility that is used by Red Hat Enterprise Linux CoreOS to manipulate disks during initial configuration. It completes common disk tasks, including partitioning disks, formatting partitions, writing files, and configuring users. On first boot, Ignition reads its configuration from the installation media or the location that you specify and applies the configuration to the machines.
				
Important

					Once Ignition has been configured as the initialization method, it cannot be reversed or re-configured.
				

	
						In the Add Virtual Machine or Edit Virtual Machine screen, click Show Advanced Options.
					
	
						In the Initial Run tab, select the Ignition 2.3.0 option and enter the VM Hostname.
					
	
						Expand the Authorization option, enter a hashed (SHA-512) password, and enter the password again to verify.
					
	
						If you are using SSH keys for authorization, enter them in the space provided.
					
	
						You can also enter a custom Ignition script in JSON format in the Ignition Script field. This script will run on the virtual machine when it starts. The scripts you enter in this field are custom JSON sections that are added to those produced by the Manager, and allow you to use custom Ignition instructions.
					
Note

							If the Red Hat Enterprise Linux CoreOS image you are using contains an Ignition version different than 2.3.0, you need to use a script in the Ignition Script field to enforce the Ignition version included in your Red Hat Enterprise Linux CoreOS image.
						

							When you use an Ignition script, the script instructions take precedence over and override any conflicting Ignition settings you configured in the UI.
						





Starting the Virtual Machine



Starting a Virtual Machine



Procedure
	
							Click Compute → Virtual Machines and select a virtual machine with a status of Down.
						
	
							Click Run.
						



					The Status of the virtual machine changes to Up, and the operating system installation begins. Open a console to the virtual machine if one does not open automatically.
				
Note

						A virtual machine will not start on a host with an overloaded CPU. By default, a host’s CPU is considered overloaded if it has a load of more than 80% for 5 minutes, but these values can be changed using scheduling policies. See Scheduling Policies in the Administration Guide for more information.
					

Troubleshooting

						Scenario - the virtual machine fails to boot with the following error message:
					
Boot failed: not a bootable disk - No Bootable device

					Possible solutions to this problem:
				
	
							Make sure that hard disk is selected in the boot sequence, and the disk that the virtual machine is booting from must be set as Bootable.
						
	
							Create a Cloned Virtual Machine Based on a Template.
						
	
							Create a new virtual machine with a local boot disk managed by RHV that contains the OS and application binaries.
						
	
							Install the OS by booting from the Network (PXE) boot option.
						



					Scenario - the virtual machine on IBM POWER9 fails to boot with the following error message:
				
qemu-kvm: Requested count cache flush assist capability level not supported by kvm, try appending -machine cap-ccf-assist=off

					Default risk level protections can prevent VMs from starting on IBM POWER9. To resolve this issue:
				
	
							Create or edit the /var/lib/obmc/cfam_overrides on the BMC.
						
	
							Set the firmware risk level to 0:
						
# Control speculative execution mode
0 0x283a 0x00000000  # bits 28:31 are used for init level -- in this case 0 Kernel and User protection (safest, default)
0 0x283F 0x20000000  # Indicate override register is valid

	
							Reboot the host system for the changes to take affect.
						


Note

						Overriding the risk level can cause unexpected behavior when running virtual machines.
					


Opening a console to a virtual machine




					Use Remote Viewer to connect to a virtual machine.
				
Note

						To allow other users to connect to the VM, make sure you shutdown and restart the virtual machine when you are finished using the console. Alternatively, the administrator can Disable strict user checking to eliminate the need for reboot between users. See Virtual Machine Console Settings Explained for more information.
					

Procedure
	
							Install Remote Viewer if it is not already installed. See Installing Console Components.
						
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Console. By default, the browser prompts you to download a file named console.vv. When you click to open the file, a console window opens for the virtual machine. You can configure your browser to automatically open these files, such that clicking Console simply opens the console.
						


Note

						console.vv expires after 120 seconds. If more than 120 seconds elapse between the time the file is downloaded and the time that you open the file, click Console again.
					

Additional resources
	
							Automatically connecting to a Virtual Machine
						
	
							Configuring Console Options
						



Opening a Serial Console to a Virtual Machine




					You can access a virtual machine’s serial console from the command line instead of opening a console from the Administration Portal or the VM Portal. The serial console is emulated through VirtIO channels, using SSH and key pairs. The Manager acts as a proxy for the connection, provides information about virtual machine placement, and stores the authentication keys. You can add public keys for each user from either the Administration Portal or the VM Portal. You can access serial consoles for only those virtual machines for which you have appropriate permissions.
				
Important

						To access the serial console of a virtual machine, the user must have UserVmManager, SuperUser, or UserInstanceManager permission on that virtual machine. These permissions must be explicitly defined for each user. It is not enough to assign these permissions to Everyone.
					


					The serial console is accessed through TCP port 2222 on the Manager. This port is opened during engine-setup on new installations. To change the port, see ovirt-vmconsole/README.md.
				

					You must configure the following firewall rules to allow a serial console:
				
	
							Rule "M3" for the Manager firewall
						
	
							Rule "H2" for the host firewall
						



					The serial console relies on the ovirt-vmconsole package and the ovirt-vmconsole-proxy on the Manager and the ovirt-vmconsole package and the ovirt-vmconsole-host package on the hosts.
				

					These packages are installed by default on new installations. To install the packages on existing installations, reinstall the hosts.
				

					Enabling a Virtual Machine’s Serial Console
				
	
							On the virtual machine whose serial console you are accessing, add the following lines to /etc/default/grub:
						
GRUB_CMDLINE_LINUX_DEFAULT="console=tty0 console=ttyS0,115200n8"
GRUB_TERMINAL="console serial"
GRUB_SERIAL_COMMAND="serial --speed=115200 --unit=0 --word=8 --parity=no --stop=1"
Note

								GRUB_CMDLINE_LINUX_DEFAULT applies this configuration only to the default menu entry. Use GRUB_CMDLINE_LINUX to apply the configuration to all the menu entries.
							

								If these lines already exist in /etc/default/grub, update them. Do not duplicate them.
							


	
							Rebuild /boot/grub2/grub.cfg:
						
	
									BIOS-based machines:
								
# grub2-mkconfig -o /boot/grub2/grub.cfg

	
									UEFI-based machines:
								
# grub2-mkconfig -o /boot/efi/EFI/redhat/grub.cfg

									See GRUB 2 over a Serial Console in the Red Hat Enterprise Linux 7 System Administrator’s Guide for details.
								




	
							On the client machine from which you are accessing the virtual machine serial console, generate an SSH key pair. The Manager supports standard SSH key types, for example, an RSA key:
						
# ssh-keygen -t rsa -b 2048 -f .ssh/serialconsolekey

							This command generates a public key and a private key.
						

	
							In the Administration Portal, click Administration → Account Settings or click the user icon on the header bar and click Account Settings to open the Account Settings screen.
						

							OR
						

							In the VM Portal, click the Settings icon on the header bar to open the Account Settings screen.
						

	
							In the User’s Public Key text field (Administration Portal) or SSH Key field (VM Portal), paste the public key of the client machine that will be used to access the serial console.
						
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							In the Console tab of the Edit Virtual Machine window, select the Enable VirtIO serial console check box.
						



					Connecting to a Virtual Machine’s Serial Console
				

					On the client machine, connect to the virtual machine’s serial console:
				
	
							If a single virtual machine is available, this command connects the user to that virtual machine:
						
# ssh -t -p 2222 ovirt-vmconsole@Manager_FQDN -i .ssh/serialconsolekey
Red Hat Enterprise Linux Server release 6.7 (Santiago)
Kernel 2.6.32-573.3.1.el6.x86_64 on an x86_64
USER login:

	
							If more than one virtual machine is available, this command lists the available virtual machines and their IDs:
						
# ssh -t -p 2222 ovirt-vmconsole@Manager_FQDN -i .ssh/serialconsolekey list
1. vm1 [vmid1]
2. vm2 [vmid2]
3. vm3 [vmid3]
> 2
Red Hat Enterprise Linux Server release 6.7 (Santiago)
Kernel 2.6.32-573.3.1.el6.x86_64 on an x86_64
USER login:

							Enter the number of the machine to which you want to connect, and press Enter.
						

	
							Alternatively, connect directly to a virtual machine using its unique identifier or its name:
						
# ssh -t -p 2222 ovirt-vmconsole@Manager_FQDN connect --vm-id vmid1
# ssh -t -p 2222 ovirt-vmconsole@Manager_FQDN connect --vm-name vm1




					Disconnecting from a Virtual Machine’s Serial Console
				

					Press any key followed by ~ . to close a serial console session.
				

					If the serial console session is disconnected abnormally, a TCP timeout occurs. You will be unable to reconnect to the virtual machine’s serial console until the timeout period expires.
				

Automatically Connecting to a Virtual Machine




					Once you have logged in, you can automatically connect to a single running virtual machine. This can be configured in the VM Portal.
				
Procedure
	
							In the Virtual Machines page, click the name of the virtual machine to go to the details view.
						
	
							Click the pencil icon beside Console and set Connect automatically to ON.
						



					The next time you log into the VM Portal, if you have only one running virtual machine, you will automatically connect to that machine.
				


Enabling the Required Repositories




				To install packages signed by Red Hat you must register the target system to the Content Delivery Network. Then, use an entitlement from your subscription pool and enable the required repositories.
			

				Enabling the Required Repositories Using Subscription Manager
			
	
						Register your system with the Content Delivery Network, entering your Customer Portal user name and password when prompted:
					
# subscription-manager register

	
						Locate the relevant subscription pools and note down the pool identifiers:
					
# subscription-manager list --available

	
						Use the pool identifiers to attach the required subscriptions:
					
# subscription-manager attach --pool=pool_id

	
						When a system is attached to a subscription pool with multiple repositories, only the main repository is enabled by default. Others are available, but disabled. Enable any additional repositories:
					
# subscription-manager repos --enable=repository

	
						Ensure that all packages currently installed are up to date:
					
# dnf upgrade --nobest
Note

							For versions of Red Hat Enterprise Linux earlier than 8, use the command yum update instead of dnf upgrade:
						
# yum update

							See also Cannot perform yum update on my RHV manager (ansible conflict)
						





Installing Guest Agents and Drivers



Red Hat Virtualization Guest agents, tools, and drivers




					The Red Hat Virtualization guest agents, tools, and drivers provide additional functionality for virtual machines, such as gracefully shutting down or rebooting virtual machines from the VM Portal and Administration Portal. The tools and agents also provide information for virtual machines, including:
				
	
							Resource usage
						
	
							IP addresses
						



					The guest agents, tools and drivers are distributed as an ISO file that you can attach to virtual machines. This ISO file is packaged as an RPM file that you can install and upgrade from the Manager machine.
				

					You need to install the guest agents and drivers on a virtual machine to enable this functionality for that machine.
				
Table 2.1. Red Hat Virtualization Guest drivers
	Driver	Description	Works on
	 
									virtio-net
								

								 	 
									Paravirtualized network driver provides enhanced performance over emulated devices like rtl.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-block
								

								 	 
									Paravirtualized HDD driver offers increased I/O performance over emulated devices like IDE by optimizing the coordination and communication between the virtual machine and the hypervisor. The driver complements the software implementation of the virtio-device used by the host to play the role of a hardware device.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-scsi
								

								 	 
									Paravirtualized iSCSI HDD driver offers similar functionality to the virtio-block device, with some additional enhancements. In particular, this driver supports adding hundreds of devices, and names devices using the standard SCSI device naming scheme.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-serial
								

								 	 
									Virtio-serial provides support for multiple serial ports. The improved performance is used for fast communication between the virtual machine and the host that avoids network complications. This fast communication is required for the guest agents and for other features such as clipboard copy-paste between the virtual machine and the host and logging.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-balloon
								

								 	 
									Virtio-balloon is used to control the amount of memory a virtual machine actually accesses. It offers improved memory overcommitment.
								

								 	 
									Server and Desktop.
								

								 
	 
									qxl
								

								 	 
									A paravirtualized display driver reduces CPU usage on the host and provides better performance through reduced network bandwidth on most workloads.
								

								 	 
									Server and Desktop.
								

								 



Table 2.2. Red Hat Virtualization Guest agents and tools
	Guest agent/tool	Description	Works on
	 
									qemu-guest-agent
								

								 	 
									Used instead of ovirt-guest-agent-common on Red Hat Enterprise Linux 8 virtual machines. It is installed and enabled by default.
								

								 	 
									Server and Desktop.
								

								 
	 
									spice-agent
								

								 	 
									The SPICE agent supports multiple monitors and is responsible for client-mouse-mode support to provide a better user experience and improved responsiveness than the QEMU emulation. Cursor capture is not needed in client-mouse-mode. The SPICE agent reduces bandwidth usage when used over a wide area network by reducing the display level, including color depth, disabling wallpaper, font smoothing, and animation. The SPICE agent enables clipboard support allowing cut and paste operations for both text and images between client and virtual machine, and automatic guest display setting according to client-side settings. On Windows-based virtual machines, the SPICE agent consists of vdservice and vdagent.
								

								 	 
									Server and Desktop.
								

								 




Installing the Guest Agents and Drivers on Red Hat Enterprise Linux




					The Red Hat Virtualization guest agents and drivers are provided by the Red Hat Virtualization Agent repository.
				
Note

						Red Hat Enterprise Linux 8 virtual machines use the qemu-guest-agent service, which is installed and enabled by default, instead of the ovirt-guest-agent service. If you need to manually install the guest agent on RHEL 8, follow the procedure below.
					

Procedure
	
							Log in to the Red Hat Enterprise Linux virtual machine.
						
	
							Enable the Red Hat Virtualization Agent repository:
						
	
									For Red Hat Enterprise Linux 6
								
# subscription-manager repos --enable=rhel-6-server-rhv-4-agent-rpms

	
									For Red Hat Enterprise Linux 7
								
# subscription-manager repos --enable=rhel-7-server-rh-common-rpms

	
									For Red Hat Enterprise Linux 8
								
# subscription-manager repos --enable=rhel-8-for-x86_64-appstream-rpms




	
							Install the guest agent and dependencies:
						
	
									For Red Hat Enterprise Linux 6 or 7, install the ovirt guest agent:
								
# yum install ovirt-guest-agent-common

	
									For Red Hat Enterprise Linux 8 and 9, install the qemu guest agent:
								
# yum install qemu-guest-agent




	
							Start and enable the ovirt-guest-agent service:
						
	
									For Red Hat Enterprise Linux 6
								
# service ovirt-guest-agent start
# chkconfig ovirt-guest-agent on

	
									For Red Hat Enterprise Linux 7
								
# systemctl start ovirt-guest-agent
# systemctl enable ovirt-guest-agent




	
							Start and enable the qemu-guest-agent service:
						
	
									For Red Hat Enterprise Linux 6
								
# service qemu-ga start
# chkconfig qemu-ga on

	
									For Red Hat Enterprise Linux 7, 8 or 9
								
# systemctl start qemu-guest-agent
# systemctl enable qemu-guest-agent







					The guest agent now passes usage information to the Red Hat Virtualization Manager. You can configure the oVirt guest agent in the /etc/ovirt-guest-agent.conf file.
				



Chapter 3. Installing Windows virtual machines




			Installing a Windows virtual machine involves the following key steps:
		
	
					Create a blank virtual machine on which to install an operating system.
				
	
					Add a virtual disk for storage.
				
	
					Add a network interface to connect the virtual machine to the network.
				
	
					Attach the Windows guest tools CD to the virtual machine so that VirtIO-optimized device drivers can be installed during the operating system installation.
				
	
					Install a Windows operating system on the virtual machine. See your operating system’s documentation for instructions.
				
	
					During the installation, install guest agents and drivers for additional virtual machine functionality.
				



			When all of these steps are complete, the new virtual machine is functional and ready to perform tasks.
		
Creating a virtual machine




				When creating a new virtual machine, you specify its settings. You can edit some of these settings later, including the chipset and BIOS type. For more information, see UEFI and the Q35 chipset in the Administration Guide. .Prerequisites
			
Note

					Before you can use this virtual machine, you must:
				
	
							Install an operating system
						
	
							Install a VirtIO-optimized disk and network drivers
						



Procedure
	
						You can change the default virtual machine name length with the engine-config tool. Run the following command on the Manager machine:
					
# engine-config --set MaxVmNameLength=integer

	
						Click Compute → Virtual Machines.
					
	
						Click New. This opens the New Virtual Machine window.
					
	
						Select an Operating System from the drop-down list.
					
	
						Enter a Name for the virtual machine.
					
	
						Add storage to the virtual machine: under Instance Images, click Attach or Create to select or create a virtual disk .
					
	
								Click Attach and select an existing virtual disk.
							

								or
							

	
								Click Create and enter a Size(GB) and Alias for a new virtual disk. You can accept the default settings for all other fields, or change them if required. See Explanation of settings in the New Virtual Disk and Edit Virtual Disk windows for more details on the fields for all disk types.
							



	
						Connect the virtual machine to the network. Add a network interface by selecting a vNIC profile from the nic1 drop-down list at the bottom of the General tab.
					
	
						Specify the virtual machine’s Memory Size on the System tab.
					
	
						In the Boot Options tab, choose the First Device that the virtual machine will use to boot.
					
	
						You can accept the default settings for all other fields, or change them if required. For more details on all fields in the New Virtual Machine window, see Explanation of settings in the New Virtual Machine and Edit Virtual Machine Windows.
					
	
						Click OK.
					



				The new virtual machine is created and displays in the list of virtual machines with a status of Down.
			

Starting the virtual machine using Run Once



Installing Windows on VirtIO-optimized hardware




					Install VirtIO-optimized disk and network device drivers during your Windows installation by attaching the virtio-win_version.iso file to your virtual machine. These drivers provide a performance improvement over emulated device drivers.
				

					Use the Run Once option to attach the virtio-win_version.iso file in a one-off boot different from the Boot Options defined in the New Virtual Machine window.
				
Prerequisites

						The following items were added to the virtual machine:
					
	
							A Red Hat VirtIO network interface
						
	
							A disk that uses the VirtIO interface
						



					You can upload virtio-win_version.iso to a data storage domain.
				
Note

						Red Hat recommends uploading ISO images to the data domain with the Administration Portal or with the REST API. For more information, see Uploading Images to a Data Storage Domain in the Administration Guide.
					

						If necessary, you can upload the virtio-win ISO file to an ISO storage domain that is hosted on the Manager. The ISO storage domain type is deprecated. For more information, see Uploading images to an ISO domain in the Administration Guide.
					

Procedure

						To install the virtio-win drivers when installing Windows, complete the following steps:
					
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Run → Run Once.
						
	
							Expand the Boot Options menu.
						
	
							Select the Attach CD check box, and select a Windows ISO from the drop-down list.
						
	
							Select the Attach Windows guest tools CD check box.
						
	
							Move CD-ROM to the top of the Boot Sequence field.
						
	
							Configure other Run Once options as required. See Virtual Machine Run Once settings explained for more details.
						
	
							Click OK. The status of the virtual machine changes to Up, and the operating system installation begins.
						

							Open a console to the virtual machine if one does not open automatically during the Windows installation.
						

	
							When prompted to select a drive onto which you want to install Windows, click Load driver and OK.
						
	
							Under Select the driver to install, select the appropriate driver for the version of Windows. For example, for Windows Server 2019, select Red Hat VirtIO SCSI controller (E:\amd64\2k19\viostor.inf)
						
	
							Click Next.
						



					The rest of the installation proceeds as normal.
				

Opening a console to a virtual machine




					Use Remote Viewer to connect to a virtual machine.
				
Note

						To allow other users to connect to the VM, make sure you shutdown and restart the virtual machine when you are finished using the console. Alternatively, the administrator can Disable strict user checking to eliminate the need for reboot between users. See Virtual Machine Console Settings Explained for more information.
					

Procedure
	
							Install Remote Viewer if it is not already installed. See Installing Console Components.
						
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Console. By default, the browser prompts you to download a file named console.vv. When you click to open the file, a console window opens for the virtual machine. You can configure your browser to automatically open these files, such that clicking Console simply opens the console.
						


Note

						console.vv expires after 120 seconds. If more than 120 seconds elapse between the time the file is downloaded and the time that you open the file, click Console again.
					

Additional resources
	
							Automatically connecting to a Virtual Machine
						
	
							Configuring Console Options
						




Installing guest agents and drivers



Red Hat Virtualization Guest agents, tools, and drivers




					The Red Hat Virtualization guest agents, tools, and drivers provide additional functionality for virtual machines, such as gracefully shutting down or rebooting virtual machines from the VM Portal and Administration Portal. The tools and agents also provide information for virtual machines, including:
				
	
							Resource usage
						
	
							IP addresses
						



					The guest agents, tools and drivers are distributed as an ISO file that you can attach to virtual machines. This ISO file is packaged as an RPM file that you can install and upgrade from the Manager machine.
				

					You need to install the guest agents and drivers on a virtual machine to enable this functionality for that machine.
				
Table 3.1. Red Hat Virtualization Guest drivers
	Driver	Description	Works on
	 
									virtio-net
								

								 	 
									Paravirtualized network driver provides enhanced performance over emulated devices like rtl.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-block
								

								 	 
									Paravirtualized HDD driver offers increased I/O performance over emulated devices like IDE by optimizing the coordination and communication between the virtual machine and the hypervisor. The driver complements the software implementation of the virtio-device used by the host to play the role of a hardware device.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-scsi
								

								 	 
									Paravirtualized iSCSI HDD driver offers similar functionality to the virtio-block device, with some additional enhancements. In particular, this driver supports adding hundreds of devices, and names devices using the standard SCSI device naming scheme.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-serial
								

								 	 
									Virtio-serial provides support for multiple serial ports. The improved performance is used for fast communication between the virtual machine and the host that avoids network complications. This fast communication is required for the guest agents and for other features such as clipboard copy-paste between the virtual machine and the host and logging.
								

								 	 
									Server and Desktop.
								

								 
	 
									virtio-balloon
								

								 	 
									Virtio-balloon is used to control the amount of memory a virtual machine actually accesses. It offers improved memory overcommitment.
								

								 	 
									Server and Desktop.
								

								 
	 
									qxl
								

								 	 
									A paravirtualized display driver reduces CPU usage on the host and provides better performance through reduced network bandwidth on most workloads.
								

								 	 
									Server and Desktop.
								

								 



Table 3.2. Red Hat Virtualization Guest agents and tools
	Guest agent/tool	Description	Works on
	 
									qemu-guest-agent
								

								 	 
									Used instead of ovirt-guest-agent-common on Red Hat Enterprise Linux 8 virtual machines. It is installed and enabled by default.
								

								 	 
									Server and Desktop.
								

								 
	 
									spice-agent
								

								 	 
									The SPICE agent supports multiple monitors and is responsible for client-mouse-mode support to provide a better user experience and improved responsiveness than the QEMU emulation. Cursor capture is not needed in client-mouse-mode. The SPICE agent reduces bandwidth usage when used over a wide area network by reducing the display level, including color depth, disabling wallpaper, font smoothing, and animation. The SPICE agent enables clipboard support allowing cut and paste operations for both text and images between client and virtual machine, and automatic guest display setting according to client-side settings. On Windows-based virtual machines, the SPICE agent consists of vdservice and vdagent.
								

								 	 
									Server and Desktop.
								

								 




Installing the guest agents, tools, and drivers on Windows



Procedure

						To install the guest agents, tools, and drivers on a Windows virtual machine, complete the following steps:
					
	
							On the Manager machine, install the virtio-win package:
						
# dnf install virtio-win*

							After you install the package, the ISO file is located in /usr/share/virtio-win/virtio-win_version.iso on the Manager machine.
						

	
							Upload virtio-win_version.iso to a data storage domain. See Uploading Images to a Data Storage Domain in the Administration Guide for details.
						
	
							In the Administration or VM Portal, if the virtual machine is running, use the Change CD button to attach the virtio-win_version.iso file to each of your virtual machines. If the virtual machine is powered off, click the Run Once button and attach the ISO as a CD.
						
	
							Log in to the virtual machine.
						
	
							Select the CD Drive containing the virtio-win_version.iso file. You can complete the installation with either the GUI or the command line.
						
	
							Run the installer.
						
	To install with the GUI, complete the following steps
		
												Double-click virtio-win-guest-tools.exe.
											
	
												Click Next at the welcome screen.
											
	
												Follow the prompts in the installation wizard.
											
	
												When installation is complete, select Yes, I want to restart my computer now and click Finish to apply the changes.
											



	To install silently with the command line, complete the following steps
		
												Open a command prompt with Administrator privileges.
											
	
												Enter the msiexec command:
											
D:\ msiexec /i "PATH_TO_MSI" /qn [/l*v "PATH_TO_LOG"][/norestart] ADDLOCAL=ALL

												Other possible values for ADDLOCAL are listed below.
											

												For example, to run the installation when virtio-win-gt-x64.msi is on the D:\ drive, without saving the log, and then immediately restart the virtual machine, enter the following command:
											
D:\ msiexec /i "virtio-win-gt-x64.msi" /qn ADDLOCAL=ALL










					After installation completes, the guest agents and drivers pass usage information to the Red Hat Virtualization Manager and enable you to access USB devices and other functionality.
				

Values for ADDLOCAL to customize virtio-win command-line installation




					When installing virtio-win-gt-x64.msi or virtio-win-gt-x32.msi with the command line, you can install any one driver, or any combination of drivers.
				

					You can also install specific agents, but you must also install each agent’s corresponding drivers.
				

					The ADDLOCAL parameter of the msiexec command enables you to specify which drivers or agents to install. ADDLOCAL=ALL installs all drivers and agents. Other values are listed in the following tables.
				
Table 3.3. Possible values for ADDLOCAL to install drivers
	Value for ADDLOCAL	Driver Name	Description
	 
									FE_network_driver
								

								 	 
									virtio-net
								

								 	 
									Paravirtualized network driver provides enhanced performance over emulated devices like rtl.
								

								 
	 
									FE_balloon_driver
								

								 	 
									virtio-balloon
								

								 	 
									Controls the amount of memory a virtual machine actually accesses. It offers improved memory overcommitment.
								

								 
	 
									FE_pvpanic_driver
								

								 	 
									pvpanic
								

								 	 
									QEMU pvpanic device driver.
								

								 
	 
									FE_qemufwcfg_driver
								

								 	 
									qemufwcfg
								

								 	 
									QEMU FWCfg device driver.
								

								 
	 
									FE_qemupciserial_driver
								

								 	 
									qemupciserial
								

								 	 
									QEMU PCI serial device driver.
								

								 
	 
									FE_spice_driver
								

								 	 
									Spice Driver
								

								 	 
									A paravirtualized display driver reduces CPU usage on the host and provides better performance through reduced network bandwidth on most workloads.
								

								 
	 
									FE_vioinput_driver
								

								 	 
									vioinput
								

								 	 
									VirtIO Input Driver.
								

								 
	 
									FE_viorng_driver
								

								 	 
									viorng
								

								 	 
									VirtIO RNG device driver.
								

								 
	 
									FE_vioscsi_driver
								

								 	 
									vioscsi
								

								 	 
									VirtIO SCSI pass-through controller.
								

								 
	 
									FE_vioserial_driver
								

								 	 
									vioserial
								

								 	 
									VirtIO Serial device driver.
								

								 
	 
									FE_viostor_driver
								

								 	 
									viostor
								

								 	 
									VirtIO Block driver.
								

								 



Table 3.4. Possible values for ADDLOCAL to install agents and required corresponding drivers
	Agent	Description	Corresponding driver(s)	Value for ADDLOCAL
	 
									Spice Agent
								

								 	 
									Supports multiple monitors, responsible for client-mouse-mode support, reduces bandwidth usage, enables clipboard support between client and virtual machine, provide a better user experience and improved responsiveness.
								

								 	 
									vioserial and Spice driver
								

								 	 
									FE_spice_Agent,FE_vioserial_driver,FE_spice_driver
								

								 



Examples

						The following command installs only the VirtIO SCSI pass-through controller, the VirtIO Serial device driver, and the VirtIO Block driver:
					
D:\ msiexec /i "virtio-win-gt-x64.msi" /qn ADDLOCAL=`FE_vioscsi_driver,FE_vioserial_driver,FE_viostor_driver

					The following command installs only the Spice Agent and its required corresponding drivers:
				
D:\ msiexec /i "virtio-win-gt-x64.msi" /qn ADDLOCAL = FE_spice_Agent,FE_vioserial_driver,FE_spice_driver
Additional resources
	
							Updating Win Guest Drivers with Windows Updates
						
	
							Updating the Guest Agents and Drivers on Windows
						



					The Microsoft Developer website:
				
	
							Windows Installer
						
	
							Command-Line Options for the Windows installer
						
	
							Property Reference for the Windows installer
						





Chapter 4. Additional Configuration



Configuring Operating Systems with osinfo




				Red Hat Virtualization stores operating system configurations for virtual machines in /etc/ovirt-engine/osinfo.conf.d/00-defaults.properties. This file contains default values such as os.other.devices.display.protocols.value = spice/qxl,vnc/vga,vnc/qxl.
			

				There are only a limited number of scenarios in which you would change these values:
			
	
						Adding an operating system that does not appear in the list of supported guest operating systems
					
	
						Adding a product key (for example, os.windows_10x64.productKey.value =)
					
	
						Configuring the sysprep path for a Windows virtual machine (for example, os.windows_10x64.sysprepPath.value = ${ENGINE_USR}/conf/sysprep/sysprep.w10x64)
					


Important

					Do not edit the actual 00-defaults.properties file. Changes will be overwritten if you upgrade or restore the Manager.
				

					Do not change values that come directly from the operating system or the Manager, such as maximum memory size.
				


				To change the operating system configurations, create an override file in /etc/ovirt-engine/osinfo.conf.d/. The file name must begin with a value greater than 00, so that the file appears after /etc/ovirt-engine/osinfo.conf.d/00-defaults.properties, and ends with the extension, .properties.
			

				For example, 10-productkeys.properties overrides the default file, 00-defaults.properties. The last file in the file list has precedence over earlier files.
			

				For virtual machines with Windows Server 2016, on each RHV host, modify the /etc/modprobe.d/kvm.conf configuration file by adding the line: options kvm ignore_msrs=1
			

Configuring Single Sign-On for Virtual Machines




				Configuring single sign-on, also known as password delegation, allows you to automatically log in to a virtual machine using the credentials you use to log in to the VM Portal. Single sign-on can be used on both Red Hat Enterprise Linux and Windows virtual machines.
			
Note

					Single sign-on is not supported for virtual machines running Red Hat Enterprise Linux 8.0.
				

Important

					If single sign-on to the VM Portal is enabled, single sign-on to virtual machines will not be possible. With single sign-on to the VM Portal enabled, the VM Portal does not need to accept a password, thus the password cannot be delegated to sign in to virtual machines.
				

Configuring Single Sign-On for Red Hat Enterprise Linux Virtual Machines Using IPA (IdM)




					To configure single sign-on for Red Hat Enterprise Linux virtual machines using GNOME and KDE graphical desktop environments and IPA (IdM) servers, you must install the ovirt-guest-agent package on the virtual machine and install the packages associated with your window manager.
				
Important

						The following procedure assumes that you have a working IPA configuration and that the IPA domain is already joined to the Manager. You must also ensure that the clocks on the Manager, the virtual machine and the system on which IPA (IdM) is hosted are synchronized using NTP.
					

Note

						Single sign-on with IPA (IdM) is deprecated for virtual machines running Red Hat Enterprise Linux version 7 or earlier and unsupported for virtual machines running Red Hat Enterprise Linux 8 or Windows operating systems.
					


					Configuring Single Sign-On for Red Hat Enterprise Linux Virtual Machines
				
	
							Log in to the Red Hat Enterprise Linux virtual machine.
						
	
							Enable the repository:
						
	
									For Red Hat Enterprise Linux 6:
								
# subscription-manager repos --enable=rhel-6-server-rhv-4-agent-rpms

	
									For Red Hat Enterprise Linux 7:
								
# subscription-manager repos --enable=rhel-7-server-rh-common-rpms




	
							Download and install the guest agent, single sign-on, and IPA packages:
						
# yum install ovirt-guest-agent-common ovirt-guest-agent-pam-module ovirt-guest-agent-gdm-plugin ipa-client

	
							Run the following command and follow the prompts to configure ipa-client and join the virtual machine to the domain:
						
# ipa-client-install --permit --mkhomedir
Note

								In environments that use DNS obfuscation, this command should be:
							
# ipa-client-install --domain=FQDN --server=FQDN


	
							For Red Hat Enterprise Linux 7.2 and later:
						
# authconfig --enablenis --update
Note

								Red Hat Enterprise Linux 7.2 has a new version of the System Security Services Daemon (SSSD), which introduces configuration that is incompatible with the Red Hat Virtualization Manager guest agent single sign-on implementation. This command ensures that single sign-on works.
							


	
							Fetch the details of an IPA user:
						
# getent passwd ipa-user

	
							Record the IPA user’s UID and GID:
						
ipa-user:*:936600010:936600001::/home/ipa-user:/bin/sh

	
							Create a home directory for the IPA user:
						
# mkdir /home/ipa-user

	
							Assign ownership of the directory to the IPA user:
						
# chown 936600010:936600001 /home/ipa-user




					Log in to the VM Portal using the user name and password of a user configured to use single sign-on and connect to the console of the virtual machine. You will be logged in automatically.
				

Configuring single sign-on for Windows virtual machines




					To configure single sign-on for Windows virtual machines, the Windows guest agent must be installed on the guest virtual machine. The virtio-win ISO image provides this agent. If the virtio-win_version.iso image is not available in your storage domain, contact your system administrator.
				
Procedure
	
							Select the Windows virtual machine. Ensure the machine is powered up.
						
	
							On the virtual machine, locate the CD drive and open the CD.
						
	
							Launch virtio-win-guest-tools.
						
	
							Click Options
						
	
							Select Install oVirt Guest Agent.
						
	
							Click OK.
						
	
							Click Install.
						
	
							When the installation completes, you are prompted to restart the machine to apply the changes.
						



					Log in to the VM Portal using the user name and password of a user configured to use single sign-on and connect to the console of the virtual machine. You will be logged in automatically.
				

Disabling Single Sign-on for Virtual Machines




					The following procedure explains how to disable single sign-on for a virtual machine.
				

					Disabling Single Sign-On for Virtual Machines
				
	
							Select a virtual machine and click Edit.
						
	
							Click the Console tab.
						
	
							Select the Disable Single Sign On check box.
						
	
							Click OK.
						




Configuring USB Devices




				A virtual machine connected with the SPICE protocol can be configured to connect directly to USB devices.
			

				The USB device will only be redirected if the virtual machine is active, in focus and is run from the VM Portal. USB redirection can be manually enabled each time a device is plugged in or set to automatically redirect to active virtual machines in the Console Options window.
			
Important

					Note the distinction between the client machine and guest machine. The client is the hardware from which you access a guest. The guest is the virtual desktop or virtual server which is accessed through the VM Portal or Administration Portal.
				


				USB redirection Enabled mode allows KVM/SPICE USB redirection for Linux and Windows virtual machines. Virtual (guest) machines require no guest-installed agents or drivers for native USB. On Red Hat Enterprise Linux clients, all packages required for USB redirection are provided by the virt-viewer package. On Windows clients, you must also install the usbdk package. Enabled USB mode is supported on the following clients and guests:
			
Note

					If you have a 64-bit architecture PC, you must use the 64-bit version of Internet Explorer to install the 64-bit version of the USB driver. The USB redirection will not work if you install the 32-bit version on a 64-bit architecture. As long as you initially install the correct USB type, you can access USB redirection from both 32- and 64-bit browsers.
				

Using USB Devices on a Windows Client




					The usbdk driver must be installed on the Windows client for the USB device to be redirected to the guest. Ensure the version of usbdk matches the architecture of the client machine. For example, the 64-bit version of usbdk must be installed on 64-bit Windows machines.
				
Note

						USB redirection is only supported when you open the virtual machine from the VM Portal.
					

Procedure
	
							When the usbdk driver is installed, click Compute → Virtual Machines and select a virtual machine that is configured to use the SPICE protocol.
						
	
							Click the Console tab.
						
	
							Select the USB enabled checkbox and click OK.
						
	
							Click Console → Console Options.
						
	
							Select the Enable USB Auto-Share check box and click OK.
						
	
							Start the virtual machine from the VM Portal and click Console to connect to that virtual machine.
						
	
							Plug your USB device into the client machine to make it appear automatically on the guest machine.
						



Using USB Devices on a Red Hat Enterprise Linux Client




					The usbredir package enables USB redirection from Red Hat Enterprise Linux clients to virtual machines. usbredir is a dependency of the virt-viewer package, and is automatically installed together with that package.
				
Note

						USB redirection is only supported when you open the virtual machine from the VM Portal.
					

Procedure
	
							Click Compute → Virtual Machines.
						
	
							Select a virtual machine that has been configured to use the SPICE protocol and click Edit. This opens the Edit Virtual Machine window.
						
	
							Click the Console tab.
						
	
							Select the USB enabled checkbox and click OK.
						
	
							Click Console → Console Options.
						
	
							Select the Enable USB Auto-Share check box and click OK.
						
	
							Start the virtual machine from the VM Portal and click Console to connect to that virtual machine.
						
	
							Plug your USB device into the client machine to make it appear automatically on the guest machine.
						




Configuring Multiple Monitors



Configuring Multiple Displays for Red Hat Enterprise Linux Virtual Machines




					A maximum of four displays can be configured for a single Red Hat Enterprise Linux virtual machine when connecting to the virtual machine using the SPICE protocol.
				
	
							Start a SPICE session with the virtual machine.
						
	
							Open the View drop-down menu at the top of the SPICE client window.
						
	
							Open the Display menu.
						
	
							Click the name of a display to enable or disable that display.
						


Note

						By default, Display 1 is the only display that is enabled on starting a SPICE session with a virtual machine. If no other displays are enabled, disabling this display will close the session.
					


Configuring Multiple Displays for Windows Virtual Machines




					A maximum of four displays can be configured for a single Windows virtual machine when connecting to the virtual machine using the SPICE protocol.
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							With the virtual machine in a powered-down state, click Edit.
						
	
							Click the Console tab.
						
	
							Select the number of displays from the Monitors drop-down list.
						
Note

								This setting controls the maximum number of displays that can be enabled for the virtual machine. While the virtual machine is running, additional displays can be enabled up to this number.
							


	
							Click OK.
						
	
							Start a SPICE session with the virtual machine.
						
	
							Open the View drop-down menu at the top of the SPICE client window.
						
	
							Open the Display menu.
						
	
							Click the name of a display to enable or disable that display.
						
Note

								By default, Display 1 is the only display that is enabled on starting a SPICE session with a virtual machine. If no other displays are enabled, disabling this display will close the session.
							






Configuring Console Options



Console Options




					Connection protocols are the underlying technology used to provide graphical consoles for virtual machines and allow users to work with virtual machines in a similar way as they would with physical machines. Red Hat Virtualization currently supports the following connection protocols:
				

					SPICE
				

					Simple Protocol for Independent Computing Environments (SPICE) is the recommended connection protocol for both Linux virtual machines and Windows virtual machines. To open a console to a virtual machine using SPICE, use Remote Viewer.
				

					VNC
				

					Virtual Network Computing (VNC) can be used to open consoles to both Linux virtual machines and Windows virtual machines. To open a console to a virtual machine using VNC, use Remote Viewer or a VNC client.
				

					RDP
				

					Remote Desktop Protocol (RDP) can only be used to open consoles to Windows virtual machines, and is only available when you access a virtual machines from a Windows machine on which Remote Desktop has been installed. Before you can connect to a Windows virtual machine using RDP, you must set up remote sharing on the virtual machine and configure the firewall to allow remote desktop connections.
				
Note

						SPICE is not supported on virtual machines running Windows 8 or Windows 8.1. If a virtual machine running one of these operating systems is configured to use the SPICE protocol, it detects the absence of the required SPICE drivers and runs in VGA compatibility mode.
					


Accessing Console Options




					You can configure several options for opening graphical consoles for virtual machines in the Administration Portal.
				
Procedure
	
							Click Compute → Virtual Machines and select a running virtual machine.
						
	
							Click Console → Console Options.
						


Note

						You can configure the connection protocols and video type in the Console tab of the Edit Virtual Machine window in the Administration Portal. Additional options specific to each of the connection protocols, such as the keyboard layout when using the VNC connection protocol, can be configured. See Virtual Machine Console settings explained for more information.
					


SPICE Console Options




					When the SPICE connection protocol is selected, the following options are available in the Console Options window.
				

					SPICE Options
				
	
							Map control-alt-del shortcut to ctrl+alt+end: Select this check box to map the Ctrl + Alt + Del key combination to Ctrl + Alt + End inside the virtual machine.
						
	
							Enable USB Auto-Share: Select this check box to automatically redirect USB devices to the virtual machine. If this option is not selected, USB devices will connect to the client machine instead of the guest virtual machine. To use the USB device on the guest machine, manually enable it in the SPICE client menu.
						
	
							Open in Full Screen: Select this check box for the virtual machine console to automatically open in full screen when you connect to the virtual machine. Press SHIFT + F11 to toggle full screen mode on or off.
						
	
							Enable SPICE Proxy: Select this check box to enable the SPICE proxy.
						



VNC Console Options




					When the VNC connection protocol is selected, the following options are available in the Console Options window.
				

					Console Invocation
				
	
							Native Client: When you connect to the console of the virtual machine, a file download dialog provides you with a file that opens a console to the virtual machine via Remote Viewer.
						
	
							noVNC: When you connect to the console of the virtual machine, a browser tab is opened that acts as the console.
						



					VNC Options
				
	
							Map control-alt-delete shortcut to ctrl+alt+end: Select this check box to map the Ctrl + Alt + Del key combination to Ctrl + Alt + End inside the virtual machine.
						



RDP Console Options




					When the RDP connection protocol is selected, the following options are available in the Console Options window.
				

					Console Invocation
				
	
							Auto: The Manager automatically selects the method for invoking the console.
						
	
							Native client: When you connect to the console of the virtual machine, a file download dialog provides you with a file that opens a console to the virtual machine via Remote Desktop.
						



					RDP Options
				
	
							Use Local Drives: Select this check box to make the drives on the client machine accessible on the guest virtual machine.
						



Remote Viewer Options



Remote Viewer Options




						When you specify the Native client console invocation option, you will connect to virtual machines using Remote Viewer. The Remote Viewer window provides a number of options for interacting with the virtual machine to which it is connected.
					
Table 4.1. Remote Viewer Options
	Option	Hotkey
	 
										File
									

									 	 	
												Screenshot: Takes a screen capture of the active window and saves it in a location of your specification.
											
	
												USB device selection: If USB redirection has been enabled on your virtual machine, the USB device plugged into your client machine can be accessed from this menu.
											
	
												Quit: Closes the console. The hot key for this option is Shift + Ctrl + Q.
											



									 
	 
										View
									

									 	 	
												Full screen: Toggles full screen mode on or off. When enabled, full screen mode expands the virtual machine to fill the entire screen. When disabled, the virtual machine is displayed as a window. The hot key for enabling or disabling full screen is SHIFT + F11.
											
	
												Zoom: Zooms in and out of the console window. Ctrl + + zooms in, Ctrl + - zooms out, and Ctrl + 0 returns the screen to its original size.
											
	
												Automatically resize: Select to enable the guest resolution to automatically scale according to the size of the console window.
											
	
												Displays: Allows users to enable and disable displays for the guest virtual machine.
											



									 
	 
										Send key
									

									 	 	
												Ctrl + Alt + Del: On a Red Hat Enterprise Linux virtual machine, it displays a dialog with options to suspend, shut down or restart the virtual machine. On a Windows virtual machine, it displays the task manager or Windows Security dialog.
											
	
												Ctrl + Alt + Backspace: On a Red Hat Enterprise Linux virtual machine, it restarts the X sever. On a Windows virtual machine, it does nothing.
											
	
												Ctrl + Alt + F1
											
	
												Ctrl + Alt + F2
											
	
												Ctrl + Alt + F3
											
	
												Ctrl + Alt + F4
											
	
												Ctrl + Alt + F5
											
	
												Ctrl + Alt + F6
											
	
												Ctrl + Alt + F7
											
	
												Ctrl + Alt + F8
											
	
												Ctrl + Alt + F9
											
	
												Ctrl + Alt + F10
											
	
												Ctrl + Alt + F11
											
	
												Ctrl + Alt + F12
											
	
												Printscreen: Passes the Printscreen keyboard option to the virtual machine.
											



									 
	 
										Help
									

									 	 
										The About entry displays the version details of Virtual Machine Viewer that you are using.
									

									 
	 
										Release Cursor from Virtual Machine
									

									 	 
										SHIFT + F12
									

									 




Remote Viewer Hotkeys




						You can access the hotkeys for a virtual machine in both full screen mode and windowed mode. If you are using full screen mode, you can display the menu containing the button for hotkeys by moving the mouse pointer to the middle of the top of the screen. If you are using windowed mode, you can access the hotkeys via the Send key menu on the virtual machine window title bar.
					
Note

							If vdagent is not running on the client machine, the mouse can become captured in a virtual machine window if it is used inside a virtual machine and the virtual machine is not in full screen. To unlock the mouse, press Shift + F12.
						


Manually Associating console.vv Files with Remote Viewer




						If you are prompted to download a console.vv file when attempting to open a console to a virtual machine using the native client console option, and Remote Viewer is already installed, then you can manually associate console.vv files with Remote Viewer so that Remote Viewer can automatically use those files to open consoles.
					

						Manually Associating console.vv Files with Remote Viewer
					
	
								Start the virtual machine.
							
	
								Open the Console Options window:
							
	
										In the Administration Portal, click Console → Console Options.
									
	
										In the VM Portal, click the virtual machine name and click the pencil icon beside Console.
									



	
								Change the console invocation method to Native client and click OK.
							
	
								Attempt to open a console to the virtual machine, then click Save when prompted to open or save the console.vv file.
							
	
								Click the location on your local machine where you saved the file.
							
	
								Double-click the console.vv file and select Select a program from a list of installed programs when prompted.
							
	
								In the Open with window, select Always use the selected program to open this kind of file and click the Browse button.
							
	
								Click the C:\Users_[user name]_\AppData\Local\virt-viewer\bin directory and select remote-viewer.exe.
							
	
								Click Open and then click OK.
							



						When you use the native client console invocation option to open a console to a virtual machine, Remote Viewer will automatically use the console.vv file that the Red Hat Virtualization Manager provides to open a console to that virtual machine without prompting you to select the application to use.
					



Configuring a Watchdog



Adding a Watchdog Card to a Virtual Machine




					You can add a watchdog card to a virtual machine to monitor the operating system’s responsiveness.
				
Procedure
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							Click the High Availability tab.
						
	
							Select the watchdog model to use from the Watchdog Model drop-down list.
						
	
							Select an action from the Watchdog Action drop-down list. This is the action that the virtual machine takes when the watchdog is triggered.
						
	
							Click OK.
						



Installing a Watchdog




					To activate a watchdog card attached to a virtual machine, you must install the watchdog package on that virtual machine and start the watchdog service.
				

					Installing Watchdogs
				
	
							Log in to the virtual machine on which the watchdog card is attached.
						
	
							Install the watchdog package and dependencies:
						
# yum install watchdog

	
							Edit the /etc/watchdog.conf file and uncomment the following line:
						
watchdog-device = /dev/watchdog

	
							Save the changes.
						
	
							Start the watchdog service and ensure this service starts on boot:
						
	
									Red Hat Enterprise Linux 6:
								
# service watchdog start
# chkconfig watchdog on

	
									Red Hat Enterprise Linux 7:
								
# systemctl start watchdog.service
# systemctl enable watchdog.service







Confirming Watchdog Functionality




					Confirm that a watchdog card has been attached to a virtual machine and that the watchdog service is active.
				
Warning

						This procedure is provided for testing the functionality of watchdogs only and must not be run on production machines.
					


					Confirming Watchdog Functionality
				
	
							Log in to the virtual machine on which the watchdog card is attached.
						
	
							Confirm that the watchdog card has been identified by the virtual machine:
						
# lspci | grep watchdog -i

	
							Run one of the following commands to confirm that the watchdog is active:
						
	
									Trigger a kernel panic:
								
# echo c > /proc/sysrq-trigger

	
									Terminate the watchdog service:
								
# kill -9 pgrep watchdog







					The watchdog timer can no longer be reset, so the watchdog counter reaches zero after a short period of time. When the watchdog counter reaches zero, the action specified in the Watchdog Action drop-down menu for that virtual machine is performed.
				

Parameters for Watchdogs in watchdog.conf




					The following is a list of options for configuring the watchdog service available in the /etc/watchdog.conf file. To configure an option, you must uncomment that option and restart the watchdog service after saving the changes.
				
Note

						For a more detailed explanation of options for configuring the watchdog service and using the watchdog command, see the watchdog man page.
					

Table 4.2. watchdog.conf variables
	Variable name	Default Value	Remarks
	 
									ping
								

								 	 
									N/A
								

								 	 
									An IP address that the watchdog attempts to ping to verify whether that address is reachable. You can specify multiple IP addresses by adding additional ping lines.
								

								 
	 
									interface
								

								 	 
									N/A
								

								 	 
									A network interface that the watchdog will monitor to verify the presence of network traffic. You can specify multiple network interfaces by adding additional interface lines.
								

								 
	 
									file
								

								 	 
									/var/log/messages
								

								 	 
									A file on the local system that the watchdog will monitor for changes. You can specify multiple files by adding additional file lines.
								

								 
	 
									change
								

								 	 
									1407
								

								 	 
									The number of watchdog intervals after which the watchdog checks for changes to files. A change line must be specified on the line directly after each file line, and applies to the file line directly above that change line.
								

								 
	 
									max-load-1
								

								 	 
									24
								

								 	 
									The maximum average load that the virtual machine can sustain over a one-minute period. If this average is exceeded, then the watchdog is triggered. A value of 0 disables this feature.
								

								 
	 
									max-load-5
								

								 	 
									18
								

								 	 
									The maximum average load that the virtual machine can sustain over a five-minute period. If this average is exceeded, then the watchdog is triggered. A value of 0 disables this feature. By default, the value of this variable is set to a value approximately three quarters that of max-load-1.
								

								 
	 
									max-load-15
								

								 	 
									12
								

								 	 
									The maximum average load that the virtual machine can sustain over a fifteen-minute period. If this average is exceeded, then the watchdog is triggered. A value of 0 disables this feature. By default, the value of this variable is set to a value approximately one half that of max-load-1.
								

								 
	 
									min-memory
								

								 	 
									1
								

								 	 
									The minimum amount of virtual memory that must remain free on the virtual machine. This value is measured in pages. A value of 0 disables this feature.
								

								 
	 
									repair-binary
								

								 	 
									/usr/sbin/repair
								

								 	 
									The path and file name of a binary file on the local system that will be run when the watchdog is triggered. If the specified file resolves the issues preventing the watchdog from resetting the watchdog counter, then the watchdog action is not triggered.
								

								 
	 
									test-binary
								

								 	 
									N/A
								

								 	 
									The path and file name of a binary file on the local system that the watchdog will attempt to run during each interval. A test binary allows you to specify a file for running user-defined tests.
								

								 
	 
									test-timeout
								

								 	 
									N/A
								

								 	 
									The time limit, in seconds, for which user-defined tests can run. A value of 0 allows user-defined tests to continue for an unlimited duration.
								

								 
	 
									temperature-device
								

								 	 
									N/A
								

								 	 
									The path to and name of a device for checking the temperature of the machine on which the watchdog service is running.
								

								 
	 
									max-temperature
								

								 	 
									120
								

								 	 
									The maximum allowed temperature for the machine on which the watchdog service is running. The machine will be halted if this temperature is reached. Unit conversion is not taken into account, so you must specify a value that matches the watchdog card being used.
								

								 
	 
									admin
								

								 	 
									root
								

								 	 
									The email address to which email notifications are sent.
								

								 
	 
									interval
								

								 	 
									10
								

								 	 
									The interval, in seconds, between updates to the watchdog device. The watchdog device expects an update at least once every minute, and if there are no updates over a one-minute period, then the watchdog is triggered. This one-minute period is hard-coded into the drivers for the watchdog device, and cannot be configured.
								

								 
	 
									logtick
								

								 	 
									1
								

								 	 
									When verbose logging is enabled for the watchdog service, the watchdog service periodically writes log messages to the local system. The logtick value represents the number of watchdog intervals after which a message is written.
								

								 
	 
									realtime
								

								 	 
									yes
								

								 	 
									Specifies whether the watchdog is locked in memory. A value of yes locks the watchdog in memory so that it is not swapped out of memory, while a value of no allows the watchdog to be swapped out of memory. If the watchdog is swapped out of memory and is not swapped back in before the watchdog counter reaches zero, then the watchdog is triggered.
								

								 
	 
									priority
								

								 	 
									1
								

								 	 
									The schedule priority when the value of realtime is set to yes.
								

								 
	 
									pidfile
								

								 	 
									/var/run/syslogd.pid
								

								 	 
									The path and file name of a PID file that the watchdog monitors to see if the corresponding process is still active. If the corresponding process is not active, then the watchdog is triggered.
								

								 





Configuring Virtual NUMA




				In the Administration Portal, you can configure virtual NUMA nodes on a virtual machine and pin them to physical NUMA nodes on one or more hosts. The host’s default policy is to schedule and run virtual machines on any available resources on the host. As a result, the resources backing a large virtual machine that cannot fit within a single host socket could be spread out across multiple NUMA nodes. Over time these resources may be moved around, leading to poor and unpredictable performance. Configure and pin virtual NUMA nodes to avoid this outcome and improve performance.
			

				Configuring virtual NUMA requires a NUMA-enabled host. To confirm whether NUMA is enabled on a host, log in to the host and run numactl --hardware. The output of this command should show at least two NUMA nodes. You can also view the host’s NUMA topology in the Administration Portal by selecting the host from the Hosts tab and clicking NUMA Support. This button is only available when the selected host has at least two NUMA nodes.
			
Note

					If you define NUMA Pinning, the default migration mode is Allow manual migration only by default.
				


				Configuring Virtual NUMA
			
	
						Click Compute → Virtual Machines and select a virtual machine.
					
	
						Click Edit.
					
	
						Click Show Advanced Options.
					
	
						Click the Host tab.
					
	
						Select the Specific Host(s) radio button and select the host(s) from the list. The selected host(s) must have at least two NUMA nodes.
					
	
						Click NUMA Pinning.
					
	
						In the NUMA Topology window, click and drag virtual NUMA nodes from the box on the right to host NUMA nodes on the left as required, and click OK.
					
	
						Select Strict, Preferred, or Interleave from the Tune Mode drop-down list in each NUMA node. If the selected mode is Preferred, the NUMA Node Count must be set to 1.
					
	
						You can also set the NUMA pinning policy automatically by selecting Resize and Pin NUMA from the CPU Pinning Polcy drop-down list under the CPU Allocation settings in the Resource Allocation tab:
					
	
								None - Runs without any CPU pinning.
							
	
								Manual - Runs a manually specified virtual CPU on a specific physical CPU and a specific host. Available only when the virtual machine is pinned to a Host.
							
	
								Resize and Pin NUMA - Resizes the virtual CPU and NUMA topology of the virtual machine according to the Host, and pins them to the Host resources.
							
	
								Dedicated - Exclusively pins virtual CPUs to host physical CPUs. Available for cluster compatibility level 4.7 or later. If the virtual machine has NUMA enabled, all nodes must be unpinned.
							
	
								Isolate Threads - Exclusively pins virtual CPUs to host physical CPUs. Each virtual CPU gets a physical core. Available for cluster compatibility level 4.7 or later. If the virtual machine has NUMA enabled, all nodes must be unpinned.
							



	
						Click OK.
					


Note

					If you do not pin the virtual NUMA node to a host NUMA node, the system defaults to the NUMA node that contains the host device’s memory-mapped I/O (MMIO), provided that there are one or more host devices and all of those devices are from a single NUMA node.
				


Configuring Satellite errata viewing for a virtual machine




				In the Administration Portal, you can configure a virtual machine to display the available errata. The virtual machine needs to be associated with a Red Hat Satellite server to show available errata.
			

				Red Hat Virtualization 4.4 supports viewing errata with Red Hat Satellite 6.6.
			
Prerequisites
	
						The Satellite server must be added as an external provider.
					
	
						The Manager and any virtual machines on which you want to view errata must all be registered in the Satellite server by their respective FQDNs. This ensures that external content host IDs do not need to be maintained in Red Hat Virtualization.
					
Important

							Virtual machines added using an IP address cannot report errata.
						


	
						The host that the virtual machine runs on also needs to be configured to receive errata information from Satellite.
					
	
						The virtual machine must have the ovirt-guest-agent package installed. This package enables the virtual machine to report its host name to the Red Hat Virtualization Manager, which enables the Red Hat Satellite server to identify the virtual machine as a content host and report the applicable errata.
					
	
						The virtual machine must be registered to the Red Hat Satellite server as a content host.
					
	
						Use Red Hat Satellite remote execution to manage packages on hosts.
					


Note

					The Katello agent is deprecated and will be removed in a future Satellite version. Migrate your processes to use the remote execution feature to update clients remotely.
				

Procedure
	
						Click Compute → Virtual Machines and select a virtual machine.
					
	
						Click Edit.
					
	
						Click the Foreman/Satellite tab.
					
	
						Select the required Satellite server from the Provider drop-down list.
					
	
						Click OK.
					


Additional resources
	
						Setting up Satellite errata viewing for a host in the Administration Guide
					
	
						Installing the Guest Agents, Tools, and Drivers on Linux in the Virtual Machine Management Guide for Red Hat Enterprise Linux virtual machines.
					
	
						Installing the Guest Agents, Tools, and Drivers on Windows in the Virtual Machine Management Guide for Windows virtual machines.
					



Configuring Headless Virtual Machines




				You can configure a headless virtual machine when it is not necessary to access the machine via a graphical console. This headless machine will run without graphical and video devices. This can be useful in situations where the host has limited resources, or to comply with virtual machine usage requirements such as real-time virtual machines.
			

				Headless virtual machines can be administered via a Serial Console, SSH, or any other service for command line access. Headless mode is applied via the Console tab when creating or editing virtual machines and machine pools, and when editing templates. It is also available when creating or editing instance types.
			

				If you are creating a new headless virtual machine, you can use the Run Once window to access the virtual machine via a graphical console for the first run only. See Virtual Machine Run Once settings explained for more details.
			
Prerequisites
	
						If you are editing an existing virtual machine, and the Red Hat Virtualization guest agent has not been installed, note the machine’s IP prior to selecting Headless Mode.
					
	
						Before running a virtual machine in headless mode, the GRUB configuration for this machine must be set to console mode otherwise the guest operating system’s boot process will hang. To set console mode, comment out the spashimage flag in the GRUB menu configuration file:
					
 #splashimage=(hd0,0)/grub/splash.xpm.gz serial --unit=0 --speed=9600 --parity=no --stop=1 terminal --timeout=2 serial



Note

					Restart the virtual machine if it is running when selecting the Headless Mode option.
				


				Configuring a Headless Virtual Machine
			
	
						Click Compute → Virtual Machines and select a virtual machine.
					
	
						Click Edit.
					
	
						Click the Console tab.
					
	
						Select Headless Mode. All other fields in the Graphical Console section are disabled.
					
	
						Optionally, select Enable VirtIO serial console to enable communicating with the virtual machine via serial console. This is highly recommended.
					
	
						Reboot the virtual machine if it is running. See Rebooting a Virtual Machine.
					



Configuring High Performance Virtual Machines, Templates, and Pools




				You can configure a virtual machine for high performance, so that it runs with performance metrics as close to bare metal as possible. When you choose high performance optimization, the virtual machine is configured with a set of automatic, and recommended manual, settings for maximum efficiency.
			

				The high performance option is only accessible in the Administration Portal, by selecting High Performance from the Optimized for dropdown list in the Edit or New virtual machine, template, or pool window. This option is not available in the VM Portal.
			

				The high performance option is supported by Red Hat Virtualization 4.2 and later. It is not available for earlier versions.
			

				Virtual Machines
			

				If you change the optimization mode of a running virtual machine to high performance, some configuration changes require restarting the virtual machine.
			

				To change the optimization mode of a new or existing virtual machine to high performance, you may need to make manual changes to the cluster and to the pinned host configuration first.
			

				A high performance virtual machine has certain limitations, because enhanced performance has a trade-off in decreased flexibility:
			
	
						If pinning is set for CPU threads, I/O threads, emulator threads, or NUMA nodes, according to the recommended settings, only a subset of cluster hosts can be assigned to the high performance virtual machine.
					
	
						Many devices are automatically disabled, which limits the virtual machine’s usability.
					



				Templates and Pools
			

				High performance templates and pools are created and edited in the same way as virtual machines. If a high performance template or pool is used to create new virtual machines, those virtual machines inherits this property and its configurations. Certain settings, however, are not inherited and must be set manually:
			
	
						CPU pinning
					
	
						Virtual NUMA and NUMA pinning topology
					
	
						I/O and emulator threads pinning topology
					
	
						Pass-through Host CPU
					


Creating a High Performance Virtual Machine, Template, or Pool




					To create a high performance virtual machine, template, or pool:
				
	
							In the New or Edit window, select High Performance from the Optimized for drop-down menu.
						

							Selecting this option automatically performs certain configuration changes to this virtual machine, which you can view by clicking different tabs. You can change them back to their original settings or override them. (See Automatic High Performance Configuration Settings for details.) If you change a setting, its latest value is saved.
						

	
							Click OK.
						

							If you have not set any manual configurations, the High Performance Virtual Machine/Pool Settings screen describing the recommended manual configurations appears.
						

							If you have set some of the manual configurations, the High Performance Virtual Machine/Pool Settings screen displays the settings you have not made.
						

							If you have set all the recommended manual configurations, the High Performance Virtual Machine/Pool Settings screen does not appear.
						

	
							If the High Performance Virtual Machine/Pool Settings screen appears, click Cancel to return to the New or Edit window to perform the manual configurations. See Configuring the Recommended Manual Settings for details.
						

							Alternatively, click OK to ignore the recommendations. The result may be a drop in the level of performance.
						

	
							Click OK.
						

							You can view the optimization type in the General tab of the details view of the virtual machine, pool, or template.
						



Note

						Certain configurations can override the high performance settings. For example, if you select an instance type for a virtual machine before selecting High Performance from the Optimized for drop-down menu and performing the manual configuration, the instance type configuration will not affect the high performance configuration. If, however, you select the instance type after the high performance configurations, you should verify the final configuration in the different tabs to ensure that the high performance configurations have not been overridden by the instance type.
					

						The last-saved configuration usually takes priority.
					

Note

						Support for instance types is now deprecated, and will be removed in a future release.
					

Automatic High Performance Configuration Settings




						The following table summarizes the automatic settings. The Enabled (Y/N) column indicates configurations that are enabled or disabled. The Applies to column indicates the relevant resources:
					
	
								VM - Virtual machine
							
	
								T - Template
							
	
								P - Pool
							
	
								C - Cluster
							


Table 4.3. Automatic High Performance Configuration Settings
	Setting	Enabled (Y/N)	Applies to
	 
										Headless Mode (Console tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										USB Enabled (Console tab)
									

									 	 
										N
									

									 	 
										VM, T, P
									

									 
	 
										Smartcard Enabled (Console tab)
									

									 	 
										N
									

									 	 
										VM, T, P
									

									 
	 
										Soundcard Enabled (Console tab)
									

									 	 
										N
									

									 	 
										VM, T, P
									

									 
	 
										Enable VirtIO serial console (Console tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										Allow manual migration only (Host tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										Pass-Through Host CPU (Host tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										Highly Available [1] (High Availability tab)
									

									 	 
										N
									

									 	 
										VM, T, P
									

									 
	 
										No-Watchdog (High Availability tab)
									

									 	 
										N
									

									 	 
										VM, T, P
									

									 
	 
										Memory Balloon Device (Resource Allocation tab)
									

									 	 
										N
									

									 	 
										VM, T, P
									

									 
	 
										I/O Threads Enabled [2] (Resource Allocation tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										Paravirtualized Random Number Generator PCI (virtio-rng) device (Random Generator tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										I/O and emulator threads pinning topology
									

									 	 
										Y
									

									 	 
										VM, T
									

									 
	 
										CPU cache layer 3
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 



	
								Highly Available is not automatically enabled. If you select it manually, high availability should be enabled for pinned hosts only.
							
	
								Number of I/O threads = 1.
							



I/O and Emulator Threads Pinning Topology (Automatic Settings)




						The I/O and emulator threads pinning topology is a new configuration setting for Red Hat Virtualization 4.2. It requires that I/O threads, NUMA nodes, and NUMA pinning be enabled and set for the virtual machine. Otherwise, a warning will appear in the engine log.
					

						Pinning topology:
					
	
								The first two CPUs of each NUMA node are pinned.
							
	
								If all vCPUs fit into one NUMA node of the host:
							
	
										The first two vCPUs are automatically reserved/pinned
									
	
										The remaining vCPUs are available for manual vCPU pinning
									



	
								If the virtual machine spans more than one NUMA node:
							
	
										The first two CPUs of the NUMA node with the most pins are reserved/pinned
									
	
										The remaining pinned NUMA node(s) are for vCPU pinning only
									






						Pools do not support I/O and emulator threads pinning.
					
Warning

							If a host CPU is pinned to both a vCPU and I/O and emulator threads, a warning will appear in the log and you will be asked to consider changing the CPU pinning topology to avoid this situation.
						


High Performance Icons




						The following icons indicate the states of a high performance virtual machine in the Compute → Virtual Machines screen.
					
Table 4.4. High Performance Icons
	Icon	Description
	 
										[image: hp vm]

									

									 	 
										High performance virtual machine
									

									 
	 
										[image: hp vm next run]

									

									 	 
										High performance virtual machine with Next Run configuration
									

									 
	 
										[image: stateless hp vm]

									

									 	 
										Stateless, high performance virtual machine
									

									 
	 
										[image: stateless hp vm next run]

									

									 	 
										Stateless, high performance virtual machine with Next Run configuration
									

									 
	 
										[image: vm hp pool]

									

									 	 
										Virtual machine in a high performance pool
									

									 
	 
										[image: vm hp pool next run]

									

									 	 
										Virtual machine in a high performance pool with Next Run configuration
									

									 





Configuring the Recommended Manual Settings




					You can configure the recommended manual settings in either the New or the Edit windows.
				

					If a recommended setting is not performed, the High Performance Virtual Machine/Pool Settings screen displays the recommended setting when you save the resource.
				

					The recommended manual settings are:
				
	
							Pinning CPUs
						
	
							Setting the NUMA Pinning Policy
						
	
							Configuring Huge Pages
						
	
							Disabling KSM
						


Manual High Performance Configuration Settings




						The following table summarizes the recommended manual settings. The Enabled (Y/N) column indicates configurations that should be enabled or disabled. The Applies to column indicates the relevant resources:
					
	
								VM - Virtual machine
							
	
								T - Template
							
	
								P - Pool
							
	
								C - Cluster
							


Table 4.5. Manual High Performance Configuration Settings
	Setting	Enabled (Y/N)	Applies to
	 
										NUMA Node Count (Host tab)
									

									 	 
										Y
									

									 	 
										VM
									

									 
	 
										Tune Mode (NUMA Pinning screen)
									

									 	 
										Y
									

									 	 
										VM
									

									 
	 
										NUMA Pinning (Host tab)
									

									 	 
										Y
									

									 	 
										VM
									

									 
	 
										CPU Pinning topology (Resource Allocation tab)
									

									 	 
										Y
									

									 	 
										VM, P
									

									 
	 
										hugepages (Custom Properties tab)
									

									 	 
										Y
									

									 	 
										VM, T, P
									

									 
	 
										KSM (Optimization tab)
									

									 	 
										N
									

									 	 
										C
									

									 




Pinning CPUs




						To pin vCPUs to a specific host’s physical CPU:
					
	
								In the Host tab, select the Specific Host(s) radio button.
							
	
								In the Resource Allocation tab, enter the CPU Pinning Topology, verifying that the configuration fits the pinned host’s configuration. See Virtual Machine Resource Allocation settings explained for information about the syntax of this field.
							

								This field is populated automatically and the CPU topology is updated when automatic NUMA pinning is activated.
							

	
								Verify that the virtual machine configuration is compatible with the host configuration:
							
	
										A virtual machine’s number of sockets must not be greater than the host’s number of sockets.
									
	
										A virtual machine’s number of cores per virtual socket must not be greater than the host’s number of cores.
									
	
										CPU-intensive workloads perform best when the host and virtual machine expect the same cache usage. To achieve the best performance, a virtual machine’s number of threads per core must not be greater than that of the host.
									





Important

							CPU pinning has the following requirements:
						
	
									If the host is NUMA-enabled, the host’s NUMA settings (memory and CPUs) must be considered because the virtual machine has to fit the host’s NUMA configuration.
								
	
									The I/O and emulator threads pinning topology must be considered.
								
	
									CPU pinning can only be set for virtual machines and pools, but not for templates. Therefore, you must set CPU pinning manually whenever you create a high performance virtual machine or pool, even if they are based on a high performance template.
								




Setting the NUMA Pinning Policy




						To set the NUMA Pinning Policy, you need a NUMA-enabled pinned host with at least two NUMA nodes.
					
To set the NUMA pinning policy manually:
	
								Click NUMA Pinning.
							
	
								In the NUMA Topology window, click and drag virtual NUMA nodes from the box on the right to the host’s physical NUMA nodes on the left as required.
							
	
								Select Strict, Preferred, or Interleave from the Tune Mode drop-down list in each NUMA node. If the selected mode is Preferred, the NUMA Node Count must be set to 1.
							
	
								Click OK.
							


To set the NUMA pinning policy automatically:
	
								In the Resource Allocation tab, under CPU Allocation, select Resize and Pin NUMA from the CPU Pinning Policy drop-down list.
							
	
								Click OK.
							


Important

							The number of declared virtual NUMA nodes and the NUMA pinning policy must take into account:
						
	
									The host’s NUMA settings (memory and CPUs)
								
	
									The NUMA node in which the host devices are declared
								
	
									The CPU pinning topology
								
	
									The IO and emulator threads pinning topology
								
	
									Huge page sizes
								
	
									NUMA pinning can only be set for virtual machines, not for pools or templates. You must set NUMA pinning manually when you create a high performance virtual machine based on a template.
								




Configuring Huge Pages




						Huge pages are pre-allocated when a virtual machine starts to run (dynamic allocation is disabled by default).
					

						To configure huge pages:
					
	
								In the Custom Properties tab, select hugepages from the custom properties list, which displays Please select a key…​ by default.
							
	
								Enter the huge page size in KB.
							

								You should set the huge page size to the largest size supported by the pinned host. The recommended size for x86_64 is 1 GiB.
							

								The huge page size has the following requirements:
							
	
										The virtual machine’s huge page size must be the same size as the pinned host’s huge page size.
									
	
										The virtual machine’s memory size must fit into the selected size of the pinned host’s free huge pages.
									
	
										The NUMA node size must be a multiple of the huge page’s selected size.
									






						To enable dynamic allocation of huge pages:
					
	
								Disable the HugePages filter in the scheduler.
							
	
								In the [performance] section in /etc/vdsm/vdsm.conf set the following:
							

								use_dynamic_hugepages = true
							




Comparison between dynamic and static hugepages

							The following table outlines advantages and disadvantages of dynamic and static hugepages.
						
Table 4.6. Dynamic vs static hugepages
	Setting	Advantages	Disadvantages	Recommendations
	 
										dynamic hugepages
									

									 	 	
												Less configuration required
											
	
												Less wasted memory (i.e. hugepages free on a host waiting for possible incoming migrations)
											



									 	 
										Failure to allocate due to fragmentation
									

									 	 
										Use 2MB hugepages
									

									 
	 
										static hugepages
									

									 	 
										Predictable results
									

									 	 	
												Requires a kernel command line in the Edit Host configuration in the Administraion Portal. See Custom kernel command line
											
	
												Requires a host reboot.
											



									 	 



Important

							The following limitations apply:
						
	
									Memory hotplug/unplug is disabled
								
	
									The host’s memory resource is limited
								




Disabling KSM




						To disable Kernel Same-page Merging (KSM) for the cluster:
					
	
								Click Compute → Clusters and select the cluster.
							
	
								Click Edit.
							
	
								In the Optimization tab, clear the Enable KSM check box.
							





Configuring the time zone




				Red Hat Virtualization stores time zone configurations for virtual machines in /etc/ovirt-engine/conf/00-timezone.properties. This file contains default time zone values such as Etc/GMT=Greenwich Standard Time. It features mappings that are valid for Windows and non-Windows time zones.
			
Important

					Do not edit the actual 00-timezone.properties file. Changes will be overwritten if you upgrade or restore the Manager.
				

					Do not change values that come directly from the operating system or the Manager.
				

Procedure
	
						Create an override file in /etc/ovirt-engine/conf/. The file name must begin with a value greater than 00, so that the file appears after /etc/ovirt-engine/conf/00-timezone.properties, and ends with the extension, .properties.
					

						For example, 10-timezone.properties overrides the default file, 00-timezone.properties. The last file in the file list has precedence over earlier files.
					

	
						Add new time zones to that file. Be sure each key is a valid General time zone from the time zone database and the value is a valid Windows time zone:
					
	General
	
									Time zones used for non-Windows operating system types, must follow the standard time zone format for example, Etc/GMT or Asia/Jerusalem.
								
	Windows
	
									Time zones specifically supported on Windows for example, GMT Standard Time or Israel Standard Time.
								



	
						Restart the rhvm service:
					
# systemctl restart ovirt-engine





Chapter 5. Editing Virtual Machines



Editing Virtual Machine Properties




				Changes to storage, operating system, or networking parameters can adversely affect the virtual machine. Ensure that you have the correct details before attempting to make any changes. Virtual machines can be edited while running, and some changes (listed in the procedure below) will be applied immediately. To apply all other changes, the virtual machine must be shut down and restarted.
			
Note

					External virtual machines (marked with the prefix external) cannot be edited through the Red Hat Virtualization Manager.
				


				Editing Virtual Machines
			
	
						Click Compute → Virtual Machines.
					
	
						Select the virtual machine to be edited.
					
	
						Click Edit.
					
	
						Change settings as required.
					

						Changes to the following settings are applied immediately:
					
	
								Name
							
	
								Description
							
	
								Comment
							
	
								Optimized for (Desktop/Server/High Performance)
							
	
								Delete Protection
							
	
								Network Interfaces
							
	
								Memory Size (Edit this field to hot plug virtual memory. See Hot Plugging Virtual Memory.)
							
	
								Virtual Sockets (Edit this field to hot plug CPUs. See CPU hot plug.)
							
	
								Highly Available
							
	
								Priority for Run/Migration queue
							
	
								Disable strict user checking
							
	
								Icon
							



	
						Click OK.
					
	
						If the Next Start Configuration pop-up window appears, click OK.
					



				Some changes are applied immediately. All other changes are applied when you shut down and restart your virtual machine. Until then, the pending changes icon ( 
				[image: pendingchanges]
				 ) appears as a reminder to restart the virtual machine.
			

Network Interfaces



Adding a New Network Interface




					You can add multiple network interfaces to virtual machines. Doing so allows you to put your virtual machine on multiple logical networks.
				
Note

						You can create an overlay network for your virtual machines, isolated from the hosts, by defining a logical network that is not attached to the physical interfaces of the host. For example, you can create a DMZ environment, in which the virtual machines communicate among themselves over the bridge created in the host.
					

						The overlay network uses OVN, which must be installed as an external network provider. See the Administration Guide for more information
					

Procedure
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Network Interfaces tab.
						
	
							Click New.
						
	
							Enter the Name of the network interface.
						
	
							Select the Profile and the Type of network interface from the drop-down lists. The Profile and Type drop-down lists are populated in accordance with the profiles and network types available to the cluster and the network interface cards available to the virtual machine.
						
	
							Select the Custom MAC address check box and enter a MAC address for the network interface card as required.
						
	
							Click OK.
						



					The new network interface is listed in the Network Interfaces tab in the details view of the virtual machine. The Link State is set to Up by default when the network interface card is defined on the virtual machine and connected to the network.
				

					For more details on the fields in the New Network Interface window, see Virtual Machine Network Interface dialogue entries.
				

Editing a Network Interface




					In order to change any network settings, you must edit the network interface. This procedure can be performed on virtual machines that are running, but some actions can be performed only on virtual machines that are not running.
				

					Editing Network Interfaces
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Network Interfaces tab and select the network interface to edit.
						
	
							Click Edit.
						
	
							Change settings as required. You can specify the Name, Profile, Type, and Custom MAC address. See Adding a Network Interface.
						
	
							Click OK.
						



Hot Plugging a Network Interface




					You can hot plug network interfaces. Hot plugging means enabling and disabling devices while a virtual machine is running.
				
Note

						The guest operating system must support hot plugging network interfaces.
					


					Hot Plugging Network Interfaces
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Network Interfaces tab and select the network interface to hot plug.
						
	
							Click Edit.
						
	
							Set the Card Status to Plugged to enable the network interface, or set it to Unplugged to disable the network interface.
						
	
							Click OK.
						



Removing a Network Interface




					Removing Network Interfaces
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Network Interfaces tab and select the network interface to remove.
						
	
							Click Remove.
						
	
							Click OK.
						



Configuring a virtual machine to ignore NICs




					You can configure the ovirt-guest-agent on a virtual machine to ignore certain NICs. This prevents IP addresses associated with network interfaces created by certain software from appearing in reports. You must specify the name and number of the network interface you want to ignore (for example, eth0, docker0).
				
Procedure
	
							In the /etc/ovirt-guest-agent.conf configuration file on the virtual machine, insert the following line, with the NICs to be ignored separated by spaces:
						
ignored_nics = first_NIC_to_ignore second_NIC_to_ignore

	
							Start the agent:
						
# systemctl start ovirt-guest-agent



Note

						Some virtual machine operating systems automatically start the guest agent during installation.
					

						If your virtual machine’s operating system automatically starts the guest agent or if you need to configure the denylist on many virtual machines, use the configured virtual machine as a template for creating additional virtual machines. See Creating a template from an existing virtual machine for details.
					



Virtual Disks



Adding a New Virtual Disk




					You can add multiple virtual disks to a virtual machine.
				

					Image is the default type of disk. You can also add a Direct LUN disk. Image disk creation is managed entirely by the Manager. Direct LUN disks require externally prepared targets that already exist. Existing disks are either floating disks or shareable disks attached to virtual machines.
				

					Adding Disks to Virtual Machines
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Disks tab.
						
	
							Click New.
						
	
							Use the appropriate radio buttons to switch between Image and Direct LUN.
						
	
							Enter a Size(GB), Alias, and Description for the new disk.
						
	
							Use the drop-down lists and check boxes to configure the disk. See Add Virtual Disk dialogue entries for more details on the fields for all disk types.
						
	
							Click OK.
						



					The new disk appears in the details view after a short time.
				

Attaching an Existing Disk to a Virtual Machine




					Floating disks are disks that are not associated with any virtual machine.
				

					Floating disks can minimize the amount of time required to set up virtual machines. Designating a floating disk as storage for a virtual machine makes it unnecessary to wait for disk preallocation at the time of a virtual machine’s creation.
				

					Floating disks can be attached to a single virtual machine, or to multiple virtual machines if the disk is shareable. Each virtual machine that uses the shared disk can use a different disk interface type.
				

					Once a floating disk is attached to a virtual machine, the virtual machine can access it.
				
Procedure
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Disks tab.
						
	
							Click Attach.
						
	
							Select one or more virtual disks from the list of available disks and select the required interface from the Interface drop-down.
						
	
							Click OK.
						


Note

						No Quota resources are consumed by attaching virtual disks to, or detaching virtual disks from, virtual machines.
					


Extending the Available Size of a Virtual Disk




					You can extend the available size of a virtual disk while the virtual disk is attached to a virtual machine. Resizing a virtual disk does not resize the underlying partitions or file systems on that virtual disk. Use the fdisk utility to resize the partitions and file systems as required. See How to Resize a Partition using fdisk for more information.
				

					Extending the Available Size of Virtual Disks
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Disks tab and select the disk to edit.
						
	
							Click Edit.
						
	
							Enter a value in the Extend size by(GB) field.
						
	
							Click OK.
						



					The target disk’s status becomes locked for a short time, during which the drive is resized. When the resizing of the drive is complete, the status of the drive becomes OK.
				

Hot Plugging a Virtual Disk




					You can hot plug virtual disks. Hot plugging means enabling or disabling devices while a virtual machine is running.
				
Note

						The guest operating system must support hot plugging virtual disks.
					


					Hot Plugging Virtual Disks
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Disks tab and select the virtual disk to hot plug.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Activate to enable the disk, or Deactivate to disable the disk.
						
	
							Click OK.
						



Removing a Virtual Disk from a Virtual Machine




					Removing Virtual Disks From Virtual Machines
				
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine name to go to the details view.
						
	
							Click the Disks tab and select the virtual disk to remove.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Deactivate.
						
	
							Click OK.
						
	
							Click Remove.
						
	
							Optionally, select the Remove Permanently check box to completely remove the virtual disk from the environment. If you do not select this option - for example, because the disk is a shared disk - the virtual disk will remain in Storage → Disks.
						
	
							Click OK.
						



					If the disk was created as block storage, for example iSCSI, and the Wipe After Delete check box was selected when creating the disk, you can view the log file on the host to confirm that the data has been wiped after permanently removing the disk. See Settings to Wipe Virtual Disks After Deletion in the Administration Guide.
				

					If the disk was created as block storage, for example iSCSI, and the Discard After Delete check box was selected on the storage domain before the disk was removed, a blkdiscard command is called on the logical volume when it is removed and the underlying storage is notified that the blocks are free. See Setting Discard After Delete for a Storage Domain in the Administration Guide. A blkdiscard is also called on the logical volume when a virtual disk is removed if the virtual disk is attached to at least one virtual machine with the Enable Discard check box selected.
				

Importing a Disk Image from an Imported Storage Domain




					You can import floating virtual disks from an imported storage domain.
				

					This procedure requires access to the Administration Portal.
				
Note

						Only QEMU-compatible disks can be imported into the Manager.
					


					Importing a Disk Image
				
	
							Click Storage → Domains.
						
	
							Click an imported storage domain to go to the details view.
						
	
							Click Disk Import.
						
	
							Select one or more disk images and click Import. This opens the Import Disk(s) window.
						
	
							Select the appropriate Disk Profile for each disk.
						
	
							Click OK to import the selected disks.
						



Importing an Unregistered Disk Image from an Imported Storage Domain




					You can import floating virtual disks from a storage domain. Floating disks created outside of a Red Hat Virtualization environment are not registered with the Manager. Scan the storage domain to identify unregistered floating disks to be imported.
				

					This procedure requires access to the Administration Portal.
				
Note

						Only QEMU-compatible disks can be imported into the Manager.
					


					Importing a Disk Image
				
	
							Click Storage → Domains.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Scan Disks so that the Manager can identify unregistered disks.
						
	
							Select an unregistered disk name and click Disk Import.
						
	
							Select one or more disk images and click Import. This opens the Import Disk(s) window.
						
	
							Select the appropriate Disk Profile for each disk.
						
	
							Click OK to import the selected disks.
						




Virtual Memory



Hot Plugging Virtual Memory




					You can hot plug virtual memory. Hot plugging means enabling or disabling devices while a virtual machine is running. Each time memory is hot plugged, it appears as a new memory device in the Vm Devices tab in the details view of the virtual machine, up to a maximum of 16 available slots. When the virtual machine is restarted, these devices are cleared from the Vm Devices tab without reducing the virtual machine’s memory, allowing you to hot plug more memory devices. If the hot plug fails (for example, if there are no more available slots), the memory increase will be applied when the virtual machine is restarted.
				
Important

						This feature is currently not supported for the self-hosted engine Manager virtual machine.
					

Note

						If you might need to later hot unplug the memory that you are now hot plugging, see Hot Unplugging Virtual Memory.
					

Procedure
	
							Click Compute → Virtual Machines and select a running virtual machine.
						
	
							Click Edit.
						
	
							Click the System tab.
						
	
							Increase the Memory Size by entering the total amount required. Memory can be added in multiples of 256 MB. By default, the maximum memory allowed for the virtual machine is set to 4x the memory size specified. Though the value is changed in the user interface, the maximum value is not hot plugged, and you will see the pending changes icon ( 
							[image: pendingchanges]
							 ). To avoid that, you can change the maximum memory back to the original value.
						
	
							Click OK.
						

							This action opens the Pending Virtual Machine changes window, as some values such as maxMemorySizeMb and minAllocatedMem will not change until the virtual machine is restarted. However, the hot plug action is triggered by the change to the Memory Size value, which can be applied immediately.
						

	
							Click OK.
						



					The virtual machine’s Defined Memory is updated in the General tab in the details view. You can see the newly added memory device in the Vm Devices tab in the details view.
				

Hot Unplugging Virtual Memory




					You can hot unplug virtual memory. Hot unplugging disables devices while a virtual machine is running.
				
Prerequisites
	
							Only memory added with hot plugging can be hot unplugged.
						
	
							The virtual machine’s operating system must support memory hot unplugging.
						
	
							The virtual machine must not have a memory balloon device enabled. This feature is disabled by default.
						
	
							All blocks of the hot-plugged memory must be set to online_movable in the virtual machine’s device management rules. In virtual machines running up-to-date versions of Red Hat Enterprise Linux or CoreOS, this rule is set by default. For information on device management rules, consult the documentation for the virtual machine’s operating system.
						
	
							To ensure that hot plugged memory can be hot unplugged later, add the movable_node option to the kernel command line of the virtual machine as follows and reboot the virtual machine:
						
# grubby --update-kernel=ALL --args="movable_node"




					For more information, see Setting kernel command-line parameters in the RHEL 8 document Managing, monitoring and updating the kernel.
				
Procedure
	
							Click Compute → Virtual Machines and select a running virtual machine.
						
	
							Click the Vm Devices tab.
						
	
							In the Hot Unplug column, click Hot Unplug beside the memory device to be removed.
						
	
							Click OK in the Memory Hot Unplug window.
						

							The Physical Memory Guaranteed value for the virtual machine is decremented automatically if necessary.
						





Hot Plugging vCPUs




				You can hot plug vCPUs. Hot plugging means enabling or disabling devices while a virtual machine is running.
			
Important

					Hot unplugging a vCPU is only supported if the vCPU was previously hot plugged. A virtual machine’s vCPUs cannot be hot unplugged to less vCPUs than it was originally created with.
				


				The following prerequisites apply:
			
	
						The virtual machine’s Operating System must be explicitly set in the New Virtual Machine or Edit Virtual Machine window.
					
	
						The virtual machine’s operating system must support CPU hot plug. See the table below for support details.
					
	
						Windows virtual machines must have the guest agents installed. See Installing the Guest Agents and Drivers on Windows.
					


Hot Plugging vCPUs
	
						Click Compute → Virtual Machines and select a running virtual machine.
					
	
						Click Edit.
					
	
						Click the System tab.
					
	
						Change the value of Virtual Sockets as required.
					
	
						Click OK.
					


Table 5.1. Operating System Support Matrix for vCPU Hot Plug
	Operating System	Version	Architecture	Hot Plug Supported	Hot Unplug Supported
	 
								Red Hat Enterprise Linux Atomic Host 7
							

							 	 	 
								x86
							

							 	 
								Yes
							

							 	 
								Yes
							

							 
	 
								Red Hat Enterprise Linux 6.3+
							

							 	 	 
								x86
							

							 	 
								Yes
							

							 	 
								Yes
							

							 
	 
								Red Hat Enterprise Linux 7.0+
							

							 	 	 
								x86
							

							 	 
								Yes
							

							 	 
								Yes
							

							 
	 
								Red Hat Enterprise Linux 7.3+
							

							 	 	 
								PPC64
							

							 	 
								Yes
							

							 	 
								Yes
							

							 
	 
								Red Hat Enterprise Linux 8.0+
							

							 	 	 
								x86
							

							 	 
								Yes
							

							 	 
								Yes
							

							 
	 
								Microsoft Windows Server 2012 R2
							

							 	 
								All
							

							 	 
								x64
							

							 	 
								Yes
							

							 	 
								No
							

							 
	 
								Microsoft Windows Server 2016
							

							 	 
								Standard, Datacenter
							

							 	 
								x64
							

							 	 
								Yes
							

							 	 
								No
							

							 
	 
								Microsoft Windows Server 2019
							

							 	 
								Standard, Datacenter
							

							 	 
								x64
							

							 	 
								Yes
							

							 	 
								No
							

							 
	 
								Microsoft Windows 8.x
							

							 	 
								All
							

							 	 
								x86
							

							 	 
								Yes
							

							 	 
								No
							

							 
	 
								Microsoft Windows 8.x
							

							 	 
								All
							

							 	 
								x64
							

							 	 
								Yes
							

							 	 
								No
							

							 
	 
								Microsoft Windows 10
							

							 	 
								All
							

							 	 
								x86
							

							 	 
								Yes
							

							 	 
								No
							

							 
	 
								Microsoft Windows 10
							

							 	 
								All
							

							 	 
								x64
							

							 	 
								Yes
							

							 	 
								No
							

							 




Pinning a Virtual Machine to Multiple Hosts




				Virtual machines can be pinned to multiple hosts. Multi-host pinning allows a virtual machine to run on a specific subset of hosts within a cluster, instead of one specific host or all hosts in the cluster. The virtual machine cannot run on any other hosts in the cluster even if all of the specified hosts are unavailable. Multi-host pinning can be used to limit virtual machines to hosts with, for example, the same physical hardware configuration.
			

				If a host fails, a highly available virtual machine is automatically restarted on one of the other hosts to which the virtual machine is pinned.
			

				Pinning Virtual Machines to Multiple Hosts
			
	
						Click Compute → Virtual Machines and select a virtual machine.
					
	
						Click Edit.
					
	
						Click the Host tab.
					
	
						Select the Specific Host(s) radio button under Start Running On and select two or more hosts from the list.
					
	
						Click the High Availability tab.
					
	
						Select the Highly Available check box.
					
	
						Select Low, Medium, or High from the Priority drop-down list. When migration is triggered, a queue is created in which the high priority virtual machines are migrated first. If a cluster is running low on resources, only the high priority virtual machines are migrated.
					
	
						Click OK.
					



Viewing Virtual Machines Pinned to a Host




				You can view virtual machines pinned to a host even while the virtual machines are offline. Use the Pinned to Host list to see which virtual machines will be affected and which virtual machines will require a manual restart after the host becomes active again.
			

				Viewing Virtual Machines Pinned to a Host
			
	
						Click Compute → Hosts.
					
	
						Click a host name to go to the details view.
					
	
						Click the Virtual Machines tab.
					
	
						Click Pinned to Host.
					



Changing the CD for a Virtual Machine




				You can change the CD accessible to a virtual machine while that virtual machine is running, using ISO images that have been uploaded to the data domain of the virtual machine’s cluster. See Uploading Images to a Data Storage Domain in the Administration Guide for details.
			
Procedure
	
						Click Compute → Virtual Machines and select a running virtual machine.
					
	
						Click More Actions ( 
						[image: moreactions]
						 ), then click Change CD.
					
	
						Select an option from the drop-down list:
					
	
								Select an ISO file from the list to eject the CD currently accessible to the virtual machine and mount that ISO file as a CD. .Procedure from the list to eject the CD currently accessible to the virtual machine.
							



	
						Click OK.
					



Smart Card Authentication




				Smart cards are an external hardware security feature, most commonly seen in credit cards, but also used by many businesses as authentication tokens. Smart cards can be used to protect Red Hat Virtualization virtual machines.
			

				Enabling Smart Cards
			
	
						Ensure that the smart card hardware is plugged into the client machine and is installed according to manufacturer’s directions.
					
	
						Click Compute → Virtual Machines and select a virtual machine.
					
	
						Click Edit.
					
	
						Click the Console tab and select the Smartcard enabled check box.
					
	
						Click OK.
					
	
						Connect to the running virtual machine by clicking the Console button. Smart card authentication is now passed from the client hardware to the virtual machine.
					


Important

					If the Smart card hardware is not correctly installed, enabling the Smart card feature will result in the virtual machine failing to load properly.
				


				Disabling Smart Cards
			
	
						Click Compute → Virtual Machines and select a virtual machine.
					
	
						Click Edit.
					
	
						Click the Console tab, and clear the Smartcard enabled check box.
					
	
						Click OK.
					



				Configuring Client Systems for Smart Card Sharing
			
	
						Smart cards may require certain libraries in order to access their certificates. These libraries must be visible to the NSS library, which spice-gtk uses to provide the smart card to the guest. NSS expects the libraries to provide the PKCS #11 interface.
					
	
						Make sure that the module architecture matches the spice-gtk / remote-viewer architecture. For instance, if you have only the 32b PKCS #11 library available, you must install the 32b build of virt-viewer in order for smart cards to work.
					



				Configuring RHEL Clients for Smart Card support
			

				Red Hat Enterprise Linux provides support for Smart cards. Install the Smart card support group. If the Smart Card Support group is installed on a Red Hat Enterprise Linux system, smart cards are redirected to the guest when Smart Cards are enabled.
			
	
						To install the Smart card support group, run the following command:
					
# dnf groupinstall "Smart card support"




				Configuring RHEL Clients with Other Smart Card Middleware
			

				Red Hat Enterprise Linux provides a system-wide registry of pkcs11 modules in the p11-kit, and these are accessible to all applications.
			
	
						To register the third party PKCS#11 library in the p11-kit database, run the following command as root:
					
# echo "module: /path/to/library.so" > /etc/pkcs11/modules/my.module

	
						To verify the Smart card is visible for p11-kit through this library run the following command:
					
$ p11-kit list-modules




				Configuring Windows Clients
			

				Red Hat does not provide PKCS #11 support to Windows clients. Libraries that provide PKCS #11 support must be obtained from third parties.
			
	
						When such libraries are obtained, register them by running the following command as a user with elevated privileges:
					
modutil -dbdir %PROGRAMDATA%\pki\nssdb -add "module name" -libfile C:_\Path\to\module_.dll





Chapter 6. Administrative Tasks



Shutting Down a Virtual Machine




				You can turn off a virtual machine using Shutdown or Power Off. Shutdown gracefully shuts down a virtual machine. Power Off executes a hard shutdown. A graceful shutdown is usually preferable to a hard shutdown.
			
Note

					If an exclamation point appears next to the virtual machine, a snapshot deletion process has failed, and you may not be able to restart the machine after shutting it down. Try to delete the snapshot again and ensure that the explanation mark disappears before shutting down the virtual machine. See Deleting a snapshot for more information.
				

Procedure
	
						Click Compute → Virtual Machines and select a running virtual machine.
					
	
						Click Shutdown or right-click the virtual machine and select Shutdown from the pop-up menu.
					
	
						Optionally in the Administration Portal, enter a Reason for shutting down the virtual machine in the Shut down Virtual Machine(s) confirmation window. This allows you to provide an explanation for the shutdown, which will appear in the logs and when the virtual machine is powered on again.
					
Note

							The virtual machine shutdown Reason field will only appear if it has been enabled in the cluster settings. For more information, see Explanation of Settings and Controls in the New Cluster and Edit Cluster Windows in the Administration Guide.
						


	
						Click OK in the Shut down Virtual Machine(s) confirmation window.
					



				If the virtual machine gracefully shuts down, the Status of the virtual machine changes to Down. If the virtual machine does not gracefully shut down, click the down arrow next to Shutdown and then click Power Off to execute a hard shutdown, or right-click the virtual machine and select Power Off from the pop-up menu.
			

Suspending a Virtual Machine




				Suspending a virtual machine is equal to placing that virtual machine into Hibernate mode.
			

				Suspending a Virtual Machine
			
	
						Click Compute → Virtual Machines and select a running virtual machine.
					
	
						Click Suspend or right-click the virtual machine and select Suspend from the pop-up menu.
					



				The Status of the virtual machine changes to Suspended.
			

Rebooting or Resetting a Virtual Machine




				You can restart your virtual machines in two different ways; either using reboot or reset.
			

				Several situations can occur where you need to reboot the virtual machine, such as after an update or configuration change. When you reboot, the virtual machine’s console remains open while the guest operating system is restarted.
			

				If a guest operating system can not be loaded or has become unresponsive, you need to reset the virtual machine. When you reset, the virtual machine’s console remains open while the guest operating system is restarted.
			
Note

					The reset reset operation can only be performed from the Administration Portal.
				


				Rebooting a Virtual Machine
			

				To reboot a virtual machine:
			
	
						Click Compute → Virtual Machines and select a running virtual machine.
					
	
						Click Reboot or right-click the virtual machine and select Reboot from the pop-up menu.
					
	
						Click OK in the Reboot Virtual Machine(s) confirmation window.
					



				Resetting a Virtual Machine
			

				To reset a virtual machine:
			
	
						Click Compute → Virtual Machines and select a running virtual machine.
					
	
						Click the down arrow next to Reboot, then click Reset, or right-click the virtual machine and select Reset from the pop-up menu.
					
	
						Click OK in the Reset Virtual Machine(s) confirmation window.
					



				During reboot and reset operations, the Status of the virtual machine changes to Reboot In Progress before returning to Up.
			

Removing a Virtual Machine



Important

					The Remove button is disabled while virtual machines are running; you must shut down a virtual machine before you can remove it.
				


				Removing Virtual Machines
			
	
						Click Compute → Virtual Machines and select the virtual machine to remove.
					
	
						Click Remove.
					
	
						Optionally, select the Remove Disk(s) check box to remove the virtual disks attached to the virtual machine together with the virtual machine. If the Remove Disk(s) check box is cleared, then the virtual disks remain in the environment as floating disks.
					
	
						Click OK.
					



Cloning a Virtual Machine




				You can clone virtual machines without having to create a template or a snapshot first.
			
Procedure
	
						Click Compute → Virtual Machines and select the virtual machine to clone.
					
	
						Click More Actions ( 
						[image: moreactions]
						 ), then click Clone VM.
					
	
						Enter a Clone Name for the new virtual machine.
					
	
						Click OK.
					



Updating Virtual Machine Guest Agents and Drivers




				The Red Hat Virtualization guest agents, tools, and drivers provide additional functionality for virtual machines, such as gracefully shutting down or rebooting virtual machines from the VM Portal and Administration Portal. The tools and agents also provide information for virtual machines, including:
			
	
						Resource usage
					
	
						IP addresses
					
	
						Installed applications
					



				The guest tools are distributed as an ISO file that you can attach to virtual machines. This ISO file is packaged as an RPM file that you can install and update from the Manager machine.
			
Updating the Guest Agents and Drivers on Red Hat Enterprise Linux




					Update the guest agents and drivers on your Red Hat Enterprise Linux virtual machines to use the latest version.
				

					Updating the Guest Agents and Drivers on Red Hat Enterprise Linux
				
	
							Log in to the Red Hat Enterprise Linux virtual machine.
						
	
							Update the ovirt-guest-agent-common package:
						
# yum update ovirt-guest-agent-common

	
							Restart the service:
						
	
									For Red Hat Enterprise Linux 6
								
# service ovirt-guest-agent restart

	
									For Red Hat Enterprise Linux 7
								
# systemctl restart ovirt-guest-agent.service







Updating Windows drivers with Windows Update




					When you need to update the drivers for a Windows virtual machine, the simplest method is to use Windows Update.
				
Procedure
	
							Log in to the virtual machine.
						
	
							Ensure that Windows Update is enabled so you can get updates.
						
	
							Check Windows Update for updates from Red Hat, Inc.
						
	
							Manually install any updates that have not been automatically installed.
						


Additional resources
	
							Updating Windows guest agents and drivers using the command prompt
						
	
							See the Microsoft documentation for details on using Windows Update.
						



Updating Windows guest agents and drivers using the command prompt




					When you do not have access to Windows Update to update Windows drivers, or when you need to update the oVirt guest agents, you can do so from the virtio-win package by using the virtual machine’s command prompt. During this procedure, you must remove and reinstall the drivers, which can lead to network disruption. This procedure restores your settings after reinstalling the drivers.
				
Procedure
	
							If you are updating the drivers, on the Windows virtual machine, use the netsh utility to save TCP settings before uninstalling the netkvm driver:
						
C:\WINDOWS\system32>netsh dump > filename.txt

	
							On the Manager machine, update the virtio-win package to the latest version:
						
# dnf upgrade -y virtio-win

							The virtio-win_version.iso file is located in /usr/share/virtio-win/ on the Manager machine.
						

	
							Upload the ISO file to a data domain. For more information, see Uploading Images to a Data Storage Domain in the Administration Guide.
						
	
							In the Administration or VM Portal, if the virtual machine is running, use the Change CD drop-down list to attach the virtio-win_version.iso file to each of your virtual machines. If the virtual machine is powered off, click the Run Once button and attach the ISO as a CD.
						
	
							Log in to the virtual machine.
						
	
							Select the CD Drive (D:\ for this example) containing the virtio-win_version.iso file.
						
	
							Reinstall the guest agents or drivers:
						
	
									To reinstall only the guest agents, use qemu-ga-x86_64.msi:
								
C:\WINDOWS\system32>msiexec.exe /i D:\guest-agent\qemu-ga-x86_64.msi /passive /norestart

	
									To reinstall the drivers, use virtio-win-gt-x64.msi:
								
C:\WINDOWS\system32>msiexec.exe /i D:\virtio-win-gt-x64.msi /passive /norestart




	
							If you are updating the drivers, restore the settings you saved using netsh:
						
C:\WINDOWS\system32>netsh -f filename.txt





Viewing Red Hat Satellite Errata for a Virtual Machine




				Errata for each virtual machine can be viewed after the Red Hat Virtualization virtual machine has been configured to receive errata information from the Red Hat Satellite server.
			

				For more information on configuring a virtual machine to display available errata see Configuring Satellite Errata
			

				Viewing Red Hat Satellite Errata
			
	
						Click Compute → Virtual Machines.
					
	
						Click the virtual machine’s name to go to the details view.
					
	
						Click Errata.
					



Virtual Machines and Permissions



Managing System Permissions for a Virtual Machine




					As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
				

					A UserVmManager is a system administration role for virtual machines in a data center. This role can be applied to specific virtual machines, to a data center, or to the whole virtualized environment; this is useful to allow different users to manage certain virtual resources.
				

					The user virtual machine administrator role permits the following actions:
				
	
							Create, edit, and remove virtual machines.
						
	
							Run, suspend, shutdown, and stop virtual machines.
						


Note

						You can only assign roles and permissions to existing users.
					


					Many end users are concerned solely with the virtual machine resources of the virtualized environment. As a result, Red Hat Virtualization provides several user roles which enable the user to manage virtual machines specifically, but not other resources in the data center.
				

Virtual Machine Administrator Roles Explained




					The table below describes the administrator roles and privileges applicable to virtual machine administration.
				
Table 6.1. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
									DataCenterAdmin
								

								 	 
									Data Center Administrator
								

								 	 
									Possesses administrative permissions for all objects underneath a specific data center except for storage.
								

								 
	 
									ClusterAdmin
								

								 	 
									Cluster Administrator
								

								 	 
									Possesses administrative permissions for all objects underneath a specific cluster.
								

								 
	 
									NetworkAdmin
								

								 	 
									Network Administrator
								

								 	 
									Possesses administrative permissions for all operations on a specific logical network. Can configure and manage networks attached to virtual machines. To configure port mirroring on a virtual machine network, apply the NetworkAdmin role on the network and the UserVmManager role on the virtual machine.
								

								 




Virtual Machine User Roles Explained




					The table below describes the user roles and privileges applicable to virtual machine users. These roles allow access to the VM Portal for managing and accessing virtual machines, but they do not confer any permissions for the Administration Portal.
				
Table 6.2. Red Hat Virtualization System User Roles
	Role	Privileges	Notes
	 
									UserRole
								

								 	 
									Can access and use virtual machines and pools.
								

								 	 
									Can log in to the VM Portal and use virtual machines and pools.
								

								 
	 
									PowerUserRole
								

								 	 
									Can create and manage virtual machines and templates.
								

								 	 
									Apply this role to a user for the whole environment with the Configure window, or for specific data centers or clusters. For example, if a PowerUserRole is applied on a data center level, the PowerUser can create virtual machines and templates in the data center. Having a PowerUserRole is equivalent to having the VmCreator, DiskCreator, and TemplateCreator roles.
								

								 
	 
									UserVmManager
								

								 	 
									System administrator of a virtual machine.
								

								 	 
									Can manage virtual machines and create and use snapshots. A user who creates a virtual machine in the VM Portal is automatically assigned the UserVmManager role on the machine.
								

								 
	 
									UserTemplateBasedVm
								

								 	 
									Limited privileges to only use Templates.
								

								 	 
									Level of privilege to create a virtual machine by means of a template.
								

								 
	 
									VmCreator
								

								 	 
									Can create virtual machines in the VM Portal.
								

								 	 
									This role is not applied to a specific virtual machine; apply this role to a user for the whole environment with the Configure window. When applying this role to a cluster, you must also apply the DiskCreator role on an entire data center, or on specific storage domains.
								

								 
	 
									VnicProfileUser
								

								 	 
									Logical network and network interface user for virtual machines.
								

								 	 
									If the Allow all users to use this Network option was selected when a logical network is created, VnicProfileUser permissions are assigned to all users for the logical network. Users can then attach or detach virtual machine network interfaces to or from the logical network.
								

								 




Assigning Virtual Machines to Users




					If you are creating virtual machines for users other than yourself, you have to assign roles to the users before they can use the virtual machines. Note that permissions can only be assigned to existing users. See Users and Roles in the Administration Guide for details on creating user accounts.
				

					The VM Portal supports three default roles: User, PowerUser and UserVmManager. However, customized roles can be configured via the Administration Portal. The default roles are described below.
				
	
							A User can connect to and use virtual machines. This role is suitable for desktop end users performing day-to-day tasks.
						
	
							A PowerUser can create virtual machines and view virtual resources. This role is suitable if you are an administrator or manager who needs to provide virtual resources for your employees.
						
	
							A UserVmManager can edit and remove virtual machines, assign user permissions, use snapshots and use templates. It is suitable if you need to make configuration changes to your virtual environment.
						



					When you create a virtual machine, you automatically inherit UserVmManager privileges. This enables you to make changes to the virtual machine and assign permissions to the users you manage, or users who are in your Identity Management (IdM) or RHDS group. See the Administration Guide for more information.
				
Procedure
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Permissions tab.
						
	
							Click Add.
						
	
							Enter a name, or user name, or part thereof in the Search text box, and click Go. A list of possible matches display in the results list.
						
	
							Select the check box of the user to be assigned the permissions.
						
	
							Select UserRole from the Role to Assign drop-down list.
						
	
							Click OK.
						



					The user’s name and role display in the list of users permitted to access this virtual machine.
				
Note

						If a user is assigned permissions to only one virtual machine, single sign-on (SSO) can be configured for the virtual machine. With single sign-on enabled, when a user logs in to the VM Portal, and then connects to a virtual machine through, for example, a SPICE console, users are automatically logged in to the virtual machine and do not need to type in the user name and password again. Single sign-on can be enabled or disabled on a per virtual machine basis. See Configuring Single Sign-On for Virtual Machines for more information on how to enable and disable single sign-on for virtual machines.
					


Removing Access to Virtual Machines from Users




					Removing Access to Virtual Machines from Users
				
	
							Click Compute → Virtual Machines.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click Permissions.
						
	
							Click Remove. A warning message displays, asking you to confirm removal of the selected permissions.
						
	
							To proceed, click OK. To abort, click Cancel.
						




Snapshots



Creating a Snapshot of a Virtual Machine




					A snapshot is a view of a virtual machine’s operating system and applications on any or all available disks at a given point in time. Take a snapshot of a virtual machine before you make a change to it that may have unintended consequences. You can use a snapshot to restore a virtual machine to a previous state.
				

					Creating a Snapshot of a Virtual Machine
				
In the VM Portal:
	
							Open a virtual machine.
						
	
							In the Snapshots panel, click +Create Snapshot.
						

							A snapshot is added to the panel, including all attached disks.
						



In the Administration Portal:
	
							Click Compute → Virtual Machines.
						
	
							Click a virtual machine’s name to go to the details view.
						
	
							Click the Snapshots tab and click Create.
						
	
							Enter a description for the snapshot.
						
	
							Select Disks to include using the check boxes.
						
Note

								If no disks are selected, a partial snapshot of the virtual machine, without a disk, is created. You can preview this snapshot to view the configuration of the virtual machine. Note that committing a partial snapshot will result in a virtual machine without a disk.
							


	
							Select Save Memory to include a running virtual machine’s memory in the snapshot.
						
	
							Click OK.
						



					The virtual machine’s operating system and applications on the selected disk(s) are stored in a snapshot that can be previewed or restored. The snapshot is created with a status of Locked, which changes to Ok. When you click the snapshot, its details are shown on the General, Disks, Network Interfaces, and Installed Applications drop-down views in the Snapshots tab.
				

Using a Snapshot to Restore a Virtual Machine




					A snapshot can be used to restore a virtual machine to its previous state.
				

					Using Snapshots to Restore Virtual Machines
				
In the VM Portal:
	
							Shutdown the virtual machine.
						
	
							In the Snapshots panel, click the Restore Snapshot icon for the snapshot you want to restore.
						

							The snapshot is loaded.
						



In the Administration Portal:
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the name of the virtual machine to go to the details view.
						
	
							Shut down the virtual machine.
						
	
							Click the Snapshots tab to list the available snapshots.
						
	
							Select a snapshot to restore in the upper pane. The snapshot details display in the lower pane.
						
	
							Click the Preview drop-down menu button and select Custom.
						
	
							Use the check boxes to select the VM Configuration, Memory, and disk(s) you want to restore, then click OK. This allows you to create and restore from a customized snapshot using the configuration and disk(s) from multiple snapshots.
						

							The status of the snapshot changes to Preview Mode. The status of the virtual machine briefly changes to Image Locked before returning to Down.
						

	
							Start the virtual machine; it runs using the disk image of the snapshot.
						
	
							Click Commit to permanently restore the virtual machine to the condition of the snapshot. Any subsequent snapshots are erased.
						

							Alternatively, click the Undo button to deactivate the snapshot and return the virtual machine to its previous state.
						




Creating a Virtual Machine from a Snapshot




					You can use a snapshot to create another virtual machine.
				

					Creating a Virtual Machine from a Snapshot
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Snapshots tab to list the available snapshots.
						
	
							Select a snapshot in the list displayed and click Clone.
						
	
							Enter the Name of the virtual machine.
						
	
							Click OK.
						



					After a short time, the cloned virtual machine appears in the Virtual Machines tab in the navigation pane with a status of Image Locked. The virtual machine remains in this state until Red Hat Virtualization completes the creation of the virtual machine. A virtual machine with a preallocated 20 GB hard drive takes about fifteen minutes to create. Sparsely-allocated virtual disks take less time to create than do preallocated virtual disks.
				

					When the virtual machine is ready to use, its status changes from Image Locked to Down in Compute → Virtual Machines.
				

Deleting a Snapshot




					You can delete a virtual machine snapshot and permanently remove it from your Red Hat Virtualization environment.
				

					Deleting a Snapshot
				
In the VM Portal:
	
							Open a virtual machine.
						
	
							In the Snapshots panel, click the Delete Snapshot icon of the snapshot you want to delete.
						


In the Administration Portal:
	
							Click Compute → Virtual Machines.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Snapshots tab to list the snapshots for that virtual machine.
						
	
							Select the snapshot to delete.
						
	
							Click Delete.
						
	
							Click OK.
						


Note

						If the deletion fails, fix the underlying problem (for example, a failed host, an inaccessible storage device, or a temporary network issue) and try again.
					



Host Devices



Adding a Host Device to a Virtual Machine




					To improve performance, you can attach a host device to a virtual machine.
				

					Host devices are physical devices connected to a particular host machine, such as:
				
	
							SCSI tape drives, disks, and changers
						
	
							PCI NICs, GPUs, and HBAs
						
	
							USB mice, cameras, and disks
						



					To add a host device to a virtual machine, you use the virtual machine’s Host Devices properties. First, you select one of the cluster hosts and a device type. Then, you choose and attach one or more of the host devices on that host.
				
Important

						When you change the Pinned Host setting, it removes the current host devices. When you save these changes, in the virtual machine’s Host settings, it sets Start Running On to Specific Host(s) and specifies the host you selected earlier using the Pinned Host setting.
					


					When you finish attaching one or more host devices, you run the virtual machine to apply the changes. The virtual machine starts on the host that has the attached host devices.
				

					If the virtual machine cannot start on the specified host or access the host device, it cancels the start operation and produces an error message with information about the cause.
				
Prerequisites
	
							The state of the host is Up.
						
	
							The host is configured for direct device assignment.
						


Procedure
	
							In the Administration Portal, click Compute → Virtual Machines.
						
	
							Shut down the virtual machine.
						
	
							Click the name of the virtual machine to go to the details view.
						
	
							Click the Host Devices tab.
						
	
							Click Add device. This opens the Add Host Devices pane.
						
	
							Use Pinned Host to select the host where the virtual machine runs.
						
	
							Use Capability to list pci, scsi, nvdimm, or usb_device devices.
						
Note

								The nvdimm option is a technical preview feature. For more information, see nvdimm host devices.
							


	
							Use Available Host Devices to select devices.
						
	
							Click the down arrow to move devices to Host Devices to be attached.
						
	
							Click OK to attach these devices to the virtual machine and close the window.
						
	
							Optional: If you attach a SCSI host device, configure the optimal driver.
						
	
									Click the Edit button. This opens the Edit Virtual Machine pane.
								
	
									Click the Custom Properties tab.
								
	
									Click the Please select a key and select scsi_hostdev from the bottom of the drop-down list.
								
	
									In most cases, select scsi-hd. Otherwise, for tape or CD changer devices, select the scsi_generic option. For more details, see Virtual Machine Custom Properties Settings Explained.
								
	
									Click the OK button.
								



	
							Run the virtual machine.
						
	
							While the virtual machine starts running, watch for Operation Canceled error messages.
						


Troubleshooting

						If you cannot add a host device to a virtual machine, or a virtual machine cannot start running with the attached host devices, it generates Operation Canceled error messages. For example:
					
Operation Canceled
Error while executing action:

<vm name>:
* Cannot run VM. There is no host that satisfies current scheduling constraints. See below for details:
* The host <first_hostname> did not satisfy internal filter HostDevice because it does not support host device passthrough.
* The host <second_hostname> did not satisfy internal filter HostDevice because the host does not provide requested host devices.

					You can fix the error by removing the host device from the virtual machine or correcting the issues the error message describes. For example:
				
	
							Respond to a The host <hostname> did not satisfy internal filter HostDevice because it does not support host device passthrough message by configuring the host for device passthrough and restarting the virtual machine.
						
	
							Respond to the The host <hostname> did not satisfy internal filter HostDevice because the host does not provide requested host devices message by adding the host device to the host.
						
	
							Respond to a Cannot add Host devices because the VM is in Up status message by shutting down the virtual machine before adding a host device.
						
	
							Verify that the state of the host is Up.
						


Additional resources
	
							Host Devices in the Virtual Machine Management Guide.
						
	
							Pinning a Virtual Machine to Multiple Hosts
						
	
							Configuring a Host for PCI Passthrough
						
	
							Additional Hardware Considerations for Using Device Assignment in Hardware Considerations for Implementing SR-IOV.
						
	
							nvdimm host devices
						



Removing Host Devices from a Virtual Machine




					If you are removing all host devices directly attached to the virtual machine in order to add devices from a different host, you can instead add the devices from the desired host, which will automatically remove all of the devices already attached to the virtual machine.
				
Procedure
	
							Click Compute → Virtual Machines.
						
	
							Select a virtual machine to go to the details view.
						
	
							Click the Host Devices tab to list the host devices attached to the virtual machine.
						
	
							Select the host device to detach from the virtual machine, or hold Ctrl to select multiple devices, and click Remove device. This opens the Remove Host Device(s) window.
						
	
							Click OK to confirm and detach these devices from the virtual machine.
						



Pinning a Virtual Machine to Another Host




					You can use the Host Devices tab in the details view of a virtual machine to pin it to a specific host.
				

					If the virtual machine has any host devices attached to it, pinning it to another host automatically removes the host devices from the virtual machine.
				

					Pinning a Virtual Machine to a Host
				
	
							Click a virtual machine name and click the Host Devices tab.
						
	
							Click Pin to another host. This opens the Pin VM to Host window.
						
	
							Use the Host drop-down menu to select a host.
						
	
							Click OK to pin the virtual machine to the selected host.
						



NVDIMM host devices



Note

						NVDIMM devices are Technology Preview features only. Technology Preview features are not supported with Red Hat production service-level agreements (SLAs) and might not be functionally complete, and Red Hat does not recommend using them for production. These features provide early access to upcoming product features, enabling customers to test functionality and provide feedback during the development process. For more information, see Red Hat Technology Preview Features Support Scope.
					


					You can add emulated NVDIMM devices to virtual machines. Elsewhere, this type of memory is also known as virtual NVDIMM or vNVDIMM.
				

					The emulated NVDIMM you can attach to a virtual machine is backed by real NVDIMM on the host machine where the virtual machine runs. Therefore, when you attach NVDIMM to a virtual machine, you also pin the virtual machine to a specific host.
				

					You can reconfigure the mode, partitioning, and other properties of the emulated NVDIMM device in the virtual machine without affecting the settings of the physical NVDIMM on the host device.
				

					To add emulated NVDIMM to a virtual machine, see Adding Host Devices to a Virtual Machine
				
Limitations
	
							Memory snapshots are disabled when an NVDIMM device is present in a virtual machine. There is no way to make a snapshot of NVDIMM content, and a memory snapshot cannot work correctly without having the corresponding NVDIMM data.
						
	
							In RHV, each NVDIMM device passed to a virtual machine has an automatically-assigned label area with a fixed size of 128 KB. IBM POWER hardware, and 128 KB is the minimum label size allowed by QEMU.
						
	
							By default, the virtual machine uses the whole NVDIMM device. You cannot configure the size of the NVDIMM from the virtual machine. To configure its size, partition the NVDIMM device on the host and add the partition to the virtual machine.
						
	
							The size of the NVDIMM device on the virtual machine may be slightly lower than on the host to comply with libvirt and QEMU alignment and size adjustments. Precise sizing is also needed to make memory hotplug work.
						
	
							libvirt and QEMU adjust their size and label placement. If those internal arrangements change, it can cause data loss.
						
	
							NVDIMM hotplug is not supported by the platform.
						
	
							Virtual machines with NVDIMM devices cannot migrate because they are pinned to a host.
						
	
							SELinux currently prevents access to NVDIMM devices in devdax mode. As a result, data persistence cannot be guaranteed if the host fails. See BZ1855336.
						


Important

						Avoid using NVDIMM on IBM POWER hardware. This combination is currently not expected to be stable until further work is completed.
					

Additional resources
	
							QEMU NVDIMM documentation
						
	
							Adding Host Devices to a Virtual Machine
						




Affinity Groups



Affinity Groups




					You can create Affinity Groups to help determine where selected virtual machines run in relation to each other and to specified hosts. This capability helps manage workload scenarios such as licensing requirements, high-availability workloads, and disaster recovery.
				
The VM Affinity Rule

						When you create an Affinity Group, you select the virtual machines that belong to the group. To define where these virtual machines can run in relation to each other, you enable a VM Affinity Rule: A Positive affinity rule tries to run the virtual machines together on a single host; a Negative affinity rule tries to run the virtual machines on separate hosts. If the rule cannot be fulfilled, the outcome depends on whether the weight or filter module is enabled.
					
The Host Affinity Rule

						Optionally, you can add hosts to the Affinity Group. To define where virtual machines in the group can run in relation to hosts in the group, you enable a Host Affinity Rule: A Positive affinity rule tries to run the virtual machines on hosts in the affinity group; a Negative affinity rule tries to run the virtual machines on hosts that are not in the affinity group. If the rule cannot be fulfilled, the outcome depends on whether the weight or filter module is enabled.
					
The Default Weight Module

						By default, both rules apply the weight module in the cluster’s scheduling policy. With the weight module, the scheduler attempts to fulfill a rule, but allows the virtual machines in the affinity group to run anyway if the rule cannot be fulfilled.
					

					For example, with a positive VM Affinity Rule and the weight module enabled, the scheduler tries to run all of the affinity group’s virtual machines on a single host. However, if a single host does not have sufficient resources for this, the scheduler runs the virtual machines on multiple hosts.
				

					For this module to work, the weight module section of the scheduling policies must contain the VmAffinityGroups and VmToHostsAffinityGroups keywords.
				
The Enforcing Option and Filter Module

						Both rules have an Enforcing option which applies the filter module in the cluster’s scheduling policy. The filter module overrides the weight module. With the filter module enabled, the scheduler requires that a rule be fulfilled. If a rule cannot be fulfilled, the filter module prevents the virtual machines in the affinity group from running.
					

					For example, with a Positive Host Affinity Rule and Enforcing enabled (the filter module enabled), the scheduler requires the virtual machines in the affinity group to run on hosts that are part of the affinity group. However, if those hosts are down, the scheduler does not run the virtual machines at all.
				

					For this module to work, the filter module section of the scheduling policies must contain the VmAffinityGroups and VmToHostsAffinityGroups keywords.
				
Examples

						To see how these rules and options can be used with one another, see Affinity group examples.
					
Warning
	
								For affinity labels to work, the filter module section of the scheduling policies must contain Label.
							
	
								If an affinity group and affinity label conflict with each other, the affected virtual machines do not run. To help prevent, troubleshoot, and resolve conflicts, see Affinity group troubleshooting.
							



Important

						Each rule is affected by the weight and filter modules in the cluster’s scheduling policy.
					
	
								For the VM Affinity Rule rule to work, the scheduling policy must have the VmAffinityGroups keyword in its Weight module and Filter module sections.
							
	
								For the Host Affinity Rule to work, the scheduling policy must have the VmToHostsAffinityGroups keyword in its Weight module and Filter module sections.
							



						For more information, see Scheduling Policies in the Administration Guide.
					

Note
	
								Affinity groups apply to virtual machines in a cluster. Moving a virtual machine from one cluster to another removes it from the affinity groups in the original cluster.
							
	
								Virtual machines do not have to restart for the affinity group rules to take effect.
							




Creating an Affinity Group




					You can create new affinity groups in the Administration Portal.
				

					Creating Affinity Groups
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Affinity Groups tab.
						
	
							Click New.
						
	
							Enter a Name and Description for the affinity group.
						
	
							From the VM Affinity Rule drop-down, select Positive to apply positive affinity or Negative to apply negative affinity. Select Disable to disable the affinity rule.
						
	
							Select the Enforcing check box to apply hard enforcement, or ensure this check box is cleared to apply soft enforcement.
						
	
							Use the drop-down list to select the virtual machines to be added to the affinity group. Use the + and - buttons to add or remove additional virtual machines.
						
	
							Click OK.
						



Editing an Affinity Group




					Editing Affinity Groups
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Affinity Groups tab.
						
	
							Click Edit.
						
	
							Change the VM Affinity Rule drop-down and Enforcing check box to the preferred values and use the + and - buttons to add or remove virtual machines to or from the affinity group.
						
	
							Click OK.
						



Removing an Affinity Group




					Removing Affinity Groups
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the virtual machine’s name to go to the details view.
						
	
							Click the Affinity Groups tab.
						
	
							Click Remove.
						
	
							Click OK.
						



					The affinity policy that applied to the virtual machines that were members of that affinity group no longer applies.
				

Affinity Groups Examples




					The following examples illustrate how to apply affinity rules for various scenarios, using the different features of the affinity group capability described in this chapter.
				
Example 6.1. High Availability

						Dalia is the DevOps engineer for a startup. For high availability, a particular system’s two virtual machines should run on separate hosts anywhere in the cluster.
					

						Dalia creates an affinity group named "high availability" and does the following:
					
	
								Adds the two virtual machines, VM01 and VM02, to the affinity group.
							
	
								Sets VM Affinity to Negative so the virtual machines try to run on separate hosts.
							
	
								Leaves Enforcing cleared (disabled) so that both virtual machines can continue running in case only one host is available during an outage.
							
	
								Leaves the Hosts list empty so the virtual machines run on any host in the cluster.
							




Example 6.2. Performance

						Sohni is a software developer who uses two virtual machines to build and test his software many times each day. There is heavy network traffic between these two virtual machines. Running the machines on the same host reduces both network traffic and the effects of network latency on the build and test process. Using high-specification hosts (faster CPUs, SSDs, and more memory) further accelerates this process.
					

						Sohni creates an affinity group called "build and test" and does the following:
					
	
								Adds VM01 and VM02, the build and test virtual machines, to the affinity group.
							
	
								Adds the high-specification hosts, host03, host04, and host05, to the affinity group.
							
	
								Sets VM affinity to Positive so the virtual machines try to run on the same host, reducing network traffic and latency effects.
							
	
								Sets Host affinity to Positive so the virtual machines try to run on the high specification hosts, accelerating the process.
							
	
								Leaves Enforcing cleared (disabled) for both rules so the virtual machines can run if the high-specification hosts are not available.
							




Example 6.3. Licensing

						Bandile, a software asset manager, helps his organization comply with the restrictive licensing requirements of a 3D imaging software vendor. These terms require the virtual machines for its licensing server, VM-LS, and imaging workstations, VM-WS#, to run on the same host. Additionally, the physical CPU-based licensing model requires that the workstations run on either of two GPU-equipped hosts, host-gpu-primary or host-gpu-backup.
					

						To meet these requirements, Bandile creates an affinity group called "3D seismic imaging" and does the following:
					
	
								Adds the previously mentioned virtual machines and hosts to the affinity group.
							
	
								Sets VM affinity to Positive and selects Enforcing so the licensing server and workstations must run together on one of the hosts, not on multiple hosts.
							
	
								Sets Host affinity to Positive and selects Enforcing so the virtual machines must run on either of the GPU-equipped the hosts, not other hosts in the cluster.
							





Affinity Groups Troubleshooting



To help prevent problems with affinity groups
	
							Plan and document the scenarios and outcomes you expect when using affinity groups.
						
	
							Verify and test the outcomes under a range of conditions.
						
	
							Follow change management best practices.
						
	
							Only use the Enforcing option if it is required.
						


If you observe problems with virtual machines not running
	
							Verify that the cluster has a scheduling policy with weight module and filter module sections that contain VmAffinityGroups and VmToHostsAffinityGroups. For more information, see Explanation of Settings in the New Scheduling Policy and Edit Scheduling Policy Window in the Administration Guide.
						
	
							Check for conflicts between affinity labels and affinity groups.
						


For possible conflicts between affinity labels and affinity groups
	
							If an affinity label and affinity group conflict with each other, the intersecting set of virtual machines do not run.
						
	
							To determine whether a conflict is possible:
						
	
									Inspect the filter module section of the cluster’s scheduling policies. These must contain both a Label keyword and a VmAffinityGroups OR VmToHostsAffinityGroups keyword. Otherwise, a conflict is not possible. (The presence of VmAffinityGroups and VmToHostsAffinityGroups in the weight module section does not matter because Label in a filter module section would override them.)
								
	
									Inspect the affinity groups. They must contain a rule that has Enforcing enabled. Otherwise, a conflict is not possible.
								



	
							If a conflict is possible, identify the set of virtual machines that might be involved:
						
	
									Inspect the affinity labels and groups. Make a list of virtual machines that are members of both an affinity label and an affinity group with an Enforcing option enabled.
								
	
									For each host and virtual machine in this intersecting set, analyze the conditions under which a potential conflict occurs.
								



	
							Determine whether the actual non-running virtual machines match the ones in the analysis.
						
	
							Restructure the affinity groups and affinity labels to help avoid unintended conflicts.
						
	
							Verify that any changes produce the expected results under a range of conditions.
						
	
							If you have overlapping affinity groups and affinity labels, it can be easier to view them in one place as affinity groups. Consider converting an affinity label into an equivalent affinity group, which has a Host affinity rule with Positive selected and Enforcing enabled.
						




Affinity Labels



About Affinity Labels




					You can create and modify Affinity Labels in the Administration Portal.
				

					Affinity Labels are used together with Affinity Groups to set any kind of affinity between virtual machines and hosts (hard, soft, positive, negative). See the Affinity Groups section for more information about affinity hardness and polarity.
				
Warning

						Affinity labels are a subset of affinity groups and can conflict with them. If there is a conflict, the virtual machine will not start.
					


Creating an Affinity Label




					You can create affinity labels from the details view of a virtual machine, host, or cluster. This procedure uses the cluster details view.
				

					Creating an Affinity Label
				
	
							Click Compute → Clusters and select the appropriate cluster.
						
	
							Click the cluster’s name to go to the details view.
						
	
							Click the Affinity Labels tab.
						
	
							Click New.
						
	
							Enter a Name for the affinity label.
						
	
							Use the drop-down lists to select the virtual machines and hosts to be associated with the label. Use the + button to add additional virtual machines and hosts.
						
	
							Click OK.
						



Editing an Affinity Label




					You can edit affinity labels from the details view of a virtual machine, host, or cluster. This procedure uses the cluster details view.
				

					Editing an Affinity Label
				
	
							Click Compute → Clusters and select the appropriate cluster.
						
	
							Click the cluster’s name to go to the details view.
						
	
							Click the Affinity Labels tab.
						
	
							Select the label you want to edit.
						
	
							Click Edit.
						
	
							Use the + and - buttons to add or remove virtual machines and hosts to or from the affinity label.
						
	
							Click OK.
						



Deleting an Affinity Label




					You can only remove an Affinity Label from the details view of a cluster after it is deleted from each entity.
				

					Deleting an Affinity Label
				
	
							Click Compute → Clusters and select the appropriate cluster.
						
	
							Click the cluster’s name to go to the details view.
						
	
							Click the Affinity Labels tab.
						
	
							Select the label you want to remove.
						
	
							Click Edit.
						
	
							Use the - buttons to remove all virtual machines and hosts from the label.
						
	
							Click OK.
						
	
							Click Delete.
						
	
							Click OK.
						




Exporting and Importing Virtual Machines and Templates



Note

					The export storage domain is deprecated. Storage data domains can be unattached from a data center and imported to another data center in the same environment, or in a different environment. Virtual machines, floating virtual disks, and templates can then be uploaded from the imported storage domain to the attached data center. See the Importing Existing Storage Domains section in the Red Hat Virtualization Administration Guide for information on importing storage domains.
				


				You can export virtual machines and templates from, and import them to, data centers in the same or different Red Hat Virtualization environment. You can export or import virtual machines by using an export domain, a data domain, or by using a Red Hat Virtualization host.
			

				When you export or import a virtual machine or template, properties including basic details such as the name and description, resource allocation, and high availability settings of that virtual machine or template are preserved.
			

				The permissions and user roles of virtual machines and templates are included in the OVF files, so that when a storage domain is detached from one data center and attached to another, the virtual machines and templates can be imported with their original permissions and user roles. In order for permissions to be registered successfully, the users and roles related to the permissions of the virtual machines or templates must exist in the data center before the registration process.
			

				You can also use the V2V feature to import virtual machines from other virtualization providers, such as RHEL 5 Xen or VMware, or import Windows virtual machines. V2V converts virtual machines so that they can be hosted by Red Hat Virtualization. For more information on installing and using V2V, see Converting Virtual Machines from Other Hypervisors to KVM with virt-v2v.
			
Important

					Virtual machines must be shut down before being imported.
				

Exporting a Virtual Machine to the Export Domain




					Export a virtual machine to the export domain so that it can be imported into a different data center. Before you begin, the export domain must be attached to the data center that contains the virtual machine to be exported.
				

					Exporting a Virtual Machine to the Export Domain
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Export to Export Domain.
						
	
							Optionally, select the following check boxes in the Export Virtual Machine window:
						
	
									Force Override: overrides existing images of the virtual machine on the export domain.
								
	
									Collapse Snapshots: creates a single export volume per disk. This option removes snapshot restore points and includes the template in a template-based virtual machine, and removes any dependencies a virtual machine has on a template. For a virtual machine that is dependent on a template, either select this option, export the template with the virtual machine, or make sure the template exists in the destination data center.
								
Note

										When you create a virtual machine from a template by clicking Compute → Templates and clicking New VM, you wll see two storage allocation options in the Storage Allocation section in the Resource Allocation tab:
									
	
												If Clone is selected, the virtual machine is not dependent on the template. The template does not have to exist in the destination data center.
											
	
												If Thin is selected, the virtual machine is dependent on the template, so the template must exist in the destination data center or be exported with the virtual machine. Alternatively, select the Collapse Snapshots check box to collapse the template disk and virtual disk into a single disk.
											



										To check which option was selected, click a virtual machine’s name and click the General tab in the details view.
									





	
							Click OK.
						



					The export of the virtual machine begins. The virtual machine displays in Compute → Virtual Machines with an Image Locked status while it is exported. Depending on the size of your virtual machine hard disk images, and your storage hardware, this can take up to an hour. Click the Events tab to view progress. When complete, the virtual machine has been exported to the export domain and displays in the VM Import tab of the export domain’s details view.
				

Exporting a Virtual Machine to a Data Domain




					You can export a virtual machine to a data domain to store a clone of the virtual machine as a backup.
				

					When you export a virtual machine that is dependent on a template, the target storage domain should include that template.
				
Note

						When you create a virtual machine from a template, you can choose from either of two storage allocation options:
					
	
								Clone: The virtual machine is not dependent on the template. The template does not have to exist in the destination storage domain.
							
	
								Thin: The virtual machine is dependent on the template, so the template must exist in the destination storage domain.
							



						To check which option is selected, click a virtual machine’s name and click the General tab in the details view.
					

Prerequisites
	
							The data domain is attached to a data center.
						
	
							The virtual machine is powered off.
						
Procedure
	
									Click Compute → Virtual Machines and select a virtual machine.
								
	
									Click Export.
								
	
									Specify a name for the exported virtual machine.
								
	
									Select a target storage domain from the Storage domain pop-up menu.
								
	
									(Optional) Check Collapse snapshots to export the virtual machine without any snapshots.
								
	
									Click OK.
								






					The Manager clones the virtual machine, including all its disks, to the target domain.
				
Note

						When you move a disk from one type of data domain another, the disk format changes accordingly. For example, if the disk is on an NFS data domain, and it is in sparse format, then if you move the disk to an iSCSI domain its format changes to preallocated. This is different from using an export domain, because an export domain is NFS.
					


					The virtual machine appears with an Image Locked status while it is exported. Depending on the size of your virtual machine hard disk images, and your storage hardware, this can take up to an hour. Click the Events tab to view progress. When complete, the virtual machine has been exported to the data domain and appears in the list of virtual machines.
				
Additional resources
	
							Creating a Virtual Machine Based on a Template in the Virtual Machine Management Guide
						



Importing a Virtual Machine from the Export Domain




					You have a virtual machine on an export domain. Before the virtual machine can be imported to a new data center, the export domain must be attached to the destination data center.
				

					Importing a Virtual Machine into the Destination Data Center
				
	
							Click Storage → Domains and select the export domain. The export domain must have a status of Active.
						
	
							Click the export domain’s name to go to the details view.
						
	
							Click the VM Import tab to list the available virtual machines to import.
						
	
							Select one or more virtual machines to import and click Import.
						
	
							Select the Target Cluster.
						
	
							Select the Collapse Snapshots check box to remove snapshot restore points and include templates in template-based virtual machines.
						
	
							Click the virtual machine to be imported and click the Disks sub-tab. From this tab, you can use the Allocation Policy and Storage Domain drop-down lists to select whether the disk used by the virtual machine will be thinly provisioned or preallocated, and can also select the storage domain on which the disk will be stored. An icon is also displayed to indicate which of the disks to be imported acts as the boot disk for that virtual machine.
						
	
							Click OK to import the virtual machines.
						

							The Import Virtual Machine Conflict window opens if the virtual machine exists in the virtualized environment.
						

							Choose one of the following radio buttons:
						
	
									Don’t import
								
	
									Import as cloned and enter a unique name for the virtual machine in the New Name field.
								



	
							Optionally select the Apply to all check box to import all duplicated virtual machines with the same suffix, and then enter a suffix in the Suffix to add to the cloned VMs field.
						
	
							Click OK.
						


Important

						During a single import operation, you can only import virtual machines that share the same architecture. If any of the virtual machines to be imported have a different architecture to that of the other virtual machines to be imported, a warning will display and you will be prompted to change your selection so that only virtual machines with the same architecture will be imported.
					


Importing a Virtual Machine from a Data Domain




					You can import a virtual machine into one or more clusters from a data storage domain.
				
Prerequisite
	
							If you are importing a virtual machine from an imported data storage domain, the imported storage domain must be attached to a data center and activated.
						


Procedure
	
							Click Storage → Domains.
						
	
							Click the imported storage domain’s name. This opens the details view.
						
	
							Click the VM Import tab.
						
	
							Select one or more virtual machines to import.
						
	
							Click Import.
						
	
							For each virtual machine in the Import Virtual Machine(s) window, ensure the correct target cluster is selected in the Cluster list.
						
	
							Map external virtual machine vNIC profiles to profiles that are present on the target cluster(s):
						
	
									Click vNic Profiles Mapping.
								
	
									Select the vNIC profile to use from the Target vNic Profile drop-down list.
								
	
									If multiple target clusters are selected in the Import Virtual Machine(s) window, select each target cluster in the Target Cluster drop-down list and ensure the mappings are correct.
								
	
									Click OK.
								



	
							If a MAC address conflict is detected, an exclamation mark appears next to the name of the virtual machine. Mouse over the icon to view a tooltip displaying the type of error that occurred.
						

							Select the Reassign Bad MACs check box to reassign new MAC addresses to all problematic virtual machines. Alternatively, you can select the Reassign check box per virtual machine.
						
Note

								If there are no available addresses to assign, the import operation will fail. However, in the case of MAC addresses that are outside the cluster’s MAC address pool range, it is possible to import the virtual machine without reassigning a new MAC address.
							


	
							Click OK.
						



					The imported virtual machines no longer appear in the list under the VM Import tab.
				

Importing a Virtual Machine from a VMware Provider




					Import virtual machines from a VMware vCenter provider to your Red Hat Virtualization environment. You can import from a VMware provider by entering its details in the Import Virtual Machine(s) window during each import operation, or you can add the VMware provider as an external provider, and select the preconfigured provider during import operations. To add an external provider, see Adding a VMware Instance as a Virtual Machine Provider.
				

					Red Hat Virtualization uses V2V to import VMware virtual machines. For OVA files, the only disk format Red Hat Virtualization supports is VMDK.
				
Note

						The virt-v2v package is not available on the ppc64le architecture and these hosts cannot be used as proxy hosts.
					

Note

						If the import fails, refer to the relevant log file in /var/log/vdsm/import/ and to /var/log/vdsm/vdsm.log on the proxy host for details.
					

Prerequisites
	
							The virt-v2v package must be installed on at least one host, referred to in this procedure as the proxy host. The virt-v2v package is available by default on Red Hat Virtualization Hosts and is installed on Red Hat Enterprise Linux hosts as a dependency of VDSM when added to the Red Hat Virtualization environment.
						
	
							Red Hat Enterprise Linux hosts must be Red Hat Enterprise Linux 7.2 or later.
						
	
							At least one data and one ISO storage domain are connected to the data center.
						
Note

								You can only migrate to shared storage, such as NFS, iSCSI, or FCP. Local storage is not supported.
							

								Although the ISO storage domain has been deprecated, it is required for migration.
							


	
							The virtio-win_version.iso image file for Windows virtual machines is uploaded to the ISO storage domain. This image includes the guest tools that are required for migrating Windows virtual machines.
						
	
							The virtual machine must be shut down before being imported. Starting the virtual machine through VMware during the import process can result in data corruption.
						
	
							An import operation can only include virtual machines that share the same architecture. If any virtual machine to be imported has a different architecture, a warning appears and you are prompted to change your selection to include only virtual machines with the same architecture.
						


Procedure
	
							Click Compute → Virtual Machines.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ) and select Import. This opens the Import Virtual Machine(s) window.
						
	
							Select VMware from the Source list.
						
	
							If you have configured a VMware provider as an external provider, select it from the External Provider list. Verify that the provider credentials are correct. If you did not specify a destination data center or proxy host when configuring the external provider, select those options now.
						
	
							If you have not configured a VMware provider, or want to import from a new VMware provider, provide the following details:
						
	
									Select from the list the Data Center in which the virtual machine will be available.
								
	
									Enter the IP address or fully qualified domain name of the VMware vCenter instance in the vCenter field.
								
	
									Enter the IP address or fully qualified domain name of the host from which the virtual machines will be imported in the ESXi field.
								
	
									Enter the name of the data center and the cluster in which the specified ESXi host resides in the Data Center field.
								
	
									If you have exchanged the SSL certificate between the ESXi host and the Manager, leave Verify server’s SSL certificate checked to verify the ESXi host’s certificate. If not, clear the option.
								
	
									Enter the Username and Password for the VMware vCenter instance. The user must have access to the VMware data center and ESXi host on which the virtual machines reside.
								
	
									Select a host in the chosen data center with virt-v2v installed to serve as the Proxy Host during virtual machine import operations. This host must also be able to connect to the network of the VMware vCenter external provider.
								



	
							Click Load to list the virtual machines on the VMware provider that can be imported.
						
	
							Select one or more virtual machines from the Virtual Machines on Source list, and use the arrows to move them to the Virtual Machines to Import list. Click Next.
						
Note

								If a virtual machine’s network device uses the driver type e1000 or rtl8139, the virtual machine will use the same driver type after it has been imported to Red Hat Virtualization.
							

								If required, you can change the driver type to VirtIO manually after the import. To change the driver type after a virtual machine has been imported, see Editing network interfaces. If the network device uses driver types other than e1000 or rtl8139, the driver type is changed to VirtIO automatically during the import. The Attach VirtIO-drivers option allows the VirtIO drivers to be injected to the imported virtual machine files so that when the driver is changed to VirtIO, the device will be properly detected by the operating system.
							


	
							Select the Cluster in which the virtual machines will reside.
						
	
							Select a CPU Profile for the virtual machines.
						
	
							Select the Collapse Snapshots check box to remove snapshot restore points and include templates in template-based virtual machines.
						
	
							Select the Clone check box to change the virtual machine name and MAC addresses, and clone all disks, removing all snapshots. If a virtual machine appears with a warning symbol beside its name or has a tick in the VM in System column, you must clone the virtual machine and change its name.
						
	
							Click each virtual machine to be imported and click the Disks sub-tab. Use the Allocation Policy and Storage Domain lists to select whether the disk used by the virtual machine will be thinly provisioned or preallocated, and select the storage domain on which the disk will be stored. An icon is also displayed to indicate which of the disks to be imported acts as the boot disk for that virtual machine.
						
	
							If you selected the Clone check box, change the name of the virtual machine in the General sub-tab.
						
	
							Click OK to import the virtual machines.
						



					The CPU type of the virtual machine must be the same as the CPU type of the cluster into which it is being imported. To view the cluster’s CPU Type in the Administration Portal:
				
	
							Click Compute → Clusters.
						
	
							Select a cluster.
						
	
							Click Edit.
						
	
							Click the General tab.
						



					If the CPU type of the virtual machine is different, configure the imported virtual machine’s CPU type:
				
	
							Click Compute → Virtual Machines.
						
	
							Select the virtual machine.
						
	
							Click Edit.
						
	
							Click the System tab.
						
	
							Click the Advanced Parameters arrow.
						
	
							Specify the Custom CPU Type and click OK.
						



Exporting a Virtual Machine to a Host




					You can export a virtual machine to a specific path or mounted NFS shared storage on a host in the Red Hat Virtualization data center. The export will produce an Open Virtual Appliance (OVA) package.
				

					Exporting a Virtual Machine to a Host
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Export to OVA.
						
	
							Select the host from the Host drop-down list.
						
	
							Enter the absolute path to the export directory in the Directory field, including the trailing slash. For example: /images2/ova/
						
	
							Optionally change the default name of the file in the Name field.
						
	
							Click OK
						



					The status of the export can be viewed in the Events tab.
				

Importing a Virtual Machine from a Host




					Import an Open Virtual Appliance (OVA) file into your Red Hat Virtualization environment. You can import the file from any Red Hat Virtualization Host in the data center.
				
Important

						Currently, only Red Hat Virtualization and OVAs created by VMware can be imported. KVM and Xen are not supported.
					

						The import process uses virt-v2v. Only virtual machines running operating systems compatible with virt-v2v can be successfully imported. See Converting virtual machines from other hypervisors to KVM with virt-v2v in RHEL 7 and RHEL 8 for a current list of compatible operating systems.
					


					Importing an OVA File
				
	
							Copy the OVA file to a host in your cluster, in a file system location such as /var/tmp.
						
Note

								The location can be a local directory or a remote NFS mount, as long as it is not in the`/root` directory or subdirectories. Ensure that it has sufficient space.
							


	
							Ensure that the OVA file has permissions allowing read/write access to the qemu user (UID 36) and the kvm group (GID 36):
						
# chown 36:36 path_to_OVA_file/file.OVA

	
							Click Compute → Virtual Machines.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ) and select Import. This opens the Import Virtual Machine(s) window.
						
	
									Select Virtual Appliance (OVA) from the Source list.
								
	
									Select a host from the Host list.
								
	
									In the Path field, specify the absolute path of the OVA file.
								
	
									Click Load to list the virtual machine to be imported.
								
	
									Select the virtual machine from the Virtual Machines on Source list, and use the arrows to move it to the Virtual Machines to Import list.
								



	
							Click Next.
						
	
									Select the Storage Domain for the virtual machine.
								
	
									Select the Target Cluster where the virtual machines will reside.
								
	
									Select the CPU Profile for the virtual machines.
								
	
									Select the Allocation Policy for the virtual machines.
								
	
									Optionally, select the Attach VirtIO-Drivers check box and select the appropriate image on the list to add VirtIO drivers.
								
	
									Select the Allocation Policy for the virtual machines.
								
	
									Select the virtual machine, and on the General tab select the Operating System.
								
	
									On the Network Interfaces tab, select the Network Name and Profile Name.
								
	
									Click the Disks tab to view the Alias, Virtual Size, and Actual Size of the virtual machine.
								



	
							Click OK to import the virtual machines.
						



Importing a virtual machine from a RHEL 5 Xen host




					Import virtual machines from Xen on Red Hat Enterprise Linux 5 to your Red Hat Virtualization environment. Red Hat Virtualization uses V2V to import QCOW2 or raw virtual machine disk formats.
				

					The virt-v2v package must be installed on at least one host (referred to in this procedure as the proxy host). The virt-v2v package is available by default on Red Hat Virtualization Hosts (RHVH) and is installed on Red Hat Enterprise Linux hosts as a dependency of VDSM when added to the Red Hat Virtualization environment. Red Hat Enterprise Linux hosts must be Red Hat Enterprise Linux 7.2 or later.
				
Warning

						If you are importing a Windows virtual machine from a RHEL 5 Xen host and you are using VirtIO devices, install the VirtIO drivers before importing the virtual machine. If the drivers are not installed, the virtual machine may not boot after import.
					

						The VirtIO drivers can be installed from the virtio-win_version.iso or the RHV-toolsSetup_version.iso. See Installing the Guest Agents and Drivers on Windows for details.
					

						If you are not using VirtIO drivers, review the configuration of the virutal machine before first boot to ensure that VirtIO devices are not being used.
					

Note

						The virt-v2v package is not available on the ppc64le architecture and these hosts cannot be used as proxy hosts.
					

Important

						An import operation can only include virtual machines that share the same architecture. If any virtual machine to be imported has a different architecture, a warning appears and you are prompted to change your selection to include only virtual machines with the same architecture.
					

Note

						If the import fails, refer to the relevant log file in /var/log/vdsm/import/ and to /var/log/vdsm/vdsm.log on the proxy host for details.
					

Procedure

						To import a virtual machine from RHEL 5 Xen, follow these steps:
					
	
							Shut down the virtual machine. Starting the virtual machine through Xen during the import process can result in data corruption.
						
	
							Enable public key authentication between the proxy host and the RHEL 5 Xen host:
						
	
									Log in to the proxy host and generate SSH keys for the vdsm user.
								
# sudo -u vdsm ssh-keygen

	
									Copy the vdsm user’s public key to the RHEL 5 Xen host.
								
# sudo -u vdsm ssh-copy-id root@xenhost.example.com

	
									Log in to the RHEL 5 Xen host to verify that the login works correctly.
								
# sudo -u vdsm ssh root@xenhost.example.com




	
							Log in to the Administration Portal.
						
	
							Click Compute → Virtual Machines.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ) and select Import. This opens the Import Virtual Machine(s) window.
						
	
							Select the Data Center that contains the proxy host.
						
	
							Select XEN (via RHEL) from the Source drop-down list.
						
	
							Optionally, select a RHEL 5 Xen External Provider from the drop-down list. The URI will be pre-filled with the correct URI. See Adding a RHEL 5 Xen Host as a Virtual Machine Provider in the Administration Guide for more information.
						
	
							Enter the URI of the RHEL 5 Xen host. The required format is pre-filled; you must replace <hostname> with the host name of the RHEL 5 Xen host.
						
	
							Select the proxy host from the Proxy Host drop-down list.
						
	
							Click Load to list the virtual machines on the RHEL 5 Xen host that can be imported.
						
	
							Select one or more virtual machines from the Virtual Machines on Source list, and use the arrows to move them to the Virtual Machines to Import list.
						
Note

								Due to current limitations, Xen virtual machines with block devices do not appear in the Virtual Machines on Source list. They must be imported manually. See Importing Block Based Virtual Machine from Xen host.
							


	
							Click Next.
						
	
							Select the Cluster in which the virtual machines will reside.
						
	
							Select a CPU Profile for the virtual machines.
						
	
							Use the Allocation Policy and Storage Domain lists to select whether the disk used by the virtual machine will be thinly provisioned or preallocated, and select the storage domain on which the disk will be stored.
						
Note

								The target storage domain must be a file-based domain. Due to current limitations, specifying a block-based domain causes the V2V operation to fail.
							


	
							If a virtual machine appears with a warning symbol beside its name, or has a tick in the VM in System column, select the Clone check box to clone the virtual machine.
						
Note

								Cloning a virtual machine changes its name and MAC addresses and clones all of its disks, removing all snapshots.
							


	
							Click OK to import the virtual machines.
						



					The CPU type of the virtual machine must be the same as the CPU type of the cluster into which it is being imported. To view the cluster’s CPU Type in the Administration Portal:
				
	
							Click Compute → Clusters.
						
	
							Select a cluster.
						
	
							Click Edit.
						
	
							Click the General tab.
						



					If the CPU type of the virtual machine is different, configure the imported virtual machine’s CPU type:
				
	
							Click Compute → Virtual Machines.
						
	
							Select the virtual machine.
						
	
							Click Edit.
						
	
							Click the System tab.
						
	
							Click the Advanced Parameters arrow.
						
	
							Specify the Custom CPU Type and click OK.
						


Importing a Block-Based Virtual Machine from a RHEL 5 Xen Host
	
							Enable public key authentication between the proxy host and the RHEL 5 Xen host:
						
	
									Log in to the proxy host and generate SSH keys for the vdsm user.
								
# sudo -u vdsm ssh-keygen

	
									Copy the vdsm user’s public key to the RHEL 5 Xen host.
								
# sudo -u vdsm ssh-copy-id root@xenhost.example.com

	
									Log in to the RHEL 5 Xen host to verify that the login works correctly.
								
# sudo -u vdsm ssh root@xenhost.example.com




	
							Attach an export domain. See Attaching an Existing Export Domain to a Data Center in the Administration Guide for details.
						
	
							On the proxy host, copy the virtual machine from the RHEL 5 Xen host:
						
# virt-v2v-copy-to-local -ic xen+ssh://root@xenhost.example.com vmname

	
							Convert the virtual machine to libvirt XML and move the file to your export domain:
						
# virt-v2v -i libvirtxml vmname.xml -o rhev -of raw -os storage.example.com:/exportdomain

	
							In the Administration Portal, click Storage → Domains, click the export domain’s name, and click the VM Import tab in the details view to verify that the virtual machine is in your export domain.
						
	
							Import the virtual machine into the destination data domain. See Importing the virtual machine from the export domain for details.
						



Importing a Virtual Machine from a KVM Host




					Import virtual machines from KVM to your Red Hat Virtualization environment. Red Hat Virtualization converts KVM virtual machines to the correct format before they are imported. You must enable public key authentication between the KVM host and at least one host in the destination data center (this host is referred to in the following procedure as the proxy host).
				
Warning

						The virtual machine must be shut down before being imported. Starting the virtual machine through KVM during the import process can result in data corruption.
					

Important

						An import operation can only include virtual machines that share the same architecture. If any virtual machine to be imported has a different architecture, a warning appears and you are prompted to change your selection to include only virtual machines with the same architecture.
					

Note

						If the import fails, refer to the relevant log file in /var/log/vdsm/import/ and to /var/log/vdsm/vdsm.log on the proxy host for details.
					


					Importing a Virtual Machine from KVM
				
	
							Enable public key authentication between the proxy host and the KVM host:
						
	
									Log in to the proxy host and generate SSH keys for the vdsm user.
								
# sudo -u vdsm ssh-keygen

	
									Copy the vdsm user’s public key to the KVM host. The proxy host’s known_hosts file will also be updated to include the host key of the KVM host.
								
# sudo -u vdsm ssh-copy-id root@kvmhost.example.com

	
									Log in to the KVM host to verify that the login works correctly.
								
# sudo -u vdsm ssh root@kvmhost.example.com




	
							Log in to the Administration Portal.
						
	
							Click Compute → Virtual Machines.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ) and select Import. This opens the Import Virtual Machine(s) window.
						
	
							Select the Data Center that contains the proxy host.
						
	
							Select KVM (via Libvirt) from the Source drop-down list.
						
	
							Optionally, select a KVM provider External Provider from the drop-down list. The URI will be pre-filled with the correct URI. See Adding a KVM Host as a Virtual Machine Provider in the Administration Guide for more information.
						
	
							Enter the URI of the KVM host in the following format:
						
qemu+ssh://root@kvmhost.example.com/system

	
							Keep the Requires Authentication check box selected.
						
	
							Enter root in the Username field.
						
	
							Enter the Password of the KVM host’s root user.
						
	
							Select the Proxy Host from the drop-down list.
						
	
							Click Load to list the virtual machines on the KVM host that can be imported.
						
	
							Select one or more virtual machines from the Virtual Machines on Source list, and use the arrows to move them to the Virtual Machines to Import list.
						
	
							Click Next.
						
	
							Select the Cluster in which the virtual machines will reside.
						
	
							Select a CPU Profile for the virtual machines.
						
	
							Optionally, select the Collapse Snapshots check box to remove snapshot restore points and include templates in template-based virtual machines.
						
	
							Optionally, select the Clone check box to change the virtual machine name and MAC addresses, and clone all disks, removing all snapshots. If a virtual machine appears with a warning symbol beside its name or has a tick in the VM in System column, you must clone the virtual machine and change its name.
						
	
							Click each virtual machine to be imported and click the Disks sub-tab. Use the Allocation Policy and Storage Domain lists to select whether the disk used by the virtual machine will be thin provisioned or preallocated, and select the storage domain on which the disk will be stored. An icon is also displayed to indicate which of the disks to be imported acts as the boot disk for that virtual machine. See Virtual Disk Storage Allocation Policies in the Technical Reference for more information.
						
	
							If you selected the Clone check box, change the name of the virtual machine in the General tab.
						
	
							Click OK to import the virtual machines.
						



					The CPU type of the virtual machine must be the same as the CPU type of the cluster into which it is being imported. To view the cluster’s CPU Type in the Administration Portal:
				
	
							Click Compute → Clusters.
						
	
							Select a cluster.
						
	
							Click Edit.
						
	
							Click the General tab.
						



					If the CPU type of the virtual machine is different, configure the imported virtual machine’s CPU type:
				
	
							Click Compute → Virtual Machines.
						
	
							Select the virtual machine.
						
	
							Click Edit.
						
	
							Click the System tab.
						
	
							Click the Advanced Parameters arrow.
						
	
							Specify the Custom CPU Type and click OK.
						



Importing a Red Hat KVM Guest Image




					You can import a Red Hat-provided KVM virtual machine image. This image is a virtual machine snapshot with a preconfigured instance of Red Hat Enterprise Linux installed.
				

					You can configure this image with the cloud-init tool, and use it to provision new virtual machines. This eliminates the need to install and configure the operating system and provides virtual machines that are ready for use.
				
Procedure
	
							Download the most recent KVM virtual machine image from the Download Red Hat Enterprise Linux list, in the Product Software tab.
						
	
							Upload the virtual machine image using the Manager or the REST API. See Uploading Images to a Data Storage Domain in the Administration Guide.
						
	
							Create a new virtual machine and attach the uploaded disk image to it. See Creating a Linux virtual machine.
						
	
							Optionally, use cloud-init to configure the virtual machine. See Using Cloud-Init to Automate the Configuration of Virtual Machines for details.
						
	
							Optionally, create a template from the virtual machine. You can generate new virtual machines from this template. See Templates for information about creating templates and generating virtual machines from templates.
						




Migrating Virtual Machines Between Hosts




				Live migration provides the ability to move a running virtual machine between physical hosts with no interruption to service. The virtual machine remains powered on and user applications continue to run while the virtual machine is relocated to a new physical host. In the background, the virtual machine’s RAM is copied from the source host to the destination host. Storage and network connectivity are not altered.
			
Note

					A virtual machine that is using a vGPU cannot be migrated to a different host.
				

Live Migration Prerequisites



Note

						This is one in a series of topics that show how to set up and configure SR-IOV on Red Hat Virtualization. For more information, see Setting Up and Configuring SR-IOV
					


					You can use live migration to seamlessly move virtual machines to support a number of common maintenance tasks. Your Red Hat Virtualization environment must be correctly configured to support live migration well in advance of using it.
				

					At a minimum, the following prerequisites must be met to enable successful live migration of virtual machines:
				
	
							The source and destination hosts are members of the same cluster, ensuring CPU compatibility between them.
						


Note

						Live migrating virtual machines between different clusters is generally not recommended.
					

	
							The source and destination hosts' status is Up.
						
	
							The source and destination hosts have access to the same virtual networks and VLANs.
						
	
							The source and destination hosts have access to the data storage domain on which the virtual machine resides.
						
	
							The destination host has sufficient CPU capacity to support the virtual machine’s requirements.
						
	
							The destination host has sufficient unused RAM to support the virtual machine’s requirements.
						
	
							The migrating virtual machine does not have the cache!=none custom property set.
						



					Live migration is performed using the management network and involves transferring large amounts of data between hosts. Concurrent migrations have the potential to saturate the management network. For best performance, create separate logical networks for management, storage, display, and virtual machine data to minimize the risk of network saturation.
				

Configuring Virtual Machines with SR-IOV-Enabled vNICs to Reduce Network Outage during Migration




					Virtual machines with vNICs that are directly connected to a virtual function (VF) of an SR-IOV-enabled host NIC can be further configured to reduce network outage during live migration:
				
	
							Ensure that the destination host has an available VF.
						
	
							Set the Passthrough and Migratable options in the passthrough vNIC’s profile. See Enabling Passthrough on a vNIC Profile in the Administration Guide.
						
	
							Enable hotplugging for the virtual machine’s network interface.
						
	
							Ensure that the virtual machine has a backup VirtIO vNIC, in addition to the passthrough vNIC, to maintain the virtual machine’s network connection during migration.
						
	
							Set the VirtIO vNIC’s No Network Filter option before configuring the bond. See Explanation of Settings in the VM Interface Profile Window in the Administration Guide.
						
	
							Add both vNICs as slaves under an active-backup bond on the virtual machine, with the passthrough vNIC as the primary interface.
						

							The bond and vNIC profiles can be configured in one of the following ways:
						
	
									The bond is not configured with fail_over_mac=active and the VF vNIC is the primary slave (recommended).
								

									Disable the VirtIO vNIC profile’s MAC-spoofing filter to ensure that traffic passing through the VirtIO vNIC is not dropped because it uses the VF vNIC MAC address.
								

	
									The bond is configured with fail_over_mac=active.
								

									This failover policy ensures that the MAC address of the bond is always the MAC address of the active slave. During failover, the virtual machine’s MAC address changes, with a slight disruption in traffic.
								







Configuring Virtual Machines with SR-IOV-Enabled vNICs with minimal downtime




					To configure virtual machines for migration with SR-IOV enabled vNICs and minimal downtime follow the procedure described below.
				
Note

						The following steps are provided only as a Technology Preview. For more information see Red Hat Technology Preview Features Support Scope.
					

	
							Create a vNIC profile with SR-IOV enabled vNICS. See Creating a vNIC profile and Setting up and configuring SR-IOV.
						
	
							In the Administration Portal, go to Network → VNIC profiles, select the vNIC profile, click Edit and select a Failover vNIC profile from the drop down list.
						
	
							Click OK to save the profile settings.
						
	
							Hotplug a network interface with the failover vNIC profile you created into the virtual machine, or start a virtual machine with this network interface plugged in.
						
Note

								The virtual machine has three network interfaces: a controller interface and two secondary interfaces. The controller interface must be active and connected in order for migration to succeed.
							


	
							For automatic deployment of virtual machines with this configuration, use the following udev rule:
						
  UBSYSTEM=="net",
  ACTION=="add|change",
  ENV{ID_NET_DRIVER}!="net_failover",
  ENV{NM_UNMANAGED}="1",
  RUN+="/bin/sh -c '/sbin/ip link set up $INTERFACE'"

							This udev rule works only on systems that manage interfaces with NetworkManager. This rule ensures that only the controller interface is activated.
						




Optimizing Live Migration




					Live virtual machine migration can be a resource-intensive operation. To optimize live migration, you can set the following two options globally for every virtual machine in an environment, for every virtual machine in a cluster, or for an individual virtual machine.
				
Note

						The Auto Converge migrations and Enable migration compression options are available for cluster levels 4.2 or earlier.
					

						For cluster levels 4.3 or later, auto converge is enabled by default for all built-in migration policies, and migration compression is enabled by default for only the Suspend workload if needed migration policy. You can change these parameters when adding a new migration policy, or by modifying the MigrationPolicies configuration value.
					


					The Auto Converge migrations option allows you to set whether auto-convergence is used during live migration of virtual machines. Large virtual machines with high workloads can dirty memory more quickly than the transfer rate achieved during live migration, and prevent the migration from converging. Auto-convergence capabilities in QEMU allow you to force convergence of virtual machine migrations. QEMU automatically detects a lack of convergence and triggers a throttle-down of the vCPUs on the virtual machine.
				

					The Enable migration compression option allows you to set whether migration compression is used during live migration of the virtual machine. This feature uses Xor Binary Zero Run-Length-Encoding to reduce virtual machine downtime and total live migration time for virtual machines running memory write-intensive workloads or for any application with a sparse memory update pattern.
				

					Both options are disabled globally by default.
				
Procedure
	
							Enable auto-convergence at the global level:
						
# engine-config -s DefaultAutoConvergence=True
	
									Enable migration compression at the global level:
								
# engine-config -s DefaultMigrationCompression=True

	
									Restart the ovirt-engine service to apply the changes:
								
# systemctl restart ovirt-engine.service




	
							Configure the optimization settings for a cluster:
						
	
									Click Compute → Clusters and select a cluster.
								
	
									Click Edit.
								
	
									Click the Migration Policy tab.
								
	
									From the Auto Converge migrations list, select Inherit from global setting, Auto Converge, or Don’t Auto Converge.
								
	
									From the Enable migration compression list, select Inherit from global setting, Compress, or Don’t Compress.
								
	
									Click OK.
								



	
							Configure the optimization settings at the virtual machine level:
						
	
									Click Compute → Virtual Machines and select a virtual machine.
								
	
									Click Edit.
								
	
									Click the Host tab.
								
	
									From the Auto Converge migrations list, select Inherit from cluster setting, Auto Converge, or Don’t Auto Converge.
								
	
									From the Enable migration compression list, select Inherit from cluster setting, Compress, or Don’t Compress.
								
	
									Click OK.
								






Guest Agent Hooks




					Hooks are scripts that trigger activity within a virtual machine when key events occur:
				
	
							Before migration
						
	
							After migration
						
	
							Before hibernation
						
	
							After hibernation
						



					The hooks configuration base directory is /etc/ovirt-guest-agent/hooks.d on Linux systems.
				

					Each event has a corresponding subdirectory: before_migration and after_migration, before_hibernation and after_hibernation. All files or symbolic links in that directory will be executed.
				

					The executing user on Linux systems is ovirtagent. If the script needs root permissions, the elevation must be executed by the creator of the hook script.
				

Automatic Virtual Machine Migration




					Red Hat Virtualization Manager automatically initiates live migration of all virtual machines running on a host when the host is moved into maintenance mode. The destination host for each virtual machine is assessed as the virtual machine is migrated, in order to spread the load across the cluster.
				

					From version 4.3, all virtual machines defined with manual or automatic migration modes are migrated when the host is moved into maintenance mode. However, for high performance and/or pinned virtual machines, a Maintenance Host window is displayed, asking you to confirm the action because the performance on the target host may be less than the performance on the current host.
				

					The Manager automatically initiates live migration of virtual machines in order to maintain load-balancing or power-saving levels in line with scheduling policy. Specify the scheduling policy that best suits the needs of your environment. You can also disable automatic, or even manual, live migration of specific virtual machines where required.
				

					If your virtual machines are configured for high performance, and/or if they have been pinned (by setting Passthrough Host CPU, CPU Pinning, or NUMA Pinning), the migration mode is set to Allow manual migration only. However, this can be changed to Allow Manual and Automatic mode if required. Special care should be taken when changing the default migration setting so that it does not result in a virtual machine migrating to a host that does not support high performance or pinning.
				

Preventing Automatic Migration of a Virtual Machine




					Red Hat Virtualization Manager allows you to disable automatic migration of virtual machines. You can also disable manual migration of virtual machines by setting the virtual machine to run only on a specific host.
				

					The ability to disable automatic migration and require a virtual machine to run on a particular host is useful when using application high availability products, such as Red Hat High Availability or Cluster Suite.
				

					Preventing Automatic Migration of Virtual Machines
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							Click the Host tab.
						
	
							In the Start Running On section, select Any Host in Cluster or Specific Host(s), which enables you to select multiple hosts.
						
Warning

								Explicitly assigning a virtual machine to a specific host and disabling migration are mutually exclusive with Red Hat Virtualization high availability.
							

Important

								If the virtual machine has host devices directly attached to it, and a different host is specified, the host devices from the previous host will be automatically removed from the virtual machine.
							


	
							Select Allow manual migration only or Do not allow migration from the Migration Options drop-down list.
						
	
							Click OK.
						



Manually Migrating Virtual Machines




					A running virtual machine can be live migrated to any host within its designated host cluster. Live migration of virtual machines does not cause any service interruption. Migrating virtual machines to a different host is especially useful if the load on a particular host is too high. For live migration prerequisites, see Live migration prerequisites.
				

					For high performance virtual machines and/or virtual machines defined with Pass-Through Host CPU, CPU Pinning, or NUMA Pinning, the default migration mode is Manual. Select Select Host Automatically so that the virtual machine migrates to the host that offers the best performance.
				
Note

						When you place a host into maintenance mode, the virtual machines running on that host are automatically migrated to other hosts in the same cluster. You do not need to manually migrate these virtual machines.
					

Note

						Live migrating virtual machines between different clusters is generally not recommended.
					

Procedure
	
							Click Compute → Virtual Machines and select a running virtual machine.
						
	
							Click Migrate.
						
	
							Use the radio buttons to select whether to Select Host Automatically or to Select Destination Host, specifying the host using the drop-down list.
						
Note

								When the Select Host Automatically option is selected, the system determines the host to which the virtual machine is migrated according to the load balancing and power management rules set up in the scheduling policy.
							


	
							Click OK.
						



					During migration, progress is shown in the Migration progress bar. Once migration is complete the Host column will update to display the host the virtual machine has been migrated to.
				

Setting Migration Priority




					Red Hat Virtualization Manager queues concurrent requests for migration of virtual machines off of a given host. The load balancing process runs every minute. Hosts already involved in a migration event are not included in the migration cycle until their migration event has completed. When there is a migration request in the queue and available hosts in the cluster to action it, a migration event is triggered in line with the load balancing policy for the cluster.
				

					You can influence the ordering of the migration queue by setting the priority of each virtual machine; for example, setting mission critical virtual machines to migrate before others. Migrations will be ordered by priority; virtual machines with the highest priority will be migrated first.
				

					Setting Migration Priority
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							Select the High Availability tab.
						
	
							Select Low, Medium, or High from the Priority drop-down list.
						
	
							Click OK.
						



Canceling Ongoing Virtual Machine Migrations




					A virtual machine migration is taking longer than you expected. You’d like to be sure where all virtual machines are running before you make any changes to your environment.
				
Procedure
	
							Select the migrating virtual machine. It is displayed in Compute → Virtual Machines with a status of Migrating from.
						
	
							Click More Actions ( 
							[image: moreactions]
							 ), then click Cancel Migration.
						



					The virtual machine status returns from Migrating from to Up.
				

Event and Log Notification upon Automatic Migration of Highly Available Virtual Servers




					When a virtual server is automatically migrated because of the high availability function, the details of an automatic migration are documented in the Events tab and in the engine log to aid in troubleshooting, as illustrated in the following examples:
				
Example 6.4. Notification in the Events Tab of the Administration Portal

						Highly Available Virtual_Machine_Name failed. It will be restarted automatically.
					

						Virtual_Machine_Name was restarted on Host Host_Name
					


Example 6.5. Notification in the Manager engine.log

						This log can be found on the Red Hat Virtualization Manager at /var/log/ovirt-engine/engine.log:
					

						Failed to start Highly Available VM. Attempting to restart. VM Name: Virtual_Machine_Name, VM Id:_Virtual_Machine_ID_Number_
					




Improving Uptime with Virtual Machine High Availability



What is High Availability?




					High availability is recommended for virtual machines running critical workloads. A highly available virtual machine is automatically restarted, either on its original host or another host in the cluster, if its process is interrupted, such as in the following scenarios:
				
	
							A host becomes non-operational due to hardware failure.
						
	
							A host is put into maintenance mode for scheduled downtime.
						
	
							A host becomes unavailable because it has lost communication with an external storage resource.
						



					A highly available virtual machine is not restarted if it is shut down cleanly, such as in the following scenarios:
				
	
							The virtual machine is shut down from within the guest.
						
	
							The virtual machine is shut down from the Manager.
						
	
							The host is shut down by an administrator without being put in maintenance mode first.
						



					With storage domains V4 or later, virtual machines have the additional capability to acquire a lease on a special volume on the storage, enabling a virtual machine to start on another host even if the original host loses power. The functionality also prevents the virtual machine from being started on two different hosts, which may lead to corruption of the virtual machine disks.
				

					With high availability, interruption to service is minimal because virtual machines are restarted within seconds with no user intervention required. High availability keeps your resources balanced by restarting guests on a host with low current resource utilization, or based on any workload balancing or power saving policies that you configure. This ensures that there is sufficient capacity to restart virtual machines at all times.
				

					High Availability and Storage I/O Errors
				

					If a storage I/O error occurs, the virtual machine is paused. You can define how the host handles highly available virtual machines after the connection with the storage domain is reestablished; they can either be resumed, ungracefully shut down, or remain paused. For more information about these options, see Virtual Machine High Availability settings explained.
				

High Availability Considerations




					A highly available host requires a power management device and fencing parameters. In addition, for a virtual machine to be highly available when its host becomes non-operational, it needs to be started on another available host in the cluster. To enable the migration of highly available virtual machines:
				
	
							Power management must be configured for the hosts running the highly available virtual machines.
						
	
							The host running the highly available virtual machine must be part of a cluster which has other available hosts.
						
	
							The destination host must be running.
						
	
							The source and destination host must have access to the data domain on which the virtual machine resides.
						
	
							The source and destination host must have access to the same virtual networks and VLANs.
						
	
							There must be enough CPUs on the destination host that are not in use to support the virtual machine’s requirements.
						
	
							There must be enough RAM on the destination host that is not in use to support the virtual machine’s requirements.
						



Configuring a Highly Available Virtual Machine




					High availability must be configured individually for each virtual machine.
				
Procedure
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							Click the High Availability tab.
						
	
							Select the Highly Available check box to enable high availability for the virtual machine.
						
	
							Select the storage domain to hold the virtual machine lease, or select No VM Lease to disable the functionality, from the Target Storage Domain for VM Lease drop-down list. See What is high availability for more information about virtual machine leases.
						
Important

								This functionality is only available on storage domains that are V4 or later.
							


	
							Select AUTO_RESUME, LEAVE_PAUSED, or KILL from the Resume Behavior drop-down list. If you defined a virtual machine lease, KILL is the only option available. For more information see Virtual Machine High Availability settings explained.
						
	
							Select Low, Medium, or High from the Priority drop-down list. When migration is triggered, a queue is created in which the high priority virtual machines are migrated first. If a cluster is running low on resources, only the high priority virtual machines are migrated.
						
	
							Click OK.
						




Other Virtual Machine Tasks



Enabling SAP Monitoring




					Enable SAP monitoring on a virtual machine through the Administration Portal.
				

					Enabling SAP Monitoring on Virtual Machines
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click Edit.
						
	
							Click the Custom Properties tab.
						
	
							Select sap_agent from the drop-down list. Ensure the secondary drop-down menu is set to True.
						

							If previous properties have been set, select the plus sign to add a new property rule and select sap_agent.
						

	
							Click OK.
						



Configuring Red Hat Enterprise Linux 5.4 and later Virtual Machines to use SPICE




					SPICE is a remote display protocol designed for virtual environments, which enables you to view a virtualized desktop or server. SPICE delivers a high quality user experience, keeps CPU consumption low, and supports high quality video streaming.
				

					Using SPICE on a Linux machine significantly improves the movement of the mouse cursor on the console of the virtual machine. To use SPICE, the X-Windows system requires additional QXL drivers. The QXL drivers are provided with Red Hat Enterprise Linux 5.4 and later. Earlier versions are not supported. Installing SPICE on a virtual machine running Red Hat Enterprise Linux significantly improves the performance of the graphical user interface.
				
Note

						Typically, this is most useful for virtual machines where the user requires the use of the graphical user interface. System administrators who are creating virtual servers may prefer not to configure SPICE if their use of the graphical user interface is minimal.
					

Installing and Configuring QXL Drivers




						You must manually install QXL drivers on virtual machines running Red Hat Enterprise Linux 5.4 or later. This is unnecessary for virtual machines running Red Hat Enterprise Linux 6 or Red Hat Enterprise Linux 7 as the QXL drivers are installed by default.
					

						Installing QXL Drivers
					
	
								Log in to a Red Hat Enterprise Linux virtual machine.
							
	
								Install the QXL drivers:
							
# yum install xorg-x11-drv-qxl




						You can configure QXL drivers using either a graphical interface or the command line. Perform only one of the following procedures.
					

						Configuring QXL drivers in GNOME
					
	
								Click System.
							
	
								Click Administration.
							
	
								Click Display.
							
	
								Click the Hardware tab.
							
	
								Click Video Cards Configure.
							
	
								Select qxl and click OK.
							
	
								Restart X-Windows by logging out of the virtual machine and logging back in.
							



						Configuring QXL drivers on the command line
					
	
								Back up /etc/X11/xorg.conf:
							
# cp /etc/X11/xorg.conf /etc/X11/xorg.conf.$$.backup

	
								Make the following change to the Device section of /etc/X11/xorg.conf:
							
Section 	"Device"
Identifier	"Videocard0"
Driver		"qxl"
Endsection




Configuring a Virtual Machine’s Tablet and Mouse to use SPICE




						Edit the /etc/X11/xorg.conf file to enable SPICE for your virtual machine’s tablet devices.
					

						Configuring a Virtual Machine’s Tablet and Mouse to use SPICE
					
	
								Verify that the tablet device is available on your guest:
							
# /sbin/lsusb -v | grep 'QEMU USB Tablet'
If there is no output from the command, do not continue configuring the tablet.

	
								Back up /etc/X11/xorg.conf:
							
# cp /etc/X11/xorg.conf /etc/X11/xorg.conf.$$.backup

	
								Make the following changes to /etc/X11/xorg.conf:
							
Section "ServerLayout"
Identifier     "single head configuration"
Screen      0  "Screen0" 0 0
InputDevice    "Keyboard0" "CoreKeyboard"
InputDevice    "Tablet" "SendCoreEvents"
InputDevice    "Mouse" "CorePointer"
EndSection

Section "InputDevice"
Identifier  "Mouse"
Driver      "void"
#Option      "Device" "/dev/input/mice"
#Option      "Emulate3Buttons" "yes"
EndSection

Section "InputDevice"
Identifier  "Tablet"
Driver      "evdev"
Option      "Device" "/dev/input/event2"
Option "CorePointer" "true"
EndSection

	
								Log out and log back into the virtual machine to restart X-Windows.
							




KVM Virtual Machine Timing Management




					Virtualization poses various challenges for virtual machine time keeping. Virtual machines which use the Time Stamp Counter (TSC) as a clock source may suffer timing issues as some CPUs do not have a constant Time Stamp Counter. Virtual machines running without accurate timekeeping can have serious affects on some networked applications as your virtual machine will run faster or slower than the actual time.
				

					KVM works around this issue by providing virtual machines with a paravirtualized clock. The KVM pvclock provides a stable source of timing for KVM guests that support it.
				

					Presently, only Red Hat Enterprise Linux 5.4 and later virtual machines fully support the paravirtualized clock.
				

					Virtual machines can have several problems caused by inaccurate clocks and counters:
				
	
							Clocks can fall out of synchronization with the actual time which invalidates sessions and affects networks.
						
	
							Virtual machines with slower clocks may have issues migrating.
						



					These problems exist on other virtualization platforms and timing should always be tested.
				
Important

						The Network Time Protocol (NTP) daemon should be running on the host and the virtual machines. Enable the ntpd service and add it to the default startup sequence:
					
	
								For Red Hat Enterprise Linux 6
							


# service ntpd start
# chkconfig ntpd on
	
								For Red Hat Enterprise Linux 7
							


# systemctl start ntpd.service
# systemctl enable ntpd.service

						Using the ntpd service should minimize the affects of clock skew in all cases.
					

						The NTP servers you are trying to use must be operational and accessible to your hosts and virtual machines.
					


					Determining if your CPU has the constant Time Stamp Counter
				

					Your CPU has a constant Time Stamp Counter if the constant_tsc flag is present. To determine if your CPU has the constant_tsc flag run the following command:
				
$ cat /proc/cpuinfo | grep constant_tsc

					If any output is given your CPU has the constant_tsc bit. If no output is given follow the instructions below.
				

					Configuring hosts without a constant Time Stamp Counter
				

					Systems without constant time stamp counters require additional configuration. Power management features interfere with accurate time keeping and must be disabled for virtual machines to accurately keep time with KVM.
				
Important

						These instructions are for AMD revision F CPUs only.
					


					If the CPU lacks the constant_tsc bit, disable all power management features (BZ#513138). Each system has several timers it uses to keep time. The TSC is not stable on the host, which is sometimes caused by cpufreq changes, deep C state, or migration to a host with a faster TSC. Deep C sleep states can stop the TSC. To prevent the kernel using deep C states append “processor.max_cstate=1” to the kernel boot options in the grub.conf file on the host:
				
term Red Hat Enterprise Linux Server (2.6.18-159.el5)
        root (hd0,0)
	kernel /vmlinuz-2.6.18-159.el5 ro root=/dev/VolGroup00/LogVol00 rhgb quiet processor.max_cstate=1

					Disable cpufreq (only necessary on hosts without the constant_tsc) by editing the /etc/sysconfig/cpuspeed configuration file and change the MIN_SPEED and MAX_SPEED variables to the highest frequency available. Valid limits can be found in the /sys/devices/system/cpu/cpu/cpufreq/scaling_available_frequencies files.
				

					Using the engine-config tool to receive alerts when hosts drift out of sync.
				

					You can use the engine-config tool to configure alerts when your hosts drift out of sync.
				

					There are 2 relevant parameters for time drift on hosts: EnableHostTimeDrift and HostTimeDriftInSec. EnableHostTimeDrift, with a default value of false, can be enabled to receive alert notifications of host time drift. The HostTimeDriftInSec parameter is used to set the maximum allowable drift before alerts start being sent.
				

					Alerts are sent once per hour per host.
				

					Using the paravirtualized clock with Red Hat Enterprise Linux virtual machines
				

					For certain Red Hat Enterprise Linux virtual machines, additional kernel parameters are required. These parameters can be set by appending them to the end of the /kernel line in the /boot/grub/grub.conf file of the virtual machine.
				
Note

						The process of configuring kernel parameters can be automated using the ktune package
					


					The ktune package provides an interactive Bourne shell script, fix_clock_drift.sh. When run as the superuser, this script inspects various system parameters to determine if the virtual machine on which it is run is susceptible to clock drift under load. If so, it then creates a new grub.conf.kvm file in the /boot/grub/ directory. This file contains a kernel boot line with additional kernel parameters that allow the kernel to account for and prevent significant clock drift on the KVM virtual machine. After running fix_clock_drift.sh as the superuser, and once the script has created the grub.conf.kvm file, then the virtual machine’s current grub.conf file should be backed up manually by the system administrator, the new grub.conf.kvm file should be manually inspected to ensure that it is identical to grub.conf with the exception of the additional boot line parameters, the grub.conf.kvm file should finally be renamed grub.conf, and the virtual machine should be rebooted.
				

					The table below lists versions of Red Hat Enterprise Linux and the parameters required for virtual machines on systems without a constant Time Stamp Counter.
				
	Red Hat Enterprise Linux	Additional virtual machine kernel parameters
	 
									5.4 AMD64/Intel 64 with the paravirtualized clock
								

								 	 
									Additional parameters are not required
								

								 
	 
									5.4 AMD64/Intel 64 without the paravirtualized clock
								

								 	 
									notsc lpj=n
								

								 
	 
									5.4 x86 with the paravirtualized clock
								

								 	 
									Additional parameters are not required
								

								 
	 
									5.4 x86 without the paravirtualized clock
								

								 	 
									clocksource=acpi_pm lpj=n
								

								 
	 
									5.3 AMD64/Intel 64
								

								 	 
									notsc
								

								 
	 
									5.3 x86
								

								 	 
									clocksource=acpi_pm
								

								 
	 
									4.8 AMD64/Intel 64
								

								 	 
									notsc
								

								 
	 
									4.8 x86
								

								 	 
									clock=pmtmr
								

								 
	 
									3.9 AMD64/Intel 64
								

								 	 
									Additional parameters are not required
								

								 
	 
									3.9 x86
								

								 	 
									Additional parameters are not required
								

								 



Adding a Trusted Platform Module device




					Trusted Platform Module (TPM) devices provide a secure crypto-processor designed to carry out cryptographic operations such as generating cryptographic keys, random numbers, and hashes, or for storing data that can be used to verify software configurations securely. TPM devices are commonly used for disk encryption.
				

					QEMU and libvirt implement support for emulated TPM 2.0 devices, which is what Red Hat Virtualization uses to add TPM devices to Virtual Machines.
				

					Once an emulated TPM device is added to the virtual machine, it can be used as a normal TPM 2.0 device in the guest OS.
				
Important

						If there is TPM data stored for the virtual machine and the TPM device is disabled in the virtual machine, the TPM data is permanently removed.
					


					Enabling a TPM device
				
	
							In the Add Virtual Machine or Edit Virtual Machine screen, click Show Advanced Options.
						
	
							In the Resource Allocation tab, select the TPM Device Enabled check box.
						



					Limitations
				

					The following limitations apply:
				
	
							TPM devices can only be used on x86_64 machines with UEFI firmware and PowerPC machines with pSeries firmware installed.
						
	
							Virtual machines with TPM devices can not have snapshots with memory.
						
	
							While the Manager retrieves and stores TPM data periodically, there is no guarantee that the Manager will always have the latest version of the TPM data.
						
Note

								This process can take 120 seconds or more, and you must wait for the process to complete before you can take snapshot of a running virtual machine, clone a running virtual machine, or migrate a running virtual machine.
							


	
							TPM devices can only be enabled for virtual machines running RHEL 7 or later and Windows 8.1 or later.
						
	
							Virtual machines and templates with TPM data can not be exported or imported.
						





Chapter 7. Templates



About Templates




				A template is a copy of a virtual machine that you can use to simplify the subsequent, repeated creation of similar virtual machines. Templates capture the configuration of software, configuration of hardware, and the software installed on the virtual machine on which the template is based. The virtual machine on which a template is based is known as the source virtual machine.
			

				When you create a template based on a virtual machine, a read-only copy of the virtual machine’s disk is created. This read-only disk becomes the base disk image of the new template, and of any virtual machines created based on the template. As such, the template cannot be deleted while any virtual machines created based on the template exist in the environment.
			

				Virtual machines created based on a template use the same NIC type and driver as the original virtual machine, but are assigned separate, unique MAC addresses.
			

				You can create a virtual machine directly from Compute → Templates, as well as from Compute → Virtual Machines. In Compute → Templates, select the required template and click New VM. For more information on selecting the settings and controls for the new virtual machine see Virtual Machine General settings explained.
			

Sealing Virtual Machines in Preparation for Deployment as Templates




				This section describes procedures for sealing Linux and Windows virtual machines. Sealing is the process of removing all system-specific details from a virtual machine before creating a template based on that virtual machine. Sealing is necessary to prevent the same details from appearing on multiple virtual machines created based on the same template. It is also necessary to ensure the functionality of other features, such as predictable vNIC order.
			
Sealing a Linux Virtual Machine for Deployment as a Template




					To seal a Linux virtual machine during the template creation process, select the Seal Template check box in the New Template window. See Creating a template from an existing virtual machine for details.
				
Note

						In RHV 4.4, to seal a RHEL 8 virtual machine for a template, its cluster level must be 4.4 and all hosts in the cluster must be based on RHEL 8. You cannot seal a RHEL 8 virtual machine if you have set its cluster level to 4.3 so it can run on RHEL 7 hosts.
					


Sealing a Windows Virtual Machine for Deployment as a Template




					A template created for Windows virtual machines must be generalized (sealed) before being used to deploy virtual machines. This ensures that machine-specific settings are not reproduced in the template.
				

					Sysprep is used to seal Windows templates before use. Sysprep generates a complete unattended installation answer file. Default values for several Windows operating systems are available in the /usr/share/ovirt-engine/conf/sysprep/ directory. These files act as templates for Sysprep. The fields in these files can be copied, pasted, and altered as required. This definition will override any values entered into the Initial Run fields of the Edit Virtual Machine window.
				

					The Sysprep file can be edited to affect various aspects of the Windows virtual machines created from the template that the Sysprep file is attached to. These include the provisioning of Windows, setting up the required domain membership, configuring the hostname, and setting the security policy.
				

					Replacement strings can be used to substitute values provided in the default files in the /usr/share/ovirt-engine/conf/sysprep/ directory. For example, "<Domain><![CDATA[$JoinDomain$"]></Domain>" can be used to indicate the domain to join.
				
Prerequisites for Sealing a Windows Virtual Machine



Important

							Do not reboot the virtual machine while Sysprep is running.
						


						Before starting Sysprep, verify that the following settings are configured:
					
	
								The Windows virtual machine parameters have been correctly defined.
							
	
								If not, click Edit in Compute → Virtual Machines and enter the required information in the Operating System and Cluster fields.
							
	
								The correct product key has been defined in an override file on the Manager.
							



						The override file must be created under /etc/ovirt-engine/osinfo.conf.d/, have a filename that puts it after /etc/ovirt-engine/osinfo.conf.d/00-defaults.properties, and ends in .properties. For example, /etc/ovirt-engine/osinfo.conf.d/10-productkeys.properties. The last file will have precedence and override any other previous file.
					

						If not, copy the default values for your Windows operating system from /etc/ovirt-engine/osinfo.conf.d/00-defaults.properties into the override file, and input your values in the productKey.value and sysprepPath.value fields.
					
Example 7.1. Windows 7 Default Configuration Values
# Windows7(11, OsType.Windows, false),false
os.windows_7.id.value = 11
os.windows_7.name.value = Windows 7
os.windows_7.derivedFrom.value = windows_xp
os.windows_7.sysprepPath.value = ${ENGINE_USR}/conf/sysprep/sysprep.w7
os.windows_7.productKey.value =
os.windows_7.devices.audio.value = ich6
os.windows_7.devices.diskInterfaces.value.3.3 = IDE, VirtIO_SCSI, VirtIO
os.windows_7.devices.diskInterfaces.value.3.4 = IDE, VirtIO_SCSI, VirtIO
os.windows_7.devices.diskInterfaces.value.3.5 = IDE, VirtIO_SCSI, VirtIO
os.windows_7.isTimezoneTypeInteger.value = false



Sealing a Windows 7, Windows 2008, or Windows 2012 Virtual Machine for Deployment as Template




						Seal a Windows 7, Windows 2008, or Windows 2012 virtual machine before creating a template to use to deploy virtual machines.
					
Procedure
	
								On the Windows virtual machine, launch Sysprep from C:\Windows\System32\sysprep\sysprep.exe.
							
	
								Enter the following information into Sysprep:
							
	
										Under System Cleanup Action, select Enter System Out-of-Box-Experience (OOBE).
									
	
										Select the Generalize check box if you need to change the computer’s system identification number (SID).
									
	
										Under Shutdown Options, select Shutdown.
									



	
								Click OK to complete the sealing process; the virtual machine shuts down automatically upon completion.
							



						The Windows 7, Windows 2008, or Windows 2012 virtual machine is sealed and ready to create a template to use for deploying virtual machines.
					



Creating a Template




				Create a template from an existing virtual machine to use as a blueprint for creating additional virtual machines.
			
Note

					In RHV 4.4, to seal a RHEL 8 virtual machine for a template, its cluster level must be 4.4 and all hosts in the cluster must be based on RHEL 8. You cannot seal a RHEL 8 virtual machine if you have set its cluster level to 4.3 so it can run on RHEL 7 hosts.
				


				When you create a template, you specify the format of the disk to be raw or QCOW2:
			
	
						QCOW2 disks are thin provisioned.
					
	
						Raw disks on file storage are thin provisioned.
					
	
						Raw disks on block storage are preallocated.
					



				Creating a Template
			
	
						Click Compute → Virtual Machines and select the source virtual machine.
					
	
						Ensure the virtual machine is powered down and has a status of Down.
					
	
						Click More Actions ( 
						[image: moreactions]
						 ), then click Make Template. For more details on all fields in the New Template window, see Explanation of Settings in the New Template and Edit Template Windows.
					
	
						Enter a Name, Description, and Comment for the template.
					
	
						Select the cluster with which to associate the template from the Cluster drop-down list. By default, this is the same as that of the source virtual machine.
					
	
						Optionally, select a CPU profile for the template from the CPU Profile drop-down list.
					
	
						Optionally, select the Create as a Template Sub-Version check box, select a Root Template, and enter a Sub-Version Name to create the new template as a sub-template of an existing template.
					
	
						In the Disks Allocation section, enter an alias for the disk in the Alias text field. Select the disk format in the Format drop-down, the storage domain on which to store the disk from the Target drop-down, and the disk profile in the Disk Profile drop-down. By default, these are the same as those of the source virtual machine.
					
	
						Select the Allow all users to access this Template check box to make the template public.
					
	
						Select the Copy VM permissions check box to copy the permissions of the source virtual machine to the template.
					
	
						Select the Seal Template check box (Linux only) to seal the template.
					
Note

							Sealing, which uses the virt-sysprep command, removes system-specific details from a virtual machine before creating a template based on that virtual machine. This prevents the original virtual machine’s details from appearing in subsequent virtual machines that are created using the same template. It also ensures the functionality of other features, such as predictable vNIC order. See virt-sysprep operations for more information.
						


	
						Click OK.
					



				The virtual machine displays a status of Image Locked while the template is being created. The process of creating a template may take up to an hour depending on the size of the virtual disk and the capabilities of your storage hardware. When complete, the template is added to the Templates tab. You can now create new virtual machines based on the template.
			
Note

					When a template is made, the virtual machine is copied so that both the existing virtual machine and its template are usable after template creation.
				


Editing a Template




				Once a template has been created, its properties can be edited. Because a template is a copy of a virtual machine, the options available when editing a template are identical to those in the Edit Virtual Machine window.
			
Procedure
	
						Click Compute → Templates and select a template.
					
	
						Click Edit.
					
	
						Change the necessary properties. Click Show Advanced Options and edit the template’s settings as required. The settings that appear in the Edit Template window are identical to those in the Edit Virtual Machine window, but with the relevant fields only. See Explanation of Settings in the New Virtual Machine and Edit Virtual Machine Windows for details.
					
	
						Click OK.
					



Deleting a Template




				If you have used a template to create a virtual machine using the thin provisioning storage allocation option, the template cannot be deleted as the virtual machine needs it to continue running. However, cloned virtual machines do not depend on the template they were cloned from and the template can be deleted.
			

				Deleting a Template
			
	
						Click Compute → Templates and select a template.
					
	
						Click Remove.
					
	
						Click OK.
					



Exporting Templates



Migrating Templates to the Export Domain



Note

						The export storage domain is deprecated. Storage data domains can be unattached from a data center and imported to another data center in the same environment, or in a different environment. Virtual machines, floating virtual disks, and templates can then be uploaded from the imported storage domain to the attached data center. See the Importing Existing Storage Domains section in the Red Hat Virtualization Administration Guide for information on importing storage domains.
					


					Export templates into the export domain to move them to another data domain, either in the same Red Hat Virtualization environment, or another one. This procedure requires access to the Administration Portal.
				

					Exporting Individual Templates to the Export Domain
				
	
							Click Compute → Templates and select a template.
						
	
							Click Export.
						
	
							Select the Force Override check box to replace any earlier version of the template on the export domain.
						
	
							Click OK to begin exporting the template; this may take up to an hour, depending on the virtual disk size and your storage hardware.
						



					Repeat these steps until the export domain contains all the templates to migrate before you start the import process.
				
	
							Click Storage → Domains and select the export domain.
						
	
							Click the domain name to see the details view.
						
	
							Click the Template Import tab to view all exported templates in the export domain.
						



Copying a Template’s Virtual Hard Disk




					If you are moving a virtual machine that was created from a template with the thin provisioning storage allocation option selected, the template’s disks must be copied to the same storage domain as that of the virtual disk. This procedure requires access to the Administration Portal.
				

					Copying a Virtual Hard Disk
				
	
							Click Storage → Disks.
						
	
							Select the template disk(s) to copy.
						
	
							Click Copy.
						
	
							Select the Target data domain from the drop-down list(s).
						
	
							Click OK.
						



					A copy of the template’s virtual hard disk has been created, either on the same, or a different, storage domain. If you were copying a template disk in preparation for moving a virtual hard disk, you can now move the virtual hard disk.
				


Importing Templates



Importing a Template into a Data Center



Note

						The export storage domain is deprecated. Storage data domains can be unattached from a data center and imported to another data center in the same environment, or in a different environment. Virtual machines, floating virtual disks, and templates can then be uploaded from the imported storage domain to the attached data center. See the Importing Existing Storage Domains section in the Red Hat Virtualization Administration Guide for information on importing storage domains.
					


					Import templates from a newly attached export domain. This procedure requires access to the Administration Portal.
				

					Importing a Template into a Data Center
				
	
							Click Storage → Domains and select the newly attached export domain.
						
	
							Click the domain name to go to the details view.
						
	
							Click the Template Import tab and select a template.
						
	
							Click Import.
						
	
							Use the drop-down lists to select the Target Cluster and CPU Profile.
						
	
							Select the template to view its details, then click the Disks tab and select the Storage Domain to import the template into.
						
	
							Click OK.
						
	
							If the Import Template Conflict window appears, enter a New Name for the template, or select the Apply to all check box and enter a Suffix to add to the cloned Templates. Click OK.
						
	
							Click Close.
						



					The template is imported into the destination data center. This can take up to an hour, depending on your storage hardware. You can view the import progress in the Events tab.
				

					Once the importing process is complete, the templates will be visible in Compute → Templates. The templates can create new virtual machines, or run existing imported virtual machines based on that template.
				

Importing a Virtual Disk from an OpenStack Image Service as a Template




					Virtual disks managed by an OpenStack Image Service can be imported into the Red Hat Virtualization Manager if that OpenStack Image Service has been added to the Manager as an external provider. This procedure requires access to the Administration Portal.
				
	
							Click Storage → Domains and select the OpenStack Image Service domain.
						
	
							Click the storage domain name to go to the details view.
						
	
							Click the Images tab and select the image to import.
						
	
							Click Import.
						
Note

								If you are importing an image from a Glance storage domain, you have the option of specifying the template name. OpenStack Glance is now deprecated. This functionality will be removed in a later release.
							


	
							Select the Data Center into which the virtual disk will be imported.
						
	
							Select the storage domain in which the virtual disk will be stored from the Domain Name drop-down list.
						
	
							Optionally, select a Quota to apply to the virtual disk.
						
	
							Select the Import as Template check box.
						
	
							Select the Cluster in which the virtual disk will be made available as a template.
						
	
							Click OK.
						



					The image is imported as a template and is displayed in the Templates tab. You can now create virtual machines based on the template.
				


Templates and Permissions



Managing System Permissions for a Template




					As the SuperUser, the system administrator manages all aspects of the Administration Portal. More specific administrative roles can be assigned to other users. These restricted administrator roles are useful for granting a user administrative privileges that limit them to a specific resource. For example, a DataCenterAdmin role has administrator privileges only for the assigned data center with the exception of the storage for that data center, and a ClusterAdmin has administrator privileges only for the assigned cluster.
				

					A template administrator is a system administration role for templates in a data center. This role can be applied to specific virtual machines, to a data center, or to the whole virtualized environment; this is useful to allow different users to manage certain virtual resources.
				

					The template administrator role permits the following actions:
				
	
							Create, edit, export, and remove associated templates.
						
	
							Import and export templates.
						


Note

						You can only assign roles and permissions to existing users.
					


Template Administrator Roles Explained




					The table below describes the administrator roles and privileges applicable to template administration.
				
Table 7.1. Red Hat Virtualization System Administrator Roles
	Role	Privileges	Notes
	 
									TemplateAdmin
								

								 	 
									Can perform all operations on templates.
								

								 	 
									Has privileges to create, delete and configure a template’s storage domain and network details, and to move templates between domains.
								

								 
	 
									NetworkAdmin
								

								 	 
									Network Administrator
								

								 	 
									Can configure and manage networks attached to templates.
								

								 




Assigning an Administrator or User Role to a Resource




					Assign administrator or user roles to resources to allow users to access or manage that resource.
				
Procedure
	
							Use the resource tabs, tree mode, or the search function to find and select the resource in the results list.
						
	
							Click the resource’s name to go to the details view.
						
	
							Click the Permissions tab to list the assigned users, the user’s role, and the inherited permissions for the selected resource.
						
	
							Click Add.
						
	
							Enter the name or user name of an existing user into the Search text box and click Go. Select a user from the resulting list of possible matches.
						
	
							Select a role from the Role to Assign: drop-down list.
						
	
							Click OK.
						



					You have assigned a role to a user; the user now has the inherited permissions of that role enabled for that resource.
				

Removing an Administrator or User Role from a Resource




					Remove an administrator or user role from a resource; the user loses the inherited permissions associated with the role for that resource.
				

					Removing a Role from a Resource
				
	
							Use the resource tabs, tree mode, or the search function to find and select the resource in the results list.
						
	
							Click the resource’s name to go to the details view.
						
	
							Click the Permissions tab to list the assigned users, the user’s role, and the inherited permissions for the selected resource.
						
	
							Select the user to remove from the resource.
						
	
							Click Remove. The Remove Permission window opens to confirm permissions removal.
						
	
							Click OK.
						



					You have removed the user’s role, and the associated permissions, from the resource.
				


Using Cloud-Init to Automate the Configuration of Virtual Machines




				Cloud-Init is a tool for automating the initial setup of virtual machines such as configuring the host name, network interfaces, and authorized keys. It can be used when provisioning virtual machines that have been deployed based on a template to avoid conflicts on the network.
			

				To use this tool, the cloud-init package must first be installed on the virtual machine. Once installed, the Cloud-Init service starts during the boot process to search for instructions on what to configure. You can then use options in the Run Once window to provide these instructions one time only, or options in the New Virtual Machine, Edit Virtual Machine and Edit Template windows to provide these instructions every time the virtual machine starts.
			
Note

					Alternatively, you can configure Cloud-Init with Ansible, Python, Java, or Ruby.
				

Cloud-Init Use Case Scenarios




					Cloud-Init can be used to automate the configuration of virtual machines in a variety of scenarios. Several common scenarios are as follows:
				
	
							Virtual Machines Created Based on Templates
						

							You can use the Cloud-Init options in the Initial Run section of the Run Once window to initialize a virtual machine that was created based on a template. This allows you to customize the virtual machine the first time that virtual machine is started.
						

	
							Virtual Machine Templates
						

							You can use the Use Cloud-Init/Sysprep options in the Initial Run tab of the Edit Template window to specify options for customizing virtual machines created based on that template.
						

	
							Virtual Machine Pools
						

							You can use the Use Cloud-Init/Sysprep options in the Initial Run tab of the New Pool window to specify options for customizing virtual machines taken from that virtual machine pool. This allows you to specify a set of standard settings that will be applied every time a virtual machine is taken from that virtual machine pool. You can inherit or override the options specified for the template on which the virtual machine is based, or specify options for the virtual machine pool itself.
						




Installing Cloud-Init




					This procedure describes how to install Cloud-Init on a virtual machine. Once Cloud-Init is installed, you can create a template based on this virtual machine. Virtual machines created based on this template can leverage Cloud-Init functions, such as configuring the host name, time zone, root password, authorized keys, network interfaces, DNS service, etc on boot.
				

					Installing Cloud-Init
				
	
							Log in to the virtual machine.
						
	
							Enable the repositories:
						
	
									For Red Hat Enterprise Linux 6:
								
# subscription-manager repos \
    --enable=rhel-6-server-rpms \
    --enable=rhel-6-server-rh-common-rpms

	
									For Red Hat Enterprise Linux 7:
								
# subscription-manager repos \
    --enable=rhel-7-server-rpms \
    --enable=rhel-7-server-rh-common-rpms

	
									For Red Hat Enterprise Linux 8, you normally do not need to enable repositories to install Cloud-Init. The Cloud-Init package is part of the AppStream repo, rhel-8-for-x86_64-appstream-rpms, which is enabled by default in Red Hat Enterprise Linux 8.
								



	
							Install the cloud-init package and dependencies:
						
# dnf install cloud-init
Note

								For versions of Red Hat Enterprise Linux earlier than version 8, use the command yum install cloud-init instead of dnf install cloud-init.
							





Using Cloud-Init to Prepare a Template




					As long as the cloud-init package is installed on a Linux virtual machine, you can use the virtual machine to make a cloud-init enabled template. Specify a set of standard settings to be included in a template as described in the following procedure or, alternatively, skip the Cloud-Init settings steps and configure them when creating a virtual machine based on this template.
				
Note

						While the following procedure outlines how to use Cloud-Init when preparing a template, the same settings are also available in the New Virtual Machine, Edit Template, and Run Once windows.
					


					Using Cloud-Init to Prepare a Template
				
	
							Click Compute → Templates and select a template.
						
	
							Click Edit.
						
	
							Click Show Advanced Options
						
	
							Click the Initial Run tab and select the Use Cloud-Init/Sysprep check box.
						
	
							Enter a host name in the VM Hostname text field.
						
	
							Select the Configure Time Zone check box and select a time zone from the Time Zone drop-down list.
						
	
							Expand the Authentication section.
						
	
									Select the Use already configured password check box to use the existing credentials, or clear that check box and enter a root password in the Password and Verify Password text fields to specify a new root password.
								
	
									Enter any SSH keys to be added to the authorized hosts file on the virtual machine in the SSH Authorized Keys text area.
								
	
									Select the Regenerate SSH Keys check box to regenerate SSH keys for the virtual machine.
								



	
							Expand the Networks section.
						
	
									Enter any DNS servers in the DNS Servers text field.
								
	
									Enter any DNS search domains in the DNS Search Domains text field.
								
	
									Select the In-guest Network Interface check box and use the + Add new and - Renove selected buttons to add or remove network interfaces to or from the virtual machine.
								
Important

										You must specify the correct network interface name and number (for example, eth0, eno3, enp0s). Otherwise, the virtual machine’s interface connection will be up, but it will not have the cloud-init network configuration.
									





	
							Expand the Custom Script section and enter any custom scripts in the Custom Script text area.
						
	
							Click OK.
						



					You can now provision new virtual machines using this template.
				

Using Cloud-Init to Initialize a Virtual Machine




					Use Cloud-Init to automate the initial configuration of a Linux virtual machine. You can use the Cloud-Init fields to configure a virtual machine’s host name, time zone, root password, authorized keys, network interfaces, and DNS service. You can also specify a custom script, a script in YAML format, to run on boot. The custom script allows for additional Cloud-Init configuration that is supported by Cloud-Init but not available in the Cloud-Init fields. For more information on custom script examples, see Cloud config examples.
				

					Using Cloud-Init to Initialize a Virtual Machine
				

					This procedure starts a virtual machine with a set of Cloud-Init settings. If the relevant settings are included in the template the virtual machine is based on, review the settings, make changes where appropriate, and click OK to start the virtual machine.
				
	
							Click Compute → Virtual Machines and select a virtual machine.
						
	
							Click the Run drop-down button and select Run Once.
						
	
							Expand the Initial Run section and select the Cloud-Init check box.
						
	
							Enter a host name in the VM Hostname text field.
						
	
							Select the Configure Time Zone check box and select a time zone from the Time Zone drop-down menu.
						
	
							Select the Use already configured password check box to use the existing credentials, or clear that check box and enter a root password in the Password and Verify Password text fields to specify a new root password.
						
	
							Enter any SSH keys to be added to the authorized hosts file on the virtual machine in the SSH Authorized Keys text area.
						
	
							Select the Regenerate SSH Keys check box to regenerate SSH keys for the virtual machine.
						
	
							Enter any DNS servers in the DNS Servers text field.
						
	
							Enter any DNS search domains in the DNS Search Domains text field.
						
	
							Select the Network check box and use the + and - buttons to add or remove network interfaces to or from the virtual machine.
						
Important

								You must specify the correct network interface name and number (for example, eth0, eno3, enp0s). Otherwise, the virtual machine’s interface connection will be up, but the cloud-init network configuration will not be defined in it.
							


	
							Enter a custom script in the Custom Script text area. Make sure the values specified in the script are appropriate. Otherwise, the action will fail.
						
	
							Click OK.
						


Note

						To check if a virtual machine has Cloud-Init installed, select a virtual machine and click the Applications sub-tab. Only shown if the guest agent is installed.
					



Using Sysprep to Automate the Configuration of Virtual Machines




				Sysprep is a tool used to automate the setup of Windows virtual machines, for example, configuring host names, network interfaces, authorized keys, set up users, or to connect to Active Directory. Sysprep is installed with every version of Windows.
			

				Red Hat Virtualization enhances Sysprep by exploiting virtualization technology to deploy virtual workstations based on a single template. Red Hat Virtualization builds a tailored auto-answer file for each virtual workstation.
			

				Sysprep generates a complete unattended installation answer file. Default values for several Windows operating systems are available in the /usr/share/ovirt-engine/conf/sysprep/ directory. You can also create a custom Sysprep file and reference it from the the osinfo file in the /etc/ovirt-engine/osinfo.conf.d/ directory. These files act as templates for Sysprep. The fields in these files can be copied and edited as required. This definition will override any values entered into the Initial Run fields of the Edit Virtual Machine window.
			

				You can create a custom sysprep file when creating a pool of Windows virtual machines, to accommodate various operating systems and domains. See Creating a Virtual Machine Pool in the Administration Guide for details.
			

				The override file must be created under /etc/ovirt-engine/osinfo.conf.d/, have a filename that puts it after /etc/ovirt-engine/osinfo.conf.d/00-defaults.properties, and ends in .properties. For example, /etc/ovirt-engine/osinfo.conf.d/10-productkeys.properties. The last file will have precedence and override any other previous file.
			

				Copy the default values for your Windows operating system from /etc/ovirt-engine/osinfo.conf.d/00-defaults.properties into the override file, and input your values in the productKey.value and sysprepPath.value fields.
			
Example 7.2. Windows 7 Default Configuration Values
# Windows7(11, OsType.Windows, false),false
os.windows_7.id.value = 11
os.windows_7.name.value = Windows 7
os.windows_7.derivedFrom.value = windows_xp
os.windows_7.sysprepPath.value = ${ENGINE_USR}/conf/sysprep/sysprep.w7
os.windows_7.productKey.value =
os.windows_7.devices.audio.value = ich6
os.windows_7.devices.diskInterfaces.value.3.3 = IDE, VirtIO_SCSI, VirtIO
os.windows_7.devices.diskInterfaces.value.3.4 = IDE, VirtIO_SCSI, VirtIO
os.windows_7.devices.diskInterfaces.value.3.5 = IDE, VirtIO_SCSI, VirtIO
os.windows_7.isTimezoneTypeInteger.value = false


Configuring Sysprep on a Template




					You can use this procedure to specify a set of standard Sysprep settings to include in the template, alternatively you can configure the Sysprep settings when creating a virtual machine based on this template.
				

					Replacement strings can be used to substitute values provided in the default files in the /usr/share/ovirt-engine/conf/sysprep/ directory. For example, "<Domain><![CDATA[$JoinDomain$"]></Domain>" can be used to indicate the domain to join.
				
Important

						Do not reboot the virtual machine while Sysprep is running.
					

Prerequisites
	
							The Windows virtual machine parameters have been correctly defined.
						

							If not, click Compute → Virtual Machines, click Edit, and enter the required information in the Operating System and Cluster fields.
						

	
							The correct product key has been defined in an override file on the Manager.
						



					Using Sysprep to Prepare a Template
				
	
							Build the Windows virtual machine with the required patches and software.
						
	
							Seal the Windows virtual machine. See Sealing Virtual Machines in Preparation for Deployment as Templates
						
	
							Create a template based on the Windows virtual machine. See Creating a template from an existing virtual machine
						
	
							Update the Sysprep file with a text editor if additional changes are required.
						



					You can now provision new virtual machines using this template.
				

Using Sysprep to Initialize a Virtual Machine




					Use Sysprep to automate the initial configuration of a Windows virtual machine. You can use the Sysprep fields to configure a virtual machine’s host name, time zone, root password, authorized keys, network interfaces, and DNS service.
				
Using Sysprep to Initialize a Virtual Machine

						This procedure starts a virtual machine with a set of Sysprep settings. If the relevant settings are included in the template the virtual machine is based on, review the settings and make changes where required.
					
	
							Create a new Windows virtual machine based on a template of the required Windows virtual machine. See Creating a Virtual Machine Based on a Template.
						
	
							Click Compute → Virtual Machines and select the virtual machine.
						
	
							Click the Run drop-down button and select Run Once.
						
	
							Expand the Boot Options section, select the Attach Floppy check box, and select the [sysprep] option.
						
	
							Select the Attach CD check box and select the required Windows ISO from the drop-down list.
						
	
							Move the CD-ROM to the top of the Boot Sequence field.
						
	
							Configure any further Run Once options as required. See Virtual Machine Run Once settings explained for more details.
						
	
							Click OK.
						




Creating a Virtual Machine Based on a Template




				Create a virtual machine from a template to enable the virtual machines to be pre-configured with an operating system, network interfaces, applications and other resources.
			
Note

					Virtual machines created from a template depend on that template. So you cannot remove a template from the Manager if a virtual machine was created from that template. However, you can clone a virtual machine from a template to remove the dependency on that template.
				

Note

					If the BIOS type of the virtual machine differs from the BIOS type of the template, the Manager might change devices in the virtual machine, possibly preventing the operating system from booting. For example, if the template uses IDE disks and the i440fx chipset, changing the BIOS type to the Q35 chipset automatically changes the IDE disks to SATA disks. So configure the chipset and BIOS type to match the chipset and BIOS type of the template.
				


				Creating a Virtual Machine Based on a Template
			
	
						Click Compute → Virtual Machines.
					
	
						Click New.
					
	
						Select the Cluster on which the virtual machine will run.
					
	
						Select a template from the Template list.
					
	
						Enter a Name, Description, and any Comments, and accept the default values inherited from the template in the rest of the fields. You can change them if needed.
					
	
						Click the Resource Allocation tab.
					
	
						Select the Thin or Clone radio button in the Storage Allocation area. If you select Thin, the disk format is QCOW2. If you select Clone, select either QCOW2 or Raw for disk format.
					
	
						Use the Target drop-down list to select the storage domain on which the virtual machine’s virtual disk will be stored.
					
	
						Click OK.
					



				The virtual machine is displayed in the Virtual Machines tab.
			
Additional Resources
	
						Creating a cloned virtual machine based on a template
					
	
						UEFI and the Q35 chipset in the Administration Guide.
					



Creating a Cloned Virtual Machine Based on a Template




				Cloned virtual machines are based on templates and inherit the settings of the template. A cloned virtual machine does not depend on the template on which it was based after it has been created. This means the template can be deleted if no other dependencies exist.
			
Note

					If you clone a virtual machine from a template, the name of the template on which that virtual machine was based is displayed in the General tab of the Edit Virtual Machine window for that virtual machine. If you change the name of that template, the name of the template in the General tab will also be updated. However, if you delete the template from the Manager, the original name of that template will be displayed instead.
				


				Cloning a Virtual Machine Based on a Template
			
	
						Click Compute → Virtual Machines.
					
	
						Click New.
					
	
						Select the Cluster on which the virtual machine will run.
					
	
						Select a template from the Based on Template drop-down menu.
					
	
						Enter a Name, Description and any Comments. You can accept the default values inherited from the template in the rest of the fields, or change them if required.
					
	
						Click the Resource Allocation tab.
					
	
						Select the Clone radio button in the Storage Allocation area.
					
	
						Select the disk format from the Format drop-down list. This affects the speed of the clone operation and the amount of disk space the new virtual machine initially requires.
					
	
								QCOW2 (Default)
							
	
										Faster clone operation
									
	
										Optimized use of storage capacity
									
	
										Disk space allocated only as required
									



	
								Raw
							
	
										Slower clone operation
									
	
										Optimized virtual machine read and write operations
									
	
										All disk space requested in the template is allocated at the time of the clone operation
									






	
						Use the Target drop-down menu to select the storage domain on which the virtual machine’s virtual disk will be stored.
					
	
						Click OK.
					


Note

					Cloning a virtual machine may take some time. A new copy of the template’s disk must be created. During this time, the virtual machine’s status is first Image Locked, then Down.
				


				The virtual machine is created and displayed in the Virtual Machines tab. You can now assign users to it, and can begin using it when the clone operation is complete.
			


Appendix A. Reference: Settings in Administration Portal and VM Portal Windows



Explanation of Settings in the New Virtual Machine and Edit Virtual Machine Windows



Virtual Machine General Settings Explained




					The following table details the options available on the General tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.1. Virtual Machine: General Settings
	Field Name	Description	Power cycle required?
	 
									Cluster
								

								 	 
									The name of the host cluster to which the virtual machine is attached. Virtual machines are hosted on any physical machine in that cluster in accordance with policy rules.
								

								 	 
									Yes. Cross-cluster migration is for emergency use only. Moving clusters requires the virtual machine to be down.
								

								 
	 
									Template
								

								 	 
									The template on which the virtual machine is based. This field is set to Blank by default, which allows you to create a virtual machine on which an operating system has not yet been installed. Templates are displayed as Name | Sub-version name (Sub-version number). Each new version is displayed with a number in brackets that indicates the relative order of the version, with a higher number indicating a more recent version.
								

								 
									The version name is displayed as base version if it is the root template of the template version chain.
								

								 
									When the virtual machine is stateless, there is an option to select the latest version of the template. This option means that anytime a new version of this template is created, the virtual machine is automatically recreated on restart based on the latest template.
								

								 	 
									Not applicable. This setting is for provisioning new virtual machines only.
								

								 
	 
									Operating System
								

								 	 
									The operating system. Valid values include a range of Red Hat Enterprise Linux and Windows variants.
								

								 	 
									Yes. Potentially changes the virtual hardware.
								

								 
	 
									Instance Type
								

								 	 
									The instance type on which the virtual machine’s hardware configuration can be based. This field is set to Custom by default, which means the virtual machine is not connected to an instance type. The other options available from this drop down menu are Large, Medium, Small, Tiny, XLarge, and any custom instance types that the Administrator has created.
								

								 
									Other settings that have a chain link icon next to them are pre-filled by the selected instance type. If one of these values is changed, the virtual machine will be detached from the instance type and the chain icon will appear broken. However, if the changed setting is restored to its original value, the virtual machine will be reattached to the instance type and the links in the chain icon will rejoin.
								

								 
									NOTE: Support for instance types is now deprecated, and will be removed in a future release.
								

								 	 
									Yes.
								

								 
	 
									Optimized for
								

								 	 
									The type of system for which the virtual machine is to be optimized. There are three options: Server, Desktop, and High Performance; by default, the field is set to Server. Virtual machines optimized to act as servers have no sound card, use a cloned disk image, and are not stateless. Virtual machines optimized to act as desktop machines do have a sound card, use an image (thin allocation), and are stateless. Virtual machines optimized for high performance have a number of configuration changes. See Configuring High Performance Virtual Machines Templates and Pools.
								

								 	 
									Yes.
								

								 
	 
									Name
								

								 	 
									The name of the virtual machine. The name must be a unique name within the data center and must not contain any spaces, and must contain at least one character from A-Z or 0-9. The maximum length of a virtual machine name is 255 characters. The name can be reused in different data centers in the environment.
								

								 	 
									Yes.
								

								 
	 
									VM ID
								

								 	 
									The virtual machine ID. The virtual machine’s creator can set a custom ID for that virtual machine. The custom ID must contain only numbers, in the format, 00000000-0000-0000-0000-00000000.
								

								 
									If no ID is specified during creation a UUID will be automatically assigned. For both custom and automatically-generated IDs, changes are not possible after virtual machine creation.
								

								 	 
									Yes.
								

								 
	 
									Description
								

								 	 
									A meaningful description of the new virtual machine.
								

								 	 
									No.
								

								 
	 
									Comment
								

								 	 
									A field for adding plain text human-readable comments regarding the virtual machine.
								

								 	 
									No.
								

								 
	 
									Affinity Labels
								

								 	 
									Add or remove a selected Affinity Label.
								

								 	 
									No.
								

								 
	 
									Stateless
								

								 	 
									Select this check box to run the virtual machine in stateless mode. This mode is used primarily for desktop virtual machines. Running a stateless desktop or server creates a new COW layer on the virtual machine hard disk image where new and changed data is stored. Shutting down the stateless virtual machine deletes the new COW layer which includes all data and configuration changes, and returns the virtual machine to its original state. Stateless virtual machines are useful when creating machines that need to be used for a short time, or by temporary staff.
								

								 	 
									Not applicable.
								

								 
	 
									Start in Pause Mode
								

								 	 
									Select this check box to always start the virtual machine in pause mode. This option is suitable for virtual machines which require a long time to establish a SPICE connection; for example, virtual machines in remote locations.
								

								 	 
									Not applicable.
								

								 
	 
									Delete Protection
								

								 	 
									Select this check box to make it impossible to delete the virtual machine. It is only possible to delete the virtual machine if this check box is not selected.
								

								 	 
									No.
								

								 
	 
									Sealed
								

								 	 
									Select this check box to seal the created virtual machine. This option eliminates machine-specific settings from virtual machines that are provisioned from the template. For more information about the sealing process, see Sealing a Windows Virtual Machine for Deployment as a Template
								

								 	 
									No.
								

								 
	 
									Instance Images
								

								 	 
									Click Attach to attach a floating disk to the virtual machine, or click Create to add a new virtual disk. Use the plus and minus buttons to add or remove additional virtual disks.
								

								 
									Click Edit to change the configuration of a virtual disk that has already been attached or created.
								

								 	 
									No.
								

								 
	 
									Instantiate VM network interfaces by picking a vNIC profile.
								

								 	 
									Add a network interface to the virtual machine by selecting a vNIC profile from the nic1 drop-down list. Use the plus and minus buttons to add or remove additional network interfaces.
								

								 	 
									No.
								

								 




Virtual Machine System Settings Explained




					CPU Considerations
				
	
							For non-CPU-intensive workloads, you can run virtual machines with a total number of processor cores greater than the number of cores in the host (the number of processor cores for a single virtual machine must not exceed the number of cores in the host). The following benefits can be achieved:
						
	
									You can run a greater number of virtual machines, which reduces hardware requirements.
								
	
									You can configure virtual machines with CPU topologies that are otherwise not possible, such as when the number of virtual cores is between the number of host cores and the number of host threads.
								



	
							For best performance, and especially for CPU-intensive workloads, you should use the same topology in the virtual machine as in the host, so the host and the virtual machine expect the same cache usage. When the host has hyperthreading enabled, QEMU treats the host’s hyperthreads as cores, so the virtual machine is not aware that it is running on a single core with multiple threads. This behavior might impact the performance of a virtual machine, because a virtual core that actually corresponds to a hyperthread in the host core might share a single cache with another hyperthread in the same host core, while the virtual machine treats it as a separate core.
						



					The following table details the options available on the System tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.2. Virtual Machine: System Settings
	Field Name	Description	Power cycle required?
	 
									Memory Size
								

								 	 
									The amount of memory assigned to the virtual machine. When allocating memory, consider the processing and storage needs of the applications that are intended to run on the virtual machine.
								

								 	 
									If OS supports hotplugging, no. Otherwise, yes.
								

								 
	 
									Maximum Memory
								

								 	 
									The maximum amount of memory that can be assigned to the virtual machine. Maximum guest memory is also constrained by the selected guest architecture and the cluster compatibility level.
								

								 	 
									If OS supports hotplugging, no. Otherwise, yes.
								

								 
	 
									Total Virtual CPUs
								

								 	 
									The processing power allocated to the virtual machine as CPU Cores. For high performance, do not assign more cores to a virtual machine than are present on the physical host.
								

								 	 
									If OS supports hotplugging, no. Otherwise, yes.
								

								 
	 
									Virtual Sockets
								

								 	 
									The number of CPU sockets for the virtual machine. Do not assign more sockets to a virtual machine than are present on the physical host.
								

								 	 
									If OS supports hotplugging, no. Otherwise, yes.
								

								 
	 
									Cores per Virtual Socket
								

								 	 
									The number of cores assigned to each virtual socket.
								

								 	 
									If OS supports hotplugging, no. Otherwise, yes.
								

								 
	 
									Threads per Core
								

								 	 
									The number of threads assigned to each core. Increasing the value enables simultaneous multi-threading (SMT). IBM POWER8 supports up to 8 threads per core. For x86 and x86_64 (Intel and AMD) CPU types, the recommended value is 1, unless you want to replicate the exact host topology, which you can do using CPU pinning. For more information, see Pinning CPU.
								

								 	 
									If OS supports hotplugging, no. Otherwise, yes.
								

								 
	 
									Chipset/Firmware Type
								

								 	 
									Specifies the chipset and firmware type. Defaults to the cluster’s default chipset and firmware type. Options are:
								

								 	
											I440FX Chipset with BIOS Legacy BIOS
										
	
											Q35 Chipset with BIOS BIOS without UEFI (Default for clusters with compatibility version 4.4)
										
	
											Q35 Chipset with UEFI BIOS with UEFI (Default for clusters with compatibility version 4.7)
										
	
											Q35 Chipset with UEFI SecureBoot UEFI with SecureBoot, which authenticates the digital signatures of the boot loader
										



								 
									For more information, see UEFI and the Q35 chipset in the Administration Guide.
								

								 	 
									Yes.
								

								 
	 
									Custom Emulated Machine
								

								 	 
									This option allows you to specify the machine type. If changed, the virtual machine will only run on hosts that support this machine type. Defaults to the cluster’s default machine type.
								

								 	 
									Yes.
								

								 
	 
									Custom CPU Type
								

								 	 
									This option allows you to specify a CPU type. If changed, the virtual machine will only run on hosts that support this CPU type. Defaults to the cluster’s default CPU type.
								

								 	 
									Yes.
								

								 
	 
									Hardware Clock Time Offset
								

								 	 
									This option sets the time zone offset of the guest hardware clock. For Windows, this should correspond to the time zone set in the guest. Most default Linux installations expect the hardware clock to be GMT+00:00.
								

								 	 
									Yes.
								

								 
	 
									Custom Compatibility Version
								

								 	 
									The compatibility version determines which features are supported by the cluster, as well as, the values of some properties and the emulated machine type. By default, the virtual machine is configured to run in the same compatibility mode as the cluster as the default is inherited from the cluster. In some situations the default compatibility mode needs to be changed. An example of this is if the cluster has been updated to a later compatibility version but the virtual machines have not been restarted. These virtual machines can be set to use a custom compatibility mode that is older than that of the cluster. See Changing the Cluster Compatibility Version in the Administration Guide for more information.
								

								 	 
									Yes.
								

								 
	 
									Serial Number Policy
								

								 	 
									Override the system-level and cluster-level policies for assigning a serial numbers to virtual machines. Apply a policy that is unique to this virtual machine:
								

								 	
											System Default: Use the system-wide defaults, which are configured in the Manager database using the engine configuration tool and the DefaultSerialNumberPolicy and DefaultCustomSerialNumber key names. The default value for DefaultSerialNumberPolicy is to use the Host ID. See Scheduling Policies in the Administration Guide for more information.
										
	
											Host ID: Set this virtual machine’s serial number to the UUID of the host.
										
	
											Vm ID: Set this virtual machine’s serial number to the UUID of this virtual machine.
										
	
											Custom serial number: Set this virtual machine’s serial number to the value you specify in the following Custom Serial Number parameter.
										



								 	 
									Yes.
								

								 
	 
									Custom Serial Number
								

								 	 
									Specify the custom serial number to apply to this virtual machine.
								

								 	 
									Yes.
								

								 




Virtual Machine Initial Run Settings Explained




					The following table details the options available on the Initial Run tab of the New Virtual Machine and Edit Virtual Machine windows. The settings in this table are only visible if the Use Cloud-Init/Sysprep check box is selected, and certain options are only visible when either a Linux-based or Windows-based option has been selected in the Operating System list in the General tab, as outlined below.
				
Note

						This table does not include information on whether a power cycle is required because the settings apply to the virtual machine’s initial run; the virtual machine is not running when you configure these settings.
					

Table A.3. Virtual Machine: Initial Run Settings
	Field Name	Operating System	Description
	 
									Use Cloud-Init/Sysprep
								

								 	 
									Linux, Windows
								

								 	 
									This check box toggles whether Cloud-Init or Sysprep will be used to initialize the virtual machine.
								

								 
	 
									VM Hostname
								

								 	 
									Linux, Windows
								

								 	 
									The host name of the virtual machine.
								

								 
	 
									Domain
								

								 	 
									Windows
								

								 	 
									The Active Directory domain to which the virtual machine belongs.
								

								 
	 
									Organization Name
								

								 	 
									Windows
								

								 	 
									The name of the organization to which the virtual machine belongs. This option corresponds to the text field for setting the organization name displayed when a machine running Windows is started for the first time.
								

								 
	 
									Active Directory OU
								

								 	 
									Windows
								

								 	 
									The organizational unit in the Active Directory domain to which the virtual machine belongs.
								

								 
	 
									Configure Time Zone
								

								 	 
									Linux, Windows
								

								 	 
									The time zone for the virtual machine. Select this check box and select a time zone from the Time Zone list.
								

								 
	 
									Admin Password
								

								 	 
									Windows
								

								 	 
									The administrative user password for the virtual machine. Click the disclosure arrow to display the settings for this option.
								

								 	
											Use already configured password: This check box is automatically selected after you specify an initial administrative user password. You must clear this check box to enable the Admin Password and Verify Admin Password fields and specify a new password.
										
	
											Admin Password: The administrative user password for the virtual machine. Enter the password in this text field and the Verify Admin Password text field to verify the password.
										



								 
	 
									Authentication
								

								 	 
									Linux
								

								 	 
									The authentication details for the virtual machine. Click the disclosure arrow to display the settings for this option.
								

								 	
											Use already configured password: This check box is automatically selected after you specify an initial root password. You must clear this check box to enable the Password and Verify Password fields and specify a new password.
										
	
											Password: The root password for the virtual machine. Enter the password in this text field and the Verify Password text field to verify the password.
										
	
											SSH Authorized Keys: SSH keys to be added to the authorized keys file of the virtual machine. You can specify multiple SSH keys by entering each SSH key on a new line.
										
	
											Regenerate SSH Keys: Regenerates SSH keys for the virtual machine.
										



								 
	 
									Custom Locale
								

								 	 
									Windows
								

								 	 
									Custom locale options for the virtual machine. Locales must be in a format such as en-US. Click the disclosure arrow to display the settings for this option.
								

								 	
											Input Locale: The locale for user input.
										
	
											UI Language: The language used for user interface elements such as buttons and menus.
										
	
											System Locale: The locale for the overall system.
										
	
											User Locale: The locale for users.
										



								 
	 
									Networks
								

								 	 
									Linux
								

								 	 
									Network-related settings for the virtual machine. Click the disclosure arrow to display the settings for this option.
								

								 	
											DNS Servers: The DNS servers to be used by the virtual machine.
										
	
											DNS Search Domains: The DNS search domains to be used by the virtual machine.
										
	
											Network: Configures network interfaces for the virtual machine. Select this check box and click + or - to add or remove network interfaces to or from the virtual machine. When you click +, a set of fields becomes visible that can specify whether to use DHCP, and configure an IP address, netmask, and gateway, and specify whether the network interface will start on boot.
										



								 
	 
									Custom Script
								

								 	 
									Linux
								

								 	 
									Custom scripts that will be run on the virtual machine when it starts. The scripts entered in this field are custom YAML sections that are added to those produced by the Manager, and allow you to automate tasks such as creating users and files, configuring yum repositories and running commands. For more information on the format of scripts that can be entered in this field, see the Custom Script documentation.
								

								 
	 
									Sysprep
								

								 	 
									Windows
								

								 	 
									A custom Sysprep definition. The definition must be in the format of a complete unattended installation answer file. You can copy and paste the default answer files in the /usr/share/ovirt-engine/conf/sysprep/ directory on the machine on which the Red Hat Virtualization Manager is installed and alter the fields as required. See Templates for more information.
								

								 
	 
									Ignition 2.3.0
								

								 	 
									Red Hat Enterprise Linux CoreOS
								

								 	 
									When Red Hat Enterprise Linux CoreOS is selected as Operating System, this check box toggles whether Ignition will be used to initialize the virtual machine.
								

								 




Virtual Machine Console Settings Explained




					The following table details the options available on the Console tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.4. Virtual Machine: Console Settings
	Field Name	Description	Power cycle required?
	 
									Graphical Console Section
								

								 	 
									A group of settings.
								

								 	 
									Yes.
								

								 
	 
									Headless Mode
								

								 	 
									Select this check box if you do not a require a graphical console for the virtual machine.
								

								 
									When selected, all other fields in the Graphical Console section are disabled. In the VM Portal, the Console icon in the virtual machine’s details view is also disabled.
								

								 Important

										See Configuring Headless Machines for more details and prerequisites for using headless mode.
									


								 	 
									Yes.
								

								 
	 
									Video Type
								

								 	 
									Defines the graphics device. QXL is the default and supports both graphic protocols. VGA supports only the VNC protocol.
								

								 	 
									Yes.
								

								 
	 
									Graphics protocol
								

								 	 
									Defines which display protocol to use. SPICE is the default protocol. VNC is an alternative option. To allow both protocols select SPICE + VNC.
								

								 	 
									Yes.
								

								 
	 
									VNC Keyboard Layout
								

								 	 
									Defines the keyboard layout for the virtual machine. This option is only available when using the VNC protocol.
								

								 	 
									Yes.
								

								 
	 
									USB enabled
								

								 	 
									Defines SPICE USB redirection. This check box is not selected by default. This option is only available for virtual machines using the SPICE protocol:
								

								 	
											Disabled (check box is cleared) - USB controller devices are added according to the devices.usb.controller value in the osinfo-defaults.properties configuration file. The default for all x86 and x86_64 operating systems is piix3-uhci. For ppc64 systems, the default is nec-xhci.
										
	
											Enabled (check box is selected) - Enables native KVM/SPICE USB redirection for Linux and Windows virtual machines. Virtual machines do not require any in-guest agents or drivers for native USB.
										



								 	 
									Yes.
								

								 
	 
									Console Disconnect Action
								

								 	 
									Defines what happens when the console is disconnected. This is only relevant with SPICE and VNC console connections. This setting can be changed while the virtual machine is running but will not take effect until a new console connection is established. Select either:
								

								 	
											No action - No action is taken.
										
	
											Lock screen - This is the default option. For all Linux machines and for Windows desktops this locks the currently active user session. For Windows servers, this locks the desktop and the currently active user.
										
	
											Logout user - For all Linux machines and Windows desktops, this logs out the currently active user session. For Windows servers, the desktop and the currently active user are logged out.
										
	
											Shutdown virtual machine - Initiates a graceful virtual machine shutdown.
										
	
											Reboot virtual machine - Initiates a graceful virtual machine reboot.
										



								 	 
									No.
								

								 
	 
									Monitors
								

								 	 
									The number of monitors for the virtual machine. This option is only available for virtual desktops using the SPICE display protocol. You can choose 1, 2 or 4. Note that multiple monitors are not supported for Windows systems with WDDMDoD drivers.
								

								 	 
									Yes.
								

								 
	 
									Smartcard Enabled
								

								 	 
									Smart cards are an external hardware security feature, most commonly seen in credit cards, but also used by many businesses as authentication tokens. Smart cards can be used to protect Red Hat Virtualization virtual machines. Select or clear the check box to activate and deactivate Smart card authentication for individual virtual machines.
								

								 	 
									Yes.
								

								 
	 
									Single Sign On method
								

								 	 
									Enabling Single Sign On allows users to sign into the guest operating system when connecting to a virtual machine from the VM Portal using the Guest Agent.
								

								 	
											Disable Single Sign On - Select this option if you do not want the Guest Agent to attempt to sign into the virtual machine.
										
	
											Use Guest Agent - Enables Single Sign On to allow the Guest Agent to sign you into the virtual machine.
										



								 	 
									If you select Use Guest Agent, no. Otherwise, yes.
								

								 
	 
									Disable strict user checking
								

								 	 
									Click the Advanced Parameters arrow and select the check box to use this option. With this option selected, the virtual machine does not need to be rebooted when a different user connects to it.
								

								 
									By default, strict checking is enabled so that only one user can connect to the console of a virtual machine. No other user is able to open a console to the same virtual machine until it has been rebooted. The exception is that a SuperUser can connect at any time and replace a existing connection. When a SuperUser has connected, no normal user can connect again until the virtual machine is rebooted.
								

								 
									Disable strict checking with caution, because you can expose the previous user’s session to the new user.
								

								 	 
									No.
								

								 
	 
									Soundcard Enabled
								

								 	 
									A sound card device is not necessary for all virtual machine use cases. If it is for yours, enable a sound card here.
								

								 	 
									Yes.
								

								 
	 
									Enable SPICE file transfer
								

								 	 
									Defines whether a user is able to drag and drop files from an external host into the virtual machine’s SPICE console. This option is only available for virtual machines using the SPICE protocol. This check box is selected by default.
								

								 	 
									No.
								

								 
	 
									Enable SPICE clipboard copy and paste
								

								 	 
									Defines whether a user is able to copy and paste content from an external host into the virtual machine’s SPICE console. This option is only available for virtual machines using the SPICE protocol. This check box is selected by default.
								

								 	 
									No.
								

								 
	 
									Serial Console Section
								

								 	 
									A group of settings.
								

								 	 
	 
									Enable VirtIO serial console
								

								 	 
									The VirtIO serial console is emulated through VirtIO channels, using SSH and key pairs, and allows you to access a virtual machine’s serial console directly from a client machine’s command line, instead of opening a console from the Administration Portal or the VM Portal. The serial console requires direct access to the Manager, since the Manager acts as a proxy for the connection, provides information about virtual machine placement, and stores the authentication keys. Select the check box to enable the VirtIO console on the virtual machine. Requires a firewall rule. See Opening a Serial Console to a Virtual Machine.
								

								 	 
									Yes.
								

								 




Virtual Machine Host Settings Explained




					The following table details the options available on the Host tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.5. Virtual Machine: Host Settings
	Field Name	Sub-element	Description	Power cycle required?
	 
									Start Running On
								

								 	 	 
									Defines the preferred host on which the virtual machine is to run. Select either:
								

								 	
											Any Host in Cluster - The virtual machine can start and run on any available host in the cluster.
										
	
											Specific Host(s) - The virtual machine will start running on a particular host in the cluster. However, the Manager or an administrator can migrate the virtual machine to a different host in the cluster depending on the migration and high-availability settings of the virtual machine. Select the specific host or group of hosts from the list of available hosts.
										



								 	 
									No. The virtual machine can migrate to that host while running.
								

								 
	 
									CPU options
								

								 	 
									Pass-Through Host CPU
								

								 	 
									When selected, allows virtual machines to use the host’s CPU flags. When selected, Migration Options is set to Allow manual migration only.
								

								 	 
									Yes
								

								 
	 	 
									Migrate only to hosts with the same TSC frequency
								

								 	 
									When selected, this virtual machine can only be migrated to a host with the same TSC frequency. This option is only valid for High Performance virtual machines.
								

								 	 
									Yes
								

								 
	 
									Migration Options
								

								 	 
									Migration mode
								

								 	 
									Defines options to run and migrate the virtual machine. If the options here are not used, the virtual machine will run or migrate according to its cluster’s policy.
								

								 	
											Allow manual and automatic migration - The virtual machine can be automatically migrated from one host to another in accordance with the status of the environment, or manually by an administrator.
										
	
											Allow manual migration only - The virtual machine can only be migrated from one host to another manually by an administrator.
										
	
											Do not allow migration - The virtual machine cannot be migrated, either automatically or manually.
										



								 	 
									No
								

								 
	 	 
									Migration policy
								

								 	 
									Defines the migration convergence policy. If the check box is left unselected, the host determines the policy.
								

								 	
											Cluster default (Minimal downtime) - Overrides in vdsm.conf are still applied. The guest agent hook mechanism is disabled.
										
	
											Minimal downtime - Allows the virtual machine to migrate in typical situations. Virtual machines should not experience any significant downtime. The migration will be aborted if virtual machine migration does not converge after a long time (dependent on QEMU iterations, with a maximum of 500 milliseconds). The guest agent hook mechanism is enabled.
										
	
											Post-copy migration - When used, post-copy migration pauses the migrating virtual machine vCPUs on the source host, transfers only a minimum of memory pages, activates the virtual machine vCPUs on the destination host, and transfers the remaining memory pages while the virtual machine is running on the destination.
										

											The post-copy policy first tries pre-copy to verify whether convergence can occur. The migration switches to post-copy if the virtual machine migration does not converge after a long time.
										

											This significantly reduces the downtime of the migrated virtual machine, and also guarantees that the migration finishes regardless of how rapidly the memory pages of the source virtual machine change. It is optimal for migrating virtual machines in heavy continuous use, which would not be possible to migrate with standard pre-copy migration.
										

											The disadvantage of this policy is that in the post-copy phase, the virtual machine may slow down significantly as the missing parts of memory are transferred between the hosts.
										
Warning

												If the network connection breaks prior to the completion of the post-copy process, the Manager pauses and then kills the running virtual machine. Do not use post-copy migration if the virtual machine availability is critical or if the migration network is unstable.
											


	
											Suspend workload if needed - Allows the virtual machine to migrate in most situations, including when the virtual machine is running a heavy workload. Because of this, virtual machines may experience a more significant downtime than with some other settings. The migration may still be aborted for extreme workloads. The guest agent hook mechanism is enabled.
										



								 	 
									No
								

								 
	 	 
									Enable migration encryption
								

								 	 
									Allows the virtual machine to be encrypted during migration.
								

								 	
											Cluster default
										
	
											Encrypt
										
	
											Don’t encrypt
										



								 	 
									No
								

								 
	 	 
									Parallel Migrations
								

								 	 
									Allows you to specify whether and how many parallel migration connections to use.
								

								 	
											Cluster default: Parallel migration connections are determined by the cluster default.
										
	
											Disabled: The virtual machine is migrated using a single, non-parallel connection.
										
	
											Auto: The number of parallel connections is automatically determined. This settings might automatically disable parallel connections.
										
	
											Auto Parallel: The number of parallel connections is automatically determined.
										
	
											Custom: Allows you to specify the preferred number of parallel connections, the actual number may be lower.
										



								 	 
	 	 
									Number of VM Migration Connections
								

								 	 
									This setting is only available when Custom is selected. The preferred number of custom parallel migrations, between 2 and 255.
								

								 	 
	 
									Configure NUMA
								

								 	 
									NUMA Node Count
								

								 	 
									The number of virtual NUMA nodes available in a host that can be assigned to the virtual machine.
								

								 	 
									No
								

								 
	 	 
									NUMA Pinning
								

								 	 
									Opens the NUMA Topology window. This window shows the host’s total CPUs, memory, and NUMA nodes, and the virtual machine’s virtual NUMA nodes. You can manually pin virtual NUMA nodes to host NUMA nodes by clicking and dragging each vNUMA from the box on the right to a NUMA node on the left.
								

								 
									You can also set Tune Mode for memory allocation:
								

								 
									Strict - Memory allocation will fail if the memory cannot be allocated on the target node.
								

								 
									Preferred - Memory is allocated from a single preferred node. If sufficient memory is not available, memory can be allocated from other nodes.
								

								 
									Interleave - Memory is allocated across nodes in a round-robin algorithm.
								

								 
									If you define NUMA pinning, Migration Options is set to Allow manual migration only.
								

								 	 
									Yes
								

								 




Virtual Machine High Availability Settings Explained




					The following table details the options available on the High Availability tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.6. Virtual Machine: High Availability Settings
	Field Name	Description	Power cycle required?
	 
									Highly Available
								

								 	 
									Select this check box if the virtual machine is to be highly available. For example, in cases of host maintenance, all virtual machines are automatically live migrated to another host. If the host crashes and is in a non-responsive state, only virtual machines with high availability are restarted on another host. If the host is manually shut down by the system administrator, the virtual machine is not automatically live migrated to another host.
								

								 
									Note that this option is unavailable for virtual machines defined as Server or Desktop if the Migration Options setting in the Hosts tab is set to Do not allow migration. For a virtual machine to be highly available, it must be possible for the Manager to migrate the virtual machine to other available hosts as necessary.
								

								 
									However, for virtual machines defined as High Performance, you can define high availability regardless of the Migration Options setting.
								

								 	 
									Yes.
								

								 
	 
									Target Storage Domain for VM Lease
								

								 	 
									Select the storage domain to hold a virtual machine lease, or select No VM Lease to disable the functionality. When a storage domain is selected, it will hold a virtual machine lease on a special volume that allows the virtual machine to be started on another host if the original host loses power or becomes unresponsive.
								

								 
									This functionality is only available on storage domain V4 or later.
								

								 Note

										If you define a lease, the only Resume Behavior available is KILL.
									


								 	 
									Yes.
								

								 
	 
									Resume Behavior
								

								 	 
									Defines the desired behavior of a virtual machine that is paused due to storage I/O errors, once a connection with the storage is reestablished. You can define the desired resume behavior even if the virtual machine is not highly available.
								

								 
									The following options are available:
								

								 	
											AUTO_RESUME - The virtual machine is automatically resumed, without requiring user intervention. This is recommended for virtual machines that are not highly available and that do not require user intervention after being in the paused state.
										
	
											LEAVE_PAUSED - The virtual machine remains in pause mode until it is manually resumed or restarted.
										
	
											KILL - The virtual machine is automatically resumed if the I/O error is remedied within 80 seconds. However, if more than 80 seconds pass, the virtual machine is ungracefully shut down. This is recommended for highly available virtual machines, to allow the Manager to restart them on another host that is not experiencing the storage I/O error.
										

											KILL is the only option available when using virtual machine leases.
										




								 	 
									No.
								

								 
	 
									Priority for Run/Migration queue
								

								 	 
									Sets the priority level for the virtual machine to be migrated or restarted on another host.
								

								 	 
									No.
								

								 
	 
									Watchdog
								

								 	 
									Allows users to attach a watchdog card to a virtual machine. A watchdog is a timer that is used to automatically detect and recover from failures. Once set, a watchdog timer continually counts down to zero while the system is in operation, and is periodically restarted by the system to prevent it from reaching zero. If the timer reaches zero, it signifies that the system has been unable to reset the timer and is therefore experiencing a failure. Corrective actions are then taken to address the failure. This functionality is especially useful for servers that demand high availability.
								

								 
									Watchdog Model: The model of watchdog card to assign to the virtual machine. At current, the only supported model is i6300esb.
								

								 
									Watchdog Action: The action to take if the watchdog timer reaches zero. The following actions are available:
								

								 	
											none - No action is taken. However, the watchdog event is recorded in the audit log.
										
	
											reset - The virtual machine is reset and the Manager is notified of the reset action.
										
	
											poweroff - The virtual machine is immediately shut down.
										
	
											dump - A dump is performed and the virtual machine is paused. The guest’s memory is dumped by libvirt, therefore, neither 'kdump' nor 'pvpanic' is required. The dump file is created in the directory that is configured by auto_dump_path in the /etc/libvirt/qemu.conf file on the host.
										
	
											pause - The virtual machine is paused, and can be resumed by users.
										



								 	 
									Yes.
								

								 




Virtual Machine Resource Allocation Settings Explained




					The following table details the options available on the Resource Allocation tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.7. Virtual Machine: Resource Allocation Settings
	Field Name	Sub-element	Description	Power cycle required?
	 
									CPU Allocation
								

								 	 
									CPU Profile
								

								 	 
									The CPU profile assigned to the virtual machine. CPU profiles define the maximum amount of processing capability a virtual machine can access on the host on which it runs, expressed as a percent of the total processing capability available to that host. CPU profiles are defined for a cluster, based on quality of service entries created for data centers.
								

								 	 
									No.
								

								 
	 	 
									CPU Shares
								

								 	 
									Allows users to set the level of CPU resources a virtual machine can demand relative to other virtual machines.
								

								 	
											Low - 512
										
	
											Medium - 1024
										
	
											High - 2048
										
	
											Custom - A custom level of CPU shares defined by the user.
										



								 	 
									No.
								

								 
	 	 
									CPU Pinning Policy
								

								 	 	
											None - Runs without any CPU pinning.
										
	
											Manual - Runs a manually specified virtual CPU on a specific physical CPU and a specific host. Available only when the virtual machine is pinned to a Host.
										
	
											Resize and Pin NUMA - Resizes the virtual CPU and NUMA topology of the virtual machine according to the Host, and pins them to the Host resources.
										
	
											Dedicated - Exclusively pins virtual CPUs to host physical CPUs. Available for cluster compatibility level 4.7 or later. If the virtual machine has NUMA enabled, all nodes must be unpinned.
										
	
											Isolate Threads - Exclusively pins virtual CPUs to host physical CPUs. Each virtual CPU gets a physical core. Available for cluster compatibility level 4.7 or later. If the virtual machine has NUMA enabled, all nodes must be unpinned.
										



								 	 
									No.
								

								 
	 	 
									CPU Pinning topology
								

								 	 
									Enables the virtual machine’s virtual CPU (vCPU) to run on a specific physical CPU (pCPU) in a specific host. The syntax of CPU pinning is v#p[_v#p], for example:
								

								 	
											0#0 - Pins vCPU 0 to pCPU 0.
										
	
											0#0_1#3 - Pins vCPU 0 to pCPU 0, and pins vCPU 1 to pCPU 3.
										
	
											1#1-4,^2 - Pins vCPU 1 to one of the pCPUs in the range of 1 to 4, excluding pCPU 2.
										



								 
									The CPU Pinning Topology is populated automatically when Resize and Pin NUMA pinning is selected in CPU Pinning Policy.
								

								 
									In order to pin a virtual machine to a host, you must also select the following on the Host tab:
								

								 	
											Start Running On: Specific
										
	
											Pass-Through Host CPU
										



								 
									If CPU pinning is set and you change Start Running On: Specific a CPU pinning topology will be lost window appears when you click OK.
								

								 
									When defined, Migration Options in the Hosts tab is set to Allow manual migration only.
								

								 	 
									Yes.
								

								 
	 
									Memory Allocation
								

								 	 
									Physical Memory Guaranteed
								

								 	 
									The amount of physical memory guaranteed for this virtual machine. Should be any number between 0 and the defined memory for this virtual machine.
								

								 	 
									If lowered, yes. Otherwise, no.
								

								 
	 	 
									Memory Balloon Device Enabled
								

								 	 
									Enables the memory balloon device for this virtual machine. Enable this setting to allow memory overcommitment in a cluster. Enable this setting for applications that allocate large amounts of memory suddenly but set the guaranteed memory to the same value as the defined memory.Use ballooning for applications and loads that slowly consume memory, occasionally release memory, or stay dormant for long periods of time, such as virtual desktops. See Optimization Settings Explained in the Administration Guide for more information.
								

								 	 
									Yes.
								

								 
	 
									Trusted Platform Module
								

								 	 
									TPM Device Enabled
								

								 	 
									Enables the addition of an emulated Trusted Platform Module (TPM) device. Select this check box to add an emulated Trusted Platform Module device to a virtual machine. TPM devices can only be used on x86_64 machines with UEFI firmware and PowerPC machines with pSeries firmware installed. See Adding Trusted Platform Module devices for more information.
								

								 	 
									Yes.
								

								 
	 
									IO Threads
								

								 	 
									IO Threads Enabled
								

								 	 
									Enables IO threads. Select this check box to improve the speed of disks that have a VirtIO interface by pinning them to a thread separate from the virtual machine’s other functions. Improved disk performance increases a virtual machine’s overall performance. Disks with VirtIO interfaces are pinned to an IO thread using a round-robin algorithm.
								

								 	 
									Yes.
								

								 
	 
									Queues
								

								 	 
									Multi Queues Enabled
								

								 	 
									Enables multiple queues. This check box is selected by default. It creates up to four queues per vNIC, depending on how many vCPUs are available.
								

								 
									It is possible to define a different number of queues per vNIC by creating a custom property as follows:
								

								 
									engine-config -s "CustomDeviceProperties={type=interface;prop={other-nic-properties;queues=[1-9][0-9]*}}"
								

								 
									where other-nic-properties is a semicolon-separated list of pre-existing NIC custom properties.
								

								 	 
									Yes.
								

								 
	 	 
									VirtIO-SCSI Enabled
								

								 	 
									Allows users to enable or disable the use of VirtIO-SCSI on the virtual machines.
								

								 	 
									Not applicable.
								

								 
	 	 
									VirtIO-SCSI Multi Queues Enabled
								

								 	 
									The VirtIO-SCSI Multi Queues Enabled option is only available when VirtIO-SCSI Enabled is selected. Select this check box to enable multiple queues in the VirtIO-SCSI driver. This setting can improve I/O throughput when multiple threads within the virtual machine access the virtual disks. It creates up to four queues per VirtIO-SCSI controller, depending on how many disks are connected to the controller and how many vCPUs are available.
								

								 	 
									Not applicable.
								

								 
	 
									Storage Allocation
								

								 	 	 
									The Storage Allocation option is only available when the virtual machine is created from a template.
								

								 	 
									Not applicable.
								

								 
	 	 
									Thin
								

								 	 
									Provides optimized usage of storage capacity. Disk space is allocated only as it is required. When selected, the format of the disks will be marked as QCOW2 and you will not be able to change it.
								

								 	 
									Not applicable.
								

								 
	 	 
									Clone
								

								 	 
									Optimized for the speed of guest read and write operations. All disk space requested in the template is allocated at the time of the clone operation. Possible disk formats are QCOW2 or Raw.
								

								 	 
									Not applicable.
								

								 
	 
									Disk Allocation
								

								 	 	 
									The Disk Allocation option is only available when you are creating a virtual machine from a template.
								

								 	 
									Not applicable.
								

								 
	 	 
									Alias
								

								 	 
									An alias for the virtual disk. By default, the alias is set to the same value as that of the template.
								

								 	 
									Not applicable.
								

								 
	 	 
									Virtual Size
								

								 	 
									The total amount of disk space that the virtual machine based on the template can use. This value cannot be edited, and is provided for reference only.
								

								 	 
									Not applicable.
								

								 
	 	 
									Format
								

								 	 
									The format of the virtual disk. The available options are QCOW2 and Raw. When Storage Allocation is Thin, the disk format is QCOW2. When Storage Allocation is Clone, select QCOW2 or Raw.
								

								 	 
									Not applicable.
								

								 
	 	 
									Target
								

								 	 
									The storage domain on which the virtual disk is stored. By default, the storage domain is set to the same value as that of the template.
								

								 	 
									Not applicable.
								

								 
	 	 
									Disk Profile
								

								 	 
									The disk profile to assign to the virtual disk. Disk profiles are created based on storage profiles defined in the data centers. For more information, see Creating a Disk Profile.
								

								 	 
									Not applicable.
								

								 




Virtual Machine Boot Options Settings Explained




					The following table details the options available on the Boot Options tab of the New Virtual Machine and Edit Virtual Machine windows
				
Table A.8. Virtual Machine: Boot Options Settings
	Field Name	Description	Power cycle required?
	 
									First Device
								

								 	 
									After installing a new virtual machine, the new virtual machine must go into Boot mode before powering up. Select the first device that the virtual machine must try to boot:
								

								 	
											Hard Disk
										
	
											CD-ROM
										
	
											Network (PXE)
										



								 	 
									Yes.
								

								 
	 
									Second Device
								

								 	 
									Select the second device for the virtual machine to use to boot if the first device is not available. The first device selected in the previous option does not appear in the options.
								

								 	 
									Yes.
								

								 
	 
									Attach CD
								

								 	 
									If you have selected CD-ROM as a boot device, select this check box and select a CD-ROM image from the drop-down menu. The images must be available in the ISO domain.
								

								 	 
									Yes.
								

								 
	 
									Enable menu to select boot device
								

								 	 
									Enables a menu to select the boot device. After the virtual machine starts and connects to the console, but before the virtual machine starts booting, a menu displays that allows you to select the boot device. This option should be enabled before the initial boot to allow you to select the required installation media.
								

								 	 
									Yes.
								

								 




Virtual Machine Random Generator Settings Explained




					The following table details the options available on the Random Generator tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.9. Virtual Machine: Random Generator Settings
	Field Name	Description	Power cycle required?
	 
									Random Generator enabled
								

								 	 
									Selecting this check box enables a paravirtualized Random Number Generator PCI device (virtio-rng). This device allows entropy to be passed from the host to the virtual machine in order to generate a more sophisticated random number. Note that this check box can only be selected if the RNG device exists on the host and is enabled in the host’s cluster.
								

								 	 
									Yes.
								

								 
	 
									Period duration (ms)
								

								 	 
									Specifies the duration of the RNG’s "full cycle" or "full period" in milliseconds. If omitted, the libvirt default of 1000 milliseconds (1 second) is used. If this field is filled, Bytes per period must be filled also.
								

								 	 
									Yes.
								

								 
	 
									Bytes per period
								

								 	 
									Specifies how many bytes are permitted to be consumed per period.
								

								 	 
									Yes.
								

								 
	 
									Device source:
								

								 	 
									The source of the random number generator. This is automatically selected depending on the source supported by the host’s cluster.
								

								 	
											/dev/urandom source - The Linux-provided random number generator.
										
	
											/dev/hwrng source - An external hardware generator.
										



								 	 
									Yes.
								

								 




Virtual Machine Custom Properties Settings Explained




					The following table details the options available on the Custom Properties tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Table A.10. Virtual Machine Custom Properties Settings
	Field Name	Description	Recommendations and Limitations	Power cycle required?
	 
									sndbuf
								

								 	 
									Enter the size of the buffer for sending the virtual machine’s outgoing data over the socket. Default value is 0.
								

								 	 
									-
								

								 	 
									Yes
								

								 
	 
									hugepages
								

								 	 
									Enter the huge page size in KB.
								

								 	 	
											Set the huge page size to the largest size supported by the pinned host.
										
	
											The recommended size for x86_64 is 1 GB.
										
	
											The virtual machine’s huge page size must be the same size as the pinned host’s huge page size.
										
	
											The virtual machine’s memory size must fit into the selected size of the pinned host’s free huge pages. The NUMA node size must be a multiple of the huge page’s selected size.
										



								 	 
									Yes
								

								 
	 
									vhost
								

								 	 
									Disables vhost-net, which is the kernel-based virtio network driver on virtual network interface cards attached to the virtual machine. To disable vhost, the format for this property is LogicalNetworkName: false.
								

								 
									This will explicitly start the virtual machine without the vhost-net setting on the virtual NIC attached to LogicalNetworkName.
								

								 	 
									vhost-net provides better performance than virtio-net, and if it is present, it is enabled on all virtual machine NICs by default. Disabling this property makes it easier to isolate and diagnose performance issues, or to debug vhost-net errors; for example, if migration fails for virtual machines on which vhost does not exist.
								

								 	 
									Yes
								

								 
	 
									sap_agent
								

								 	 
									Enables SAP monitoring on the virtual machine. Set to true or false.
								

								 	 
									-
								

								 	 
									Yes
								

								 
	 
									viodiskcache
								

								 	 
									Caching mode for the virtio disk. writethrough writes data to the cache and the disk in parallel, writeback does not copy modifications from the cache to the disk, and none disables caching.
								

								 	 
									In order to ensure data integrity in the event of a fault in storage, in the network, or in a host during migration, do not migrate virtual machines with viodiskcache enabled, unless virtual machine clustering or application-level clustering is also enabled.
								

								 	 
									Yes
								

								 
	 
									scsi_hostdev
								

								 	 
									Optionally, if you add a SCSI host device to a virtual machine, you can specify the optimal SCSI host device driver. For details, see Adding Host Devices to a Virtual Machine.
								

								 	
											scsi_generic: (Default) Enables the guest operating system to access OS-supported SCSI host devices attached to the host. Use this driver for SCSI media changers that require raw access, such as tape or CD changers.
										
	
											scsi_block: Similar to scsi_generic but better speed and reliability. Use for SCSI disk devices. If trim or discard for the underlying device is desired, and it’s a hard disk, use this driver.
										
	
											scsi_hd: Provides performance with lowered overhead. Supports large numbers of devices. Uses the standard SCSI device naming scheme. Can be used with aio-native. Use this driver for high-performance SSDs.
										
	
											virtio_blk_pci: Provides the highest performance without the SCSI overhead. Supports identifying devices by their serial numbers.
										



								 	 
									If you are not sure, try scsi_hd.
								

								 	 
									Yes
								

								 



Warning

						Increasing the value of the sndbuf custom property results in increased occurrences of communication failure between hosts and unresponsive virtual machines.
					


Virtual Machine Icon Settings Explained




					You can add custom icons to virtual machines and templates. Custom icons can help to differentiate virtual machines in the VM Portal. The following table details the options available on the Icon tab of the New Virtual Machine and Edit Virtual Machine windows.
				
Note

						This table does not include information on whether a power cycle is required because these settings apply to the virtual machine’s appearance in the Administration portal, not to its configuration.
					

Table A.11. Virtual Machine: Icon Settings
	Button Name	Description
	 
									Upload
								

								 	 
									Click this button to select a custom image to use as the virtual machine’s icon. The following limitations apply:
								

								 	
											Supported formats: jpg, png, gif
										
	
											Maximum size: 24 KB
										
	
											Maximum dimensions: 150px width, 120px height
										



								 
	 
									Power cycle required?
								

								 	 
									Use default
								

								 




Virtual Machine Foreman/Satellite Settings Explained




					The following table details the options available on the Foreman/Satellite tab of the New Virtual Machine and Edit Virtual Machine windows
				
Table A.12. Virtual Machine:Foreman/Satellite Settings
	Field Name	Description	Power cycle required?
	 
									Provider
								

								 	 
									If the virtual machine is running Red Hat Enterprise Linux and the system is configured to work with a Satellite server, select the name of the Satellite from the list. This enables you to use Satellite’s content management feature to display the relevant Errata for this virtual machine. See Configuring Satellite Errata for more details.
								

								 	 
									Yes.
								

								 





Explanation of settings in the Run Once window




				The Run Once window defines one-off boot options for a virtual machine. For persistent boot options, use the Boot Options tab in the New Virtual Machine window. The Run Once window contains multiple sections that can be configured.
			

				The standalone Rollback this configuration during reboots check box specifies whether reboots (initiated by the Manager, or from within the guest) will be warm (soft) or cold (hard). Select this check box to configure a cold reboot that restarts the virtual machine with regular (non-Run Once) configuration. Clear this check box to configure a warm reboot that retains the virtual machine’s Run Once configuration.
			

				The Boot Options section defines the virtual machine’s boot sequence, running options, and source images for installing the operating system and required drivers.
			
Note

					The following tables do not include information on whether a power cycle is required because these one-off boot options apply only when you reboot the virtual machine.
				

Table A.13. Boot Options Section
	Field Name	Description
	 
								Attach CD
							

							 	 
								Attaches an ISO image to the virtual machine. Use this option to install the virtual machine’s operating system and applications. The CD image must reside in the ISO domain.
							

							 
	 
								Attach Windows guest tools CD
							

							 	 
								Attaches a secondary virtual CD-ROM to the virtual machine with the virtio-win ISO image. Use this option to install Windows drivers. For information on installing the image, see Uploading the VirtIO Image Files to a Storage Domain in the Administration Guide.
							

							 
	 
								Enable menu to select boot device
							

							 	 
								Enables a menu to select the boot device. After the virtual machine starts and connects to the console, but before the virtual machine starts booting, a menu displays that allows you to select the boot device. This option should be enabled before the initial boot to allow you to select the required installation media.
							

							 
	 
								Start in Pause Mode
							

							 	 
								Starts and then pauses the virtual machine to enable connection to the console. Suitable for virtual machines in remote locations.
							

							 
	 
								Predefined Boot Sequence
							

							 	 
								Determines the order in which the boot devices are used to boot the virtual machine. Select Hard Disk, CD-ROM, or Network (PXE), and use Up and Down to move the option up or down in the list.
							

							 
	 
								Run Stateless
							

							 	 
								Deletes all data and configuration changes to the virtual machine upon shutdown. This option is only available if a virtual disk is attached to the virtual machine.
							

							 




				The Linux Boot Options section contains fields to boot a Linux kernel directly instead of through the BIOS bootloader.
			
Table A.14. Linux Boot Options Section
	Field Name	Description
	 
								kernel path
							

							 	 
								A fully qualified path to a kernel image to boot the virtual machine. The kernel image must be stored on either the ISO domain (path name in the format of iso://path-to-image) or on the host’s local storage domain (path name in the format of /data/images).
							

							 
	 
								initrd path
							

							 	 
								A fully qualified path to a ramdisk image to be used with the previously specified kernel. The ramdisk image must be stored on the ISO domain (path name in the format of iso://path-to-image) or on the host’s local storage domain (path name in the format of /data/images).
							

							 
	 
								kernel parameters
							

							 	 
								Kernel command line parameter strings to be used with the defined kernel on boot.
							

							 




				The Initial Run section is used to specify whether to use Cloud-Init or Sysprep to initialize the virtual machine. For Linux-based virtual machines, you must select the Use Cloud-Init check box in the Initial Run tab to view the available options. For Windows-based virtual machines, you must attach the [sysprep] floppy by selecting the Attach Floppy check box in the Boot Options tab and selecting the floppy from the list.
			

				The options that are available in the Initial Run section differ depending on the operating system that the virtual machine is based on.
			
Table A.15. Initial Run Section (Linux-based Virtual Machines)
	Field Name	Description
	 
								VM Hostname
							

							 	 
								The host name of the virtual machine.
							

							 
	 
								Configure Time Zone
							

							 	 
								The time zone for the virtual machine. Select this check box and select a time zone from the Time Zone list.
							

							 
	 
								Authentication
							

							 	 
								The authentication details for the virtual machine. Click the disclosure arrow to display the settings for this option.
							

							 
	 
								Authentication → User Name
							

							 	 
								Creates a new user account on the virtual machine. If this field is not filled in, the default user is root.
							

							 
	 
								Authentication → Use already configured password
							

							 	 
								This check box is automatically selected after you specify an initial root password. You must clear this check box to enable the Password and Verify Password fields and specify a new password.
							

							 
	 
								Authentication → Password
							

							 	 
								The root password for the virtual machine. Enter the password in this text field and the Verify Password text field to verify the password.
							

							 
	 
								Authentication → SSH Authorized Keys
							

							 	 
								SSH keys to be added to the authorized keys file of the virtual machine.
							

							 
	 
								Authentication → Regenerate SSH Keys
							

							 	 
								Regenerates SSH keys for the virtual machine.
							

							 
	 
								Networks
							

							 	 
								Network-related settings for the virtual machine. Click the disclosure arrow to display the settings for this option.
							

							 
	 
								Networks → DNS Servers
							

							 	 
								The DNS servers to be used by the virtual machine.
							

							 
	 
								Networks → DNS Search Domains
							

							 	 
								The DNS search domains to be used by the virtual machine.
							

							 
	 
								Networks → Network
							

							 	 
								Configures network interfaces for the virtual machine. Select this check box and click + or - to add or remove network interfaces to or from the virtual machine. When you click +, a set of fields becomes visible that can specify whether to use DHCP, and configure an IP address, netmask, and gateway, and specify whether the network interface will start on boot.
							

							 
	 
								Custom Script
							

							 	 
								Custom scripts that will be run on the virtual machine when it starts. The scripts entered in this field are custom YAML sections that are added to those produced by the Manager, and allow you to automate tasks such as creating users and files, configuring yum repositories and running commands. For more information on the format of scripts that can be entered in this field, see the Custom Script documentation.
							

							 



Table A.16. Initial Run Section (Windows-based Virtual Machines)
	Field Name	Description
	 
								VM Hostname
							

							 	 
								The host name of the virtual machine.
							

							 
	 
								Domain
							

							 	 
								The Active Directory domain to which the virtual machine belongs.
							

							 
	 
								Organization Name
							

							 	 
								The name of the organization to which the virtual machine belongs. This option corresponds to the text field for setting the organization name displayed when a machine running Windows is started for the first time.
							

							 
	 
								Active Directory OU
							

							 	 
								The organizational unit in the Active Directory domain to which the virtual machine belongs. The distinguished name must be provided. For example CN=Users,DC=lab,DC=local
							

							 
	 
								Configure Time Zone
							

							 	 
								The time zone for the virtual machine. Select this check box and select a time zone from the Time Zone list.
							

							 
	 
								Admin Password
							

							 	 
								The administrative user password for the virtual machine. Click the disclosure arrow to display the settings for this option.
							

							 
	 
								Admin Password → Use already configured password
							

							 	 
								This check box is automatically selected after you specify an initial administrative user password. You must clear this check box to enable the Admin Password and Verify Admin Password fields and specify a new password.
							

							 
	 
								Admin Password → Admin Password
							

							 	 
								The administrative user password for the virtual machine. Enter the password in this text field and the Verify Admin Password text field to verify the password.
							

							 
	 
								Custom Locale
							

							 	 
								Locales must be in a format such as en-US. Click the disclosure arrow to display the settings for this option.
							

							 
	 
								Custom Locale → Input Locale
							

							 	 
								The locale for user input.
							

							 
	 
								Custom Locale → UI Language
							

							 	 
								The language used for user interface elements such as buttons and menus.
							

							 
	 
								Custom Locale → System Locale
							

							 	 
								The locale for the overall system.
							

							 
	 
								Custom Locale → User Locale
							

							 	 
								The locale for users.
							

							 
	 
								Sysprep
							

							 	 
								A custom Sysprep definition. The definition must be in the format of a complete unattended installation answer file. You can copy and paste the default answer files in the /usr/share/ovirt-engine/conf/sysprep/ directory on the machine on which the Red Hat Virtualization Manager is installed and alter the fields as required. The definition will overwrite any values entered in the Initial Run fields. See Templates for more information.
							

							 
	 
								Domain
							

							 	 
								The Active Directory domain to which the virtual machine belongs. If left blank, the value of the previous Domain field is used.
							

							 
	 
								Alternate Credentials
							

							 	 
								Selecting this check box allows you to set a User Name and Password as alternative credentials.
							

							 




				The System section enables you to define the supported machine type or CPU type.
			
Table A.17. System Section
	Field Name	Description
	 
								Custom Emulated Machine
							

							 	 
								This option allows you to specify the machine type. If changed, the virtual machine will only run on hosts that support this machine type. Defaults to the cluster’s default machine type.
							

							 
	 
								Custom CPU Type
							

							 	 
								This option allows you to specify a CPU type. If changed, the virtual machine will only run on hosts that support this CPU type. Defaults to the cluster’s default CPU type.
							

							 




				The Host section is used to define the virtual machine’s host.
			
Table A.18. Host Section
	Field Name	Description
	 
								Any host in cluster
							

							 	 
								Allocates the virtual machine to any available host.
							

							 
	 
								Specific Host(s)
							

							 	 
								Specifies a user-defined host for the virtual machine.
							

							 




				The Console section defines the protocol to connect to virtual machines.
			
Table A.19. Console Section
	Field Name	Description
	 
								Headless Mode
							

							 	 
								Select this option if you do not require a graphical console when running the machine for the first time. See Configuring Headless Machines for more information.
							

							 
	 
								VNC
							

							 	 
								Requires a VNC client to connect to a virtual machine using VNC. Optionally, specify VNC Keyboard Layout from the drop-down list.
							

							 
	 
								SPICE
							

							 	 
								Recommended protocol for Linux and Windows virtual machines. Using SPICE protocol with QXLDOD drivers is supported for Windows 10 and Windows Server 2016 and later virtual machines.
							

							 
	 
								Enable SPICE file transfer
							

							 	 
								Determines whether you can drag and drop files from an external host into the virtual machine’s SPICE console. This option is only available for virtual machines using the SPICE protocol. This check box is selected by default.
							

							 
	 
								Enable SPICE clipboard copy and paste
							

							 	 
								Defines whether you can copy and paste content from an external host into the virtual machine’s SPICE console. This option is only available for virtual machines using the SPICE protocol. This check box is selected by default.
							

							 




				The Custom Properties section contains additional VDSM options for running virtual machines. See New VMs Custom Properties for details.
			

Explanation of Settings in the New Network Interface and Edit Network Interface Windows




				These settings apply when you are adding or editing a virtual machine network interface. If you have more than one network interface attached to a virtual machine, you can put the virtual machine on more than one logical network.
			
Table A.20. Network Interface Settings
	Field Name	Description	Power cycle required?
	 
								Name
							

							 	 
								The name of the network interface. This text field has a 21-character limit and must be a unique name with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores.
							

							 	 
								No.
							

							 
	 
								Profile
							

							 	 
								The vNIC profile and logical network that the network interface is placed on. By default, all network interfaces are put on the ovirtmgmt management network.
							

							 	 
								No.
							

							 
	 
								Type
							

							 	 
								The virtual interface the network interface presents to virtual machines.
							

							 	
										rtl8139 and e1000 device drivers are included in most operating systems.
									
	
										VirtIO is faster but requires VirtIO drivers. Red Hat Enterprise Linux 5 and later include VirtIO drivers. Windows does not include VirtIO drivers, but they can be installed from the guest tools ISO or virtual floppy disk.
									
	
										PCI Passthrough enables the vNIC to be directly connected to a virtual function (VF) of an SR-IOV-enabled NIC. The vNIC will then bypass the software network virtualization and connect directly to the VF for direct device assignment. The selected vNIC profile must also have Passthrough enabled.
									



							 	 
								Yes.
							

							 
	 
								Custom MAC address
							

							 	 
								Choose this option to set a custom MAC address. The Red Hat Virtualization Manager automatically generates a MAC address that is unique to the environment to identify the network interface. Having two devices with the same MAC address online in the same network causes networking conflicts.
							

							 	 
								Yes.
							

							 
	 
								Link State
							

							 	 
								Whether or not the network interface is connected to the logical network.
							

							 	
										Up: The network interface is located on its slot.
									
	
												When the Card Status is Plugged, it means the network interface is connected to a network cable, and is active.
											
	
												When the Card Status is Unplugged, the network interface will automatically be connected to the network and become active once plugged.
											



	
										Down: The network interface is located on its slot, but it is not connected to any network. Virtual machines will not be able to run in this state.
									



							 	 
								No.
							

							 
	 
								Card Status
							

							 	 
								Whether or not the network interface is defined on the virtual machine.
							

							 	
										Plugged: The network interface has been defined on the virtual machine.
									
	
												If its Link State is Up, it means the network interface is connected to a network cable, and is active.
											
	
												If its Link State is Down, the network interface is not connected to a network cable.
											



	
										Unplugged: The network interface is only defined on the Manager, and is not associated with a virtual machine.
									
	
												If its Link State is Up, when the network interface is plugged it will automatically be connected to a network and become active.
											
	
												If its Link State is Down, the network interface is not connected to any network until it is defined on a virtual machine.
											






							 	 
								No.
							

							 




Explanation of settings in the New Virtual Disk and Edit Virtual Disk windows



Note

					The following tables do not include information on whether a power cycle is required because that information is not applicable to these scenarios.
				

Table A.21. New Virtual Disk and Edit Virtual Disk settings: Image
	Field Name	Description
	 
								Size(GB)
							

							 	 
								The size of the new virtual disk in GB.
							

							 
	 
								Alias
							

							 	 
								The name of the virtual disk, limited to 40 characters.
							

							 
	 
								Description
							

							 	 
								A description of the virtual disk. This field is recommended but not mandatory.
							

							 
	 
								Interface
							

							 	 
								The virtual interface the disk presents to virtual machines. VirtIO is faster, but requires drivers. Red Hat Enterprise Linux 5 and later include these drivers. Windows does not include these drivers, but you can install them from the virtio-win ISO image. IDE and SATA devices do not require special drivers.
							

							 
								The interface type can be updated after stopping all virtual machines that the disk is attached to.
							

							 
	 
								Data Center
							

							 	 
								The data center in which the virtual disk will be available.
							

							 
	 
								Storage Domain
							

							 	 
								The storage domain in which the virtual disk will be stored. The drop-down list shows all storage domains available in the given data center, and also shows the total space and currently available space in the storage domain.
							

							 
	 
								Allocation Policy
							

							 	 
								The provisioning policy for the new virtual disk.
							

							 	
										Preallocated allocates the entire size of the disk on the storage domain at the time the virtual disk is created. The virtual size and the actual size of a preallocated disk are the same. Preallocated virtual disks take more time to create than thin provisioned virtual disks, but have better read and write performance. Preallocated virtual disks are recommended for servers and other I/O intensive virtual machines. If a virtual machine is able to write more than 1 GB every four seconds, use preallocated disks where possible.
									
	
										Thin Provision allocates 1 GB at the time the virtual disk is created and sets a maximum limit on the size to which the disk can grow. The virtual size of the disk is the maximum limit; the actual size of the disk is the space that has been allocated so far. Thin provisioned disks are faster to create than preallocated disks and allow for storage over-commitment. Thin provisioned virtual disks are recommended for desktops.
									



							 
	 
								Disk Profile
							

							 	 
								The disk profile assigned to the virtual disk. Disk profiles define the maximum amount of throughput and the maximum level of input and output operations for a virtual disk in a storage domain. Disk profiles are defined on the storage domain level based on storage quality of service entries created for data centers.
							

							 
	 
								Activate Disk(s)
							

							 	 
								Activate the virtual disk immediately after creation. This option is not available when creating a floating disk.
							

							 
	 
								Wipe After Delete
							

							 	 
								Allows you to enable enhanced security for deletion of sensitive material when the virtual disk is deleted.
							

							 
	 
								Bootable
							

							 	 
								Enables the bootable flag on the virtual disk.
							

							 
	 
								Shareable
							

							 	 
								Attaches the virtual disk to more than one virtual machine at a time.
							

							 
	 
								Read Only
							

							 	 
								Allows you to set the disk as read-only. The same disk can be attached as read-only to one virtual machine, and as rewritable to another. This option is not available when creating a floating disk.
							

							 
	 
								Enable Discard
							

							 	 
								Allows you to shrink a thin provisioned disk while the virtual machine is up. For block storage, the underlying storage device must support discard calls, and the option cannot be used with Wipe After Delete unless the underlying storage supports the discard_zeroes_data property. For file storage, the underlying file system and the block device must support discard calls. If all requirements are met, SCSI UNMAP commands issued from guest virtual machines is passed on by QEMU to the underlying storage to free up the unused space.
							

							 




				The Direct LUN settings can be displayed in either Targets > LUNs or LUNs > Targets. Targets > LUNs sorts available LUNs according to the host on which they are discovered, whereas LUNs > Targets displays a single list of LUNs.
			
Table A.22. New Virtual Disk and Edit Virtual Disk settings: Direct LUN
	Field Name	Description
	 
								Alias
							

							 	 
								The name of the virtual disk, limited to 40 characters.
							

							 
	 
								Description
							

							 	 
								A description of the virtual disk. This field is recommended but not mandatory. By default the last 4 characters of the LUN ID is inserted into the field.
							

							 
								The default behavior can be configured by setting the PopulateDirectLUNDiskDescriptionWithLUNId configuration key to the appropriate value using the engine-config command. The configuration key can be set to -1 for the full LUN ID to be used, or 0 for this feature to be ignored. A positive integer populates the description with the corresponding number of characters of the LUN ID.
							

							 
	 
								Interface
							

							 	 
								The virtual interface the disk presents to virtual machines. VirtIO is faster, but requires drivers. Red Hat Enterprise Linux 5 and later include these drivers. Windows does not include these drivers, but you can install them from the virtio-win ISO image. IDE and SATA devices do not require special drivers.
							

							 
								The interface type can be updated after stopping all virtual machines that the disk is attached to.
							

							 
	 
								Data Center
							

							 	 
								The data center in which the virtual disk will be available.
							

							 
	 
								Host
							

							 	 
								The host on which the LUN will be mounted. You can select any host in the data center.
							

							 
	 
								Storage Type
							

							 	 
								The type of external LUN to add. You can select from either iSCSI or Fibre Channel.
							

							 
	 
								Discover Targets
							

							 	 
								This section can be expanded when you are using iSCSI external LUNs and Targets > LUNs is selected.
							

							 
								Address - The host name or IP address of the target server.
							

							 
								Port - The port by which to attempt a connection to the target server. The default port is 3260.
							

							 
								User Authentication - The iSCSI server requires User Authentication. The User Authentication field is visible when you are using iSCSI external LUNs.
							

							 
								CHAP user name - The user name of a user with permission to log in to LUNs. This field is accessible when the User Authentication check box is selected.
							

							 
								CHAP password - The password of a user with permission to log in to LUNs. This field is accessible when the User Authentication check box is selected.
							

							 
	 
								Activate Disk(s)
							

							 	 
								Activate the virtual disk immediately after creation. This option is not available when creating a floating disk.
							

							 
	 
								Bootable
							

							 	 
								Allows you to enable the bootable flag on the virtual disk.
							

							 
	 
								Shareable
							

							 	 
								Allows you to attach the virtual disk to more than one virtual machine at a time.
							

							 
	 
								Read Only
							

							 	 
								Allows you to set the disk as read-only. The same disk can be attached as read-only to one virtual machine, and as rewritable to another. This option is not available when creating a floating disk.
							

							 
	 
								Enable Discard
							

							 	 
								Allows you to shrink a thin provisioned disk while the virtual machine is up. With this option enabled, SCSI UNMAP commands issued from guest virtual machines is passed on by QEMU to the underlying storage to free up the unused space.
							

							 
	 
								Enable SCSI Pass-Through
							

							 	 
								Available when the Interface is set to VirtIO-SCSI. Selecting this check box enables passthrough of a physical SCSI device to the virtual disk. A VirtIO-SCSI interface with SCSI passthrough enabled automatically includes SCSI discard support. Read Only is not supported when this check box is selected.
							

							 
								When this check box is not selected, the virtual disk uses an emulated SCSI device. Read Only is supported on emulated VirtIO-SCSI disks.
							

							 
	 
								Allow Privileged SCSI I/O
							

							 	 
								Available when the Enable SCSI Pass-Through check box is selected. Selecting this check box enables unfiltered SCSI Generic I/O (SG_IO) access, allowing privileged SG_IO commands on the disk. This is required for persistent reservations.
							

							 
	 
								Using SCSI Reservation
							

							 	 
								Available when the Enable SCSI Pass-Through and Allow Privileged SCSI I/O check boxes are selected. Selecting this check box disables migration for any virtual machine using this disk, to prevent virtual machines that are using SCSI reservation from losing access to the disk.
							

							 




				Fill in the fields in the Discover Targets section and click Discover to discover the target server. You can then click the Login All button to list the available LUNs on the target server and, using the radio buttons next to each LUN, select the LUN to add.
			

				Using LUNs directly as virtual machine hard disk images removes a layer of abstraction between your virtual machines and their data.
			

				The following considerations must be made when using a direct LUN as a virtual machine hard disk image:
			
	
						Live storage migration of direct LUN hard disk images is not supported.
					
	
						Direct LUN disks are not included in virtual machine exports.
					
	
						Direct LUN disks are not included in virtual machine snapshots.
					


Important

					Mounting a journaled file system requires read-write access. Using the Read Only option is not appropriate for virtual disks that contain such file systems (e.g. EXT3, EXT4, or XFS).
				


Explanation of Settings in the New Template Window




				The following table details the settings for the New Template window.
			
Note

					The following tables do not include information on whether a power cycle is required because that information is not applicable to this scenario.
				

	
						New Template Settings
					


	 
								Field
							

							 
	 
								Description/Action
							

							 
	 
								Name
							

							 
	 
								The name of the template. This is the name by which the template is listed in the Templates tab in the Administration Portal and is accessed via the REST API. This text field has a 40-character limit and must be a unique name within the data center with any combination of uppercase and lowercase letters, numbers, hyphens, and underscores. The name can be reused in different data centers in the environment.
							

							 
	 
								Description
							

							 
	 
								A description of the template. This field is recommended but not mandatory.
							

							 
	 
								Comment
							

							 
	 
								A field for adding plain text, human-readable comments regarding the template.
							

							 
	 
								Cluster
							

							 
	 
								The cluster with which the template is associated. This is the same as the original virtual machines by default. You can select any cluster in the data center.
							

							 
	 
								CPU Profile
							

							 
	 
								The CPU profile assigned to the template. CPU profiles define the maximum amount of processing capability a virtual machine can access on the host on which it runs, expressed as a percent of the total processing capability available to that host. CPU profiles are defined for a cluster based on quality of service entries created for data centers.
							

							 
	 
								Create as a Template Sub-Version
							

							 
	 
								Specifies whether the template is created as a new version of an existing template. Select this check box to access the settings for configuring this option.
							

							 	
										Root Template: The template under which the sub-template is added.
									
	
										Sub-Version Name: The name of the template. This is the name by which the template is accessed when creating a new virtual machine based on the template. If the virtual machine is stateless, the list of sub-versions will contain a latest option rather than the name of the latest sub-version. This option automatically applies the latest template sub-version to the virtual machine upon reboot. Sub-versions are particularly useful when working with pools of stateless virtual machines.
									



							 
	 
								Disks Allocation
							

							 
	 
								Alias - An alias for the virtual disk used by the template. By default, the alias is set to the same value as that of the source virtual machine.
							

							 
								Virtual Size - The total amount of disk space that a virtual machine based on the template can use. This value cannot be edited, and is provided for reference only. This value corresponds with the size, in GB, that was specified when the disk was created or edited.
							

							 
								Format - The format of the virtual disk used by the template. The available options are QCOW2 and Raw. By default, the format is set to Raw.
							

							 
								Target - The storage domain on which the virtual disk used by the template is stored. By default, the storage domain is set to the same value as that of the source virtual machine. You can select any storage domain in the cluster.
							

							 
								Disk Profile - The disk profile to assign to the virtual disk used by the template. Disk profiles are created based on storage profiles defined in the data centers. For more information, see Creating a Disk Profile.
							

							 
	 
								Allow all users to access this Template
							

							 
	 
								Specifies whether a template is public or private. A public template can be accessed by all users, whereas a private template can only be accessed by users with the TemplateAdmin or SuperUser roles.
							

							 
	 
								Copy VM permissions
							

							 
	 
								Copies explicit permissions that have been set on the source virtual machine to the template.
							

							 
	 
								Seal Template (Linux only)
							

							 
	 
								Specifies whether a template is sealed. 'Sealing' is an operation that erases all machine-specific configurations from a filesystem, including SSH keys, UDEV rules, MAC addresses, system ID, and hostname. This setting prevents a virtual machine based on this template from inheriting the configuration of the source virtual machine.
							

							 




Appendix B. virt-sysprep Operations




			The virt-sysprep command removes system-specific details.
		

			Only operations marked with * are performed during the template sealing process.
		
# virt-sysprep --list-operations
abrt-data * Remove the crash data generated by ABRT
bash-history * Remove the bash history in the guest
blkid-tab * Remove blkid tab in the guest
ca-certificates   Remove CA certificates in the guest
crash-data * Remove the crash data generated by kexec-tools
cron-spool * Remove user at-jobs and cron-jobs
customize * Customize the guest
dhcp-client-state * Remove DHCP client leases
dhcp-server-state * Remove DHCP server leases
dovecot-data * Remove Dovecot (mail server) data
firewall-rules   Remove the firewall rules
flag-reconfiguration   Flag the system for reconfiguration
fs-uuids   Change filesystem UUIDs
kerberos-data   Remove Kerberos data in the guest
logfiles * Remove many log files from the guest
lvm-uuids * Change LVM2 PV and VG UUIDs
machine-id * Remove the local machine ID
mail-spool * Remove email from the local mail spool directory
net-hostname * Remove HOSTNAME in network interface configuration
net-hwaddr * Remove HWADDR (hard-coded MAC address) configuration
pacct-log * Remove the process accounting log files
package-manager-cache * Remove package manager cache
pam-data * Remove the PAM data in the guest
puppet-data-log * Remove the data and log files of puppet
rh-subscription-manager * Remove the RH subscription manager files
rhn-systemid * Remove the RHN system ID
rpm-db * Remove host-specific RPM database files
samba-db-log * Remove the database and log files of Samba
script * Run arbitrary scripts against the guest
smolt-uuid * Remove the Smolt hardware UUID
ssh-hostkeys * Remove the SSH host keys in the guest
ssh-userdir * Remove ".ssh" directories in the guest
sssd-db-log * Remove the database and log files of sssd
tmp-files * Remove temporary files
udev-persistent-net * Remove udev persistent net rules
user-account   Remove the user accounts in the guest
utmp * Remove the utmp file
yum-uuid * Remove the yum UUID
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# Highlight.js

Highlight.js — это подсветчик синтаксиса, написанный на JavaScript. Он работает
и в браузере, и на сервере. Он работает с практически любой HTML разметкой, не
зависит от каких-либо фреймворков и умеет автоматически определять язык.


## Начало работы

Минимум, что нужно сделать для использования highlight.js на веб-странице — это
подключить библиотеку, CSS-стили и вызывать [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

Библиотека найдёт и раскрасит код внутри тегов `<pre><code>`, попытавшись
автоматически определить язык. Когда автоопределение не срабатывает, можно явно
указать язык в атрибуте class:

```html
<pre><code class="html">...</code></pre>
```

Список поддерживаемых классов языков доступен в [справочнике по классам][8].
Класс также можно предваоить префиксами `language-` или `lang-`.

Чтобы отключить подсветку для какого-то блока, используйте класс `nohighlight`:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Инициализация вручную

Чтобы иметь чуть больше контроля за инициализацией подсветки, вы можете
использовать функции [`highlightBlock`][2] и [`configure`][3]. Таким образом
можно управлять тем, *что* подсвечивать и *когда*.

Вот пример инициализация, эквивалентной вызову [`initHighlightingOnLoad`][1], но
с использованием jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

Вы можете использовать любые теги разметки вместо `<pre><code>`. Если
используете контейнер, не сохраняющий переводы строк, вам нужно сказать
highlight.js использовать для них тег `<br>`:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

Другие опции можно найти в документации функции [`configure`][3].


## Установка библиотеки

Highlight.js можно использовать в браузере прямо с CDN хостинга или скачать
индивидуальную сборку, а также установив модуль на сервере. На
[страница загрузки][4] подробно описаны все варианты.

Обратите внимание, что библиотека не предназначена для использования в виде
исходного кода на GitHub, а требует отдельной сборки. Если вам не подходит ни
один из готовых вариантов, читайте [документацию по сборке][5].


## Лицензия

Highlight.js распространяется под лицензией BSD. Подробнее читайте файл
[LICENSE][10].


## Ссылки

Официальный сайт билиотеки расположен по адресу <https://highlightjs.org/>.

Более подробная документация по API и другим темам расположена на
<http://highlightjs.readthedocs.org/>.

Авторы и контрибьютора перечислена в файле [AUTHORS.ru.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.ru.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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/*! jQuery v1.7.1 jquery.com | jquery.org/license */
(function(a,b){function cy(a){return f.isWindow(a)?a:a.nodeType===9?a.defaultView||a.parentWindow:!1}function cv(a){if(!ck[a]){var b=c.body,d=f("<"+a+">").appendTo(b),e=d.css("display");d.remove();if(e==="none"||e===""){cl||(cl=c.createElement("iframe"),cl.frameBorder=cl.width=cl.height=0),b.appendChild(cl);if(!cm||!cl.createElement)cm=(cl.contentWindow||cl.contentDocument).document,cm.write((c.compatMode==="CSS1Compat"?"<!doctype html>":"")+"<html><body>"),cm.close();d=cm.createElement(a),cm.body.appendChild(d),e=f.css(d,"display"),b.removeChild(cl)}ck[a]=e}return ck[a]}function cu(a,b){var c={};f.each(cq.concat.apply([],cq.slice(0,b)),function(){c[this]=a});return c}function ct(){cr=b}function cs(){setTimeout(ct,0);return cr=f.now()}function cj(){try{return new a.ActiveXObject("Microsoft.XMLHTTP")}catch(b){}}function ci(){try{return new a.XMLHttpRequest}catch(b){}}function cc(a,c){a.dataFilter&&(c=a.dataFilter(c,a.dataType));var d=a.dataTypes,e={},g,h,i=d.length,j,k=d[0],l,m,n,o,p;for(g=1;g<i;g++){if(g===1)for(h in a.converters)typeof h=="string"&&(e[h.toLowerCase()]=a.converters[h]);l=k,k=d[g];if(k==="*")k=l;else if(l!=="*"&&l!==k){m=l+" "+k,n=e[m]||e["* "+k];if(!n){p=b;for(o in e){j=o.split(" ");if(j[0]===l||j[0]==="*"){p=e[j[1]+" "+k];if(p){o=e[o],o===!0?n=p:p===!0&&(n=o);break}}}}!n&&!p&&f.error("No conversion from "+m.replace(" "," to ")),n!==!0&&(c=n?n(c):p(o(c)))}}return c}function cb(a,c,d){var e=a.contents,f=a.dataTypes,g=a.responseFields,h,i,j,k;for(i in g)i in d&&(c[g[i]]=d[i]);while(f[0]==="*")f.shift(),h===b&&(h=a.mimeType||c.getResponseHeader("content-type"));if(h)for(i in e)if(e[i]&&e[i].test(h)){f.unshift(i);break}if(f[0]in d)j=f[0];else{for(i in d){if(!f[0]||a.converters[i+" "+f[0]]){j=i;break}k||(k=i)}j=j||k}if(j){j!==f[0]&&f.unshift(j);return d[j]}}function ca(a,b,c,d){if(f.isArray(b))f.each(b,function(b,e){c||bE.test(a)?d(a,e):ca(a+"["+(typeof e=="object"||f.isArray(e)?b:"")+"]",e,c,d)});else if(!c&&b!=null&&typeof b=="object")for(var e in b)ca(a+"["+e+"]",b[e],c,d);else d(a,b)}function b_(a,c){var d,e,g=f.ajaxSettings.flatOptions||{};for(d in c)c[d]!==b&&((g[d]?a:e||(e={}))[d]=c[d]);e&&f.extend(!0,a,e)}function b$(a,c,d,e,f,g){f=f||c.dataTypes[0],g=g||{},g[f]=!0;var h=a[f],i=0,j=h?h.length:0,k=a===bT,l;for(;i<j&&(k||!l);i++)l=h[i](c,d,e),typeof l=="string"&&(!k||g[l]?l=b:(c.dataTypes.unshift(l),l=b$(a,c,d,e,l,g)));(k||!l)&&!g["*"]&&(l=b$(a,c,d,e,"*",g));return l}function bZ(a){return function(b,c){typeof b!="string"&&(c=b,b="*");if(f.isFunction(c)){var d=b.toLowerCase().split(bP),e=0,g=d.length,h,i,j;for(;e<g;e++)h=d[e],j=/^\+/.test(h),j&&(h=h.substr(1)||"*"),i=a[h]=a[h]||[],i[j?"unshift":"push"](c)}}}function bC(a,b,c){var d=b==="width"?a.offsetWidth:a.offsetHeight,e=b==="width"?bx:by,g=0,h=e.length;if(d>0){if(c!=="border")for(;g<h;g++)c||(d-=parseFloat(f.css(a,"padding"+e[g]))||0),c==="margin"?d+=parseFloat(f.css(a,c+e[g]))||0:d-=parseFloat(f.css(a,"border"+e[g]+"Width"))||0;return d+"px"}d=bz(a,b,b);if(d<0||d==null)d=a.style[b]||0;d=parseFloat(d)||0;if(c)for(;g<h;g++)d+=parseFloat(f.css(a,"padding"+e[g]))||0,c!=="padding"&&(d+=parseFloat(f.css(a,"border"+e[g]+"Width"))||0),c==="margin"&&(d+=parseFloat(f.css(a,c+e[g]))||0);return d+"px"}function bp(a,b){b.src?f.ajax({url:b.src,async:!1,dataType:"script"}):f.globalEval((b.text||b.textContent||b.innerHTML||"").replace(bf,"/*$0*/")),b.parentNode&&b.parentNode.removeChild(b)}function bo(a){var b=c.createElement("div");bh.appendChild(b),b.innerHTML=a.outerHTML;return b.firstChild}function bn(a){var b=(a.nodeName||"").toLowerCase();b==="input"?bm(a):b!=="script"&&typeof a.getElementsByTagName!="undefined"&&f.grep(a.getElementsByTagName("input"),bm)}function bm(a){if(a.type==="checkbox"||a.type==="radio")a.defaultChecked=a.checked}function bl(a){return typeof a.getElementsByTagName!="undefined"?a.getElementsByTagName("*"):typeof a.querySelectorAll!="undefined"?a.querySelectorAll("*"):[]}function bk(a,b){var c;if(b.nodeType===1){b.clearAttributes&&b.clearAttributes(),b.mergeAttributes&&b.mergeAttributes(a),c=b.nodeName.toLowerCase();if(c==="object")b.outerHTML=a.outerHTML;else if(c!=="input"||a.type!=="checkbox"&&a.type!=="radio"){if(c==="option")b.selected=a.defaultSelected;else if(c==="input"||c==="textarea")b.defaultValue=a.defaultValue}else a.checked&&(b.defaultChecked=b.checked=a.checked),b.value!==a.value&&(b.value=a.value);b.removeAttribute(f.expando)}}function bj(a,b){if(b.nodeType===1&&!!f.hasData(a)){var c,d,e,g=f._data(a),h=f._data(b,g),i=g.events;if(i){delete h.handle,h.events={};for(c in i)for(d=0,e=i[c].length;d<e;d++)f.event.add(b,c+(i[c][d].namespace?".":"")+i[c][d].namespace,i[c][d],i[c][d].data)}h.data&&(h.data=f.extend({},h.data))}}function bi(a,b){return f.nodeName(a,"table")?a.getElementsByTagName("tbody")[0]||a.appendChild(a.ownerDocument.createElement("tbody")):a}function U(a){var b=V.split("|"),c=a.createDocumentFragment();if(c.createElement)while(b.length)c.createElement(b.pop());return c}function T(a,b,c){b=b||0;if(f.isFunction(b))return f.grep(a,function(a,d){var e=!!b.call(a,d,a);return e===c});if(b.nodeType)return f.grep(a,function(a,d){return a===b===c});if(typeof b=="string"){var d=f.grep(a,function(a){return a.nodeType===1});if(O.test(b))return f.filter(b,d,!c);b=f.filter(b,d)}return f.grep(a,function(a,d){return f.inArray(a,b)>=0===c})}function S(a){return!a||!a.parentNode||a.parentNode.nodeType===11}function K(){return!0}function J(){return!1}function n(a,b,c){var d=b+"defer",e=b+"queue",g=b+"mark",h=f._data(a,d);h&&(c==="queue"||!f._data(a,e))&&(c==="mark"||!f._data(a,g))&&setTimeout(function(){!f._data(a,e)&&!f._data(a,g)&&(f.removeData(a,d,!0),h.fire())},0)}function m(a){for(var b in a){if(b==="data"&&f.isEmptyObject(a[b]))continue;if(b!=="toJSON")return!1}return!0}function l(a,c,d){if(d===b&&a.nodeType===1){var e="data-"+c.replace(k,"-$1").toLowerCase();d=a.getAttribute(e);if(typeof d=="string"){try{d=d==="true"?!0:d==="false"?!1:d==="null"?null:f.isNumeric(d)?parseFloat(d):j.test(d)?f.parseJSON(d):d}catch(g){}f.data(a,c,d)}else d=b}return d}function h(a){var b=g[a]={},c,d;a=a.split(/\s+/);for(c=0,d=a.length;c<d;c++)b[a[c]]=!0;return b}var c=a.document,d=a.navigator,e=a.location,f=function(){function J(){if(!e.isReady){try{c.documentElement.doScroll("left")}catch(a){setTimeout(J,1);return}e.ready()}}var e=function(a,b){return new e.fn.init(a,b,h)},f=a.jQuery,g=a.$,h,i=/^(?:[^#<]*(<[\w\W]+>)[^>]*$|#([\w\-]*)$)/,j=/\S/,k=/^\s+/,l=/\s+$/,m=/^<(\w+)\s*\/?>(?:<\/\1>)?$/,n=/^[\],:{}\s]*$/,o=/\\(?:["\\\/bfnrt]|u[0-9a-fA-F]{4})/g,p=/"[^"\\\n\r]*"|true|false|null|-?\d+(?:\.\d*)?(?:[eE][+\-]?\d+)?/g,q=/(?:^|:|,)(?:\s*\[)+/g,r=/(webkit)[ \/]([\w.]+)/,s=/(opera)(?:.*version)?[ \/]([\w.]+)/,t=/(msie) ([\w.]+)/,u=/(mozilla)(?:.*? rv:([\w.]+))?/,v=/-([a-z]|[0-9])/ig,w=/^-ms-/,x=function(a,b){return(b+"").toUpperCase()},y=d.userAgent,z,A,B,C=Object.prototype.toString,D=Object.prototype.hasOwnProperty,E=Array.prototype.push,F=Array.prototype.slice,G=String.prototype.trim,H=Array.prototype.indexOf,I={};e.fn=e.prototype={constructor:e,init:function(a,d,f){var g,h,j,k;if(!a)return this;if(a.nodeType){this.context=this[0]=a,this.length=1;return this}if(a==="body"&&!d&&c.body){this.context=c,this[0]=c.body,this.selector=a,this.length=1;return this}if(typeof a=="string"){a.charAt(0)!=="<"||a.charAt(a.length-1)!==">"||a.length<3?g=i.exec(a):g=[null,a,null];if(g&&(g[1]||!d)){if(g[1]){d=d instanceof e?d[0]:d,k=d?d.ownerDocument||d:c,j=m.exec(a),j?e.isPlainObject(d)?(a=[c.createElement(j[1])],e.fn.attr.call(a,d,!0)):a=[k.createElement(j[1])]:(j=e.buildFragment([g[1]],[k]),a=(j.cacheable?e.clone(j.fragment):j.fragment).childNodes);return e.merge(this,a)}h=c.getElementById(g[2]);if(h&&h.parentNode){if(h.id!==g[2])return f.find(a);this.length=1,this[0]=h}this.context=c,this.selector=a;return this}return!d||d.jquery?(d||f).find(a):this.constructor(d).find(a)}if(e.isFunction(a))return f.ready(a);a.selector!==b&&(this.selector=a.selector,this.context=a.context);return e.makeArray(a,this)},selector:"",jquery:"1.7.1",length:0,size:function(){return this.length},toArray:function(){return F.call(this,0)},get:function(a){return a==null?this.toArray():a<0?this[this.length+a]:this[a]},pushStack:function(a,b,c){var d=this.constructor();e.isArray(a)?E.apply(d,a):e.merge(d,a),d.prevObject=this,d.context=this.context,b==="find"?d.selector=this.selector+(this.selector?" ":"")+c:b&&(d.selector=this.selector+"."+b+"("+c+")");return d},each:function(a,b){return e.each(this,a,b)},ready:function(a){e.bindReady(),A.add(a);return this},eq:function(a){a=+a;return a===-1?this.slice(a):this.slice(a,a+1)},first:function(){return this.eq(0)},last:function(){return this.eq(-1)},slice:function(){return this.pushStack(F.apply(this,arguments),"slice",F.call(arguments).join(","))},map:function(a){return this.pushStack(e.map(this,function(b,c){return a.call(b,c,b)}))},end:function(){return this.prevObject||this.constructor(null)},push:E,sort:[].sort,splice:[].splice},e.fn.init.prototype=e.fn,e.extend=e.fn.extend=function(){var a,c,d,f,g,h,i=arguments[0]||{},j=1,k=arguments.length,l=!1;typeof i=="boolean"&&(l=i,i=arguments[1]||{},j=2),typeof i!="object"&&!e.isFunction(i)&&(i={}),k===j&&(i=this,--j);for(;j<k;j++)if((a=arguments[j])!=null)for(c in a){d=i[c],f=a[c];if(i===f)continue;l&&f&&(e.isPlainObject(f)||(g=e.isArray(f)))?(g?(g=!1,h=d&&e.isArray(d)?d:[]):h=d&&e.isPlainObject(d)?d:{},i[c]=e.extend(l,h,f)):f!==b&&(i[c]=f)}return i},e.extend({noConflict:function(b){a.$===e&&(a.$=g),b&&a.jQuery===e&&(a.jQuery=f);return e},isReady:!1,readyWait:1,holdReady:function(a){a?e.readyWait++:e.ready(!0)},ready:function(a){if(a===!0&&!--e.readyWait||a!==!0&&!e.isReady){if(!c.body)return setTimeout(e.ready,1);e.isReady=!0;if(a!==!0&&--e.readyWait>0)return;A.fireWith(c,[e]),e.fn.trigger&&e(c).trigger("ready").off("ready")}},bindReady:function(){if(!A){A=e.Callbacks("once memory");if(c.readyState==="complete")return setTimeout(e.ready,1);if(c.addEventListener)c.addEventListener("DOMContentLoaded",B,!1),a.addEventListener("load",e.ready,!1);else if(c.attachEvent){c.attachEvent("onreadystatechange",B),a.attachEvent("onload",e.ready);var b=!1;try{b=a.frameElement==null}catch(d){}c.documentElement.doScroll&&b&&J()}}},isFunction:function(a){return e.type(a)==="function"},isArray:Array.isArray||function(a){return e.type(a)==="array"},isWindow:function(a){return a&&typeof a=="object"&&"setInterval"in a},isNumeric:function(a){return!isNaN(parseFloat(a))&&isFinite(a)},type:function(a){return a==null?String(a):I[C.call(a)]||"object"},isPlainObject:function(a){if(!a||e.type(a)!=="object"||a.nodeType||e.isWindow(a))return!1;try{if(a.constructor&&!D.call(a,"constructor")&&!D.call(a.constructor.prototype,"isPrototypeOf"))return!1}catch(c){return!1}var d;for(d in a);return d===b||D.call(a,d)},isEmptyObject:function(a){for(var b in a)return!1;return!0},error:function(a){throw new Error(a)},parseJSON:function(b){if(typeof b!="string"||!b)return null;b=e.trim(b);if(a.JSON&&a.JSON.parse)return a.JSON.parse(b);if(n.test(b.replace(o,"@").replace(p,"]").replace(q,"")))return(new Function("return "+b))();e.error("Invalid JSON: "+b)},parseXML:function(c){var d,f;try{a.DOMParser?(f=new DOMParser,d=f.parseFromString(c,"text/xml")):(d=new ActiveXObject("Microsoft.XMLDOM"),d.async="false",d.loadXML(c))}catch(g){d=b}(!d||!d.documentElement||d.getElementsByTagName("parsererror").length)&&e.error("Invalid XML: "+c);return d},noop:function(){},globalEval:function(b){b&&j.test(b)&&(a.execScript||function(b){a.eval.call(a,b)})(b)},camelCase:function(a){return a.replace(w,"ms-").replace(v,x)},nodeName:function(a,b){return a.nodeName&&a.nodeName.toUpperCase()===b.toUpperCase()},each:function(a,c,d){var f,g=0,h=a.length,i=h===b||e.isFunction(a);if(d){if(i){for(f in a)if(c.apply(a[f],d)===!1)break}else for(;g<h;)if(c.apply(a[g++],d)===!1)break}else if(i){for(f in a)if(c.call(a[f],f,a[f])===!1)break}else for(;g<h;)if(c.call(a[g],g,a[g++])===!1)break;return a},trim:G?function(a){return a==null?"":G.call(a)}:function(a){return a==null?"":(a+"").replace(k,"").replace(l,"")},makeArray:function(a,b){var c=b||[];if(a!=null){var d=e.type(a);a.length==null||d==="string"||d==="function"||d==="regexp"||e.isWindow(a)?E.call(c,a):e.merge(c,a)}return c},inArray:function(a,b,c){var d;if(b){if(H)return H.call(b,a,c);d=b.length,c=c?c<0?Math.max(0,d+c):c:0;for(;c<d;c++)if(c in b&&b[c]===a)return c}return-1},merge:function(a,c){var d=a.length,e=0;if(typeof c.length=="number")for(var f=c.length;e<f;e++)a[d++]=c[e];else while(c[e]!==b)a[d++]=c[e++];a.length=d;return a},grep:function(a,b,c){var d=[],e;c=!!c;for(var f=0,g=a.length;f<g;f++)e=!!b(a[f],f),c!==e&&d.push(a[f]);return d},map:function(a,c,d){var f,g,h=[],i=0,j=a.length,k=a instanceof e||j!==b&&typeof j=="number"&&(j>0&&a[0]&&a[j-1]||j===0||e.isArray(a));if(k)for(;i<j;i++)f=c(a[i],i,d),f!=null&&(h[h.length]=f);else for(g in a)f=c(a[g],g,d),f!=null&&(h[h.length]=f);return h.concat.apply([],h)},guid:1,proxy:function(a,c){if(typeof c=="string"){var d=a[c];c=a,a=d}if(!e.isFunction(a))return b;var f=F.call(arguments,2),g=function(){return a.apply(c,f.concat(F.call(arguments)))};g.guid=a.guid=a.guid||g.guid||e.guid++;return g},access:function(a,c,d,f,g,h){var i=a.length;if(typeof c=="object"){for(var j in c)e.access(a,j,c[j],f,g,d);return a}if(d!==b){f=!h&&f&&e.isFunction(d);for(var k=0;k<i;k++)g(a[k],c,f?d.call(a[k],k,g(a[k],c)):d,h);return a}return i?g(a[0],c):b},now:function(){return(new Date).getTime()},uaMatch:function(a){a=a.toLowerCase();var b=r.exec(a)||s.exec(a)||t.exec(a)||a.indexOf("compatible")<0&&u.exec(a)||[];return{browser:b[1]||"",version:b[2]||"0"}},sub:function(){function a(b,c){return new a.fn.init(b,c)}e.extend(!0,a,this),a.superclass=this,a.fn=a.prototype=this(),a.fn.constructor=a,a.sub=this.sub,a.fn.init=function(d,f){f&&f instanceof e&&!(f instanceof a)&&(f=a(f));return e.fn.init.call(this,d,f,b)},a.fn.init.prototype=a.fn;var b=a(c);return a},browser:{}}),e.each("Boolean Number String Function Array Date RegExp Object".split(" "),function(a,b){I["[object "+b+"]"]=b.toLowerCase()}),z=e.uaMatch(y),z.browser&&(e.browser[z.browser]=!0,e.browser.version=z.version),e.browser.webkit&&(e.browser.safari=!0),j.test(" ")&&(k=/^[\s\xA0]+/,l=/[\s\xA0]+$/),h=e(c),c.addEventListener?B=function(){c.removeEventListener("DOMContentLoaded",B,!1),e.ready()}:c.attachEvent&&(B=function(){c.readyState==="complete"&&(c.detachEvent("onreadystatechange",B),e.ready())});return e}(),g={};f.Callbacks=function(a){a=a?g[a]||h(a):{};var c=[],d=[],e,i,j,k,l,m=function(b){var d,e,g,h,i;for(d=0,e=b.length;d<e;d++)g=b[d],h=f.type(g),h==="array"?m(g):h==="function"&&(!a.unique||!o.has(g))&&c.push(g)},n=function(b,f){f=f||[],e=!a.memory||[b,f],i=!0,l=j||0,j=0,k=c.length;for(;c&&l<k;l++)if(c[l].apply(b,f)===!1&&a.stopOnFalse){e=!0;break}i=!1,c&&(a.once?e===!0?o.disable():c=[]:d&&d.length&&(e=d.shift(),o.fireWith(e[0],e[1])))},o={add:function(){if(c){var a=c.length;m(arguments),i?k=c.length:e&&e!==!0&&(j=a,n(e[0],e[1]))}return this},remove:function(){if(c){var b=arguments,d=0,e=b.length;for(;d<e;d++)for(var f=0;f<c.length;f++)if(b[d]===c[f]){i&&f<=k&&(k--,f<=l&&l--),c.splice(f--,1);if(a.unique)break}}return this},has:function(a){if(c){var b=0,d=c.length;for(;b<d;b++)if(a===c[b])return!0}return!1},empty:function(){c=[];return this},disable:function(){c=d=e=b;return this},disabled:function(){return!c},lock:function(){d=b,(!e||e===!0)&&o.disable();return this},locked:function(){return!d},fireWith:function(b,c){d&&(i?a.once||d.push([b,c]):(!a.once||!e)&&n(b,c));return this},fire:function(){o.fireWith(this,arguments);return this},fired:function(){return!!e}};return o};var i=[].slice;f.extend({Deferred:function(a){var b=f.Callbacks("once memory"),c=f.Callbacks("once memory"),d=f.Callbacks("memory"),e="pending",g={resolve:b,reject:c,notify:d},h={done:b.add,fail:c.add,progress:d.add,state:function(){return e},isResolved:b.fired,isRejected:c.fired,then:function(a,b,c){i.done(a).fail(b).progress(c);return this},always:function(){i.done.apply(i,arguments).fail.apply(i,arguments);return this},pipe:function(a,b,c){return f.Deferred(function(d){f.each({done:[a,"resolve"],fail:[b,"reject"],progress:[c,"notify"]},function(a,b){var c=b[0],e=b[1],g;f.isFunction(c)?i[a](function(){g=c.apply(this,arguments),g&&f.isFunction(g.promise)?g.promise().then(d.resolve,d.reject,d.notify):d[e+"With"](this===i?d:this,[g])}):i[a](d[e])})}).promise()},promise:function(a){if(a==null)a=h;else for(var b in h)a[b]=h[b];return a}},i=h.promise({}),j;for(j in g)i[j]=g[j].fire,i[j+"With"]=g[j].fireWith;i.done(function(){e="resolved"},c.disable,d.lock).fail(function(){e="rejected"},b.disable,d.lock),a&&a.call(i,i);return i},when:function(a){function m(a){return function(b){e[a]=arguments.length>1?i.call(arguments,0):b,j.notifyWith(k,e)}}function l(a){return function(c){b[a]=arguments.length>1?i.call(arguments,0):c,--g||j.resolveWith(j,b)}}var b=i.call(arguments,0),c=0,d=b.length,e=Array(d),g=d,h=d,j=d<=1&&a&&f.isFunction(a.promise)?a:f.Deferred(),k=j.promise();if(d>1){for(;c<d;c++)b[c]&&b[c].promise&&f.isFunction(b[c].promise)?b[c].promise().then(l(c),j.reject,m(c)):--g;g||j.resolveWith(j,b)}else j!==a&&j.resolveWith(j,d?[a]:[]);return k}}),f.support=function(){var b,d,e,g,h,i,j,k,l,m,n,o,p,q=c.createElement("div"),r=c.documentElement;q.setAttribute("className","t"),q.innerHTML="   <link/><table></table><a href='/a' style='top:1px;float:left;opacity:.55;'>a</a><input type='checkbox'/>",d=q.getElementsByTagName("*"),e=q.getElementsByTagName("a")[0];if(!d||!d.length||!e)return{};g=c.createElement("select"),h=g.appendChild(c.createElement("option")),i=q.getElementsByTagName("input")[0],b={leadingWhitespace:q.firstChild.nodeType===3,tbody:!q.getElementsByTagName("tbody").length,htmlSerialize:!!q.getElementsByTagName("link").length,style:/top/.test(e.getAttribute("style")),hrefNormalized:e.getAttribute("href")==="/a",opacity:/^0.55/.test(e.style.opacity),cssFloat:!!e.style.cssFloat,checkOn:i.value==="on",optSelected:h.selected,getSetAttribute:q.className!=="t",enctype:!!c.createElement("form").enctype,html5Clone:c.createElement("nav").cloneNode(!0).outerHTML!=="<:nav></:nav>",submitBubbles:!0,changeBubbles:!0,focusinBubbles:!1,deleteExpando:!0,noCloneEvent:!0,inlineBlockNeedsLayout:!1,shrinkWrapBlocks:!1,reliableMarginRight:!0},i.checked=!0,b.noCloneChecked=i.cloneNode(!0).checked,g.disabled=!0,b.optDisabled=!h.disabled;try{delete q.test}catch(s){b.deleteExpando=!1}!q.addEventListener&&q.attachEvent&&q.fireEvent&&(q.attachEvent("onclick",function(){b.noCloneEvent=!1}),q.cloneNode(!0).fireEvent("onclick")),i=c.createElement("input"),i.value="t",i.setAttribute("type","radio"),b.radioValue=i.value==="t",i.setAttribute("checked","checked"),q.appendChild(i),k=c.createDocumentFragment(),k.appendChild(q.lastChild),b.checkClone=k.cloneNode(!0).cloneNode(!0).lastChild.checked,b.appendChecked=i.checked,k.removeChild(i),k.appendChild(q),q.innerHTML="",a.getComputedStyle&&(j=c.createElement("div"),j.style.width="0",j.style.marginRight="0",q.style.width="2px",q.appendChild(j),b.reliableMarginRight=(parseInt((a.getComputedStyle(j,null)||{marginRight:0}).marginRight,10)||0)===0);if(q.attachEvent)for(o in{submit:1,change:1,focusin:1})n="on"+o,p=n in q,p||(q.setAttribute(n,"return;"),p=typeof q[n]=="function"),b[o+"Bubbles"]=p;k.removeChild(q),k=g=h=j=q=i=null,f(function(){var a,d,e,g,h,i,j,k,m,n,o,r=c.getElementsByTagName("body")[0];!r||(j=1,k="position:absolute;top:0;left:0;width:1px;height:1px;margin:0;",m="visibility:hidden;border:0;",n="style='"+k+"border:5px solid #000;padding:0;'",o="<div "+n+"><div></div></div>"+"<table "+n+" cellpadding='0' cellspacing='0'>"+"<tr><td></td></tr></table>",a=c.createElement("div"),a.style.cssText=m+"width:0;height:0;position:static;top:0;margin-top:"+j+"px",r.insertBefore(a,r.firstChild),q=c.createElement("div"),a.appendChild(q),q.innerHTML="<table><tr><td style='padding:0;border:0;display:none'></td><td>t</td></tr></table>",l=q.getElementsByTagName("td"),p=l[0].offsetHeight===0,l[0].style.display="",l[1].style.display="none",b.reliableHiddenOffsets=p&&l[0].offsetHeight===0,q.innerHTML="",q.style.width=q.style.paddingLeft="1px",f.boxModel=b.boxModel=q.offsetWidth===2,typeof q.style.zoom!="undefined"&&(q.style.display="inline",q.style.zoom=1,b.inlineBlockNeedsLayout=q.offsetWidth===2,q.style.display="",q.innerHTML="<div style='width:4px;'></div>",b.shrinkWrapBlocks=q.offsetWidth!==2),q.style.cssText=k+m,q.innerHTML=o,d=q.firstChild,e=d.firstChild,h=d.nextSibling.firstChild.firstChild,i={doesNotAddBorder:e.offsetTop!==5,doesAddBorderForTableAndCells:h.offsetTop===5},e.style.position="fixed",e.style.top="20px",i.fixedPosition=e.offsetTop===20||e.offsetTop===15,e.style.position=e.style.top="",d.style.overflow="hidden",d.style.position="relative",i.subtractsBorderForOverflowNotVisible=e.offsetTop===-5,i.doesNotIncludeMarginInBodyOffset=r.offsetTop!==j,r.removeChild(a),q=a=null,f.extend(b,i))});return b}();var j=/^(?:\{.*\}|\[.*\])$/,k=/([A-Z])/g;f.extend({cache:{},uuid:0,expando:"jQuery"+(f.fn.jquery+Math.random()).replace(/\D/g,""),noData:{embed:!0,object:"clsid:D27CDB6E-AE6D-11cf-96B8-444553540000",applet:!0},hasData:function(a){a=a.nodeType?f.cache[a[f.expando]]:a[f.expando];return!!a&&!m(a)},data:function(a,c,d,e){if(!!f.acceptData(a)){var g,h,i,j=f.expando,k=typeof c=="string",l=a.nodeType,m=l?f.cache:a,n=l?a[j]:a[j]&&j,o=c==="events";if((!n||!m[n]||!o&&!e&&!m[n].data)&&k&&d===b)return;n||(l?a[j]=n=++f.uuid:n=j),m[n]||(m[n]={},l||(m[n].toJSON=f.noop));if(typeof c=="object"||typeof c=="function")e?m[n]=f.extend(m[n],c):m[n].data=f.extend(m[n].data,c);g=h=m[n],e||(h.data||(h.data={}),h=h.data),d!==b&&(h[f.camelCase(c)]=d);if(o&&!h[c])return g.events;k?(i=h[c],i==null&&(i=h[f.camelCase(c)])):i=h;return i}},removeData:function(a,b,c){if(!!f.acceptData(a)){var d,e,g,h=f.expando,i=a.nodeType,j=i?f.cache:a,k=i?a[h]:h;if(!j[k])return;if(b){d=c?j[k]:j[k].data;if(d){f.isArray(b)||(b in d?b=[b]:(b=f.camelCase(b),b in d?b=[b]:b=b.split(" ")));for(e=0,g=b.length;e<g;e++)delete d[b[e]];if(!(c?m:f.isEmptyObject)(d))return}}if(!c){delete j[k].data;if(!m(j[k]))return}f.support.deleteExpando||!j.setInterval?delete j[k]:j[k]=null,i&&(f.support.deleteExpando?delete a[h]:a.removeAttribute?a.removeAttribute(h):a[h]=null)}},_data:function(a,b,c){return f.data(a,b,c,!0)},acceptData:function(a){if(a.nodeName){var b=f.noData[a.nodeName.toLowerCase()];if(b)return b!==!0&&a.getAttribute("classid")===b}return!0}}),f.fn.extend({data:function(a,c){var d,e,g,h=null;if(typeof a=="undefined"){if(this.length){h=f.data(this[0]);if(this[0].nodeType===1&&!f._data(this[0],"parsedAttrs")){e=this[0].attributes;for(var i=0,j=e.length;i<j;i++)g=e[i].name,g.indexOf("data-")===0&&(g=f.camelCase(g.substring(5)),l(this[0],g,h[g]));f._data(this[0],"parsedAttrs",!0)}}return h}if(typeof a=="object")return this.each(function(){f.data(this,a)});d=a.split("."),d[1]=d[1]?"."+d[1]:"";if(c===b){h=this.triggerHandler("getData"+d[1]+"!",[d[0]]),h===b&&this.length&&(h=f.data(this[0],a),h=l(this[0],a,h));return h===b&&d[1]?this.data(d[0]):h}return this.each(function(){var b=f(this),e=[d[0],c];b.triggerHandler("setData"+d[1]+"!",e),f.data(this,a,c),b.triggerHandler("changeData"+d[1]+"!",e)})},removeData:function(a){return this.each(function(){f.removeData(this,a)})}}),f.extend({_mark:function(a,b){a&&(b=(b||"fx")+"mark",f._data(a,b,(f._data(a,b)||0)+1))},_unmark:function(a,b,c){a!==!0&&(c=b,b=a,a=!1);if(b){c=c||"fx";var d=c+"mark",e=a?0:(f._data(b,d)||1)-1;e?f._data(b,d,e):(f.removeData(b,d,!0),n(b,c,"mark"))}},queue:function(a,b,c){var d;if(a){b=(b||"fx")+"queue",d=f._data(a,b),c&&(!d||f.isArray(c)?d=f._data(a,b,f.makeArray(c)):d.push(c));return d||[]}},dequeue:function(a,b){b=b||"fx";var c=f.queue(a,b),d=c.shift(),e={};d==="inprogress"&&(d=c.shift()),d&&(b==="fx"&&c.unshift("inprogress"),f._data(a,b+".run",e),d.call(a,function(){f.dequeue(a,b)},e)),c.length||(f.removeData(a,b+"queue "+b+".run",!0),n(a,b,"queue"))}}),f.fn.extend({queue:function(a,c){typeof a!="string"&&(c=a,a="fx");if(c===b)return f.queue(this[0],a);return this.each(function(){var b=f.queue(this,a,c);a==="fx"&&b[0]!=="inprogress"&&f.dequeue(this,a)})},dequeue:function(a){return this.each(function(){f.dequeue(this,a)})},delay:function(a,b){a=f.fx?f.fx.speeds[a]||a:a,b=b||"fx";return this.queue(b,function(b,c){var d=setTimeout(b,a);c.stop=function(){clearTimeout(d)}})},clearQueue:function(a){return this.queue(a||"fx",[])},promise:function(a,c){function m(){--h||d.resolveWith(e,[e])}typeof a!="string"&&(c=a,a=b),a=a||"fx";var d=f.Deferred(),e=this,g=e.length,h=1,i=a+"defer",j=a+"queue",k=a+"mark",l;while(g--)if(l=f.data(e[g],i,b,!0)||(f.data(e[g],j,b,!0)||f.data(e[g],k,b,!0))&&f.data(e[g],i,f.Callbacks("once memory"),!0))h++,l.add(m);m();return d.promise()}});var o=/[\n\t\r]/g,p=/\s+/,q=/\r/g,r=/^(?:button|input)$/i,s=/^(?:button|input|object|select|textarea)$/i,t=/^a(?:rea)?$/i,u=/^(?:autofocus|autoplay|async|checked|controls|defer|disabled|hidden|loop|multiple|open|readonly|required|scoped|selected)$/i,v=f.support.getSetAttribute,w,x,y;f.fn.extend({attr:function(a,b){return f.access(this,a,b,!0,f.attr)},removeAttr:function(a){return this.each(function(){f.removeAttr(this,a)})},prop:function(a,b){return f.access(this,a,b,!0,f.prop)},removeProp:function(a){a=f.propFix[a]||a;return this.each(function(){try{this[a]=b,delete this[a]}catch(c){}})},addClass:function(a){var b,c,d,e,g,h,i;if(f.isFunction(a))return this.each(function(b){f(this).addClass(a.call(this,b,this.className))});if(a&&typeof a=="string"){b=a.split(p);for(c=0,d=this.length;c<d;c++){e=this[c];if(e.nodeType===1)if(!e.className&&b.length===1)e.className=a;else{g=" "+e.className+" ";for(h=0,i=b.length;h<i;h++)~g.indexOf(" "+b[h]+" ")||(g+=b[h]+" ");e.className=f.trim(g)}}}return this},removeClass:function(a){var c,d,e,g,h,i,j;if(f.isFunction(a))return this.each(function(b){f(this).removeClass(a.call(this,b,this.className))});if(a&&typeof a=="string"||a===b){c=(a||"").split(p);for(d=0,e=this.length;d<e;d++){g=this[d];if(g.nodeType===1&&g.className)if(a){h=(" "+g.className+" ").replace(o," ");for(i=0,j=c.length;i<j;i++)h=h.replace(" "+c[i]+" "," ");g.className=f.trim(h)}else g.className=""}}return this},toggleClass:function(a,b){var c=typeof a,d=typeof b=="boolean";if(f.isFunction(a))return this.each(function(c){f(this).toggleClass(a.call(this,c,this.className,b),b)});return this.each(function(){if(c==="string"){var e,g=0,h=f(this),i=b,j=a.split(p);while(e=j[g++])i=d?i:!h.hasClass(e),h[i?"addClass":"removeClass"](e)}else if(c==="undefined"||c==="boolean")this.className&&f._data(this,"__className__",this.className),this.className=this.className||a===!1?"":f._data(this,"__className__")||""})},hasClass:function(a){var b=" "+a+" ",c=0,d=this.length;for(;c<d;c++)if(this[c].nodeType===1&&(" "+this[c].className+" ").replace(o," ").indexOf(b)>-1)return!0;return!1},val:function(a){var c,d,e,g=this[0];{if(!!arguments.length){e=f.isFunction(a);return this.each(function(d){var g=f(this),h;if(this.nodeType===1){e?h=a.call(this,d,g.val()):h=a,h==null?h="":typeof h=="number"?h+="":f.isArray(h)&&(h=f.map(h,function(a){return a==null?"":a+""})),c=f.valHooks[this.nodeName.toLowerCase()]||f.valHooks[this.type];if(!c||!("set"in c)||c.set(this,h,"value")===b)this.value=h}})}if(g){c=f.valHooks[g.nodeName.toLowerCase()]||f.valHooks[g.type];if(c&&"get"in c&&(d=c.get(g,"value"))!==b)return d;d=g.value;return typeof d=="string"?d.replace(q,""):d==null?"":d}}}}),f.extend({valHooks:{option:{get:function(a){var b=a.attributes.value;return!b||b.specified?a.value:a.text}},select:{get:function(a){var b,c,d,e,g=a.selectedIndex,h=[],i=a.options,j=a.type==="select-one";if(g<0)return null;c=j?g:0,d=j?g+1:i.length;for(;c<d;c++){e=i[c];if(e.selected&&(f.support.optDisabled?!e.disabled:e.getAttribute("disabled")===null)&&(!e.parentNode.disabled||!f.nodeName(e.parentNode,"optgroup"))){b=f(e).val();if(j)return b;h.push(b)}}if(j&&!h.length&&i.length)return f(i[g]).val();return h},set:function(a,b){var c=f.makeArray(b);f(a).find("option").each(function(){this.selected=f.inArray(f(this).val(),c)>=0}),c.length||(a.selectedIndex=-1);return c}}},attrFn:{val:!0,css:!0,html:!0,text:!0,data:!0,width:!0,height:!0,offset:!0},attr:function(a,c,d,e){var g,h,i,j=a.nodeType;if(!!a&&j!==3&&j!==8&&j!==2){if(e&&c in f.attrFn)return f(a)[c](d);if(typeof a.getAttribute=="undefined")return f.prop(a,c,d);i=j!==1||!f.isXMLDoc(a),i&&(c=c.toLowerCase(),h=f.attrHooks[c]||(u.test(c)?x:w));if(d!==b){if(d===null){f.removeAttr(a,c);return}if(h&&"set"in h&&i&&(g=h.set(a,d,c))!==b)return g;a.setAttribute(c,""+d);return d}if(h&&"get"in h&&i&&(g=h.get(a,c))!==null)return g;g=a.getAttribute(c);return g===null?b:g}},removeAttr:function(a,b){var c,d,e,g,h=0;if(b&&a.nodeType===1){d=b.toLowerCase().split(p),g=d.length;for(;h<g;h++)e=d[h],e&&(c=f.propFix[e]||e,f.attr(a,e,""),a.removeAttribute(v?e:c),u.test(e)&&c in a&&(a[c]=!1))}},attrHooks:{type:{set:function(a,b){if(r.test(a.nodeName)&&a.parentNode)f.error("type property can't be changed");else if(!f.support.radioValue&&b==="radio"&&f.nodeName(a,"input")){var c=a.value;a.setAttribute("type",b),c&&(a.value=c);return b}}},value:{get:function(a,b){if(w&&f.nodeName(a,"button"))return w.get(a,b);return b in a?a.value:null},set:function(a,b,c){if(w&&f.nodeName(a,"button"))return w.set(a,b,c);a.value=b}}},propFix:{tabindex:"tabIndex",readonly:"readOnly","for":"htmlFor","class":"className",maxlength:"maxLength",cellspacing:"cellSpacing",cellpadding:"cellPadding",rowspan:"rowSpan",colspan:"colSpan",usemap:"useMap",frameborder:"frameBorder",contenteditable:"contentEditable"},prop:function(a,c,d){var e,g,h,i=a.nodeType;if(!!a&&i!==3&&i!==8&&i!==2){h=i!==1||!f.isXMLDoc(a),h&&(c=f.propFix[c]||c,g=f.propHooks[c]);return d!==b?g&&"set"in g&&(e=g.set(a,d,c))!==b?e:a[c]=d:g&&"get"in g&&(e=g.get(a,c))!==null?e:a[c]}},propHooks:{tabIndex:{get:function(a){var c=a.getAttributeNode("tabindex");return c&&c.specified?parseInt(c.value,10):s.test(a.nodeName)||t.test(a.nodeName)&&a.href?0:b}}}}),f.attrHooks.tabindex=f.propHooks.tabIndex,x={get:function(a,c){var d,e=f.prop(a,c);return e===!0||typeof e!="boolean"&&(d=a.getAttributeNode(c))&&d.nodeValue!==!1?c.toLowerCase():b},set:function(a,b,c){var d;b===!1?f.removeAttr(a,c):(d=f.propFix[c]||c,d in a&&(a[d]=!0),a.setAttribute(c,c.toLowerCase()));return c}},v||(y={name:!0,id:!0},w=f.valHooks.button={get:function(a,c){var d;d=a.getAttributeNode(c);return d&&(y[c]?d.nodeValue!=="":d.specified)?d.nodeValue:b},set:function(a,b,d){var e=a.getAttributeNode(d);e||(e=c.createAttribute(d),a.setAttributeNode(e));return e.nodeValue=b+""}},f.attrHooks.tabindex.set=w.set,f.each(["width","height"],function(a,b){f.attrHooks[b]=f.extend(f.attrHooks[b],{set:function(a,c){if(c===""){a.setAttribute(b,"auto");return c}}})}),f.attrHooks.contenteditable={get:w.get,set:function(a,b,c){b===""&&(b="false"),w.set(a,b,c)}}),f.support.hrefNormalized||f.each(["href","src","width","height"],function(a,c){f.attrHooks[c]=f.extend(f.attrHooks[c],{get:function(a){var d=a.getAttribute(c,2);return d===null?b:d}})}),f.support.style||(f.attrHooks.style={get:function(a){return a.style.cssText.toLowerCase()||b},set:function(a,b){return a.style.cssText=""+b}}),f.support.optSelected||(f.propHooks.selected=f.extend(f.propHooks.selected,{get:function(a){var b=a.parentNode;b&&(b.selectedIndex,b.parentNode&&b.parentNode.selectedIndex);return null}})),f.support.enctype||(f.propFix.enctype="encoding"),f.support.checkOn||f.each(["radio","checkbox"],function(){f.valHooks[this]={get:function(a){return a.getAttribute("value")===null?"on":a.value}}}),f.each(["radio","checkbox"],function(){f.valHooks[this]=f.extend(f.valHooks[this],{set:function(a,b){if(f.isArray(b))return a.checked=f.inArray(f(a).val(),b)>=0}})});var z=/^(?:textarea|input|select)$/i,A=/^([^\.]*)?(?:\.(.+))?$/,B=/\bhover(\.\S+)?\b/,C=/^key/,D=/^(?:mouse|contextmenu)|click/,E=/^(?:focusinfocus|focusoutblur)$/,F=/^(\w*)(?:#([\w\-]+))?(?:\.([\w\-]+))?$/,G=function(a){var b=F.exec(a);b&&(b[1]=(b[1]||"").toLowerCase(),b[3]=b[3]&&new RegExp("(?:^|\\s)"+b[3]+"(?:\\s|$)"));return b},H=function(a,b){var c=a.attributes||{};return(!b[1]||a.nodeName.toLowerCase()===b[1])&&(!b[2]||(c.id||{}).value===b[2])&&(!b[3]||b[3].test((c["class"]||{}).value))},I=function(a){return f.event.special.hover?a:a.replace(B,"mouseenter$1 mouseleave$1")};
f.event={add:function(a,c,d,e,g){var h,i,j,k,l,m,n,o,p,q,r,s;if(!(a.nodeType===3||a.nodeType===8||!c||!d||!(h=f._data(a)))){d.handler&&(p=d,d=p.handler),d.guid||(d.guid=f.guid++),j=h.events,j||(h.events=j={}),i=h.handle,i||(h.handle=i=function(a){return typeof f!="undefined"&&(!a||f.event.triggered!==a.type)?f.event.dispatch.apply(i.elem,arguments):b},i.elem=a),c=f.trim(I(c)).split(" ");for(k=0;k<c.length;k++){l=A.exec(c[k])||[],m=l[1],n=(l[2]||"").split(".").sort(),s=f.event.special[m]||{},m=(g?s.delegateType:s.bindType)||m,s=f.event.special[m]||{},o=f.extend({type:m,origType:l[1],data:e,handler:d,guid:d.guid,selector:g,quick:G(g),namespace:n.join(".")},p),r=j[m];if(!r){r=j[m]=[],r.delegateCount=0;if(!s.setup||s.setup.call(a,e,n,i)===!1)a.addEventListener?a.addEventListener(m,i,!1):a.attachEvent&&a.attachEvent("on"+m,i)}s.add&&(s.add.call(a,o),o.handler.guid||(o.handler.guid=d.guid)),g?r.splice(r.delegateCount++,0,o):r.push(o),f.event.global[m]=!0}a=null}},global:{},remove:function(a,b,c,d,e){var g=f.hasData(a)&&f._data(a),h,i,j,k,l,m,n,o,p,q,r,s;if(!!g&&!!(o=g.events)){b=f.trim(I(b||"")).split(" ");for(h=0;h<b.length;h++){i=A.exec(b[h])||[],j=k=i[1],l=i[2];if(!j){for(j in o)f.event.remove(a,j+b[h],c,d,!0);continue}p=f.event.special[j]||{},j=(d?p.delegateType:p.bindType)||j,r=o[j]||[],m=r.length,l=l?new RegExp("(^|\\.)"+l.split(".").sort().join("\\.(?:.*\\.)?")+"(\\.|$)"):null;for(n=0;n<r.length;n++)s=r[n],(e||k===s.origType)&&(!c||c.guid===s.guid)&&(!l||l.test(s.namespace))&&(!d||d===s.selector||d==="**"&&s.selector)&&(r.splice(n--,1),s.selector&&r.delegateCount--,p.remove&&p.remove.call(a,s));r.length===0&&m!==r.length&&((!p.teardown||p.teardown.call(a,l)===!1)&&f.removeEvent(a,j,g.handle),delete o[j])}f.isEmptyObject(o)&&(q=g.handle,q&&(q.elem=null),f.removeData(a,["events","handle"],!0))}},customEvent:{getData:!0,setData:!0,changeData:!0},trigger:function(c,d,e,g){if(!e||e.nodeType!==3&&e.nodeType!==8){var h=c.type||c,i=[],j,k,l,m,n,o,p,q,r,s;if(E.test(h+f.event.triggered))return;h.indexOf("!")>=0&&(h=h.slice(0,-1),k=!0),h.indexOf(".")>=0&&(i=h.split("."),h=i.shift(),i.sort());if((!e||f.event.customEvent[h])&&!f.event.global[h])return;c=typeof c=="object"?c[f.expando]?c:new f.Event(h,c):new f.Event(h),c.type=h,c.isTrigger=!0,c.exclusive=k,c.namespace=i.join("."),c.namespace_re=c.namespace?new RegExp("(^|\\.)"+i.join("\\.(?:.*\\.)?")+"(\\.|$)"):null,o=h.indexOf(":")<0?"on"+h:"";if(!e){j=f.cache;for(l in j)j[l].events&&j[l].events[h]&&f.event.trigger(c,d,j[l].handle.elem,!0);return}c.result=b,c.target||(c.target=e),d=d!=null?f.makeArray(d):[],d.unshift(c),p=f.event.special[h]||{};if(p.trigger&&p.trigger.apply(e,d)===!1)return;r=[[e,p.bindType||h]];if(!g&&!p.noBubble&&!f.isWindow(e)){s=p.delegateType||h,m=E.test(s+h)?e:e.parentNode,n=null;for(;m;m=m.parentNode)r.push([m,s]),n=m;n&&n===e.ownerDocument&&r.push([n.defaultView||n.parentWindow||a,s])}for(l=0;l<r.length&&!c.isPropagationStopped();l++)m=r[l][0],c.type=r[l][1],q=(f._data(m,"events")||{})[c.type]&&f._data(m,"handle"),q&&q.apply(m,d),q=o&&m[o],q&&f.acceptData(m)&&q.apply(m,d)===!1&&c.preventDefault();c.type=h,!g&&!c.isDefaultPrevented()&&(!p._default||p._default.apply(e.ownerDocument,d)===!1)&&(h!=="click"||!f.nodeName(e,"a"))&&f.acceptData(e)&&o&&e[h]&&(h!=="focus"&&h!=="blur"||c.target.offsetWidth!==0)&&!f.isWindow(e)&&(n=e[o],n&&(e[o]=null),f.event.triggered=h,e[h](),f.event.triggered=b,n&&(e[o]=n));return c.result}},dispatch:function(c){c=f.event.fix(c||a.event);var d=(f._data(this,"events")||{})[c.type]||[],e=d.delegateCount,g=[].slice.call(arguments,0),h=!c.exclusive&&!c.namespace,i=[],j,k,l,m,n,o,p,q,r,s,t;g[0]=c,c.delegateTarget=this;if(e&&!c.target.disabled&&(!c.button||c.type!=="click")){m=f(this),m.context=this.ownerDocument||this;for(l=c.target;l!=this;l=l.parentNode||this){o={},q=[],m[0]=l;for(j=0;j<e;j++)r=d[j],s=r.selector,o[s]===b&&(o[s]=r.quick?H(l,r.quick):m.is(s)),o[s]&&q.push(r);q.length&&i.push({elem:l,matches:q})}}d.length>e&&i.push({elem:this,matches:d.slice(e)});for(j=0;j<i.length&&!c.isPropagationStopped();j++){p=i[j],c.currentTarget=p.elem;for(k=0;k<p.matches.length&&!c.isImmediatePropagationStopped();k++){r=p.matches[k];if(h||!c.namespace&&!r.namespace||c.namespace_re&&c.namespace_re.test(r.namespace))c.data=r.data,c.handleObj=r,n=((f.event.special[r.origType]||{}).handle||r.handler).apply(p.elem,g),n!==b&&(c.result=n,n===!1&&(c.preventDefault(),c.stopPropagation()))}}return c.result},props:"attrChange attrName relatedNode srcElement altKey bubbles cancelable ctrlKey currentTarget eventPhase metaKey relatedTarget shiftKey target timeStamp view which".split(" "),fixHooks:{},keyHooks:{props:"char charCode key keyCode".split(" "),filter:function(a,b){a.which==null&&(a.which=b.charCode!=null?b.charCode:b.keyCode);return a}},mouseHooks:{props:"button buttons clientX clientY fromElement offsetX offsetY pageX pageY screenX screenY toElement".split(" "),filter:function(a,d){var e,f,g,h=d.button,i=d.fromElement;a.pageX==null&&d.clientX!=null&&(e=a.target.ownerDocument||c,f=e.documentElement,g=e.body,a.pageX=d.clientX+(f&&f.scrollLeft||g&&g.scrollLeft||0)-(f&&f.clientLeft||g&&g.clientLeft||0),a.pageY=d.clientY+(f&&f.scrollTop||g&&g.scrollTop||0)-(f&&f.clientTop||g&&g.clientTop||0)),!a.relatedTarget&&i&&(a.relatedTarget=i===a.target?d.toElement:i),!a.which&&h!==b&&(a.which=h&1?1:h&2?3:h&4?2:0);return a}},fix:function(a){if(a[f.expando])return a;var d,e,g=a,h=f.event.fixHooks[a.type]||{},i=h.props?this.props.concat(h.props):this.props;a=f.Event(g);for(d=i.length;d;)e=i[--d],a[e]=g[e];a.target||(a.target=g.srcElement||c),a.target.nodeType===3&&(a.target=a.target.parentNode),a.metaKey===b&&(a.metaKey=a.ctrlKey);return h.filter?h.filter(a,g):a},special:{ready:{setup:f.bindReady},load:{noBubble:!0},focus:{delegateType:"focusin"},blur:{delegateType:"focusout"},beforeunload:{setup:function(a,b,c){f.isWindow(this)&&(this.onbeforeunload=c)},teardown:function(a,b){this.onbeforeunload===b&&(this.onbeforeunload=null)}}},simulate:function(a,b,c,d){var e=f.extend(new f.Event,c,{type:a,isSimulated:!0,originalEvent:{}});d?f.event.trigger(e,null,b):f.event.dispatch.call(b,e),e.isDefaultPrevented()&&c.preventDefault()}},f.event.handle=f.event.dispatch,f.removeEvent=c.removeEventListener?function(a,b,c){a.removeEventListener&&a.removeEventListener(b,c,!1)}:function(a,b,c){a.detachEvent&&a.detachEvent("on"+b,c)},f.Event=function(a,b){if(!(this instanceof f.Event))return new f.Event(a,b);a&&a.type?(this.originalEvent=a,this.type=a.type,this.isDefaultPrevented=a.defaultPrevented||a.returnValue===!1||a.getPreventDefault&&a.getPreventDefault()?K:J):this.type=a,b&&f.extend(this,b),this.timeStamp=a&&a.timeStamp||f.now(),this[f.expando]=!0},f.Event.prototype={preventDefault:function(){this.isDefaultPrevented=K;var a=this.originalEvent;!a||(a.preventDefault?a.preventDefault():a.returnValue=!1)},stopPropagation:function(){this.isPropagationStopped=K;var a=this.originalEvent;!a||(a.stopPropagation&&a.stopPropagation(),a.cancelBubble=!0)},stopImmediatePropagation:function(){this.isImmediatePropagationStopped=K,this.stopPropagation()},isDefaultPrevented:J,isPropagationStopped:J,isImmediatePropagationStopped:J},f.each({mouseenter:"mouseover",mouseleave:"mouseout"},function(a,b){f.event.special[a]={delegateType:b,bindType:b,handle:function(a){var c=this,d=a.relatedTarget,e=a.handleObj,g=e.selector,h;if(!d||d!==c&&!f.contains(c,d))a.type=e.origType,h=e.handler.apply(this,arguments),a.type=b;return h}}}),f.support.submitBubbles||(f.event.special.submit={setup:function(){if(f.nodeName(this,"form"))return!1;f.event.add(this,"click._submit keypress._submit",function(a){var c=a.target,d=f.nodeName(c,"input")||f.nodeName(c,"button")?c.form:b;d&&!d._submit_attached&&(f.event.add(d,"submit._submit",function(a){this.parentNode&&!a.isTrigger&&f.event.simulate("submit",this.parentNode,a,!0)}),d._submit_attached=!0)})},teardown:function(){if(f.nodeName(this,"form"))return!1;f.event.remove(this,"._submit")}}),f.support.changeBubbles||(f.event.special.change={setup:function(){if(z.test(this.nodeName)){if(this.type==="checkbox"||this.type==="radio")f.event.add(this,"propertychange._change",function(a){a.originalEvent.propertyName==="checked"&&(this._just_changed=!0)}),f.event.add(this,"click._change",function(a){this._just_changed&&!a.isTrigger&&(this._just_changed=!1,f.event.simulate("change",this,a,!0))});return!1}f.event.add(this,"beforeactivate._change",function(a){var b=a.target;z.test(b.nodeName)&&!b._change_attached&&(f.event.add(b,"change._change",function(a){this.parentNode&&!a.isSimulated&&!a.isTrigger&&f.event.simulate("change",this.parentNode,a,!0)}),b._change_attached=!0)})},handle:function(a){var b=a.target;if(this!==b||a.isSimulated||a.isTrigger||b.type!=="radio"&&b.type!=="checkbox")return a.handleObj.handler.apply(this,arguments)},teardown:function(){f.event.remove(this,"._change");return z.test(this.nodeName)}}),f.support.focusinBubbles||f.each({focus:"focusin",blur:"focusout"},function(a,b){var d=0,e=function(a){f.event.simulate(b,a.target,f.event.fix(a),!0)};f.event.special[b]={setup:function(){d++===0&&c.addEventListener(a,e,!0)},teardown:function(){--d===0&&c.removeEventListener(a,e,!0)}}}),f.fn.extend({on:function(a,c,d,e,g){var h,i;if(typeof a=="object"){typeof c!="string"&&(d=c,c=b);for(i in a)this.on(i,c,d,a[i],g);return this}d==null&&e==null?(e=c,d=c=b):e==null&&(typeof c=="string"?(e=d,d=b):(e=d,d=c,c=b));if(e===!1)e=J;else if(!e)return this;g===1&&(h=e,e=function(a){f().off(a);return h.apply(this,arguments)},e.guid=h.guid||(h.guid=f.guid++));return this.each(function(){f.event.add(this,a,e,d,c)})},one:function(a,b,c,d){return this.on.call(this,a,b,c,d,1)},off:function(a,c,d){if(a&&a.preventDefault&&a.handleObj){var e=a.handleObj;f(a.delegateTarget).off(e.namespace?e.type+"."+e.namespace:e.type,e.selector,e.handler);return this}if(typeof a=="object"){for(var g in a)this.off(g,c,a[g]);return this}if(c===!1||typeof c=="function")d=c,c=b;d===!1&&(d=J);return this.each(function(){f.event.remove(this,a,d,c)})},bind:function(a,b,c){return this.on(a,null,b,c)},unbind:function(a,b){return this.off(a,null,b)},live:function(a,b,c){f(this.context).on(a,this.selector,b,c);return this},die:function(a,b){f(this.context).off(a,this.selector||"**",b);return this},delegate:function(a,b,c,d){return this.on(b,a,c,d)},undelegate:function(a,b,c){return arguments.length==1?this.off(a,"**"):this.off(b,a,c)},trigger:function(a,b){return this.each(function(){f.event.trigger(a,b,this)})},triggerHandler:function(a,b){if(this[0])return f.event.trigger(a,b,this[0],!0)},toggle:function(a){var b=arguments,c=a.guid||f.guid++,d=0,e=function(c){var e=(f._data(this,"lastToggle"+a.guid)||0)%d;f._data(this,"lastToggle"+a.guid,e+1),c.preventDefault();return b[e].apply(this,arguments)||!1};e.guid=c;while(d<b.length)b[d++].guid=c;return this.click(e)},hover:function(a,b){return this.mouseenter(a).mouseleave(b||a)}}),f.each("blur focus focusin focusout load resize scroll unload click dblclick mousedown mouseup mousemove mouseover mouseout mouseenter mouseleave change select submit keydown keypress keyup error contextmenu".split(" "),function(a,b){f.fn[b]=function(a,c){c==null&&(c=a,a=null);return arguments.length>0?this.on(b,null,a,c):this.trigger(b)},f.attrFn&&(f.attrFn[b]=!0),C.test(b)&&(f.event.fixHooks[b]=f.event.keyHooks),D.test(b)&&(f.event.fixHooks[b]=f.event.mouseHooks)}),function(){function x(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}if(j.nodeType===1){g||(j[d]=c,j.sizset=h);if(typeof b!="string"){if(j===b){k=!0;break}}else if(m.filter(b,[j]).length>0){k=j;break}}j=j[a]}e[h]=k}}}function w(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}j.nodeType===1&&!g&&(j[d]=c,j.sizset=h);if(j.nodeName.toLowerCase()===b){k=j;break}j=j[a]}e[h]=k}}}var a=/((?:\((?:\([^()]+\)|[^()]+)+\)|\[(?:\[[^\[\]]*\]|['"][^'"]*['"]|[^\[\]'"]+)+\]|\\.|[^ >+~,(\[\\]+)+|[>+~])(\s*,\s*)?((?:.|\r|\n)*)/g,d="sizcache"+(Math.random()+"").replace(".",""),e=0,g=Object.prototype.toString,h=!1,i=!0,j=/\\/g,k=/\r\n/g,l=/\W/;[0,0].sort(function(){i=!1;return 0});var m=function(b,d,e,f){e=e||[],d=d||c;var h=d;if(d.nodeType!==1&&d.nodeType!==9)return[];if(!b||typeof b!="string")return e;var i,j,k,l,n,q,r,t,u=!0,v=m.isXML(d),w=[],x=b;do{a.exec(""),i=a.exec(x);if(i){x=i[3],w.push(i[1]);if(i[2]){l=i[3];break}}}while(i);if(w.length>1&&p.exec(b))if(w.length===2&&o.relative[w[0]])j=y(w[0]+w[1],d,f);else{j=o.relative[w[0]]?[d]:m(w.shift(),d);while(w.length)b=w.shift(),o.relative[b]&&(b+=w.shift()),j=y(b,j,f)}else{!f&&w.length>1&&d.nodeType===9&&!v&&o.match.ID.test(w[0])&&!o.match.ID.test(w[w.length-1])&&(n=m.find(w.shift(),d,v),d=n.expr?m.filter(n.expr,n.set)[0]:n.set[0]);if(d){n=f?{expr:w.pop(),set:s(f)}:m.find(w.pop(),w.length===1&&(w[0]==="~"||w[0]==="+")&&d.parentNode?d.parentNode:d,v),j=n.expr?m.filter(n.expr,n.set):n.set,w.length>0?k=s(j):u=!1;while(w.length)q=w.pop(),r=q,o.relative[q]?r=w.pop():q="",r==null&&(r=d),o.relative[q](k,r,v)}else k=w=[]}k||(k=j),k||m.error(q||b);if(g.call(k)==="[object Array]")if(!u)e.push.apply(e,k);else if(d&&d.nodeType===1)for(t=0;k[t]!=null;t++)k[t]&&(k[t]===!0||k[t].nodeType===1&&m.contains(d,k[t]))&&e.push(j[t]);else for(t=0;k[t]!=null;t++)k[t]&&k[t].nodeType===1&&e.push(j[t]);else s(k,e);l&&(m(l,h,e,f),m.uniqueSort(e));return e};m.uniqueSort=function(a){if(u){h=i,a.sort(u);if(h)for(var b=1;b<a.length;b++)a[b]===a[b-1]&&a.splice(b--,1)}return a},m.matches=function(a,b){return m(a,null,null,b)},m.matchesSelector=function(a,b){return m(b,null,null,[a]).length>0},m.find=function(a,b,c){var d,e,f,g,h,i;if(!a)return[];for(e=0,f=o.order.length;e<f;e++){h=o.order[e];if(g=o.leftMatch[h].exec(a)){i=g[1],g.splice(1,1);if(i.substr(i.length-1)!=="\\"){g[1]=(g[1]||"").replace(j,""),d=o.find[h](g,b,c);if(d!=null){a=a.replace(o.match[h],"");break}}}}d||(d=typeof b.getElementsByTagName!="undefined"?b.getElementsByTagName("*"):[]);return{set:d,expr:a}},m.filter=function(a,c,d,e){var f,g,h,i,j,k,l,n,p,q=a,r=[],s=c,t=c&&c[0]&&m.isXML(c[0]);while(a&&c.length){for(h in o.filter)if((f=o.leftMatch[h].exec(a))!=null&&f[2]){k=o.filter[h],l=f[1],g=!1,f.splice(1,1);if(l.substr(l.length-1)==="\\")continue;s===r&&(r=[]);if(o.preFilter[h]){f=o.preFilter[h](f,s,d,r,e,t);if(!f)g=i=!0;else if(f===!0)continue}if(f)for(n=0;(j=s[n])!=null;n++)j&&(i=k(j,f,n,s),p=e^i,d&&i!=null?p?g=!0:s[n]=!1:p&&(r.push(j),g=!0));if(i!==b){d||(s=r),a=a.replace(o.match[h],"");if(!g)return[];break}}if(a===q)if(g==null)m.error(a);else break;q=a}return s},m.error=function(a){throw new Error("Syntax error, unrecognized expression: "+a)};var n=m.getText=function(a){var b,c,d=a.nodeType,e="";if(d){if(d===1||d===9){if(typeof a.textContent=="string")return a.textContent;if(typeof a.innerText=="string")return a.innerText.replace(k,"");for(a=a.firstChild;a;a=a.nextSibling)e+=n(a)}else if(d===3||d===4)return a.nodeValue}else for(b=0;c=a[b];b++)c.nodeType!==8&&(e+=n(c));return e},o=m.selectors={order:["ID","NAME","TAG"],match:{ID:/#((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,CLASS:/\.((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,NAME:/\[name=['"]*((?:[\w\u00c0-\uFFFF\-]|\\.)+)['"]*\]/,ATTR:/\[\s*((?:[\w\u00c0-\uFFFF\-]|\\.)+)\s*(?:(\S?=)\s*(?:(['"])(.*?)\3|(#?(?:[\w\u00c0-\uFFFF\-]|\\.)*)|)|)\s*\]/,TAG:/^((?:[\w\u00c0-\uFFFF\*\-]|\\.)+)/,CHILD:/:(only|nth|last|first)-child(?:\(\s*(even|odd|(?:[+\-]?\d+|(?:[+\-]?\d*)?n\s*(?:[+\-]\s*\d+)?))\s*\))?/,POS:/:(nth|eq|gt|lt|first|last|even|odd)(?:\((\d*)\))?(?=[^\-]|$)/,PSEUDO:/:((?:[\w\u00c0-\uFFFF\-]|\\.)+)(?:\((['"]?)((?:\([^\)]+\)|[^\(\)]*)+)\2\))?/},leftMatch:{},attrMap:{"class":"className","for":"htmlFor"},attrHandle:{href:function(a){return a.getAttribute("href")},type:function(a){return a.getAttribute("type")}},relative:{"+":function(a,b){var c=typeof b=="string",d=c&&!l.test(b),e=c&&!d;d&&(b=b.toLowerCase());for(var f=0,g=a.length,h;f<g;f++)if(h=a[f]){while((h=h.previousSibling)&&h.nodeType!==1);a[f]=e||h&&h.nodeName.toLowerCase()===b?h||!1:h===b}e&&m.filter(b,a,!0)},">":function(a,b){var c,d=typeof b=="string",e=0,f=a.length;if(d&&!l.test(b)){b=b.toLowerCase();for(;e<f;e++){c=a[e];if(c){var g=c.parentNode;a[e]=g.nodeName.toLowerCase()===b?g:!1}}}else{for(;e<f;e++)c=a[e],c&&(a[e]=d?c.parentNode:c.parentNode===b);d&&m.filter(b,a,!0)}},"":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("parentNode",b,f,a,d,c)},"~":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("previousSibling",b,f,a,d,c)}},find:{ID:function(a,b,c){if(typeof b.getElementById!="undefined"&&!c){var d=b.getElementById(a[1]);return d&&d.parentNode?[d]:[]}},NAME:function(a,b){if(typeof b.getElementsByName!="undefined"){var c=[],d=b.getElementsByName(a[1]);for(var e=0,f=d.length;e<f;e++)d[e].getAttribute("name")===a[1]&&c.push(d[e]);return c.length===0?null:c}},TAG:function(a,b){if(typeof b.getElementsByTagName!="undefined")return b.getElementsByTagName(a[1])}},preFilter:{CLASS:function(a,b,c,d,e,f){a=" "+a[1].replace(j,"")+" ";if(f)return a;for(var g=0,h;(h=b[g])!=null;g++)h&&(e^(h.className&&(" "+h.className+" ").replace(/[\t\n\r]/g," ").indexOf(a)>=0)?c||d.push(h):c&&(b[g]=!1));return!1},ID:function(a){return a[1].replace(j,"")},TAG:function(a,b){return a[1].replace(j,"").toLowerCase()},CHILD:function(a){if(a[1]==="nth"){a[2]||m.error(a[0]),a[2]=a[2].replace(/^\+|\s*/g,"");var b=/(-?)(\d*)(?:n([+\-]?\d*))?/.exec(a[2]==="even"&&"2n"||a[2]==="odd"&&"2n+1"||!/\D/.test(a[2])&&"0n+"+a[2]||a[2]);a[2]=b[1]+(b[2]||1)-0,a[3]=b[3]-0}else a[2]&&m.error(a[0]);a[0]=e++;return a},ATTR:function(a,b,c,d,e,f){var g=a[1]=a[1].replace(j,"");!f&&o.attrMap[g]&&(a[1]=o.attrMap[g]),a[4]=(a[4]||a[5]||"").replace(j,""),a[2]==="~="&&(a[4]=" "+a[4]+" ");return a},PSEUDO:function(b,c,d,e,f){if(b[1]==="not")if((a.exec(b[3])||"").length>1||/^\w/.test(b[3]))b[3]=m(b[3],null,null,c);else{var g=m.filter(b[3],c,d,!0^f);d||e.push.apply(e,g);return!1}else if(o.match.POS.test(b[0])||o.match.CHILD.test(b[0]))return!0;return b},POS:function(a){a.unshift(!0);return a}},filters:{enabled:function(a){return a.disabled===!1&&a.type!=="hidden"},disabled:function(a){return a.disabled===!0},checked:function(a){return a.checked===!0},selected:function(a){a.parentNode&&a.parentNode.selectedIndex;return a.selected===!0},parent:function(a){return!!a.firstChild},empty:function(a){return!a.firstChild},has:function(a,b,c){return!!m(c[3],a).length},header:function(a){return/h\d/i.test(a.nodeName)},text:function(a){var b=a.getAttribute("type"),c=a.type;return a.nodeName.toLowerCase()==="input"&&"text"===c&&(b===c||b===null)},radio:function(a){return a.nodeName.toLowerCase()==="input"&&"radio"===a.type},checkbox:function(a){return a.nodeName.toLowerCase()==="input"&&"checkbox"===a.type},file:function(a){return a.nodeName.toLowerCase()==="input"&&"file"===a.type},password:function(a){return a.nodeName.toLowerCase()==="input"&&"password"===a.type},submit:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"submit"===a.type},image:function(a){return a.nodeName.toLowerCase()==="input"&&"image"===a.type},reset:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"reset"===a.type},button:function(a){var b=a.nodeName.toLowerCase();return b==="input"&&"button"===a.type||b==="button"},input:function(a){return/input|select|textarea|button/i.test(a.nodeName)},focus:function(a){return a===a.ownerDocument.activeElement}},setFilters:{first:function(a,b){return b===0},last:function(a,b,c,d){return b===d.length-1},even:function(a,b){return b%2===0},odd:function(a,b){return b%2===1},lt:function(a,b,c){return b<c[3]-0},gt:function(a,b,c){return b>c[3]-0},nth:function(a,b,c){return c[3]-0===b},eq:function(a,b,c){return c[3]-0===b}},filter:{PSEUDO:function(a,b,c,d){var e=b[1],f=o.filters[e];if(f)return f(a,c,b,d);if(e==="contains")return(a.textContent||a.innerText||n([a])||"").indexOf(b[3])>=0;if(e==="not"){var g=b[3];for(var h=0,i=g.length;h<i;h++)if(g[h]===a)return!1;return!0}m.error(e)},CHILD:function(a,b){var c,e,f,g,h,i,j,k=b[1],l=a;switch(k){case"only":case"first":while(l=l.previousSibling)if(l.nodeType===1)return!1;if(k==="first")return!0;l=a;case"last":while(l=l.nextSibling)if(l.nodeType===1)return!1;return!0;case"nth":c=b[2],e=b[3];if(c===1&&e===0)return!0;f=b[0],g=a.parentNode;if(g&&(g[d]!==f||!a.nodeIndex)){i=0;for(l=g.firstChild;l;l=l.nextSibling)l.nodeType===1&&(l.nodeIndex=++i);g[d]=f}j=a.nodeIndex-e;return c===0?j===0:j%c===0&&j/c>=0}},ID:function(a,b){return a.nodeType===1&&a.getAttribute("id")===b},TAG:function(a,b){return b==="*"&&a.nodeType===1||!!a.nodeName&&a.nodeName.toLowerCase()===b},CLASS:function(a,b){return(" "+(a.className||a.getAttribute("class"))+" ").indexOf(b)>-1},ATTR:function(a,b){var c=b[1],d=m.attr?m.attr(a,c):o.attrHandle[c]?o.attrHandle[c](a):a[c]!=null?a[c]:a.getAttribute(c),e=d+"",f=b[2],g=b[4];return d==null?f==="!=":!f&&m.attr?d!=null:f==="="?e===g:f==="*="?e.indexOf(g)>=0:f==="~="?(" "+e+" ").indexOf(g)>=0:g?f==="!="?e!==g:f==="^="?e.indexOf(g)===0:f==="$="?e.substr(e.length-g.length)===g:f==="|="?e===g||e.substr(0,g.length+1)===g+"-":!1:e&&d!==!1},POS:function(a,b,c,d){var e=b[2],f=o.setFilters[e];if(f)return f(a,c,b,d)}}},p=o.match.POS,q=function(a,b){return"\\"+(b-0+1)};for(var r in o.match)o.match[r]=new RegExp(o.match[r].source+/(?![^\[]*\])(?![^\(]*\))/.source),o.leftMatch[r]=new RegExp(/(^(?:.|\r|\n)*?)/.source+o.match[r].source.replace(/\\(\d+)/g,q));var s=function(a,b){a=Array.prototype.slice.call(a,0);if(b){b.push.apply(b,a);return b}return a};try{Array.prototype.slice.call(c.documentElement.childNodes,0)[0].nodeType}catch(t){s=function(a,b){var c=0,d=b||[];if(g.call(a)==="[object Array]")Array.prototype.push.apply(d,a);else if(typeof a.length=="number")for(var e=a.length;c<e;c++)d.push(a[c]);else for(;a[c];c++)d.push(a[c]);return d}}var u,v;c.documentElement.compareDocumentPosition?u=function(a,b){if(a===b){h=!0;return 0}if(!a.compareDocumentPosition||!b.compareDocumentPosition)return a.compareDocumentPosition?-1:1;return a.compareDocumentPosition(b)&4?-1:1}:(u=function(a,b){if(a===b){h=!0;return 0}if(a.sourceIndex&&b.sourceIndex)return a.sourceIndex-b.sourceIndex;var c,d,e=[],f=[],g=a.parentNode,i=b.parentNode,j=g;if(g===i)return v(a,b);if(!g)return-1;if(!i)return 1;while(j)e.unshift(j),j=j.parentNode;j=i;while(j)f.unshift(j),j=j.parentNode;c=e.length,d=f.length;for(var k=0;k<c&&k<d;k++)if(e[k]!==f[k])return v(e[k],f[k]);return k===c?v(a,f[k],-1):v(e[k],b,1)},v=function(a,b,c){if(a===b)return c;var d=a.nextSibling;while(d){if(d===b)return-1;d=d.nextSibling}return 1}),function(){var a=c.createElement("div"),d="script"+(new Date).getTime(),e=c.documentElement;a.innerHTML="<a name='"+d+"'/>",e.insertBefore(a,e.firstChild),c.getElementById(d)&&(o.find.ID=function(a,c,d){if(typeof c.getElementById!="undefined"&&!d){var e=c.getElementById(a[1]);return e?e.id===a[1]||typeof e.getAttributeNode!="undefined"&&e.getAttributeNode("id").nodeValue===a[1]?[e]:b:[]}},o.filter.ID=function(a,b){var c=typeof a.getAttributeNode!="undefined"&&a.getAttributeNode("id");return a.nodeType===1&&c&&c.nodeValue===b}),e.removeChild(a),e=a=null}(),function(){var a=c.createElement("div");a.appendChild(c.createComment("")),a.getElementsByTagName("*").length>0&&(o.find.TAG=function(a,b){var c=b.getElementsByTagName(a[1]);if(a[1]==="*"){var d=[];for(var e=0;c[e];e++)c[e].nodeType===1&&d.push(c[e]);c=d}return c}),a.innerHTML="<a href='#'></a>",a.firstChild&&typeof a.firstChild.getAttribute!="undefined"&&a.firstChild.getAttribute("href")!=="#"&&(o.attrHandle.href=function(a){return a.getAttribute("href",2)}),a=null}(),c.querySelectorAll&&function(){var a=m,b=c.createElement("div"),d="__sizzle__";b.innerHTML="<p class='TEST'></p>";if(!b.querySelectorAll||b.querySelectorAll(".TEST").length!==0){m=function(b,e,f,g){e=e||c;if(!g&&!m.isXML(e)){var h=/^(\w+$)|^\.([\w\-]+$)|^#([\w\-]+$)/.exec(b);if(h&&(e.nodeType===1||e.nodeType===9)){if(h[1])return s(e.getElementsByTagName(b),f);if(h[2]&&o.find.CLASS&&e.getElementsByClassName)return s(e.getElementsByClassName(h[2]),f)}if(e.nodeType===9){if(b==="body"&&e.body)return s([e.body],f);if(h&&h[3]){var i=e.getElementById(h[3]);if(!i||!i.parentNode)return s([],f);if(i.id===h[3])return s([i],f)}try{return s(e.querySelectorAll(b),f)}catch(j){}}else if(e.nodeType===1&&e.nodeName.toLowerCase()!=="object"){var k=e,l=e.getAttribute("id"),n=l||d,p=e.parentNode,q=/^\s*[+~]/.test(b);l?n=n.replace(/'/g,"\\$&"):e.setAttribute("id",n),q&&p&&(e=e.parentNode);try{if(!q||p)return s(e.querySelectorAll("[id='"+n+"'] "+b),f)}catch(r){}finally{l||k.removeAttribute("id")}}}return a(b,e,f,g)};for(var e in a)m[e]=a[e];b=null}}(),function(){var a=c.documentElement,b=a.matchesSelector||a.mozMatchesSelector||a.webkitMatchesSelector||a.msMatchesSelector;if(b){var d=!b.call(c.createElement("div"),"div"),e=!1;try{b.call(c.documentElement,"[test!='']:sizzle")}catch(f){e=!0}m.matchesSelector=function(a,c){c=c.replace(/\=\s*([^'"\]]*)\s*\]/g,"='$1']");if(!m.isXML(a))try{if(e||!o.match.PSEUDO.test(c)&&!/!=/.test(c)){var f=b.call(a,c);if(f||!d||a.document&&a.document.nodeType!==11)return f}}catch(g){}return m(c,null,null,[a]).length>0}}}(),function(){var a=c.createElement("div");a.innerHTML="<div class='test e'></div><div class='test'></div>";if(!!a.getElementsByClassName&&a.getElementsByClassName("e").length!==0){a.lastChild.className="e";if(a.getElementsByClassName("e").length===1)return;o.order.splice(1,0,"CLASS"),o.find.CLASS=function(a,b,c){if(typeof b.getElementsByClassName!="undefined"&&!c)return b.getElementsByClassName(a[1])},a=null}}(),c.documentElement.contains?m.contains=function(a,b){return a!==b&&(a.contains?a.contains(b):!0)}:c.documentElement.compareDocumentPosition?m.contains=function(a,b){return!!(a.compareDocumentPosition(b)&16)}:m.contains=function(){return!1},m.isXML=function(a){var b=(a?a.ownerDocument||a:0).documentElement;return b?b.nodeName!=="HTML":!1};var y=function(a,b,c){var d,e=[],f="",g=b.nodeType?[b]:b;while(d=o.match.PSEUDO.exec(a))f+=d[0],a=a.replace(o.match.PSEUDO,"");a=o.relative[a]?a+"*":a;for(var h=0,i=g.length;h<i;h++)m(a,g[h],e,c);return m.filter(f,e)};m.attr=f.attr,m.selectors.attrMap={},f.find=m,f.expr=m.selectors,f.expr[":"]=f.expr.filters,f.unique=m.uniqueSort,f.text=m.getText,f.isXMLDoc=m.isXML,f.contains=m.contains}();var L=/Until$/,M=/^(?:parents|prevUntil|prevAll)/,N=/,/,O=/^.[^:#\[\.,]*$/,P=Array.prototype.slice,Q=f.expr.match.POS,R={children:!0,contents:!0,next:!0,prev:!0};f.fn.extend({find:function(a){var b=this,c,d;if(typeof a!="string")return f(a).filter(function(){for(c=0,d=b.length;c<d;c++)if(f.contains(b[c],this))return!0});var e=this.pushStack("","find",a),g,h,i;for(c=0,d=this.length;c<d;c++){g=e.length,f.find(a,this[c],e);if(c>0)for(h=g;h<e.length;h++)for(i=0;i<g;i++)if(e[i]===e[h]){e.splice(h--,1);break}}return e},has:function(a){var b=f(a);return this.filter(function(){for(var a=0,c=b.length;a<c;a++)if(f.contains(this,b[a]))return!0})},not:function(a){return this.pushStack(T(this,a,!1),"not",a)},filter:function(a){return this.pushStack(T(this,a,!0),"filter",a)},is:function(a){return!!a&&(typeof a=="string"?Q.test(a)?f(a,this.context).index(this[0])>=0:f.filter(a,this).length>0:this.filter(a).length>0)},closest:function(a,b){var c=[],d,e,g=this[0];if(f.isArray(a)){var h=1;while(g&&g.ownerDocument&&g!==b){for(d=0;d<a.length;d++)f(g).is(a[d])&&c.push({selector:a[d],elem:g,level:h});g=g.parentNode,h++}return c}var i=Q.test(a)||typeof a!="string"?f(a,b||this.context):0;for(d=0,e=this.length;d<e;d++){g=this[d];while(g){if(i?i.index(g)>-1:f.find.matchesSelector(g,a)){c.push(g);break}g=g.parentNode;if(!g||!g.ownerDocument||g===b||g.nodeType===11)break}}c=c.length>1?f.unique(c):c;return this.pushStack(c,"closest",a)},index:function(a){if(!a)return this[0]&&this[0].parentNode?this.prevAll().length:-1;if(typeof a=="string")return f.inArray(this[0],f(a));return f.inArray(a.jquery?a[0]:a,this)},add:function(a,b){var c=typeof a=="string"?f(a,b):f.makeArray(a&&a.nodeType?[a]:a),d=f.merge(this.get(),c);return this.pushStack(S(c[0])||S(d[0])?d:f.unique(d))},andSelf:function(){return this.add(this.prevObject)}}),f.each({parent:function(a){var b=a.parentNode;return b&&b.nodeType!==11?b:null},parents:function(a){return f.dir(a,"parentNode")},parentsUntil:function(a,b,c){return f.dir(a,"parentNode",c)},next:function(a){return f.nth(a,2,"nextSibling")},prev:function(a){return f.nth(a,2,"previousSibling")},nextAll:function(a){return f.dir(a,"nextSibling")},prevAll:function(a){return f.dir(a,"previousSibling")},nextUntil:function(a,b,c){return f.dir(a,"nextSibling",c)},prevUntil:function(a,b,c){return f.dir(a,"previousSibling",c)},siblings:function(a){return f.sibling(a.parentNode.firstChild,a)},children:function(a){return f.sibling(a.firstChild)},contents:function(a){return f.nodeName(a,"iframe")?a.contentDocument||a.contentWindow.document:f.makeArray(a.childNodes)}},function(a,b){f.fn[a]=function(c,d){var e=f.map(this,b,c);L.test(a)||(d=c),d&&typeof d=="string"&&(e=f.filter(d,e)),e=this.length>1&&!R[a]?f.unique(e):e,(this.length>1||N.test(d))&&M.test(a)&&(e=e.reverse());return this.pushStack(e,a,P.call(arguments).join(","))}}),f.extend({filter:function(a,b,c){c&&(a=":not("+a+")");return b.length===1?f.find.matchesSelector(b[0],a)?[b[0]]:[]:f.find.matches(a,b)},dir:function(a,c,d){var e=[],g=a[c];while(g&&g.nodeType!==9&&(d===b||g.nodeType!==1||!f(g).is(d)))g.nodeType===1&&e.push(g),g=g[c];return e},nth:function(a,b,c,d){b=b||1;var e=0;for(;a;a=a[c])if(a.nodeType===1&&++e===b)break;return a},sibling:function(a,b){var c=[];for(;a;a=a.nextSibling)a.nodeType===1&&a!==b&&c.push(a);return c}});var V="abbr|article|aside|audio|canvas|datalist|details|figcaption|figure|footer|header|hgroup|mark|meter|nav|output|progress|section|summary|time|video",W=/ jQuery\d+="(?:\d+|null)"/g,X=/^\s+/,Y=/<(?!area|br|col|embed|hr|img|input|link|meta|param)(([\w:]+)[^>]*)\/>/ig,Z=/<([\w:]+)/,$=/<tbody/i,_=/<|&#?\w+;/,ba=/<(?:script|style)/i,bb=/<(?:script|object|embed|option|style)/i,bc=new RegExp("<(?:"+V+")","i"),bd=/checked\s*(?:[^=]|=\s*.checked.)/i,be=/\/(java|ecma)script/i,bf=/^\s*<!(?:\[CDATA\[|\-\-)/,bg={option:[1,"<select multiple='multiple'>","</select>"],legend:[1,"<fieldset>","</fieldset>"],thead:[1,"<table>","</table>"],tr:[2,"<table><tbody>","</tbody></table>"],td:[3,"<table><tbody><tr>","</tr></tbody></table>"],col:[2,"<table><tbody></tbody><colgroup>","</colgroup></table>"],area:[1,"<map>","</map>"],_default:[0,"",""]},bh=U(c);bg.optgroup=bg.option,bg.tbody=bg.tfoot=bg.colgroup=bg.caption=bg.thead,bg.th=bg.td,f.support.htmlSerialize||(bg._default=[1,"div<div>","</div>"]),f.fn.extend({text:function(a){if(f.isFunction(a))return this.each(function(b){var c=f(this);c.text(a.call(this,b,c.text()))});if(typeof a!="object"&&a!==b)return this.empty().append((this[0]&&this[0].ownerDocument||c).createTextNode(a));return f.text(this)},wrapAll:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapAll(a.call(this,b))});if(this[0]){var b=f(a,this[0].ownerDocument).eq(0).clone(!0);this[0].parentNode&&b.insertBefore(this[0]),b.map(function(){var a=this;while(a.firstChild&&a.firstChild.nodeType===1)a=a.firstChild;return a}).append(this)}return this},wrapInner:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapInner(a.call(this,b))});return this.each(function(){var b=f(this),c=b.contents();c.length?c.wrapAll(a):b.append(a)})},wrap:function(a){var b=f.isFunction(a);return this.each(function(c){f(this).wrapAll(b?a.call(this,c):a)})},unwrap:function(){return this.parent().each(function(){f.nodeName(this,"body")||f(this).replaceWith(this.childNodes)}).end()},append:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.appendChild(a)})},prepend:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.insertBefore(a,this.firstChild)})},before:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this)});if(arguments.length){var a=f.clean(arguments);a.push.apply(a,this.toArray());return this.pushStack(a,"before",arguments)}},after:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this.nextSibling)});if(arguments.length){var a=this.pushStack(this,"after",arguments);a.push.apply(a,f.clean(arguments));return a}},remove:function(a,b){for(var c=0,d;(d=this[c])!=null;c++)if(!a||f.filter(a,[d]).length)!b&&d.nodeType===1&&(f.cleanData(d.getElementsByTagName("*")),f.cleanData([d])),d.parentNode&&d.parentNode.removeChild(d);return this},empty:function()
{for(var a=0,b;(b=this[a])!=null;a++){b.nodeType===1&&f.cleanData(b.getElementsByTagName("*"));while(b.firstChild)b.removeChild(b.firstChild)}return this},clone:function(a,b){a=a==null?!1:a,b=b==null?a:b;return this.map(function(){return f.clone(this,a,b)})},html:function(a){if(a===b)return this[0]&&this[0].nodeType===1?this[0].innerHTML.replace(W,""):null;if(typeof a=="string"&&!ba.test(a)&&(f.support.leadingWhitespace||!X.test(a))&&!bg[(Z.exec(a)||["",""])[1].toLowerCase()]){a=a.replace(Y,"<$1></$2>");try{for(var c=0,d=this.length;c<d;c++)this[c].nodeType===1&&(f.cleanData(this[c].getElementsByTagName("*")),this[c].innerHTML=a)}catch(e){this.empty().append(a)}}else f.isFunction(a)?this.each(function(b){var c=f(this);c.html(a.call(this,b,c.html()))}):this.empty().append(a);return this},replaceWith:function(a){if(this[0]&&this[0].parentNode){if(f.isFunction(a))return this.each(function(b){var c=f(this),d=c.html();c.replaceWith(a.call(this,b,d))});typeof a!="string"&&(a=f(a).detach());return this.each(function(){var b=this.nextSibling,c=this.parentNode;f(this).remove(),b?f(b).before(a):f(c).append(a)})}return this.length?this.pushStack(f(f.isFunction(a)?a():a),"replaceWith",a):this},detach:function(a){return this.remove(a,!0)},domManip:function(a,c,d){var e,g,h,i,j=a[0],k=[];if(!f.support.checkClone&&arguments.length===3&&typeof j=="string"&&bd.test(j))return this.each(function(){f(this).domManip(a,c,d,!0)});if(f.isFunction(j))return this.each(function(e){var g=f(this);a[0]=j.call(this,e,c?g.html():b),g.domManip(a,c,d)});if(this[0]){i=j&&j.parentNode,f.support.parentNode&&i&&i.nodeType===11&&i.childNodes.length===this.length?e={fragment:i}:e=f.buildFragment(a,this,k),h=e.fragment,h.childNodes.length===1?g=h=h.firstChild:g=h.firstChild;if(g){c=c&&f.nodeName(g,"tr");for(var l=0,m=this.length,n=m-1;l<m;l++)d.call(c?bi(this[l],g):this[l],e.cacheable||m>1&&l<n?f.clone(h,!0,!0):h)}k.length&&f.each(k,bp)}return this}}),f.buildFragment=function(a,b,d){var e,g,h,i,j=a[0];b&&b[0]&&(i=b[0].ownerDocument||b[0]),i.createDocumentFragment||(i=c),a.length===1&&typeof j=="string"&&j.length<512&&i===c&&j.charAt(0)==="<"&&!bb.test(j)&&(f.support.checkClone||!bd.test(j))&&(f.support.html5Clone||!bc.test(j))&&(g=!0,h=f.fragments[j],h&&h!==1&&(e=h)),e||(e=i.createDocumentFragment(),f.clean(a,i,e,d)),g&&(f.fragments[j]=h?e:1);return{fragment:e,cacheable:g}},f.fragments={},f.each({appendTo:"append",prependTo:"prepend",insertBefore:"before",insertAfter:"after",replaceAll:"replaceWith"},function(a,b){f.fn[a]=function(c){var d=[],e=f(c),g=this.length===1&&this[0].parentNode;if(g&&g.nodeType===11&&g.childNodes.length===1&&e.length===1){e[b](this[0]);return this}for(var h=0,i=e.length;h<i;h++){var j=(h>0?this.clone(!0):this).get();f(e[h])[b](j),d=d.concat(j)}return this.pushStack(d,a,e.selector)}}),f.extend({clone:function(a,b,c){var d,e,g,h=f.support.html5Clone||!bc.test("<"+a.nodeName)?a.cloneNode(!0):bo(a);if((!f.support.noCloneEvent||!f.support.noCloneChecked)&&(a.nodeType===1||a.nodeType===11)&&!f.isXMLDoc(a)){bk(a,h),d=bl(a),e=bl(h);for(g=0;d[g];++g)e[g]&&bk(d[g],e[g])}if(b){bj(a,h);if(c){d=bl(a),e=bl(h);for(g=0;d[g];++g)bj(d[g],e[g])}}d=e=null;return h},clean:function(a,b,d,e){var g;b=b||c,typeof b.createElement=="undefined"&&(b=b.ownerDocument||b[0]&&b[0].ownerDocument||c);var h=[],i;for(var j=0,k;(k=a[j])!=null;j++){typeof k=="number"&&(k+="");if(!k)continue;if(typeof k=="string")if(!_.test(k))k=b.createTextNode(k);else{k=k.replace(Y,"<$1></$2>");var l=(Z.exec(k)||["",""])[1].toLowerCase(),m=bg[l]||bg._default,n=m[0],o=b.createElement("div");b===c?bh.appendChild(o):U(b).appendChild(o),o.innerHTML=m[1]+k+m[2];while(n--)o=o.lastChild;if(!f.support.tbody){var p=$.test(k),q=l==="table"&&!p?o.firstChild&&o.firstChild.childNodes:m[1]==="<table>"&&!p?o.childNodes:[];for(i=q.length-1;i>=0;--i)f.nodeName(q[i],"tbody")&&!q[i].childNodes.length&&q[i].parentNode.removeChild(q[i])}!f.support.leadingWhitespace&&X.test(k)&&o.insertBefore(b.createTextNode(X.exec(k)[0]),o.firstChild),k=o.childNodes}var r;if(!f.support.appendChecked)if(k[0]&&typeof (r=k.length)=="number")for(i=0;i<r;i++)bn(k[i]);else bn(k);k.nodeType?h.push(k):h=f.merge(h,k)}if(d){g=function(a){return!a.type||be.test(a.type)};for(j=0;h[j];j++)if(e&&f.nodeName(h[j],"script")&&(!h[j].type||h[j].type.toLowerCase()==="text/javascript"))e.push(h[j].parentNode?h[j].parentNode.removeChild(h[j]):h[j]);else{if(h[j].nodeType===1){var s=f.grep(h[j].getElementsByTagName("script"),g);h.splice.apply(h,[j+1,0].concat(s))}d.appendChild(h[j])}}return h},cleanData:function(a){var b,c,d=f.cache,e=f.event.special,g=f.support.deleteExpando;for(var h=0,i;(i=a[h])!=null;h++){if(i.nodeName&&f.noData[i.nodeName.toLowerCase()])continue;c=i[f.expando];if(c){b=d[c];if(b&&b.events){for(var j in b.events)e[j]?f.event.remove(i,j):f.removeEvent(i,j,b.handle);b.handle&&(b.handle.elem=null)}g?delete i[f.expando]:i.removeAttribute&&i.removeAttribute(f.expando),delete d[c]}}}});var bq=/alpha\([^)]*\)/i,br=/opacity=([^)]*)/,bs=/([A-Z]|^ms)/g,bt=/^-?\d+(?:px)?$/i,bu=/^-?\d/,bv=/^([\-+])=([\-+.\de]+)/,bw={position:"absolute",visibility:"hidden",display:"block"},bx=["Left","Right"],by=["Top","Bottom"],bz,bA,bB;f.fn.css=function(a,c){if(arguments.length===2&&c===b)return this;return f.access(this,a,c,!0,function(a,c,d){return d!==b?f.style(a,c,d):f.css(a,c)})},f.extend({cssHooks:{opacity:{get:function(a,b){if(b){var c=bz(a,"opacity","opacity");return c===""?"1":c}return a.style.opacity}}},cssNumber:{fillOpacity:!0,fontWeight:!0,lineHeight:!0,opacity:!0,orphans:!0,widows:!0,zIndex:!0,zoom:!0},cssProps:{"float":f.support.cssFloat?"cssFloat":"styleFloat"},style:function(a,c,d,e){if(!!a&&a.nodeType!==3&&a.nodeType!==8&&!!a.style){var g,h,i=f.camelCase(c),j=a.style,k=f.cssHooks[i];c=f.cssProps[i]||i;if(d===b){if(k&&"get"in k&&(g=k.get(a,!1,e))!==b)return g;return j[c]}h=typeof d,h==="string"&&(g=bv.exec(d))&&(d=+(g[1]+1)*+g[2]+parseFloat(f.css(a,c)),h="number");if(d==null||h==="number"&&isNaN(d))return;h==="number"&&!f.cssNumber[i]&&(d+="px");if(!k||!("set"in k)||(d=k.set(a,d))!==b)try{j[c]=d}catch(l){}}},css:function(a,c,d){var e,g;c=f.camelCase(c),g=f.cssHooks[c],c=f.cssProps[c]||c,c==="cssFloat"&&(c="float");if(g&&"get"in g&&(e=g.get(a,!0,d))!==b)return e;if(bz)return bz(a,c)},swap:function(a,b,c){var d={};for(var e in b)d[e]=a.style[e],a.style[e]=b[e];c.call(a);for(e in b)a.style[e]=d[e]}}),f.curCSS=f.css,f.each(["height","width"],function(a,b){f.cssHooks[b]={get:function(a,c,d){var e;if(c){if(a.offsetWidth!==0)return bC(a,b,d);f.swap(a,bw,function(){e=bC(a,b,d)});return e}},set:function(a,b){if(!bt.test(b))return b;b=parseFloat(b);if(b>=0)return b+"px"}}}),f.support.opacity||(f.cssHooks.opacity={get:function(a,b){return br.test((b&&a.currentStyle?a.currentStyle.filter:a.style.filter)||"")?parseFloat(RegExp.$1)/100+"":b?"1":""},set:function(a,b){var c=a.style,d=a.currentStyle,e=f.isNumeric(b)?"alpha(opacity="+b*100+")":"",g=d&&d.filter||c.filter||"";c.zoom=1;if(b>=1&&f.trim(g.replace(bq,""))===""){c.removeAttribute("filter");if(d&&!d.filter)return}c.filter=bq.test(g)?g.replace(bq,e):g+" "+e}}),f(function(){f.support.reliableMarginRight||(f.cssHooks.marginRight={get:function(a,b){var c;f.swap(a,{display:"inline-block"},function(){b?c=bz(a,"margin-right","marginRight"):c=a.style.marginRight});return c}})}),c.defaultView&&c.defaultView.getComputedStyle&&(bA=function(a,b){var c,d,e;b=b.replace(bs,"-$1").toLowerCase(),(d=a.ownerDocument.defaultView)&&(e=d.getComputedStyle(a,null))&&(c=e.getPropertyValue(b),c===""&&!f.contains(a.ownerDocument.documentElement,a)&&(c=f.style(a,b)));return c}),c.documentElement.currentStyle&&(bB=function(a,b){var c,d,e,f=a.currentStyle&&a.currentStyle[b],g=a.style;f===null&&g&&(e=g[b])&&(f=e),!bt.test(f)&&bu.test(f)&&(c=g.left,d=a.runtimeStyle&&a.runtimeStyle.left,d&&(a.runtimeStyle.left=a.currentStyle.left),g.left=b==="fontSize"?"1em":f||0,f=g.pixelLeft+"px",g.left=c,d&&(a.runtimeStyle.left=d));return f===""?"auto":f}),bz=bA||bB,f.expr&&f.expr.filters&&(f.expr.filters.hidden=function(a){var b=a.offsetWidth,c=a.offsetHeight;return b===0&&c===0||!f.support.reliableHiddenOffsets&&(a.style&&a.style.display||f.css(a,"display"))==="none"},f.expr.filters.visible=function(a){return!f.expr.filters.hidden(a)});var bD=/%20/g,bE=/\[\]$/,bF=/\r?\n/g,bG=/#.*$/,bH=/^(.*?):[ \t]*([^\r\n]*)\r?$/mg,bI=/^(?:color|date|datetime|datetime-local|email|hidden|month|number|password|range|search|tel|text|time|url|week)$/i,bJ=/^(?:about|app|app\-storage|.+\-extension|file|res|widget):$/,bK=/^(?:GET|HEAD)$/,bL=/^\/\//,bM=/\?/,bN=/<script\b[^<]*(?:(?!<\/script>)<[^<]*)*<\/script>/gi,bO=/^(?:select|textarea)/i,bP=/\s+/,bQ=/([?&])_=[^&]*/,bR=/^([\w\+\.\-]+:)(?:\/\/([^\/?#:]*)(?::(\d+))?)?/,bS=f.fn.load,bT={},bU={},bV,bW,bX=["*/"]+["*"];try{bV=e.href}catch(bY){bV=c.createElement("a"),bV.href="",bV=bV.href}bW=bR.exec(bV.toLowerCase())||[],f.fn.extend({load:function(a,c,d){if(typeof a!="string"&&bS)return bS.apply(this,arguments);if(!this.length)return this;var e=a.indexOf(" ");if(e>=0){var g=a.slice(e,a.length);a=a.slice(0,e)}var h="GET";c&&(f.isFunction(c)?(d=c,c=b):typeof c=="object"&&(c=f.param(c,f.ajaxSettings.traditional),h="POST"));var i=this;f.ajax({url:a,type:h,dataType:"html",data:c,complete:function(a,b,c){c=a.responseText,a.isResolved()&&(a.done(function(a){c=a}),i.html(g?f("<div>").append(c.replace(bN,"")).find(g):c)),d&&i.each(d,[c,b,a])}});return this},serialize:function(){return f.param(this.serializeArray())},serializeArray:function(){return this.map(function(){return this.elements?f.makeArray(this.elements):this}).filter(function(){return this.name&&!this.disabled&&(this.checked||bO.test(this.nodeName)||bI.test(this.type))}).map(function(a,b){var c=f(this).val();return c==null?null:f.isArray(c)?f.map(c,function(a,c){return{name:b.name,value:a.replace(bF,"\r\n")}}):{name:b.name,value:c.replace(bF,"\r\n")}}).get()}}),f.each("ajaxStart ajaxStop ajaxComplete ajaxError ajaxSuccess ajaxSend".split(" "),function(a,b){f.fn[b]=function(a){return this.on(b,a)}}),f.each(["get","post"],function(a,c){f[c]=function(a,d,e,g){f.isFunction(d)&&(g=g||e,e=d,d=b);return f.ajax({type:c,url:a,data:d,success:e,dataType:g})}}),f.extend({getScript:function(a,c){return f.get(a,b,c,"script")},getJSON:function(a,b,c){return f.get(a,b,c,"json")},ajaxSetup:function(a,b){b?b_(a,f.ajaxSettings):(b=a,a=f.ajaxSettings),b_(a,b);return a},ajaxSettings:{url:bV,isLocal:bJ.test(bW[1]),global:!0,type:"GET",contentType:"application/x-www-form-urlencoded",processData:!0,async:!0,accepts:{xml:"application/xml, text/xml",html:"text/html",text:"text/plain",json:"application/json, text/javascript","*":bX},contents:{xml:/xml/,html:/html/,json:/json/},responseFields:{xml:"responseXML",text:"responseText"},converters:{"* text":a.String,"text html":!0,"text json":f.parseJSON,"text xml":f.parseXML},flatOptions:{context:!0,url:!0}},ajaxPrefilter:bZ(bT),ajaxTransport:bZ(bU),ajax:function(a,c){function w(a,c,l,m){if(s!==2){s=2,q&&clearTimeout(q),p=b,n=m||"",v.readyState=a>0?4:0;var o,r,u,w=c,x=l?cb(d,v,l):b,y,z;if(a>=200&&a<300||a===304){if(d.ifModified){if(y=v.getResponseHeader("Last-Modified"))f.lastModified[k]=y;if(z=v.getResponseHeader("Etag"))f.etag[k]=z}if(a===304)w="notmodified",o=!0;else try{r=cc(d,x),w="success",o=!0}catch(A){w="parsererror",u=A}}else{u=w;if(!w||a)w="error",a<0&&(a=0)}v.status=a,v.statusText=""+(c||w),o?h.resolveWith(e,[r,w,v]):h.rejectWith(e,[v,w,u]),v.statusCode(j),j=b,t&&g.trigger("ajax"+(o?"Success":"Error"),[v,d,o?r:u]),i.fireWith(e,[v,w]),t&&(g.trigger("ajaxComplete",[v,d]),--f.active||f.event.trigger("ajaxStop"))}}typeof a=="object"&&(c=a,a=b),c=c||{};var d=f.ajaxSetup({},c),e=d.context||d,g=e!==d&&(e.nodeType||e instanceof f)?f(e):f.event,h=f.Deferred(),i=f.Callbacks("once memory"),j=d.statusCode||{},k,l={},m={},n,o,p,q,r,s=0,t,u,v={readyState:0,setRequestHeader:function(a,b){if(!s){var c=a.toLowerCase();a=m[c]=m[c]||a,l[a]=b}return this},getAllResponseHeaders:function(){return s===2?n:null},getResponseHeader:function(a){var c;if(s===2){if(!o){o={};while(c=bH.exec(n))o[c[1].toLowerCase()]=c[2]}c=o[a.toLowerCase()]}return c===b?null:c},overrideMimeType:function(a){s||(d.mimeType=a);return this},abort:function(a){a=a||"abort",p&&p.abort(a),w(0,a);return this}};h.promise(v),v.success=v.done,v.error=v.fail,v.complete=i.add,v.statusCode=function(a){if(a){var b;if(s<2)for(b in a)j[b]=[j[b],a[b]];else b=a[v.status],v.then(b,b)}return this},d.url=((a||d.url)+"").replace(bG,"").replace(bL,bW[1]+"//"),d.dataTypes=f.trim(d.dataType||"*").toLowerCase().split(bP),d.crossDomain==null&&(r=bR.exec(d.url.toLowerCase()),d.crossDomain=!(!r||r[1]==bW[1]&&r[2]==bW[2]&&(r[3]||(r[1]==="http:"?80:443))==(bW[3]||(bW[1]==="http:"?80:443)))),d.data&&d.processData&&typeof d.data!="string"&&(d.data=f.param(d.data,d.traditional)),b$(bT,d,c,v);if(s===2)return!1;t=d.global,d.type=d.type.toUpperCase(),d.hasContent=!bK.test(d.type),t&&f.active++===0&&f.event.trigger("ajaxStart");if(!d.hasContent){d.data&&(d.url+=(bM.test(d.url)?"&":"?")+d.data,delete d.data),k=d.url;if(d.cache===!1){var x=f.now(),y=d.url.replace(bQ,"$1_="+x);d.url=y+(y===d.url?(bM.test(d.url)?"&":"?")+"_="+x:"")}}(d.data&&d.hasContent&&d.contentType!==!1||c.contentType)&&v.setRequestHeader("Content-Type",d.contentType),d.ifModified&&(k=k||d.url,f.lastModified[k]&&v.setRequestHeader("If-Modified-Since",f.lastModified[k]),f.etag[k]&&v.setRequestHeader("If-None-Match",f.etag[k])),v.setRequestHeader("Accept",d.dataTypes[0]&&d.accepts[d.dataTypes[0]]?d.accepts[d.dataTypes[0]]+(d.dataTypes[0]!=="*"?", "+bX+"; q=0.01":""):d.accepts["*"]);for(u in d.headers)v.setRequestHeader(u,d.headers[u]);if(d.beforeSend&&(d.beforeSend.call(e,v,d)===!1||s===2)){v.abort();return!1}for(u in{success:1,error:1,complete:1})v[u](d[u]);p=b$(bU,d,c,v);if(!p)w(-1,"No Transport");else{v.readyState=1,t&&g.trigger("ajaxSend",[v,d]),d.async&&d.timeout>0&&(q=setTimeout(function(){v.abort("timeout")},d.timeout));try{s=1,p.send(l,w)}catch(z){if(s<2)w(-1,z);else throw z}}return v},param:function(a,c){var d=[],e=function(a,b){b=f.isFunction(b)?b():b,d[d.length]=encodeURIComponent(a)+"="+encodeURIComponent(b)};c===b&&(c=f.ajaxSettings.traditional);if(f.isArray(a)||a.jquery&&!f.isPlainObject(a))f.each(a,function(){e(this.name,this.value)});else for(var g in a)ca(g,a[g],c,e);return d.join("&").replace(bD,"+")}}),f.extend({active:0,lastModified:{},etag:{}});var cd=f.now(),ce=/(\=)\?(&|$)|\?\?/i;f.ajaxSetup({jsonp:"callback",jsonpCallback:function(){return f.expando+"_"+cd++}}),f.ajaxPrefilter("json jsonp",function(b,c,d){var e=b.contentType==="application/x-www-form-urlencoded"&&typeof b.data=="string";if(b.dataTypes[0]==="jsonp"||b.jsonp!==!1&&(ce.test(b.url)||e&&ce.test(b.data))){var g,h=b.jsonpCallback=f.isFunction(b.jsonpCallback)?b.jsonpCallback():b.jsonpCallback,i=a[h],j=b.url,k=b.data,l="$1"+h+"$2";b.jsonp!==!1&&(j=j.replace(ce,l),b.url===j&&(e&&(k=k.replace(ce,l)),b.data===k&&(j+=(/\?/.test(j)?"&":"?")+b.jsonp+"="+h))),b.url=j,b.data=k,a[h]=function(a){g=[a]},d.always(function(){a[h]=i,g&&f.isFunction(i)&&a[h](g[0])}),b.converters["script json"]=function(){g||f.error(h+" was not called");return g[0]},b.dataTypes[0]="json";return"script"}}),f.ajaxSetup({accepts:{script:"text/javascript, application/javascript, application/ecmascript, application/x-ecmascript"},contents:{script:/javascript|ecmascript/},converters:{"text script":function(a){f.globalEval(a);return a}}}),f.ajaxPrefilter("script",function(a){a.cache===b&&(a.cache=!1),a.crossDomain&&(a.type="GET",a.global=!1)}),f.ajaxTransport("script",function(a){if(a.crossDomain){var d,e=c.head||c.getElementsByTagName("head")[0]||c.documentElement;return{send:function(f,g){d=c.createElement("script"),d.async="async",a.scriptCharset&&(d.charset=a.scriptCharset),d.src=a.url,d.onload=d.onreadystatechange=function(a,c){if(c||!d.readyState||/loaded|complete/.test(d.readyState))d.onload=d.onreadystatechange=null,e&&d.parentNode&&e.removeChild(d),d=b,c||g(200,"success")},e.insertBefore(d,e.firstChild)},abort:function(){d&&d.onload(0,1)}}}});var cf=a.ActiveXObject?function(){for(var a in ch)ch[a](0,1)}:!1,cg=0,ch;f.ajaxSettings.xhr=a.ActiveXObject?function(){return!this.isLocal&&ci()||cj()}:ci,function(a){f.extend(f.support,{ajax:!!a,cors:!!a&&"withCredentials"in a})}(f.ajaxSettings.xhr()),f.support.ajax&&f.ajaxTransport(function(c){if(!c.crossDomain||f.support.cors){var d;return{send:function(e,g){var h=c.xhr(),i,j;c.username?h.open(c.type,c.url,c.async,c.username,c.password):h.open(c.type,c.url,c.async);if(c.xhrFields)for(j in c.xhrFields)h[j]=c.xhrFields[j];c.mimeType&&h.overrideMimeType&&h.overrideMimeType(c.mimeType),!c.crossDomain&&!e["X-Requested-With"]&&(e["X-Requested-With"]="XMLHttpRequest");try{for(j in e)h.setRequestHeader(j,e[j])}catch(k){}h.send(c.hasContent&&c.data||null),d=function(a,e){var j,k,l,m,n;try{if(d&&(e||h.readyState===4)){d=b,i&&(h.onreadystatechange=f.noop,cf&&delete ch[i]);if(e)h.readyState!==4&&h.abort();else{j=h.status,l=h.getAllResponseHeaders(),m={},n=h.responseXML,n&&n.documentElement&&(m.xml=n),m.text=h.responseText;try{k=h.statusText}catch(o){k=""}!j&&c.isLocal&&!c.crossDomain?j=m.text?200:404:j===1223&&(j=204)}}}catch(p){e||g(-1,p)}m&&g(j,k,m,l)},!c.async||h.readyState===4?d():(i=++cg,cf&&(ch||(ch={},f(a).unload(cf)),ch[i]=d),h.onreadystatechange=d)},abort:function(){d&&d(0,1)}}}});var ck={},cl,cm,cn=/^(?:toggle|show|hide)$/,co=/^([+\-]=)?([\d+.\-]+)([a-z%]*)$/i,cp,cq=[["height","marginTop","marginBottom","paddingTop","paddingBottom"],["width","marginLeft","marginRight","paddingLeft","paddingRight"],["opacity"]],cr;f.fn.extend({show:function(a,b,c){var d,e;if(a||a===0)return this.animate(cu("show",3),a,b,c);for(var g=0,h=this.length;g<h;g++)d=this[g],d.style&&(e=d.style.display,!f._data(d,"olddisplay")&&e==="none"&&(e=d.style.display=""),e===""&&f.css(d,"display")==="none"&&f._data(d,"olddisplay",cv(d.nodeName)));for(g=0;g<h;g++){d=this[g];if(d.style){e=d.style.display;if(e===""||e==="none")d.style.display=f._data(d,"olddisplay")||""}}return this},hide:function(a,b,c){if(a||a===0)return this.animate(cu("hide",3),a,b,c);var d,e,g=0,h=this.length;for(;g<h;g++)d=this[g],d.style&&(e=f.css(d,"display"),e!=="none"&&!f._data(d,"olddisplay")&&f._data(d,"olddisplay",e));for(g=0;g<h;g++)this[g].style&&(this[g].style.display="none");return this},_toggle:f.fn.toggle,toggle:function(a,b,c){var d=typeof a=="boolean";f.isFunction(a)&&f.isFunction(b)?this._toggle.apply(this,arguments):a==null||d?this.each(function(){var b=d?a:f(this).is(":hidden");f(this)[b?"show":"hide"]()}):this.animate(cu("toggle",3),a,b,c);return this},fadeTo:function(a,b,c,d){return this.filter(":hidden").css("opacity",0).show().end().animate({opacity:b},a,c,d)},animate:function(a,b,c,d){function g(){e.queue===!1&&f._mark(this);var b=f.extend({},e),c=this.nodeType===1,d=c&&f(this).is(":hidden"),g,h,i,j,k,l,m,n,o;b.animatedProperties={};for(i in a){g=f.camelCase(i),i!==g&&(a[g]=a[i],delete a[i]),h=a[g],f.isArray(h)?(b.animatedProperties[g]=h[1],h=a[g]=h[0]):b.animatedProperties[g]=b.specialEasing&&b.specialEasing[g]||b.easing||"swing";if(h==="hide"&&d||h==="show"&&!d)return b.complete.call(this);c&&(g==="height"||g==="width")&&(b.overflow=[this.style.overflow,this.style.overflowX,this.style.overflowY],f.css(this,"display")==="inline"&&f.css(this,"float")==="none"&&(!f.support.inlineBlockNeedsLayout||cv(this.nodeName)==="inline"?this.style.display="inline-block":this.style.zoom=1))}b.overflow!=null&&(this.style.overflow="hidden");for(i in a)j=new f.fx(this,b,i),h=a[i],cn.test(h)?(o=f._data(this,"toggle"+i)||(h==="toggle"?d?"show":"hide":0),o?(f._data(this,"toggle"+i,o==="show"?"hide":"show"),j[o]()):j[h]()):(k=co.exec(h),l=j.cur(),k?(m=parseFloat(k[2]),n=k[3]||(f.cssNumber[i]?"":"px"),n!=="px"&&(f.style(this,i,(m||1)+n),l=(m||1)/j.cur()*l,f.style(this,i,l+n)),k[1]&&(m=(k[1]==="-="?-1:1)*m+l),j.custom(l,m,n)):j.custom(l,h,""));return!0}var e=f.speed(b,c,d);if(f.isEmptyObject(a))return this.each(e.complete,[!1]);a=f.extend({},a);return e.queue===!1?this.each(g):this.queue(e.queue,g)},stop:function(a,c,d){typeof a!="string"&&(d=c,c=a,a=b),c&&a!==!1&&this.queue(a||"fx",[]);return this.each(function(){function h(a,b,c){var e=b[c];f.removeData(a,c,!0),e.stop(d)}var b,c=!1,e=f.timers,g=f._data(this);d||f._unmark(!0,this);if(a==null)for(b in g)g[b]&&g[b].stop&&b.indexOf(".run")===b.length-4&&h(this,g,b);else g[b=a+".run"]&&g[b].stop&&h(this,g,b);for(b=e.length;b--;)e[b].elem===this&&(a==null||e[b].queue===a)&&(d?e[b](!0):e[b].saveState(),c=!0,e.splice(b,1));(!d||!c)&&f.dequeue(this,a)})}}),f.each({slideDown:cu("show",1),slideUp:cu("hide",1),slideToggle:cu("toggle",1),fadeIn:{opacity:"show"},fadeOut:{opacity:"hide"},fadeToggle:{opacity:"toggle"}},function(a,b){f.fn[a]=function(a,c,d){return this.animate(b,a,c,d)}}),f.extend({speed:function(a,b,c){var d=a&&typeof a=="object"?f.extend({},a):{complete:c||!c&&b||f.isFunction(a)&&a,duration:a,easing:c&&b||b&&!f.isFunction(b)&&b};d.duration=f.fx.off?0:typeof d.duration=="number"?d.duration:d.duration in f.fx.speeds?f.fx.speeds[d.duration]:f.fx.speeds._default;if(d.queue==null||d.queue===!0)d.queue="fx";d.old=d.complete,d.complete=function(a){f.isFunction(d.old)&&d.old.call(this),d.queue?f.dequeue(this,d.queue):a!==!1&&f._unmark(this)};return d},easing:{linear:function(a,b,c,d){return c+d*a},swing:function(a,b,c,d){return(-Math.cos(a*Math.PI)/2+.5)*d+c}},timers:[],fx:function(a,b,c){this.options=b,this.elem=a,this.prop=c,b.orig=b.orig||{}}}),f.fx.prototype={update:function(){this.options.step&&this.options.step.call(this.elem,this.now,this),(f.fx.step[this.prop]||f.fx.step._default)(this)},cur:function(){if(this.elem[this.prop]!=null&&(!this.elem.style||this.elem.style[this.prop]==null))return this.elem[this.prop];var a,b=f.css(this.elem,this.prop);return isNaN(a=parseFloat(b))?!b||b==="auto"?0:b:a},custom:function(a,c,d){function h(a){return e.step(a)}var e=this,g=f.fx;this.startTime=cr||cs(),this.end=c,this.now=this.start=a,this.pos=this.state=0,this.unit=d||this.unit||(f.cssNumber[this.prop]?"":"px"),h.queue=this.options.queue,h.elem=this.elem,h.saveState=function(){e.options.hide&&f._data(e.elem,"fxshow"+e.prop)===b&&f._data(e.elem,"fxshow"+e.prop,e.start)},h()&&f.timers.push(h)&&!cp&&(cp=setInterval(g.tick,g.interval))},show:function(){var a=f._data(this.elem,"fxshow"+this.prop);this.options.orig[this.prop]=a||f.style(this.elem,this.prop),this.options.show=!0,a!==b?this.custom(this.cur(),a):this.custom(this.prop==="width"||this.prop==="height"?1:0,this.cur()),f(this.elem).show()},hide:function(){this.options.orig[this.prop]=f._data(this.elem,"fxshow"+this.prop)||f.style(this.elem,this.prop),this.options.hide=!0,this.custom(this.cur(),0)},step:function(a){var b,c,d,e=cr||cs(),g=!0,h=this.elem,i=this.options;if(a||e>=i.duration+this.startTime){this.now=this.end,this.pos=this.state=1,this.update(),i.animatedProperties[this.prop]=!0;for(b in i.animatedProperties)i.animatedProperties[b]!==!0&&(g=!1);if(g){i.overflow!=null&&!f.support.shrinkWrapBlocks&&f.each(["","X","Y"],function(a,b){h.style["overflow"+b]=i.overflow[a]}),i.hide&&f(h).hide();if(i.hide||i.show)for(b in i.animatedProperties)f.style(h,b,i.orig[b]),f.removeData(h,"fxshow"+b,!0),f.removeData(h,"toggle"+b,!0);d=i.complete,d&&(i.complete=!1,d.call(h))}return!1}i.duration==Infinity?this.now=e:(c=e-this.startTime,this.state=c/i.duration,this.pos=f.easing[i.animatedProperties[this.prop]](this.state,c,0,1,i.duration),this.now=this.start+(this.end-this.start)*this.pos),this.update();return!0}},f.extend(f.fx,{tick:function(){var a,b=f.timers,c=0;for(;c<b.length;c++)a=b[c],!a()&&b[c]===a&&b.splice(c--,1);b.length||f.fx.stop()},interval:13,stop:function(){clearInterval(cp),cp=null},speeds:{slow:600,fast:200,_default:400},step:{opacity:function(a){f.style(a.elem,"opacity",a.now)},_default:function(a){a.elem.style&&a.elem.style[a.prop]!=null?a.elem.style[a.prop]=a.now+a.unit:a.elem[a.prop]=a.now}}}),f.each(["width","height"],function(a,b){f.fx.step[b]=function(a){f.style(a.elem,b,Math.max(0,a.now)+a.unit)}}),f.expr&&f.expr.filters&&(f.expr.filters.animated=function(a){return f.grep(f.timers,function(b){return a===b.elem}).length});var cw=/^t(?:able|d|h)$/i,cx=/^(?:body|html)$/i;"getBoundingClientRect"in c.documentElement?f.fn.offset=function(a){var b=this[0],c;if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);try{c=b.getBoundingClientRect()}catch(d){}var e=b.ownerDocument,g=e.documentElement;if(!c||!f.contains(g,b))return c?{top:c.top,left:c.left}:{top:0,left:0};var h=e.body,i=cy(e),j=g.clientTop||h.clientTop||0,k=g.clientLeft||h.clientLeft||0,l=i.pageYOffset||f.support.boxModel&&g.scrollTop||h.scrollTop,m=i.pageXOffset||f.support.boxModel&&g.scrollLeft||h.scrollLeft,n=c.top+l-j,o=c.left+m-k;return{top:n,left:o}}:f.fn.offset=function(a){var b=this[0];if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);var c,d=b.offsetParent,e=b,g=b.ownerDocument,h=g.documentElement,i=g.body,j=g.defaultView,k=j?j.getComputedStyle(b,null):b.currentStyle,l=b.offsetTop,m=b.offsetLeft;while((b=b.parentNode)&&b!==i&&b!==h){if(f.support.fixedPosition&&k.position==="fixed")break;c=j?j.getComputedStyle(b,null):b.currentStyle,l-=b.scrollTop,m-=b.scrollLeft,b===d&&(l+=b.offsetTop,m+=b.offsetLeft,f.support.doesNotAddBorder&&(!f.support.doesAddBorderForTableAndCells||!cw.test(b.nodeName))&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),e=d,d=b.offsetParent),f.support.subtractsBorderForOverflowNotVisible&&c.overflow!=="visible"&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),k=c}if(k.position==="relative"||k.position==="static")l+=i.offsetTop,m+=i.offsetLeft;f.support.fixedPosition&&k.position==="fixed"&&(l+=Math.max(h.scrollTop,i.scrollTop),m+=Math.max(h.scrollLeft,i.scrollLeft));return{top:l,left:m}},f.offset={bodyOffset:function(a){var b=a.offsetTop,c=a.offsetLeft;f.support.doesNotIncludeMarginInBodyOffset&&(b+=parseFloat(f.css(a,"marginTop"))||0,c+=parseFloat(f.css(a,"marginLeft"))||0);return{top:b,left:c}},setOffset:function(a,b,c){var d=f.css(a,"position");d==="static"&&(a.style.position="relative");var e=f(a),g=e.offset(),h=f.css(a,"top"),i=f.css(a,"left"),j=(d==="absolute"||d==="fixed")&&f.inArray("auto",[h,i])>-1,k={},l={},m,n;j?(l=e.position(),m=l.top,n=l.left):(m=parseFloat(h)||0,n=parseFloat(i)||0),f.isFunction(b)&&(b=b.call(a,c,g)),b.top!=null&&(k.top=b.top-g.top+m),b.left!=null&&(k.left=b.left-g.left+n),"using"in b?b.using.call(a,k):e.css(k)}},f.fn.extend({position:function(){if(!this[0])return null;var a=this[0],b=this.offsetParent(),c=this.offset(),d=cx.test(b[0].nodeName)?{top:0,left:0}:b.offset();c.top-=parseFloat(f.css(a,"marginTop"))||0,c.left-=parseFloat(f.css(a,"marginLeft"))||0,d.top+=parseFloat(f.css(b[0],"borderTopWidth"))||0,d.left+=parseFloat(f.css(b[0],"borderLeftWidth"))||0;return{top:c.top-d.top,left:c.left-d.left}},offsetParent:function(){return this.map(function(){var a=this.offsetParent||c.body;while(a&&!cx.test(a.nodeName)&&f.css(a,"position")==="static")a=a.offsetParent;return a})}}),f.each(["Left","Top"],function(a,c){var d="scroll"+c;f.fn[d]=function(c){var e,g;if(c===b){e=this[0];if(!e)return null;g=cy(e);return g?"pageXOffset"in g?g[a?"pageYOffset":"pageXOffset"]:f.support.boxModel&&g.document.documentElement[d]||g.document.body[d]:e[d]}return this.each(function(){g=cy(this),g?g.scrollTo(a?f(g).scrollLeft():c,a?c:f(g).scrollTop()):this[d]=c})}}),f.each(["Height","Width"],function(a,c){var d=c.toLowerCase();f.fn["inner"+c]=function(){var a=this[0];return a?a.style?parseFloat(f.css(a,d,"padding")):this[d]():null},f.fn["outer"+c]=function(a){var b=this[0];return b?b.style?parseFloat(f.css(b,d,a?"margin":"border")):this[d]():null},f.fn[d]=function(a){var e=this[0];if(!e)return a==null?null:this;if(f.isFunction(a))return this.each(function(b){var c=f(this);c[d](a.call(this,b,c[d]()))});if(f.isWindow(e)){var g=e.document.documentElement["client"+c],h=e.document.body;return e.document.compatMode==="CSS1Compat"&&g||h&&h["client"+c]||g}if(e.nodeType===9)return Math.max(e.documentElement["client"+c],e.body["scroll"+c],e.documentElement["scroll"+c],e.body["offset"+c],e.documentElement["offset"+c]);if(a===b){var i=f.css(e,d),j=parseFloat(i);return f.isNumeric(j)?j:i}return this.css(d,typeof a=="string"?a:a+"px")}}),a.jQuery=a.$=f,typeof define=="function"&&define.amd&&define.amd.jQuery&&define("jquery",[],function(){return f})})(window);
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OEBPS/Common_Content/scripts/highlight.js/CHANGES.md
## Version 8.4

We've got the new [demo page][]! The obvious new feature is the new look, but
apart from that it's got smarter: by presenting languages in groups it avoids
running 10000 highlighting attempts after first load which was slowing it down
and giving bad overall impression. It is now also being generated from test
code snippets so the authors of new languages don't have to update both tests
and the demo page with the same thing.

Other notable changes:

- The `template_comment` class is gone in favor of the more general `comment`.
- Number parsing unified and improved across languages.
- C++, Java and C# now use unified grammar to highlight titles in
  function/method definitions.
- The browser build is now usable as an AMD module, there's no separate build
  target for that anymore.
- OCaml has got a [comprehensive overhaul][ocaml] by [Mickaël Delahaye][].
- Clojure's data structures and literals are now highlighted outside of lists
  and we can now highlight Clojure's REPL sessions.

New languages:

- *AspectJ* by [Hakan Özler][]
- *STEP Part 21* by [Adam Joseph Cook][]
- *SML* derived by [Edwin Dalorzo][] from OCaml definition
- *Mercury* by [mucaho][]
- *Smali* by [Dennis Titze][]
- *Verilog* by [Jon Evans][]
- *Stata* by [Brian Quistorff][]

[Hakan Özler]: https://github.com/ozlerhakan
[Adam Joseph Cook]: https://github.com/adamjcook
[demo page]: https://highlightjs.org/static/demo/
[Ivan Sagalaev]: https://github.com/isagalaev
[Edwin Dalorzo]: https://github.com/edalorzo
[mucaho]: https://github.com/mucaho
[Dennis Titze]: https://github.com/titze
[Jon Evans]: https://github.com/craftyjon
[Brian Quistorff]: https://github.com/bquistorff
[ocaml]: https://github.com/isagalaev/highlight.js/pull/608#issue-46190207
[Mickaël Delahaye]: https://github.com/polazarus


## Version 8.3

We streamlined our tool chain, it is now based entirely on node.js instead of
being a mix of node.js, Python and Java. The build script options and arguments
remained the same, and we've noted all the changes in the [documentation][b].
Apart from reducing complexity, the new build script is also faster from not
having to start Java machine repeatedly. The credits for the work go to [Jeremy
Hull][].

Some notable fixes:

- PHP and JavaScript mixed in HTML now live happily with each other.
- JavaScript regexes now understand ES6 flags "u" and "y".
- `throw` keyword is no longer detected as a method name in Java.
- Fixed parsing of numbers and symbols in Clojure thanks to [input from Ivan
  Kleshnin][ik].

New languages in this release:

- *Less* by [Max Mikhailov][]
- *Stylus* by [Bryant Williams][]
- *Tcl* by [Radek Liska][]
- *Puppet* by [Jose Molina Colmenero][]
- *Processing* by [Erik Paluka][]
- *Twig* templates by [Luke Holder][]
- *PowerShell* by [David Mohundro][], based on [the work of Nicholas
  Blumhardt][ps]
- *XL* by [Christophe de Dinechin][]
- *LiveScript* by [Taneli Vatanen][] and [Jen Evers-Corvina][]
- *ERB* (Ruby in HTML) by [Lucas Mazza][]
- *Roboconf* by [Vincent Zurczak][]

[b]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[Jeremy Hull]: https://github.com/sourrust
[ik]: https://twitter.com/IvanKleshnin/status/514041599484231680
[Max Mikhailov]: https://github.com/seven-phases-max
[Bryant Williams]: https://github.com/scien
[Radek Liska]: https://github.com/Nindaleth
[Jose Molina Colmenero]: https://github.com/Moliholy
[Erik Paluka]: https://github.com/paluka
[Luke Holder]: https://github.com/lukeholder
[David Mohundro]: https://github.com/drmohundro
[ps]: https://github.com/OctopusDeploy/Library/blob/master/app/shared/presentation/highlighting/powershell.js
[Christophe de Dinechin]: https://github.com/c3d
[Taneli Vatanen]: https://github.com/Daiz-
[Jen Evers-Corvina]: https://github.com/sevvie
[Lucas Mazza]: https://github.com/lucasmazza
[Vincent Zurczak]: https://github.com/vincent-zurczak

## Version 8.2

We've finally got [real tests][test] and [continuous testing on Travis][ci]
thanks to [Jeremy Hull][] and [Chris Eidhof][]. The tests designed to cover
everything: language detection, correct parsing of individual language features
and various special cases. This is a very important change that gives us
confidence in extending language definitions and refactoring library core.

We're going to redesign the old [demo/test suite][demo] into an interactive
demo web app. If you're confident front-end developer or designer and want to
help us with it, drop a comment into [the issue][#542] on GitHub.

[test]: https://github.com/isagalaev/highlight.js/tree/master/test
[demo]: https://highlightjs.org/static/test.html
[#542]: https://github.com/isagalaev/highlight.js/issues/542
[ci]: https://travis-ci.org/isagalaev/highlight.js
[Jeremy Hull]: https://github.com/sourrust
[Chris Eidhof]: https://github.com/chriseidhof

As usually there's a handful of new languages in this release:

- *Groovy* by [Guillaume Laforge][]
- *Dart* by [Maxim Dikun][]
- *Dust* by [Michael Allen][]
- *Scheme* by [JP Verkamp][]
- *G-Code* by [Adam Joseph Cook][]
- *Q* from Kx Systems by [Sergey Vidyuk][]

[Guillaume Laforge]: https://github.com/glaforge
[Maxim Dikun]: https://github.com/dikmax
[Michael Allen]: https://github.com/bfui
[JP Verkamp]: https://github.com/jpverkamp
[Adam Joseph Cook]: https://github.com/adamjcook
[Sergey Vidyuk]: https://github.com/sv

Other improvements:

- [Erik Osheim][] heavily reworked Scala definitions making it richer.
- [Lucas Mazza][] fixed Ruby hashes highlighting
- Lisp variants (Lisp, Clojure and Scheme) are unified in regard to naming
  the first symbol in parentheses: it's "keyword" in general case and also
  "built_in" for built-in functions in Clojure and Scheme.

[Erik Osheim]: https://github.com/non
[Lucas Mazza]: https://github.com/lucasmazza

## Version 8.1

New languages:

- *Gherkin* by [Sam Pikesley][]
- *Elixir* by [Josh Adams][]
- *NSIS* by [Jan T. Sott][]
- *VIM script* by [Jun Yang][]
- *Protocol Buffers* by [Dan Tao][]
- *Nix* by [Domen Kožar][]
- *x86asm* by [innocenat][]
- *Cap’n Proto* and *Thrift* by [Oleg Efimov][]
- *Monkey* by [Arthur Bikmullin][]
- *TypeScript* by [Panu Horsmalahti][]
- *Nimrod* by [Flaviu Tamas][]
- *Gradle* by [Damian Mee][]
- *Haxe* by [Christopher Kaster][]
- *Swift* by [Chris Eidhof][] and [Nate Cook][]

New styles:

- *Kimbie*, light and dark variants by [Jan T. Sott][]
- *Color brewer* by [Fabrício Tavares de Oliveira][]
- *Codepen.io embed* by [Justin Perry][]
- *Hybrid* by [Nic West][]

[Sam Pikesley]: https://github.com/pikesley
[Sindre Sorhus]: https://github.com/sindresorhus
[Josh Adams]: https://github.com/knewter
[Jan T. Sott]: https://github.com/idleberg
[Jun Yang]: https://github.com/harttle
[Dan Tao]: https://github.com/dtao
[Domen Kožar]: https://github.com/iElectric
[innocenat]: https://github.com/innocenat
[Oleg Efimov]: https://github.com/Sannis
[Arthur Bikmullin]: https://github.com/devolonter
[Panu Horsmalahti]: https://github.com/panuhorsmalahti
[Flaviu Tamas]: https://github.com/flaviut
[Damian Mee]: https://github.com/chester1000
[Christopher Kaster]: http://christopher.kaster.ws
[Fabrício Tavares de Oliveira]: https://github.com/fabriciotav
[Justin Perry]: https://github.com/ourmaninamsterdam
[Nic West]: https://github.com/nicwest
[Chris Eidhof]: https://github.com/chriseidhof
[Nate Cook]: https://github.com/natecook1000

Other improvements:

- The README is heavily reworked and brought up to date by [Jeremy Hull][].
- Added [`listLanguages()`][ll] method in the API.
- Improved C/C++/C# detection.
- Added a bunch of new language aliases, documented the existing ones. Thanks to
  [Sindre Sorhus][] for background research.
- Added phrasal English words to boost relevance in comments.
- Many improvements to SQL definition made by [Heiko August][],
  [Nikolay Lisienko][] and [Travis Odom][].
- The shorter `lang-` prefix for language names in HTML classes supported
  alongside `language-`. Thanks to [Jeff Escalante][].
- Ruby's got support for interactive console sessions. Thanks to
  [Pascal Hurni][].
- Added built-in functions for R language. Thanks to [Artem A. Klevtsov][].
- Rust's got definition for lifetime parameters and improved string syntax.
  Thanks to [Roman Shmatov][].
- Various improvements to Objective-C definition by [Matt Diephouse][].
- Fixed highlighting of generics in Java.

[ll]: http://highlightjs.readthedocs.org/en/latest/api.html#listlanguages
[Sindre Sorhus]: https://github.com/sindresorhus
[Heiko August]: https://github.com/auge8472
[Nikolay Lisienko]: https://github.com/neor-ru
[Travis Odom]: https://github.com/Burstaholic
[Jeff Escalante]: https://github.com/jenius
[Pascal Hurni]: https://github.com/phurni
[Jiyin Yiyong]: https://github.com/jiyinyiyong
[Artem A. Klevtsov]: https://github.com/unikum
[Roman Shmatov]: https://github.com/shmatov
[Jeremy Hull]: https://github.com/sourrust
[Matt Diephouse]: https://github.com/mdiep


## Version 8.0

This new major release is quite a big overhaul bringing both new features and
some backwards incompatible changes. However, chances are that the majority of
users won't be affected by the latter: the basic scenario described in the
README is left intact.

Here's what did change in an incompatible way:

- We're now prefixing all classes located in [CSS classes reference][cr] with
  `hljs-`, by default, because some class names would collide with other
  people's stylesheets. If you were using an older version, you might still want
  the previous behavior, but still want to upgrade. To suppress this new
  behavior, you would initialize like so:

  ```html
  <script type="text/javascript">
    hljs.configure({classPrefix: ''});
    hljs.initHighlightingOnLoad();
  </script>
  ```

- `tabReplace` and `useBR` that were used in different places are also unified
  into the global options object and are to be set using `configure(options)`.
  This function is documented in our [API docs][]. Also note that these
  parameters are gone from `highlightBlock` and `fixMarkup` which are now also
  rely on `configure`.

- We removed public-facing (though undocumented) object `hljs.LANGUAGES` which
  was used to register languages with the library in favor of two new methods:
  `registerLanguage` and `getLanguage`. Both are documented in our [API docs][].

- Result returned from `highlight` and `highlightAuto` no longer contains two
  separate attributes contributing to relevance score, `relevance` and
  `keyword_count`. They are now unified in `relevance`.

Another technically compatible change that nonetheless might need attention:

- The structure of the NPM package was refactored, so if you had installed it
  locally, you'll have to update your paths. The usual `require('highlight.js')`
  works as before. This is contributed by [Dmitry Smolin][].

New features:

- Languages now can be recognized by multiple names like "js" for JavaScript or
  "html" for, well, HTML (which earlier insisted on calling it "xml"). These
  aliases can be specified in the class attribute of the code container in your
  HTML as well as in various API calls. For now there are only a few very common
  aliases but we'll expand it in the future. All of them are listed in the
  [class reference][cr].

- Language detection can now be restricted to a subset of languages relevant in
  a given context — a web page or even a single highlighting call. This is
  especially useful for node.js build that includes all the known languages.
  Another example is a StackOverflow-style site where users specify languages
  as tags rather than in the markdown-formatted code snippets. This is
  documented in the [API reference][] (see methods `highlightAuto` and
  `configure`).

- Language definition syntax streamlined with [variants][] and
  [beginKeywords][].

New languages and styles:

- *Oxygene* by [Carlo Kok][]
- *Mathematica* by [Daniel Kvasnička][]
- *Autohotkey* by [Seongwon Lee][]
- *Atelier* family of styles in 10 variants by [Bram de Haan][]
- *Paraíso* styles by [Jan T. Sott][]

Miscellaneous improvements:

- Highlighting `=>` prompts in Clojure.
- [Jeremy Hull][] fixed a lot of styles for consistency.
- Finally, highlighting PHP and HTML [mixed in peculiar ways][php-html].
- Objective C and C# now properly highlight titles in method definition.
- Big overhaul of relevance counting for a number of languages. Please do report
  bugs about mis-detection of non-trivial code snippets!

[API reference]: http://highlightjs.readthedocs.org/en/latest/api.html

[cr]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[api docs]: http://highlightjs.readthedocs.org/en/latest/api.html
[variants]: https://groups.google.com/d/topic/highlightjs/VoGC9-1p5vk/discussion
[beginKeywords]: https://github.com/isagalaev/highlight.js/commit/6c7fdea002eb3949577a85b3f7930137c7c3038d
[php-html]: https://twitter.com/highlightjs/status/408890903017689088

[Carlo Kok]: https://github.com/carlokok
[Bram de Haan]: https://github.com/atelierbram
[Daniel Kvasnička]: https://github.com/dkvasnicka
[Dmitry Smolin]: https://github.com/dimsmol
[Jeremy Hull]: https://github.com/sourrust
[Seongwon Lee]: https://github.com/dlimpid
[Jan T. Sott]: https://github.com/idleberg


## Version 7.5

A catch-up release dealing with some of the accumulated contributions. This one
is probably will be the last before the 8.0 which will be slightly backwards
incompatible regarding some advanced use-cases.

One outstanding change in this version is the addition of 6 languages to the
[hosted script][d]: Markdown, ObjectiveC, CoffeeScript, Apache, Nginx and
Makefile. It now weighs about 6K more but we're going to keep it under 30K.

New languages:

- OCaml by [Mehdi Dogguy][mehdid] and [Nicolas Braud-Santoni][nbraud]
- [LiveCode Server][lcs] by [Ralf Bitter][revig]
- Scilab by [Sylvestre Ledru][sylvestre]
- basic support for Makefile by [Ivan Sagalaev][isagalaev]

Improvements:

- Ruby's got support for characters like `?A`, `?1`, `?\012` etc. and `%r{..}`
  regexps.
- Clojure now allows a function call in the beginning of s-expressions
  `(($filter "myCount") (arr 1 2 3 4 5))`.
- Haskell's got new keywords and now recognizes more things like pragmas,
  preprocessors, modules, containers, FFIs etc. Thanks to [Zena Treep][treep]
  for the implementation and to [Jeremy Hull][sourrust] for guiding it.
- Miscellaneous fixes in PHP, Brainfuck, SCSS, Asciidoc, CMake, Python and F#.

[mehdid]: https://github.com/mehdid
[nbraud]: https://github.com/nbraud
[revig]: https://github.com/revig
[lcs]: http://livecode.com/developers/guides/server/
[sylvestre]: https://github.com/sylvestre
[isagalaev]: https://github.com/isagalaev
[treep]: https://github.com/treep
[sourrust]: https://github.com/sourrust
[d]: http://highlightjs.org/download/


## New core developers

The latest long period of almost complete inactivity in the project coincided
with growing interest to it led to a decision that now seems completely obvious:
we need more core developers.

So without further ado let me welcome to the core team two long-time
contributors: [Jeremy Hull][] and [Oleg
Efimov][].

Hope now we'll be able to work through stuff faster!

P.S. The historical commit is [here][1] for the record.

[Jeremy Hull]: https://github.com/sourrust
[Oleg Efimov]: https://github.com/sannis
[1]: https://github.com/isagalaev/highlight.js/commit/f3056941bda56d2b72276b97bc0dd5f230f2473f


## Version 7.4

This long overdue version is a snapshot of the current source tree with all the
changes that happened during the past year. Sorry for taking so long!

Along with the changes in code highlight.js has finally got its new home at
<http://highlightjs.org/>, moving from its cradle on Software Maniacs which it
outgrew a long time ago. Be sure to report any bugs about the site to
<mailto:info@highlightjs.org>.

On to what's new…

New languages:

- Handlebars templates by [Robin Ward][]
- Oracle Rules Language by [Jason Jacobson][]
- F# by [Joans Follesø][]
- AsciiDoc and Haml by [Dan Allen][]
- Lasso by [Eric Knibbe][]
- SCSS by [Kurt Emch][]
- VB.NET by [Poren Chiang][]
- Mizar by [Kelley van Evert][]

[Robin Ward]: https://github.com/eviltrout
[Jason Jacobson]: https://github.com/jayce7
[Joans Follesø]: https://github.com/follesoe
[Dan Allen]: https://github.com/mojavelinux
[Eric Knibbe]: https://github.com/EricFromCanada
[Kurt Emch]: https://github.com/kemch
[Poren Chiang]: https://github.com/rschiang
[Kelley van Evert]: https://github.com/kelleyvanevert

New style themes:

- Monokai Sublime by [noformnocontent][]
- Railscasts by [Damien White][]
- Obsidian by [Alexander Marenin][]
- Docco by [Simon Madine][]
- Mono Blue by [Ivan Sagalaev][] (uses a single color hue for everything)
- Foundation by [Dan Allen][]

[noformnocontent]: http://nn.mit-license.org/
[Damien White]: https://github.com/visoft
[Alexander Marenin]: https://github.com/ioncreature
[Simon Madine]: https://github.com/thingsinjars
[Ivan Sagalaev]: https://github.com/isagalaev

Other notable changes:

- Corrected many corner cases in CSS.
- Dropped Python 2 version of the build tool.
- Implemented building for the AMD format.
- Updated Rust keywords (thanks to [Dmitry Medvinsky][]).
- Literal regexes can now be used in language definitions.
- CoffeeScript highlighting is now significantly more robust and rich due to
  input from [Cédric Néhémie][].

[Dmitry Medvinsky]: https://github.com/dmedvinsky
[Cédric Néhémie]: https://github.com/abe33


## Version 7.3

- Since this version highlight.js no longer works in IE version 8 and older.
  It's made it possible to reduce the library size and dramatically improve code
  readability and made it easier to maintain. Time to go forward!

- New languages: AppleScript (by [Nathan Grigg][ng] and [Dr. Drang][dd]) and
  Brainfuck (by [Evgeny Stepanischev][bolk]).

- Improvements to existing languages:

    - interpreter prompt in Python (`>>>` and `...`)
    - @-properties and classes in CoffeeScript
    - E4X in JavaScript (by [Oleg Efimov][oe])
    - new keywords in Perl (by [Kirk Kimmel][kk])
    - big Ruby syntax update (by [Vasily Polovnyov][vast])
    - small fixes in Bash

- Also Oleg Efimov did a great job of moving all the docs for language and style
  developers and contributors from the old wiki under the source code in the
  "docs" directory. Now these docs are nicely presented at
  <http://highlightjs.readthedocs.org/>.

[ng]: https://github.com/nathan11g
[dd]: https://github.com/drdrang
[bolk]: https://github.com/bolknote
[oe]: https://github.com/Sannis
[kk]: https://github.com/kimmel
[vast]: https://github.com/vast


## Version 7.2

A regular bug-fix release without any significant new features. Enjoy!


## Version 7.1

A Summer crop:

- [Marc Fornos][mf] made the definition for Clojure along with the matching
  style Rainbow (which, of course, works for other languages too).
- CoffeeScript support continues to improve getting support for regular
  expressions.
- Yoshihide Jimbo ported to highlight.js [five Tomorrow styles][tm] from the
  [project by Chris Kempson][tm0].
- Thanks to [Casey Duncun][cd] the library can now be built in the popular
  [AMD format][amd].
- And last but not least, we've got a fair number of correctness and consistency
  fixes, including a pretty significant refactoring of Ruby.

[mf]: https://github.com/mfornos
[tm]: http://jmblog.github.com/color-themes-for-highlightjs/
[tm0]: https://github.com/ChrisKempson/Tomorrow-Theme
[cd]: https://github.com/caseman
[amd]: http://requirejs.org/docs/whyamd.html


## Version 7.0

The reason for the new major version update is a global change of keyword syntax
which resulted in the library getting smaller once again. For example, the
hosted build is 2K less than at the previous version while supporting two new
languages.

Notable changes:

- The library now works not only in a browser but also with [node.js][]. It is
  installable with `npm install highlight.js`. [API][] docs are available on our
  wiki.

- The new unique feature (apparently) among syntax highlighters is highlighting
  *HTTP* headers and an arbitrary language in the request body. The most useful
  languages here are *XML* and *JSON* both of which highlight.js does support.
  Here's [the detailed post][p] about the feature.

- Two new style themes: a dark "south" *[Pojoaque][]* by Jason Tate and an
  emulation of*XCode* IDE by [Angel Olloqui][ao].

- Three new languages: *D* by [Aleksandar Ružičić][ar], *R* by [Joe Cheng][jc]
  and *GLSL* by [Sergey Tikhomirov][st].

- *Nginx* syntax has become a million times smaller and more universal thanks to
  remaking it in a more generic manner that doesn't require listing all the
  directives in the known universe.

- Function titles are now highlighted in *PHP*.

- *Haskell* and *VHDL* were significantly reworked to be more rich and correct
  by their respective maintainers [Jeremy Hull][sr] and [Igor Kalnitsky][ik].

And last but not least, many bugs have been fixed around correctness and
language detection.

Overall highlight.js currently supports 51 languages and 20 style themes.

[node.js]: http://nodejs.org/
[api]: http://softwaremaniacs.org/wiki/doku.php/highlight.js:api
[p]: http://softwaremaniacs.org/blog/2012/05/10/http-and-json-in-highlight-js/en/
[pojoaque]: http://web-cms-designs.com/ftopict-10-pojoaque-style-for-highlight-js-code-highlighter.html
[ao]: https://github.com/angelolloqui
[ar]: https://github.com/raleksandar
[jc]: https://github.com/jcheng5
[st]: https://github.com/tikhomirov
[sr]: https://github.com/sourrust
[ik]: https://github.com/ikalnitsky


## Version 6.2

A lot of things happened in highlight.js since the last version! We've got nine
new contributors, the discussion group came alive, and the main branch on GitHub
now counts more than 350 followers. Here are most significant results coming
from all this activity:

- 5 (five!) new languages: Rust, ActionScript, CoffeeScript, MatLab and
  experimental support for markdown. Thanks go to [Andrey Vlasovskikh][av],
  [Alexander Myadzel][am], [Dmytrii Nagirniak][dn], [Oleg Efimov][oe], [Denis
  Bardadym][db] and [John Crepezzi][jc].

- 2 new style themes: Monokai by [Luigi Maselli][lm] and stylistic imitation of
  another well-known highlighter Google Code Prettify by [Aahan Krish][ak].

- A vast number of [correctness fixes and code refactorings][log], mostly made
  by [Oleg Efimov][oe] and [Evgeny Stepanischev][es].

[av]: https://github.com/vlasovskikh
[am]: https://github.com/myadzel
[dn]: https://github.com/dnagir
[oe]: https://github.com/Sannis
[db]: https://github.com/btd
[jc]: https://github.com/seejohnrun
[lm]: http://grigio.org/
[ak]: https://github.com/geekpanth3r
[es]: https://github.com/bolknote
[log]: https://github.com/isagalaev/highlight.js/commits/


## Version 6.1 — Solarized

[Jeremy Hull][jh] has implemented my dream feature — a port of [Solarized][]
style theme famous for being based on the intricate color theory to achieve
correct contrast and color perception. It is now available for highlight.js in
both variants — light and dark.

This version also adds a new original style Arta. Its author pumbur maintains a
[heavily modified fork of highlight.js][pb] on GitHub.

[jh]: https://github.com/sourrust
[solarized]: http://ethanschoonover.com/solarized
[pb]: https://github.com/pumbur/highlight.js


## Version 6.0

New major version of the highlighter has been built on a significantly
refactored syntax. Due to this it's even smaller than the previous one while
supporting more languages!

New languages are:

- Haskell by [Jeremy Hull][sourrust]
- Erlang in two varieties — module and REPL — made collectively by [Nikolay
  Zakharov][desh], [Dmitry Kovega][arhibot] and [Sergey Ignatov][ignatov]
- Objective C by [Valerii Hiora][vhbit]
- Vala by [Antono Vasiljev][antono]
- Go by [Stephan Kountso][steplg]

[sourrust]: https://github.com/sourrust
[desh]: http://desh.su/
[arhibot]: https://github.com/arhibot
[ignatov]: https://github.com/ignatov
[vhbit]: https://github.com/vhbit
[antono]: https://github.com/antono
[steplg]: https://github.com/steplg

Also this version is marginally faster and fixes a number of small long-standing
bugs.

Developer overview of the new language syntax is available in a [blog post about
recent beta release][beta].

[beta]: http://softwaremaniacs.org/blog/2011/04/25/highlight-js-60-beta/en/

P.S. New version is not yet available on a Yandex CDN, so for now you have to
download [your own copy][d].

[d]: /soft/highlight/en/download/


## Version 5.14

Fixed bugs in HTML/XML detection and relevance introduced in previous
refactoring.

Also test.html now shows the second best result of language detection by
relevance.


## Version 5.13

Past weekend began with a couple of simple additions for existing languages but
ended up in a big code refactoring bringing along nice improvements for language
developers.

### For users

- Description of C++ has got new keywords from the upcoming [C++ 0x][] standard.
- Description of HTML has got new tags from [HTML 5][].
- CSS-styles have been unified to use consistent padding and also have lost
  pop-outs with names of detected languages.
- [Igor Kalnitsky][ik] has sent two new language descriptions: CMake & VHDL.

This makes total number of languages supported by highlight.js to reach 35.

Bug fixes:

- Custom classes on `<pre>` tags are not being overridden anymore
- More correct highlighting of code blocks inside non-`<pre>` containers:
  highlighter now doesn't insist on replacing them with its own container and
  just replaces the contents.
- Small fixes in browser compatibility and heuristics.

[c++ 0x]: http://ru.wikipedia.org/wiki/C%2B%2B0x
[html 5]: http://en.wikipedia.org/wiki/HTML5
[ik]: http://kalnitsky.org.ua/

### For developers

The most significant change is the ability to include language submodes right
under `contains` instead of defining explicit named submodes in the main array:

    contains: [
      'string',
      'number',
      {begin: '\\n', end: hljs.IMMEDIATE_RE}
    ]

This is useful for auxiliary modes needed only in one place to define parsing.
Note that such modes often don't have `className` and hence won't generate a
separate `<span>` in the resulting markup. This is similar in effect to
`noMarkup: true`. All existing languages have been refactored accordingly.

Test file test.html has at last become a real test. Now it not only puts the
detected language name under the code snippet but also tests if it matches the
expected one. Test summary is displayed right above all language snippets.


## CDN

Fine people at [Yandex][] agreed to host highlight.js on their big fast servers.
[Link up][l]!

[yandex]: http://yandex.com/
[l]: http://softwaremaniacs.org/soft/highlight/en/download/


## Version 5.10 — "Paris".

Though I'm on a vacation in Paris, I decided to release a new version with a
couple of small fixes:

- Tomas Vitvar discovered that TAB replacement doesn't always work when used
  with custom markup in code
- SQL parsing is even more rigid now and doesn't step over SmallTalk in tests


## Version 5.9

A long-awaited version is finally released.

New languages:

- Andrew Fedorov made a definition for Lua
- a long-time highlight.js contributor [Peter Leonov][pl] made a definition for
  Nginx config
- [Vladimir Moskva][vm] made a definition for TeX

[pl]: http://kung-fu-tzu.ru/
[vm]: http://fulc.ru/

Fixes for existing languages:

- [Loren Segal][ls] reworked the Ruby definition and added highlighting for
  [YARD][] inline documentation
- the definition of SQL has become more solid and now it shouldn't be overly
  greedy when it comes to language detection

[ls]: http://gnuu.org/
[yard]: http://yardoc.org/

The highlighter has become more usable as a library allowing to do highlighting
from initialization code of JS frameworks and in ajax methods (see.
readme.eng.txt).

Also this version drops support for the [WordPress][wp] plugin. Everyone is
welcome to [pick up its maintenance][p] if needed.

[wp]: http://wordpress.org/
[p]: http://bazaar.launchpad.net/~isagalaev/+junk/highlight/annotate/342/src/wp_highlight.js.php


## Version 5.8

- Jan Berkel has contributed a definition for Scala. +1 to hotness!
- All CSS-styles are rewritten to work only inside `<pre>` tags to avoid
  conflicts with host site styles.


## Version 5.7.

Fixed escaping of quotes in VBScript strings.


## Version 5.5

This version brings a small change: now .ini-files allow digits, underscores and
square brackets in key names.


## Version 5.4

Fixed small but upsetting bug in the packer which caused incorrect highlighting
of explicitly specified languages. Thanks to Andrew Fedorov for precise
diagnostics!


## Version 5.3

The version to fulfil old promises.

The most significant change is that highlight.js now preserves custom user
markup in code along with its own highlighting markup. This means that now it's
possible to use, say, links in code. Thanks to [Vladimir Dolzhenko][vd] for the
[initial proposal][1] and for making a proof-of-concept patch.

Also in this version:

- [Vasily Polovnyov][vp] has sent a GitHub-like style and has implemented
  support for CSS @-rules and Ruby symbols.
- Yura Zaripov has sent two styles: Brown Paper and School Book.
- Oleg Volchkov has sent a definition for [Parser 3][p3].

[1]: http://softwaremaniacs.org/forum/highlightjs/6612/
[p3]: http://www.parser.ru/
[vp]: http://vasily.polovnyov.ru/
[vd]: http://dolzhenko.blogspot.com/


## Version 5.2

- at last it's possible to replace indentation TABs with something sensible
  (e.g. 2 or 4 spaces)
- new keywords and built-ins for 1C by Sergey Baranov
- a couple of small fixes to Apache highlighting


## Version 5.1

This is one of those nice version consisting entirely of new and shiny
contributions!

- [Vladimir Ermakov][vooon] created highlighting for AVR Assembler
- [Ruslan Keba][rukeba] created highlighting for Apache config file. Also his
  original visual style for it is now available for all highlight.js languages
  under the name "Magula".
- [Shuen-Huei Guan][drake] (aka Drake) sent new keywords for RenderMan
  languages. Also thanks go to [Konstantin Evdokimenko][ke] for his advice on
  the matter.

[vooon]: http://vehq.ru/about/
[rukeba]: http://rukeba.com/
[drake]: http://drakeguan.org/
[ke]: http://k-evdokimenko.moikrug.ru/


## Version 5.0

The main change in the new major version of highlight.js is a mechanism for
packing several languages along with the library itself into a single compressed
file. Now sites using several languages will load considerably faster because
the library won't dynamically include additional files while loading.

Also this version fixes a long-standing bug with Javascript highlighting that
couldn't distinguish between regular expressions and division operations.

And as usually there were a couple of minor correctness fixes.

Great thanks to all contributors! Keep using highlight.js.


## Version 4.3

This version comes with two contributions from [Jason Diamond][jd]:

- language definition for C# (yes! it was a long-missed thing!)
- Visual Studio-like highlighting style

Plus there are a couple of minor bug fixes for parsing HTML and XML attributes.

[jd]: http://jason.diamond.name/weblog/


## Version 4.2

The biggest news is highlighting for Lisp, courtesy of Vasily Polovnyov. It's
somewhat experimental meaning that for highlighting "keywords" it doesn't use
any pre-defined set of a Lisp dialect. Instead it tries to highlight first word
in parentheses wherever it makes sense. I'd like to ask people programming in
Lisp to confirm if it's a good idea and send feedback to [the forum][f].

Other changes:

- Smalltalk was excluded from DEFAULT_LANGUAGES to save traffic
- [Vladimir Epifanov][voldmar] has implemented javascript style switcher for
  test.html
- comments now allowed inside Ruby function definition
- [MEL][] language from [Shuen-Huei Guan][drake]
- whitespace now allowed between `<pre>` and `<code>`
- better auto-detection of C++ and PHP
- HTML allows embedded VBScript (`<% .. %>`)

[f]: http://softwaremaniacs.org/forum/highlightjs/
[voldmar]: http://voldmar.ya.ru/
[mel]: http://en.wikipedia.org/wiki/Maya_Embedded_Language
[drake]: http://drakeguan.org/


## Version 4.1

Languages:

- Bash from Vah
- DOS bat-files from Alexander Makarov (Sam)
- Diff files from Vasily Polovnyov
- Ini files from myself though initial idea was from Sam

Styles:

- Zenburn from Vladimir Epifanov, this is an imitation of a
  [well-known theme for Vim][zenburn].
- Ascetic from myself, as a realization of ideals of non-flashy highlighting:
  just one color in only three gradations :-)

In other news. [One small bug][bug] was fixed, built-in keywords were added for
Python and C++ which improved auto-detection for the latter (it was shame that
[my wife's blog][alenacpp] had issues with it from time to time). And lastly
thanks go to Sam for getting rid of my stylistic comments in code that were
getting in the way of [JSMin][].

[zenburn]: http://en.wikipedia.org/wiki/Zenburn
[alenacpp]: http://alenacpp.blogspot.com/
[bug]: http://softwaremaniacs.org/forum/viewtopic.php?id=1823
[jsmin]: http://code.google.com/p/jsmin-php/


## Version 4.0

New major version is a result of vast refactoring and of many contributions.

Visible new features:

- Highlighting of embedded languages. Currently is implemented highlighting of
  Javascript and CSS inside HTML.
- Bundled 5 ready-made style themes!

Invisible new features:

- Highlight.js no longer pollutes global namespace. Only one object and one
  function for backward compatibility.
- Performance is further increased by about 15%.

Changing of a major version number caused by a new format of language definition
files. If you use some third-party language files they should be updated.


## Version 3.5

A very nice version in my opinion fixing a number of small bugs and slightly
increased speed in a couple of corner cases. Thanks to everybody who reports
bugs in he [forum][f] and by email!

There is also a new language — XML. A custom XML formerly was detected as HTML
and didn't highlight custom tags. In this version I tried to make custom XML to
be detected and highlighted by its own rules. Which by the way include such
things as CDATA sections and processing instructions (`<? ... ?>`).

[f]: http://softwaremaniacs.org/forum/viewforum.php?id=6


## Version 3.3

[Vladimir Gubarkov][xonix] has provided an interesting and useful addition.
File export.html contains a little program that shows and allows to copy and
paste an HTML code generated by the highlighter for any code snippet. This can
be useful in situations when one can't use the script itself on a site.


[xonix]: http://xonixx.blogspot.com/


## Version 3.2 consists completely of contributions:

- Vladimir Gubarkov has described SmallTalk
- Yuri Ivanov has described 1C
- Peter Leonov has packaged the highlighter as a Firefox extension
- Vladimir Ermakov has compiled a mod for phpBB

Many thanks to you all!


## Version 3.1

Three new languages are available: Django templates, SQL and Axapta. The latter
two are sent by [Dmitri Roudakov][1]. However I've almost entirely rewrote an
SQL definition but I'd never started it be it from the ground up :-)

The engine itself has got a long awaited feature of grouping keywords
("keyword", "built-in function", "literal"). No more hacks!

[1]: http://roudakov.ru/


## Version 3.0

It is major mainly because now highlight.js has grown large and has become
modular. Now when you pass it a list of languages to highlight it will
dynamically load into a browser only those languages.

Also:

- Konstantin Evdokimenko of [RibKit][] project has created a highlighting for
  RenderMan Shading Language and RenderMan Interface Bytestream. Yay for more
  languages!
- Heuristics for C++ and HTML got better.
- I've implemented (at last) a correct handling of backslash escapes in C-like
  languages.

There is also a small backwards incompatible change in the new version. The
function initHighlighting that was used to initialize highlighting instead of
initHighlightingOnLoad a long time ago no longer works. If you by chance still
use it — replace it with the new one.

[RibKit]: http://ribkit.sourceforge.net/


## Version 2.9

Highlight.js is a parser, not just a couple of regular expressions. That said
I'm glad to announce that in the new version 2.9 has support for:

- in-string substitutions for Ruby -- `#{...}`
- strings from from numeric symbol codes (like #XX) for Delphi


## Version 2.8

A maintenance release with more tuned heuristics. Fully backwards compatible.


## Version 2.7

- Nikita Ledyaev presents highlighting for VBScript, yay!
- A couple of bugs with escaping in strings were fixed thanks to Mickle
- Ongoing tuning of heuristics

Fixed bugs were rather unpleasant so I encourage everyone to upgrade!


## Version 2.4

- Peter Leonov provides another improved highlighting for Perl
- Javascript gets a new kind of keywords — "literals". These are the words
  "true", "false" and "null"

Also highlight.js homepage now lists sites that use the library. Feel free to
add your site by [dropping me a message][mail] until I find the time to build a
submit form.

[mail]: mailto:Maniac@SoftwareManiacs.Org


## Version 2.3

This version fixes IE breakage in previous version. My apologies to all who have
already downloaded that one!


## Version 2.2

- added highlighting for Javascript
- at last fixed parsing of Delphi's escaped apostrophes in strings
- in Ruby fixed highlighting of keywords 'def' and 'class', same for 'sub' in
  Perl


## Version 2.0

- Ruby support by [Anton Kovalyov][ak]
- speed increased by orders of magnitude due to new way of parsing
- this same way allows now correct highlighting of keywords in some tricky
  places (like keyword "End" at the end of Delphi classes)

[ak]: http://anton.kovalyov.net/


## Version 1.0

Version 1.0 of javascript syntax highlighter is released!

It's the first version available with English description. Feel free to post
your comments and question to [highlight.js forum][forum]. And don't be afraid
if you find there some fancy Cyrillic letters -- it's for Russian users too :-)

[forum]: http://softwaremaniacs.org/forum/viewforum.php?id=6
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# Highlight.js

[![Build Status](https://travis-ci.org/isagalaev/highlight.js.svg?branch=master)](https://travis-ci.org/isagalaev/highlight.js)

Highlight.js is a syntax highlighter written in JavaScript. It works in the
browser as well as on the server. It works with pretty much any markup,
doesn't depend on any framework and has automatic language detection.


## Getting Started

The bare minimum for using highlight.js on a web page is linking to the library
along with one of the styles and calling [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

This will find and highlight code inside of `<pre><code>` tags trying to detect
the language automatically. If automatic detection doesn't work for you, you can
specify the language in the class attribute:

```html
<pre><code class="html">...</code></pre>
```

The list of supported language classes is available in the [class reference][8].
Classes can also be prefixed with either `language-` or `lang-`.

To disable highlighting altogether use the `nohighlight` class:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Custom Initialization

When you need a bit more control over the initialization of
highlight.js, you can use the [`highlightBlock`][2] and [`configure`][3]
functions. This allows you to control *what* to highlight and *when*.

Here's an equivalent way to calling [`initHighlightingOnLoad`][1] using jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

You can use any tags instead of `<pre><code>` to mark up your code. If you don't
use a container that preserve line breaks you will need to configure
highlight.js to use the `<br>` tag:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

For other options refer to the documentation for [`configure`][3].


## Getting the Library

You can get highlight.js as a hosted or custom-build browser script or as a
server module. Head over to the [download page][4] for all the options.

Note, that the library is not supposed to work straight from the source on
GitHub, it requires building. If none of the pre-packaged options work for you
refer to the [building documentation][5].


## License

Highlight.js is released under the BSD License. See [LICENSE][10] file for
details.


## Links

The official site for the library is at <https://highlightjs.org/>.

Further in-depth documentation for the API and other topics is at
<http://highlightjs.readthedocs.org/>.

Authors and contributors are listed in the [AUTHORS.en.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.en.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE




OEBPS/content.opf
   4.4_idm139732978196224 Virtual Machine Management Guide 2024-02-26 This document describes the installation, configuration, and administration of virtual machines in Red Hat Virtualization. Red Hat Virtualization Documentation Team en                                                                                                                                                                                                                                                                             



OEBPS/Common_Content/images/shine.png





OEBPS/Common_Content/images/shade.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-BoldItalic.woff2


OEBPS/images/hp_vm.png





OEBPS/Common_Content/images/36.png





OEBPS/Common_Content/images/stock-home.png





OEBPS/Common_Content/images/image_right.png





OEBPS/Common_Content/images/stock-go-up.png





OEBPS/Common_Content/images/red.png





OEBPS/Common_Content/images/32.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-RegularItalic.woff


OEBPS/Common_Content/icons/redhat-books-icons-a2efd68d1f13be356c9c4e5c29a64e69.ttf


OEBPS/Common_Content/scripts/highlight.js/styles/pojoaque.jpg





OEBPS/Common_Content/images/28.png





OEBPS/Common_Content/images/3.png





OEBPS/Common_Content/scripts/highlight.js/styles/brown_papersq.png





OEBPS/Common_Content/fonts/redhat/text/RedHatText-BoldItalic.woff2


OEBPS/Common_Content/images/image_left.png
& RedHat





OEBPS/Common_Content/fonts/overpass_regular-web.ttf


OEBPS/Common_Content/images/16.png





OEBPS/Common_Content/scripts/highlight.js/styles/school_book.png





OEBPS/Common_Content/images/13.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-BlackItalic.woff2


OEBPS/Common_Content/images/39.png





OEBPS/Common_Content/fonts/redhat/text/RedHatText-MediumItalic.eot


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Medium.woff2


OEBPS/Common_Content/fonts/overpass_bold-web.ttf


OEBPS/Common_Content/images/bullet_arrowblue.png





OEBPS/Common_Content/fonts/portal/nimbus/iconfont.woff


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Medium.eot


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Black.eot


OEBPS/Common_Content/images/24.png





OEBPS/Common_Content/scripts/highlight.js/highlight.pack.js
/*! highlight.js v9.2.0 | BSD3 License | git.io/hljslicense */
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OEBPS/Common_Content/scripts/highlight.js/LICENSE
Copyright (c) 2006, Ivan Sagalaev
All rights reserved.
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

    * Redistributions of source code must retain the above copyright
      notice, this list of conditions and the following disclaimer.
    * Redistributions in binary form must reproduce the above copyright
      notice, this list of conditions and the following disclaimer in the
      documentation and/or other materials provided with the distribution.
    * Neither the name of highlight.js nor the names of its contributors 
      may be used to endorse or promote products derived from this software 
      without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE REGENTS AND CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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OEBPS/Common_Content/scripts/utils.js
var work = 1;

function pop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popper/,"popped");
	}
}
function unpop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popped/,"popper");
	}
}

function siblings(entity){
	var r = [];
	for ( var n = entity.parentNode.firstChild; n; n = n.nextSibling ) 
		if ( n.nodeType == 1 && n != entity)
			r.push( n );		
	return r;
}

/* This activates an element and deactivates all it's siblings */
function activateElement(id) {
	var entity = document.getElementById(id);
	if(entity.className.indexOf("active") == -1) {
		entity.className = entity.className + " active";
	}
	var sibs = siblings(entity);

	for(var i=0; i < sibs.length; i++) {
		if(sibs[i].className.indexOf("active") != -1) {
			deactivateElement(sibs[i]);
		}
	}
}

function deactivateElement(entity) {
	if(entity.className.indexOf("active") != -1) {
		 entity.className = entity.className.replace(/[ ]*active/, '');
	}
}

function getCookie(name) {
	var name_c = window.location.hostname + '-' + name;

	if(document.cookie) {
		var cookies = document.cookie.split(/ *; */);
		for(var i=0; i < cookies.length; i++) {
			var current_c = cookies[i].split("=");
			if(current_c[0] == name_c) {
				return(current_c[1]);
				break;
			}
		}
	}
	return('');
}

function setCookie(name, value, expires, path) {
	name = window.location.hostname + '-' + name;

	var curCookie = name + "=" + value + 
		((expires) ? ";expires=" + expires.toGMTString() : "") + 
		((path) ? ";path=" + path : "");
	document.cookie = curCookie; 
}

function setDefLangCookie(entity) {
	setCookie('switchery', entity.options[entity.selectedIndex].value, '', '/');
}

function initSwitchery() {
	var divs = document.getElementsByTagName('div');
	for(i in divs) {
		if(typeof(divs[i].className) != 'undefined' && divs[i].className.indexOf("switchery") != -1) {
			var lang = getCookie('switchery');
			if(lang != '') {
				var entity = document.getElementById(divs[i].id + '-' + lang);
				if(entity) {
					entity.onclick();
					entity.parentNode.lastChild.value = lang;
				} else {
					divs[i].firstChild.firstChild.onclick();
				}
			} else {
				divs[i].firstChild.firstChild.onclick();
			}
		}
	}

}

function showhide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("hidden") != -1) {
				entity.className = my_class.replace(/hidden/,"visible");
			}
			else if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	}

	return false;
}

function hide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	} else {
		work=1;
	}
}

var preventReset = 0;

function dehighlightTarget(entity) {
	if(preventReset == 0 && entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		var target = document.getElementById(id);
		if(target) {
			deactivateElement(target);
		}
		}
}

function highlightTarget(entity, norefresh) {
	if(entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		activateElement(id);
		preventReset = 0;
	} 
	if(norefresh == 1) {
		preventReset=1;
	}
}





OEBPS/Common_Content/images/29.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-BlackItalic.eot


OEBPS/Common_Content/images/21.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-RegularItalic.eot


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Medium.woff


OEBPS/Common_Content/fonts/redhat/text/RedHatText-Regular.woff2


OEBPS/Common_Content/fonts/portal/nimbus/iconfont.ttf


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Bold.eot


OEBPS/Common_Content/images/31.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Regular.eot


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-MediumItalic.eot


OEBPS/Common_Content/images/stock-go-forward.png





OEBPS/Common_Content/images/6.png





OEBPS/Common_Content/images/14.png





OEBPS/Common_Content/images/1.png





OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Black.woff2


OEBPS/images/vm_hp_pool.png





OEBPS/Common_Content/images/25.png





OEBPS/Common_Content/fonts/redhat/text/RedHatText-RegularItalic.woff2


OEBPS/Common_Content/fonts/redhat/display/RedHatDisplay-Black.woff


